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Safety Information

Safety Information

Important Information

Please Note

Read these instructions carefully, and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this documentation or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an
electrical hazard exists which will result in personal injury if the instructions are not
followed.

hazards. Obey all safety messages that follow this symbol to avoid possible injury or
death.

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

2 This is the safety alert symbol. It is used to alert you to potential personal injury

A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and its installation, and has received safety
training to recognize and avoid the hazards involved.

EIO0000003412.05
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About the Book

About the Book

Document Scope

This document describes how to use the EcoStruxure™ Machine Expert - HYAC
software to configure, program, and commission applications for supported logic

controllers.

Validity Note

The information in this document is applicable only for EcoStruxure Machine

Expert - HVAC products.

This document has been updated for the release of EcoStruxure Machine Expert -

HVAC V1.6.0.

Related Documents

Title of documentation Reference number
Modicon M171 Optimized Logic Controller - Hardware Guide EI00000002032 (ENG)
Modicon M172 Performance Logic Controller - Hardware Guide EIO0000002015 (ENG)
EcoStruxure Machine Expert HYAC&R Function Library User Guide EI00000002057 (ENG)
TM172 Optimized & Performance 7/18 10 - Instruction Sheet QGH90428

TM172 Performance 28/42 10 - Instruction Sheet NHA87740

TM172 Optimized & Performance Isolated 28/42 IO - Instruction Sheet PHA83703

TM172 Optimized & Performance Expansion 12/28 IO - Instruction Sheet QGH26895
TM172DCLW?e+« Display Color Touchscreen - Instruction Sheet QGH26896
TM172DCLF- Display Color Touchscreen Flush Mounting - Instruction Sheet PHA38669
TM172DGRP Monochrome Display - Instruction Sheet JYT15912

Modicon M171A Communication Modules - Instruction Sheet EAV96007

To find documents online, visit the Schneider Electric download center

(www.se.com/ww/en/download/).
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About the Book

Product Related Information

AWARNING

LOSS OF CONTROL

» The designer of any control scheme must consider the potential failure
modes of control paths and, for certain critical control functions, provide a
means to achieve a safe state during and after a path failure. Examples of
critical control functions are emergency stop and overtravel stop, power
outage and restart.

» Separate or redundant control paths must be provided for critical control
functions.

» System control paths may include communication links. Consideration must
be given to the implications of unanticipated transmission delays or failures
of the link.

* Observe all accident prevention regulations and local safety guidelines.!

» Each implementation of this equipment must be individually and thoroughly
tested for proper operation before being placed into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety
Guidelines for the Application, Installation, and Maintenance of Solid State
Control" and to NEMA ICS 7.1 (latest edition), "Safety Standards for Construction
and Guide for Selection, Installation and Operation of Adjustable-Speed Drive
Systems" or their equivalent governing your particular location.

AWARNING

UNINTENDED EQUIPMENT OPERATION

» Only use software approved by Schneider Electric for use with this
equipment.

» Update your application program every time you change the physical
hardware configuration.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Terminology Derived from Standards

The technical terms, terminology, symbols and the corresponding descriptions in
the information contained herein, or that appear in or on the products themselves,
are generally derived from the terms or definitions of international standards.

In the area of functional safety systems, drives and general automation, this may
include, but is not limited to, terms such as safety, safety function, safe state, fault,
fault reset, malfunction, failure, error, error message, dangerous, etc.

Among others, these standards include:

Standard Description

IEC 61131-2:2007 Programmable controllers, part 2: Equipment
requirements and tests.

1ISO 13849-1:2023 Safety of machinery: Safety related parts of
control systems.
General principles for design.

EN 61496-1:2013 Safety of machinery: Electro-sensitive protective
equipment.
Part 1: General requirements and tests.

EIO0000003412.05 13
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ISO 12100:2010

Safety of machinery — General principles for
design — Risk assessment and risk reduction.

EN 60204-1:2006

Safety of machinery — Electrical equipment of
machines — Part 1: General requirements.

ISO 14119:2013

Safety of machinery — Interlocking devices
associated with guards — Principles for design
and selection.

ISO 13850:2015

Safety of machinery — Emergency stop —
Principles for design.

IEC 62061:2021

Safety of machinery — Functional safety of
safety-related electrical, electronic, and
electronic programmable control systems.

IEC 61508-1:2010

Functional safety of electrical/electronic/
programmable electronic safety-related
systems: General requirements.

IEC 61508-2:2010

Functional safety of electrical/electronic/
programmable electronic safety-related
systems: Requirements for electrical/electronic/
programmable electronic safety-related
systems.

IEC 61508-3:2010

Functional safety of electrical/electronic/
programmable electronic safety-related
systems: Software requirements.

IEC 61784-3:2021

Industrial communication networks — Profiles
— Part 3: Functional safety fieldbuses —
General rules and profile definitions.

2006/42/EC Machine Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive

In addition, terms used in the present document may tangentially be used as they

are derived from other standards such as:

Standard Description

IEC 60034 series Rotating electrical machines.

IEC 61800 series Adjustable speed electrical power drive
systems.

IEC 61158 series Digital data communications for measurement

and control — Fieldbus for use in industrial
control systems.

Finally, the term zone of operation may be used in conjunction with the description
of specific hazards, and is defined as it is for a hazard zone or danger zone in the
Machinery Directive (2006/42/EC) and ISO 12100:2010.

NOTE: The aforementioned standards may or may not apply to the specific
products cited in the present documentation. For more information concerning
the individual standards applicable to the products described herein, see the
characteristics tables for those product references.

14
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Introduction to EcoStruxure Machine Expert - HVAC

Overview

Features

The EcoStruxure Machine Expert - HVAC software makes it possible to create and
customize IEC 61131-3 programs for various types of applications. You can
download EcoStruxure Machine Expert - HVAC from Schneider-electric web site
download center. It is intended for applications in HVYAC&R.

EcoStruxure Machine Expert - HVAC is an IEC 61131-3 Integrated Development
Environment supporting the whole range of languages defined in the standard.

In order to support the user in the activities involved in the development of an
application, EcoStruxure Machine Expert - HVAC includes:

+ Textual source code editors programming languages:
o |Instruction List (IL) , page 272
o Structured Text (ST), page 281
» Graphical source code editors programming languages:
o Ladder Diagram (LD), page 279
o Function Block Diagram (FBD), page 275
o Sequential Function Chart (SFC), page 290

» A compiler, which translates applications written according to the IEC
standard directly into object code, avoiding the need for a run-time interpreter,
thus making the program execution as fast as possible.

* A communication system which allows the download of the application to the
target environment.

» A set of debugging tools, ranging from an easy-to-use watch window to more
powerful tools, which allows the sampling of fast changing data directly on the
target environment.

EcoStruxure Machine Expert - HVAC Software Component

EcoStruxure Machine Expert - HVAC allows you to:
+ Create and manage libraries, applications, and diagnostics

* Manage previously developed projects, download projects, and modify device
parameters from a communication port

EcoStruxure Machine Expert - HVAC is divided into four tabs:
» Configuration
* Programming
+ Display

16
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+ Commissioning

For more information about the tabs of EcoStruxure Machine Expert - HVAC, refer
to Tabs, page 24.

System Requirements and Supported Devices

System Requirements

Overview

EcoStruxure Machine Expert - HVAC can be installed on a personal computer
having the following characteristics.

Operative System:

*  Windows 10 64 Bit

*  Windows 11 64 Bit
Hardware requirements:

* Processor Pentium 1.6 GHz or later

*+ RAM Memory 1 GB; 2 GB preferred

» Hard Disk 1 GB of free space

» Peripherals Mouse or compatible pointing device

» Peripherals USB interface

+  Web access: Web registration requires Internet access
EcoStruxure Machine Expert - HVAC requires Administrator rights to be installed.

For further information, contact your Schneider Electric support center.

Supported Devices

Logic Controllers

For more information about the logic controllers, refer to the following hardware

guides:

Reference Description Hardware Guide

M1730 Modicon M173 Optimized Logic Controller Modicon M173 Optimized Logic
Controller — Hardware Guide

TM172Q000ee Modicon M172 Optimized Logic Controller Modicon M172 Logic Controller -
Hardware Guide

TMA72Pesesee Modicon M172 Performance Logic Controller

TMA171000eee Modicon M171 Optimized Logic Controller Modicon M171 Optimized Logic
Controller - Hardware Guide

TM171Poeses Modicon M171 Performance Logic Controller Modicon M171 Performance Logic
Controller - Hardware Guide

Expansion Modules

For more information about the expansion modules and their compatibility, refer to
the following hardware guides:

Reference Description Hardware Guide

TM171EO14R M171 Optimized Expansion 14 I/Os Modicon M171 Optimized Logic
Controller - Hardware Guide
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Reference Description Hardware Guide

TM171EO15R M171 Optimized Expansion 15 1/Os

TM171EO22R M171 Optimized Expansion 22 1/Os

TM171EP14R Modicon M171 Performance Expansion 14 |/Os Modicon M171 Performance Logic
Controller - Hardware Guide

TM171EP27R Modicon M171 Performance Expansion 27 |/Os

TM172E12R Modicon M172 Optimized & Performance Expansion 12 1/0Os | Modicon M172 Logic Controller -
Hardware Guide

TM172E28R Modicon M172 Optimized & Performance Expansion 28 I/Os

Electronic Expansion Valve Driver

For more information about the electric expansion valve drivers and their

compatibility, refer to the following guide:

Reference Description Hardware Guide
TM172EVEV-+ Modicon M172 Electronic Expansion Valve Driver Modicon M172 Electronic Expansion
Valve Driver - Hardware Guide
Displays
For more information about the displays and their compatibility, refer to the
following hardware guides:
Reference Description Hardware Guide
TM173DLED M173 Optimized Remote Display LED Modicon M173 Optimized Logic
Controller — Hardware Guide
TM172DCLFG M172 Color Touchscreen remote display flush mounting white | Modicon M172 Logic Controller -
Hardware Guide
TM172DCLFW M172 Color Touchscreen remote display flush mounting gray
TM172DCLWT M172 Color Touchscreen remote display vertical mounting
with built-in temperature sensor
TM172DCLWTH M172 Color Touchscreen remote display vertical mounting
with built-in temperature and humidity sensors
TM172DCLWTHP M172 Color Touchscreen remote display vertical mounting
with built-in temperature, humidity, and presence (PIR)
sensors
TM172DGRP M172 Monochrome Display Graphic
TM171DLED M171 Optimized Display LED Modicon M171 Optimized Logic
Controller - Hardware Guide
TM171DLCD2U M171 Optimized Display LCD
TM171DWAL2U M171 Optimized Wall thermostat without backlight
TM171DWAL2L M171 Optimized Wall thermostat with backlight
TM171DGRP M171 Performance Display Graphic Modicon M171 Performance

Logic Controller - Hardware Guide

Connection and Communication Accessories

Overview

Several connection and communication accessories may be required to connect

the target to a PC.

Connection to the PC allows you to debug, commission, download and upload

your application.

18
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AWARNING

AUTOMATIC RESTART OF CONTROLLER

» Do not download your application without first accessing the state of your
machine or process.

» Do not download your application without first ascertaining that there is no
risk of injury to anyone in or around your machine or process.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

M1710 PC Connection

M1710 can be connected to a PC through the USB/TTL-12C hardware interface:
* Use the software itself.
» Connect to the target device in order to control it.
+ Connect to the Programming Stick component.
The Programming Stick is a memory support, which allows to:
» Update the firmware of the target device.
« Update the controller application of the target device.
» Update the parameter values of the target device.
* Upload the parameter values from the target device.
The following connection cables are available:
*  “Yellow” cable with JST — molex terminals.
+ “Blue” cable with JST — JST terminals.
» USB-A/A extension lead, 2 m.

M172 PC Connection

M172 can be connected to a PC through the USB port and a USB cable:

*  Type Mini-B USB (DEVICE). Used to connect TM172Pseeece [ TM172Q¢ee¢ to
a PC via Mini-B/A USB cable for debugging, commissioning, downloading,
and uploading with EcoStruxure Machine Expert - HVAC.

» Type micro-B USB (DEVICE). Used to connect TM172DCLe*** to a PC via
micro-B/A USB cable for debugging, commissioning, downloading, and
uploading with EcoStruxure Machine Expert - HVAC.

Alternatively, the type A USB (HOST) port of the controller can be used to connect
a USB memory key drive to download the application.

The TM172Peesces | TM17207¢+++ can also be supplied through the USB cable with
limited functionalities related to debugging, commissioning, downloading and
uploading with EcoStruxure Machine Expert - HVAC.

For more details, refer to Modicon M172 Logic Controller Hardware Guide.

M171P PC Connection

M171P can be connected to a PC through the USB port and a USB cable:

* Type AUSB (HOST). Used to connect a USB memory key drive when
downloading the application, and to export if the application running on the
PLC supports this feature.

* Type Mini-B USB (DEVICE). Used to connect M171P to a PC via Mini-B/A
USB cable for debugging, commissioning, downloading, and uploading with
EcoStruxure Machine Expert - HVAC.
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M1730 PC Connection

M1730 can be connected to a PC through the USB port and a USB cable:

USB (Type C). Used to connect M1730 to a PC via USB (Type A) / USB (Type C)
cable for debugging, commissioning, downloading, and uploading with
EcoStruxure Machine Expert - HVAC.

Alternatively, the USB (Type C) port of the controller can be used to connect a
USB (Type C) memory key drive to download the application.

For more details, refer to Modicon M173 Optimized Logic Controller — Hardware
Guide.

M171P/M172 Programming Converters

To communicate with the controller, you can also use an USB/RS-485 adapter
TSXCUSB485 with cable VW3A8306D30.

Alternatively, if there is an RS-232 serial port, M171P/M172 can be connected to
the PC using an RS-485/RS-232 adapter.

M171P/M172 Communication Modules

A wide range of communication modules allows integration with industrial
systems, BMS, and Ethernet networks.

NOTE: Not available with M171P Flush Mounting.
For more details, refer to communication modules description, page 88.

EcoStruxure Machine Expert - HVAC Basics

Creating Projects with EcoStruxure Machine Expert - HVAC

Overview

EcoStruxure Machine Expert - HVAC is a graphical programming tool designed to
configure, develop, and commission programs for logic controllers.

EcoStruxure Machine Expert - HVAC Terminology

EcoStruxure Machine Expert - HVAC uses the following terms:
* Project: A EcoStruxure Machine Expert - HVAC project contains:
o The developer and purpose of the project.

o The configuration of the logic controller and associated expansion
modules targeted by the project.

o The source code of a program, symbols, comments, documentation, and
the other related information.

» Application: Contains the parts of the project that are downloaded to the
logic controller, including the compiled program and hardware configuration.

* Program: The compiled source code that runs on the logic controller.

» POU (Program Organization Unit): The reusable object that contains a
variable declaration and a set of instructions used in a program.

» Target: Device connected to the PC.
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Developing Programs with EcoStruxure Machine Expert - HVAC

Introduction

The following diagram presents the typical stages of developing a project in
EcoStruxure Machine Expert - HVAC:

Business
Specifications &
Requirements
v ‘ " Select & assemble
B hardware :
- :
Configure | Configuration
... ’ . :
Set hardware :
settings
Define I/0 and
objects
v e T
. Ct& ......
> Program e ; rea epoSrgamze :
. - S Programming
h - o andlor
|| PePugging in .. ... Create & organize Display
online mode B : ;
: . display pages
Debugging in
simulator mode
- Define Targets .
.+ (Discover through :
Ethernet & USB) -
Y N Program :
e """ . Download/Upload :
Deploy  [G ‘ Commissioning
\ 5 Read and edit
- parameters
Simulate targets
R R T T T T T T T P PP PP i’.......

‘ Produce

Operating Modes

Introduction

The operating modes provide control to develop, debug, monitor, and modify the
application when the controller is connected or not connected to EcoStruxure
Machine Expert - HVAC.

EcoStruxure Machine Expert - HVAC can operate in the following modes:
+ Offline mode
* Online mode
+ Simulator mode
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Offline Mode

Online Mode

Simulator Mode

EcoStruxure Machine Expert - HVAC operates in offline mode when no physical
connection to a logic controller has been established.

In offline mode, you configure EcoStruxure Machine Expert - HVAC to match the
hardware components you are targeting, then develop your application.

EcoStruxure Machine Expert - HVAC operates in online mode when a logic
controller is physically connected to the PC.

In online mode, you can download your application to the logic controller.
Downloading and uploading application is not possible in the simulator mode.
EcoStruxure Machine Expert - HVAC then synchronizes the application in the PC
memory with the version stored in the logic controller, allowing you to debug,
monitor, and modify the application.

AWARNING

AUTOMATIC RESTART OF CONTROLLER

» Do not download your application without first accessing the state of your
machine or process.

» Do not download your application without first ascertaining that there is no
risk of injury to anyone in or around your machine or process.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

You can modify certain elements of a program in online mode. For example, you
can add or delete rungs, or modify the values of certain function block parameters.

NOTE: Online program modifications are subjected to the predefined
configuration. For more information, refer to Live Debug, page 213 and
Triggers, page 216.

EcoStruxure Machine Expert - HVAC operates in simulator mode when a
connection has been established with a simulated logic controller. In simulator
mode, no physical connection to a logic controller is established; instead
EcoStruxure Machine Expert - HVAC simulates a connection to a logic controller
and the expansion modules to run and test the program.

For more information, refer to Simulation, page 187.

22
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Software Interface

What’s in

Overview

Software Interface Customization

Overview

Welcome Window

This Chapter

The Welcome window is always displayed when you launch EcoStruxure
Machine Expert - HVAC. Use this window to select and open an existing project or
create a project, page 40.

Main Window

The EcoStruxure Machine Expert - HYAC main window provides access to menus
and commands, windows, and toolbars.

The illustration presents the EcoStruxure Machine Expert - HYAC main window:
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Description

Project toolbar, page 24

Tabs, page 24

Menu bar, page 25

Toolbars, page 33

Workspace, page 34
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Project Toolbar

Tabs

Item Description

6 Editor window

7 Tool windows, page 33
8 Status bar, page 34

The project toolbar is located at the top left of the main window which provides
access to the main commands using icons:

Icon Description

New project: creates a new project, any opened project must be closed. If the project
is not saved, a dialog box asks to save the project.

For more information, refer to Create a New Project, page 40.

Open project: opens a project saved on your computer.

For more information, refer to Open an Existing Project, page 44.

Save project: saves modifications to the current project.

For more information, refer to Save a Project, page 43.

Build all: compiles your project.

For more information, refer to Build All, page 47.

k= |EEe 00|

Download all: downloads onto the target.

For more information, refer to Download and Upload Applications, page 47.

EcoStruxure Machine Expert - HVAC consists of four development environments
for programming controllers:

Configuration, page 52

For creating networks. It is the entry point of the software.

Programming, page 92

For creating and managing libraries, controller applications and diagnostics.

It includes a Simulation mode, page 187, dedicated to software developers,
for running and testing controller applications without a logic controller and
expansion modules physically connected.

Display, page 319
For creating the graphical interface on built-in displays and remote displays.
Commissioning, page 406

For downloading the project to the connected logic controller device and
modifying device parameters from a serial port.

24
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Menu Bars
Overview
EcoStruxure Machine Expert - HVAC has several different menus. Most of them
depend on the context. They may or may not appear depending on the tab or the
action you are performing.
Tab Menu
All File, page 27
View, page 32
Help, page 27
Partially common Edit, page 26
Project, page 29
On-line, page 28
Options, page 28
Window, page 33
Configuration Developer, page 26
Programming Debug, page 25
Scheme, page 30
Variables, page 31
Tools, page 31
Display Page, page 28
Commissioning Parameters, page 29
Recipes, page 30
Target, page 31
Debug Menu
Command Icon Key Description
Simulation mode . - Open/close the integrated simulation environment.
o| i
Start/Stop watch value ‘a - Starts or stops (toggle) the evaluation of the symbols added in the watch
window.
Add symbol to watch - F8 Adds a symbol to the Watch window.
Inserts new item into watch .|.ﬂ Shift+F8 Inserts a new item into the Watch window.
Add symbol to a debug - F10 Adds a symbol to a debug window.
window
Inserts new item into a - Shift+F10 Inserts a new item into a debug window.
debug window
Quick watch symbol - F11 View and force the value of the selected symbol.
Live debug mode ..E.E - If debug mode is running, starts or stops (toggle) the live debug mode.
Add/remove text trigger g F9 Adds/removes a text trigger.
Add/remove Shift+F9 Adds/removes a graphic trigger.
graphic trigger m
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Command Icon Key Description

Remove all CtrI+Shift+F9 | Removes the active triggers.

triggers H

Trigger list & Ctri+l Lists the active triggers.

Run P - Restarts program after a breakpoint is hit.
Add/Remove F12 Adds or removes a breakpoint.
breakpoint .

Remove all - Removes the active breakpoints.
breakpoints D

Breakpoint list r.:' - Lists the active breakpoints.

Change current instance - - Changes the current function block instance (live debug mode).

Developer Menu

This menu gives access to features allowing you to share your project with other

developers:
Command Icon Key Description
Data export - - Export data to a CSV file, page 46.
Import EDS - - Import EDS (Electronic Data Sheet) file, page 74.
Run Modbus custom Editor - - Run Modbus custom editor, page 83.
Build Web site - - Generate a website to manage the target device remotely, page 67.
Generate EDE files - - Generates the Engineering Data Exchange (EDE) files in CSV format (in order to
be used by SCADA BACnet supervisor).
Edit Menu

Command Icon Key Description
Undo .9 Ctrl+zZ Cancels last action made.
Redo ? Ctri+Y Restores the last action canceled by Undo.
Cut Ctrl+X Removes the selected items from the active document and stores themin a

% system buffer.
Copy |j—-| Ctrl+C Copies the selected items to a system buffer.
Paste Ctrl+V Pastes in the active document the contents of the system buffer.

Al
Delete line - Ctrl+E Deletes the whole source code line.
Go to symbol = Shift+F12 Goes to variable declaration.

|

Find in project Ctrl+ Opens the Find in project dialog box.

s Shift+F
Bookmarks... - - Allows to manage the existing bookmarks.
Add/toggle - Ctrl+F2 Adds a bookmark to mark lines. If a bookmark is already defined, removes it.
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Command lcon Key Description

Next - F2 Goes to next defined bookmark.

Prev - Shift+F2 Goes to previous defined bookmark.

Remove all - - Removes the defined bookmarks.

Go to line - Ctri+G Allows user to move to a specific line in the source code editor.

Find... Ctrl+F Asks user to type a string and searches for its first instance within the active
I:k document from the current location of the cursor.

Find next - F3 Iterates between the results of the research, found by the Find command.

o
Replace - Ctri+H Allows you to automatically replace one or all the instances of a string with

another string.

Insert/Move mode

Toggle between those two editing modes, used to insert or move blocks.

Connection mode

Editing mode which allows user to draw logical wires to connect pins.

Watch mode I:k - Editing mode which allows user to add variables to any debugging tool.
File Menu
This menu gives access to features allowing you to manage your project:
Command Icon Key Description

New project

Creates a new project, page 40.

Open project

I—| Ctrl+O

Opens an existing project, page 44.

Save project

H Ctrl+S

Saves the current open project., page 43

Save project as...

Saves the current open project specifying new name, location and extension,
page 43.

Close project

Closes the open project, page 45.

Options...

Opens the Program options dialog box, page 38.

Print...

E Ctrl+P

Prints the document of the currently active window, page 42.

Print preview

Creates a preview of the document of the currently active window, ready to be
printed.

Printer setup...

Opens the Printer setup dialog box.

..recent..

Lists a set of recently opened project file.

Exit

Closes EcoStruxure Machine Expert - HVAC.

Help Menu

This menu gives access to features allowing you to read documentation about
hardware or some specific EcoStruxure Machine Expert - HVAC features:

EI00000003412.05
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Command Icon Key Description
Index - - Lists the Help keywords and opens the related topic.
Context - F1 Context-sensitive help. Opens the topic related to the currently active window.
About... - - Credits and version information.
On-line Menu
Command Icon Key Description

Set up communication...

Lets you set the properties of the connection to the target, page 177.

Connect

Starts the communication with the device, page 182.

Download code

Download the configuration and PLC application of the project to the device, page
184.

Download options...

Allows to set the properties of the source code downloaded to the target.

Force image upload

If the target device is connected, allows to upload the image file.

Force debug symbols
upload

If the target device is connected, allows to upload the debug symbols file.

Halt

Stops the PLC execution.

Cold restart

Restarts the PLC execution and both retain and non-retain variables are reset.

Warm restart

Restarts the PLC execution and non-retain variables are reset.

Hot restart

Restarts the PLC execution without any reset on variables.

Reboot target

Reboots the target.

Read all logs again

hN® ® @

Reloads the remote logs from target.

Options Menu

This menu gives access to features allowing to manage the commissioning

options:

Command

Icon Key

Description

Logging options...

Select what types of information are recorded in the event log.

Refresh interval...

Set refresh interval for monitor, graph, and auto-refresh (ms).

Page Menu
This menu gives access to features allowing to add objects on pages:
Command Icon Key Description
New Static - Add a new static object.
tlld
New Image - Add a new image object.

28
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Command Icon Key Description

New Animation - Add a new animation object.
28

New Edit - Add a new edit box.

New Button - Add a new button object.

New Custom Ctrl - Add a new custom control.
Y

New TextBox - Add a new text box.

New Progress - Add a new progress bar.
=

New Chart - Add a new chart object.

New Trend - Add a new trend object.

Parameters Menu

This menu gives access to features allowing to manage project parameters:

Command Icon Key Description
Read selected - Ctrl+R Read selected value.
Write selected - Ctrl+W Write selected value.
Write default values - - Reset the selected value to default.
Refresh page - - Updates the parameters and their values in the Resources window.
Select all - CtrlI+A Select the parameters from the Resources window
Read all - Ctrl Read the values of the Resources window.

+Shift+R
Write all - Ctrl Write the values of the Resources window.

+Shift

+W
Write all default values - - Reset the values of the Resources window to default.
Search parameters... - - Search for a specific parameter using filters.
Connected mode - Ctrl+T Simulates the connection of the target device.

Auto refresh mode

Changing parameter values in the application are written automatically to the
target device.

Export to text file...

Export the parameters of the Resources window as a *.csv text file.

project...

Import values from other

Apply parameter values from another project to the current project.

Project Menu

This menu gives access to features allowing you to compile your project and to
manage your target device:

EI00000003412.05
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Command

Icon

Key

Description

Compile

F7

Launches the compiler, page 47.

Select target...

Lets you select a new target for the project, page 46.

Refresh current target

Allows to update the target file for the same version of the target.

Recipes Menu

This menu gives access to features allowing you to manage recipes:

Command Icon Key Description
Add recipe - - Add a new recipe.
Import recipe - - Import an existing recipe from the hard drive disk or a removable media.
Delete recipe - - Delete the selected recipe.
Export recipe - - Export an existing recipe to the hard drive disk or a removable media.
Set recipe values - - Applying the change in the value of the selected parameter to the value of the
recipe.
Delete parameters from recipe | - - Delete one or more selected parameters from the actual recipe folder.
Write all recipe values - - Download the recipes to the target device.
Scheme Menu
Command Icon Key Description
Network - - Adds new networks.
New - - List of new networks.
Top E - Adds a new network at the top.
=
Bottom E - Adds a new network at the bottom.
F
Before F:l - Adds a new network at the before the current selection.
i
After F - Adds a new network at the after the current selection.
o—
Label - - Adds a new network label.
Object - - Adds new objects.
New - - List of new objects.
Function - - Adds a new function.
Function Block - - Adds a new function block.
Variable Shift+V | Adds a new variable.
B
Constant Shift+K | Adds a new constant.
3
Return Shift+tR | Adds a new return.
o
Jump Shift+J Adds a new jump.
pL
Operator - - Adds a new operator.
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Comment

I_T_I Shift+M

Adds a new comment.

Instance name

Modifies the name of an instance of a function block.

Open source

Displays the source code of the selected object.

Auto connect

Connects blocks automatically.

Delete invalid connection

- Ctrl+M

Removes invalid connections of deleted blocks.

Increment pins

+! Ctrl + '+

Increments the number of input pins of some operators and embedded functions.

Decrement pins

-1 Ctrl + -~

Decrements the number of input pins of some operators and embedded
functions.

Enable EN/ENO pins

Displays the enable input and output pins.

Object properties

Shows the properties of the selected object.

Target Menu

This menu gives access to features allowing you to set the communication

settings:

Command Icon Key Description

Communication settings - - Select and configure the protocol to use to communicate with the target device.,
page 413

Tools Menu
Command Icon Key Description
Custom tools - - Displays up to 16 user defined commands, page 39.
Variables Menu

Command Icon Key Description

Add - -

Automatic - - Creates a new automatic variable. A dialog is prompted in order to specify the
new variable.

Mapped variable - Ctrl+ Creates a new mapped variable. A dialog is prompted in order to specify the new
variable.

Shift+M

Constant - - Creates a new constant. A dialog is prompted in order to specify the new
constant.

Retain - - Creates a new retain variable. A dialog is prompted in order to specify the new
variable.

Insert - Ctrl+ Adds a new row to the grid in the currently active editor.

Shift+ins

Delete - Delete Deletes the variable in the selected row of the currently active table.

Create multiple... - - Lets you create a set of multiple variables.

Group - - Opens a dialog box which lets you create and delete groups of variables.
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View Menu
This menu gives access to features allowing you to choose what is displayed in
the workspace:
Command Icon Key Description
Toolbars - - Refer to Toolbars, page 35.
Main - - Shows or hides the Main toolbar.
Project - - Shows or hides the Project bar.
Debug - - Shows or hides the Debug toolbar.
FBD Bar - - Shows or hides the FBD toolbar.
SFC Bar - - Shows or hides the SFC toolbar.
LD Bar - - Shows or hides the LD toolbar.
Network - - Shows or hides the Network toolbar.
Configuration - - Shows or hides the Configuration toolbar.
HMI Page - - Shows or hides the HMI Page toolbar.
HMI Project - - Shows or hides the HMI Project toolbar.
HMI Profiles - - Shows or hides the HMI Profiles toolbar.
Commissioning - - Shows or hides the Commissioning toolbar.
Tool windows - - Refer to Tool Windows Management, page 36.
Local variables - - Shows or hides the Local variables window.
Project - - Shows or hides the Project window.
Watch - Ctrl+T Shows or hides the Watch window.
Properties Window - Ctrl+W Shows or hides the Properties Window window.
Oscilloscope - - Shows or hides the Oscilloscope window.
PLC run-time status - - Shows or hides the PLC run-time status bar.
Operators and blocks - - Shows or hides the Operators and blocks window.
Library Tree - - Shows or hides the Library Tree window.
Output - - Shows or hides the Output window.
Cross Reference - - Shows or hides the Cross Reference window.
Resources - - Shows or hides the Resources window.
Catalog - - Shows or hides the Catalog window.
HMI Project - - Shows or hides the HMI Project window.
HMI Properties - - Shows or hides the HMI Properties window.
HMI Actions - - Shows or hides the HMI Actions window.
HMI Vars and Parameters - - Shows or hides the HMI Vars and Parameters window.
HMI Templates - - Shows or hides the HMI Templates window.
Commissioning - - Shows or hides the Commissioning window.
Commissioning Watch - - Shows or hides the Commissioning Watch window.
Commissioning Oscilloscope - - Shows or hides the Commissioning Oscilloscope window.
Full screen Ctrl+U Expands the currently active document window to fill entire screen,

page 37. (Esc to exit from this mode).
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Window Menu

Command Icon Key Description

Cascade - - Displaces the open documents in cascade so that they completely overlap except
for the caption.

Tile - - The PLC editors area is split into frames having the same dimensions, depending
on the number of currently open documents. Each frame is automatically assigned
to one of such documents.

Arrange Icons - - Displaces the icons of the minimized documents in the bottom left-hand corner of
the PLC editors area.

Close all - - Closes the open documents.

Windows... - Alt+W Opens a Windows List browser.

Toolbars
EcoStruxure Machine Expert - HVAC has several toolbars dedicated to software
tabs:
Toolbars Dedicated tabs
Main All
Project Programming, page 96
Debug
FBD
SFC
LD
Network

Configuration Configuration, page 54

HMI Page Display, page 324

HMI Project

HMI Profiles

Commissioning Commissioning, page 408

To manage toolbars, refer to Toolbars Management, page 35.

Tool Windows

EcoStruxure Machine Expert - HVAC has several tool windows dedicated to
software tabs:

Tool windows

Dedicated tabs

Local variables

Configuration, page 52

Project

Watch

Properties Window

Oscilloscope

PLC run-time status

Operators and blocks

Library Tree

Programming, page 92

Output

Configuration, page 52
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Status Bar

Overview

Tool windows Dedicated tabs

Cross Reference
Programming, page 92

Resources Configuration, page 52
Catalog
HMI Project Display, page 319

HMI Properties

HMI Actions

HMI Vars and Parameters

HMI Templates

Commissioning Commissioning, page 406

Commissioning Watch

Commissioning

Oscilloscope

To manage tool windows, refer to Tool Windows Management, page 36.

The status bar is located at the bottom right of the EcoStruxure Machine Expert -
HVAC window. It indicates the state of communication and the status of the
application currently executing on the target device.

| SOURCE OK CONNECTED

For more information, refer to:
+ Edit and Debug Mode, page 212
+ Connection Status, page 183

EDIT MODE

+ Application Status, page 183

Software Interface Customization

Overview

Layout

Overview

This section describes how to manage the user interface elements of the software.
It allows you to set up the integrated software environment in the way which best
suits to your specific development process.

The layout of the software workspace can be freely customized in order to suit
your needs.

The layout configuration is saved on application exit. Your modifications remain
between different working sessions.

34
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Reset Layout
To reset layout parameters to default values of standard layout:
Step Action
1 Click File > Options....
The Program options dialog box appears.
2 In Tool windows area, click Reset bars positions button.
A new dialog box appears.
3 Click OK button.
4 In Program options dialog box, click OK button.
5 In the project toolbar, click Save project icon.
6 Click File > Exit.
7 Restart EcoStruxure Machine Expert - HVAC.
NOTE: When you reset the layout, all the tab layouts are reset.
Toolbars
Show/Hide
To show or hide a toolbar, proceed as follow:
Step Action
1 Click View > Toolbars and select
Or right-click in the toolbar area.
2
The toolbar list is displayed in a pop-up window:
Main
Project
Debug
FBD Bar
SFC Bar
LD bar
Network
Configuration
HMI Page
HMI Project
HMI Profils
Commissioning
3 Click the Toolbar name you want to show/hide.
Move

To move a toolbar, click its left border and drag it to the new destination.
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Tool Windows Management

Show/Hide Tool Windows

To show or hide a tool window:

Step

Action

1

Click View > Tool windows.

Local variables

Project

Watch

Properties Window
Oscilloscope

PLC run-time status
Operators and blocks
Library Tree

Output

Cross Reference
Resources

Catalog

HMI Project

HMI Properties

HMI Actions

HMI Vars and Parameters
HMI Templates
Commissioning
Commissioning Watch

Commissioning Oscilloscope

Select the toolbar to show or hide

Undock Tool Windows

Dock Tool Windows

To undock a tool window from its default location, click its title bar and drag it to a
new location.

To take back a tool window to its last docked location, double-click the title bar of
the window.

To dock a tool window to another location:

Step Action
1 Click the title bar of the tool window and move the pointer.
A guide diamond appears, move the pointer over the desired portion of the guide
diamond. The designated area is shaded.
=
2 Release the mouse button.
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Auto-Hide Tool Windows

To auto-hide a tool window, click the pin button on the top right corner of the tool
window.

The tool window is reduced in a tab on the upper left corner of the main window.
To show the tool window again, click the tab.

To switch the tool window from auto-hide mode to regular docking mode, reclick
the pin button when the tool window is displayed.

Window Management

Overview

EcoStruxure Machine Expert - HVAC allows you to navigate between the opened
source code editor windows.

Document Tab

To switch between the currently open editors, click the title program on the tab
located below the programming window.

Window Menu

The Window menu allows you:
» To present the currently opened programs in a cascade.
« To present the currently opened programs in tiles.

» To arrange the icons of the minimized documents in the bottom left-hand
corner of the editors window.

» To close the currently opened programs.

« To switch between the currently opened programs by clicking the title
program.

Cascade

Tile
Arrange Icons

Close All

2 Ungrouped_vars

Windows... Alt+W

Full Screen Mode

Overview

To switch on or off the full screen mode, click View > Full screen (or press Ctrl
+U).

In full screen mode, the source code editor extends to the whole working area,
making the coding with graphical programming languages easier.
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Software Options

Overview

General

Graphic Editor

Text Editors

EcoStruxure Machine Expert - HVAC allows you to customize some options of the
software.

To display the dialog box options, click File > Options....

General tab allows you to configure:

Visual Theme:

It is just possible to choose, in the Color theme list, the Standard color
theme.

Save options:

o Autosave: if Autosave box is checked, the software periodically saves
the whole project. You can specify the period of execution of this task by
entering the number of minutes between two automatic savings in Interval
(min) box.

o Max previous version to keep: it indicates the maximum number of
copies of the project that must be zipped and stored in the
PreviousVersions folder.

Output window:
You can specify the family and the size of the font used for output window.
Communication:

If Use last port check box is selected, the last used port is set as the default
one.

Tooltip:

If Enable tooltip on editors check box is selected, small information boxes
appear when the cursor is placed over a symbol in the editors.

Tool windows:
You can specify the family and the size of the font used for tool windows.

Reset bars positions: the layout of the dock bars in the IDE is reinitiate to
default positions and dimensions. In order to take effect, the software must be
restarted.

Source editors options:

If ST - LD: Auto declaration of variables check box is selected, variables
are automatically declared for ST and Ladder programs.

This panel lets you edit the properties of the LD, FBD, and SFC source code
editors.

You can specify the family and the size of the font used for graphical editors.

You can also modify the colors of the graphical object.

You can specify the family and the size of the font both for code and variable
editors.
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Language

You can modify the language of the environment:

Step

Action

1

Select a language from the list displayed in this panel.

Click the Select button.

Click the OK button to confirm.

2
3
4

To make effective this modification, restart the software.

Custom Tools

You can add up to 16 commands to the Custom tools menu. These commands
can be associated with any program that runs on your operating system. You can
also specify arguments for any command that you add to the Custom tools

menu.

To add a tool to the Custom tools menu:

Step

Action

1

In the Command box, type the full path of the program file you want to use as a tool.

Otherwise, you can select the program file by clicking the browse button.

In the Arguments box, type the arguments - if any - to be passed to the executable
command mentioned at the first step. They must be separated by a space.

In Menu string box, type the name you want to give to the tool you are adding.

This is the string that is displayed in the Tools menu.

Click Add button to insert the new command into the suitable menu.

Click OK button to confirm, or Cancel button to quit.

For example, if you want to add Windows Calculator to the Custom tools menu:

Step

Action

1

Fill the fields of the dialog box as displayed.

2

Click Add button.

The name you gave to this tool (in this example, Calc) is now displayed in the Custom
tools menu.

Merge

If Enable Merge check box is selected, you can configure the following
parameters:

« |dentical name:

o

o

o

Objects with different types
Object with same type (not variables)
Variables

¢ Check address:

o

o

Overlapped
Copy\Paste mapped variable

For more information about Merge, refer to Merge Function, page 113.
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Managing Projects

What’s in This Chapter

Create @ NeW ProjeCt.........oouuuiiiii e 40
Print @ Project ..o 42
SAVE @ PrOJECT. .. 43
Manage EXisting Projects...... ... 44
Distribute Projects .....ccooviiiiii e 45
EXPOrt CSV FlES ..cuniiiiiei e e 46
Select The Target DEVICE ........oiiiiiiiiiiiiiii et 46
BUII All ... e et ettt e 47
Download a Projectto The Target........ccoouoiiiiiiii e 47
INStaller SOftWAre .......ooiii e 49
Close EcoStruxure Machine Expert - HVAC ... 51

Create a New Project

Overview

Welcome Page

There are two ways to create a new project:
* Inthe Welcome page, page 40.
* Inthe New project window, page 42.

When EcoStruxure Machine Expert - HVAC starts, the Welcome page appears:

New project Open project

Name: Create Choose from disk...

Directory: C:\ Recent projects

I Case sensitive MyProject
M172 07-18 1/Os 668 Import old project |Choose from disk...

- M172 28-42 1/0s 596

M172DCL Portrait 659 5 I o I
M172DCL Landscape 659 0 E I ectr | C

The Welcome page is divided into three group boxes:
* New project
* Open project
* Import old project

To create a new project:

40
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Step Action

1 In Name box, type the name of the new project.

The string you enter is also the name of the folder which contains the files making up the
project.

The name can be modified afterward, refer to Project Options, page 102.

2 In the Directory box, the default location of this folder is indicated.

Click the browse button to choose another folder.

3 In the device list, click the target device which runs the project.
NOTE: Available targets are listed in Supported Devices, page 17.

4 If Case-sensitive check box is selected, the source code of the project is case-sensitive.

This option can be modified afterward, refer to Project Options, page 102.
NOTE: This option is not compliant with IEC 61131-3 standard.

5 Click Create button.

To open an existing project, use one of the two procedures:
+ Click Choose from disk... button.

Result: A dialog box to appear, which lets you load the directory containing

the project and select the relative project file.
* In the Recent projects list, double-click the project name.
To import an old project:
+ Click Choose from disk... button.

Result: A dialog box appears, which lets you load the directory containing the

project and select the relative project file.

The "old project" is one created with SoMachine HVAC. EcoStruxure Machine

Expert - HVAC will proceed to convert the old program. However,
incompatibilities may exist between SoMachine HVAC and EcoStruxure
Machine Expert - HVAC.

AWARNING

UNINTENDED EQUIPMENT OPERATION

» Always verify that your application program operates as it did prior to the
conversion, having all the correct configurations, parameters, parameter
values, functions, and function blocks as required.

* Modify the application as necessary such that it conforms to its previous
operation.

* Thoroughly test and validate the newly compiled version prior to putting your

application into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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New Project Window

Print a Project

Print the Project

Click File > New project or File icon D of the project toolbar to display the New
project window:

New project X

Project

Name |

Directory | C:\User\Documents E]

Target selection

Select the target for a new project | M1710 542.8 v

Options

[] Case sensitive

[ OK ] [ Cancel ]

NOTE: If you already have an open project, a dialog box appears to ask you if
you want to save the current project.

Create a new project:

Step | Action

1 In Name box, type the name of the new project.

The string you enter is also the name of the folder which contains the files making up the
project.

The name can be modified afterward, refer to Project Options, page 102.

2 In the Directory box, the default location of this folder is indicated.
Click the "= browse button to choose another folder.

3 In the Select the target for a new project list, click the target device which runs the
project.

NOTE: Available targets are listed in Supported Devices, page 17.

4 If Case-sensitive check box is selected, the source code of the project is case-sensitive.

This option can be modified afterward, refer to Project Options, page 102.
NOTE: This option is not compliant with IEC 61131-3 standard.

5 Click OK button.

EcoStruxure Machine Expert - HVAC allows you to print the data which make up
the project such as programs and variables.

To print a project:

Step Action

1 In Programming tab, click File > Print Project.
2 In Name box, select the printer to print your project.
3 Click OK button.
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Print the Current Working Window

EcoStruxure Machine Expert - HVAC allows you to print only the current working
window.

To print the current working window:

Step Action

1 In Programming tab, click File > Print....
2 In Name box, select the printer to print your project.
3 Click OK button.

Print Preview
To preview your printing before, click File > Print preview. The preview is

displayed in the current working window.

Save a Project

Overview

EcoStruxure Machine Expert - HVAC projects can be saved as files to the local PC
or into a server directory. This file has the extension *.plcprj or *.ppjs and
contains:

» The source code of the program.
» The current hardware configuration.
» Settings and preferences of the EcoStruxure Machine Expert - HVAC project.

Save the Project
To save the project:

=
» Click ™21l Save project icon on the project toolbar.
» Click File > Save project.

Save the Project As

To save the project with a different name, a different format or in a different folder:

Step Action
1 Click File > Save project As ....
2 Type the new name of the project file.
3 Browse and select the new folder in which to store the project file.
4 Choose the new format, page 45 of the project file.
5 Click OK button.
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AutoSave

Backup Copies

EcoStruxure Machine Expert - HVAC includes an AutoSave feature that
periodically saves your project as you work on it.

AutoSave saves data in a separate folder, called Backup, stored at the same
location of the project folder.

If you regularly save or close the currently opened file, the associated auto save
file is deleted, unless the save file command is canceled or terminated in error. In
this case, the file is kept. If you reopen a project for which an appropriate auto
save file is found, the AutoSave Backup dialog box is displayed. You can reopen
the auto save project or the saved last version.

You can specify the interval time (in minutes) between saving. By default,
AutoSave is running with 1 minute of interval. For more information, refer to Save
options, page 38.

EcoStruxure Machine Expert - HVAC includes a backup feature of the previous
version of the project on which you are working.

When you explicitly save the project, EcoStruxure Machine Expert - HVAC saves
the current version (before save) of the project in the PreviousVersions folder
stored at the same location of the project folder.

You can set the upper limit of the backup files to be kept on your PC. By default
this is 10; set to 0 if you want to disable this feature. For more information, refer to
Save options, page 38.

Manage Existing Projects

Open an Existing Project

Edit the Project

To open an existing project, click File > Open project.

You can also open an existing project in the Welcome page (when no project is
opened).

This causes a dialog box to appear, which lets you load the directory containing
the project and select the relative project file.

To modify an element of a project:

Step Action

1 Locate the element in the tree structure of the tool window.

2 Double-click its name to open it.

Result: An editor consistent with the object type is opened. For example, when you
double-click the name of a project POU, the appropriate source code editor is
displayed; if you double-click the name of a global variable, the variable editor is
displayed.

EcoStruxure Machine Expert - HVAC cannot modify elements of a project when at
least one of the following conditions holds:

» EcoStruxure Machine Expert - HVAC is in debug mode.
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Close the Project

* ltis an object of an included library (whereas you can modify an object that
you imported from a library).

» The project is opened in read-only mode (view project).

To close the project, click File > Close project or close the software.

In both cases, when there are modifications which have not been saved,
EcoStruxure Machine Expert - HVAC asks you to choose between saving and
discarding them.

Then the Welcome page, page 40 is displayed so that you can start a new
working session.

Distribute Projects

Overview

To share a project with another developer, send either a copy of one or more
project files or a redistributable source module (RSM) generated by EcoStruxure
Machine Expert - HVAC.

In the former case, the number of files to share depends on the format of the
project file:

» PLC single project file (. pp7 s file extension): the project file itself contains
the whole information needed to run the application (assuming the receiving
developer has an appropriate available target device). It includes the source
code modules so that only the . pp7 s file is needed to share the project.

* PLC multiple project file (. ppjx or . ppj file extension): the project file
contains only the links to the source code modules composing the project,
which are stored as single files in the project directory. The whole directory is
needed to share the project.

* Full XML PLC project file (.plcpr): the project file is generated entirely in
XML language. The information contained in the project file and its behavior
are the same as .ppjs file extension.

To generate a redistributable source module (RSM), click Project > Generate
redistributable source module.

EcoStruxure Machine Expert - HVAC displays the name of the RSM file and lets
you choose whether to protect the file with a password. To protect the file, a
password must be entered.

The advantages of the RSM file format are:

+ ltis encoded in binary format, thus it can only be read by third parties which
use EcoStruxure Machine Expert - HVAC.

* It can require a password when opening the file in EcoStruxure Machine
Expert - HVAC.

+ lIts size is reduced because it is a binary file.
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Export CSV Files

Overview

EcoStruxure Machine Expert - HVAC allows you to export parameters and
variables defined in .csv format which can be used for sharing information and
developing documentation to be supplied with the product.

Data Export

To export data:

Step Action

1 Click Configuration tab.

2 In the Resources window, click the target device.

3 In the main box, click Export button.

4 In Data Export window, select data you want to export and click OK button.

5 In the Save As dialog box, choose the name of your file and click Save button.
6 In Export succeeded dialog box, click OK button.

Select The Target Device

Overview

You may need to adapt a PLC application on a new target device which differs
from the one for which you originally wrote the code.

To adapt your application project to a new target device:

Step | Action

1 In Programming tab, click Project > Select target....

The following dialog box appears:

Select target X

Available Targets

M1710 542.8 B
M1710 Modbus Slave Only 412.20
M171P Blind 477.27

M171P Display 423.27

M171P Flush Mounting 489.20
M172 4DIN 668.7

M172DCL landscape 659.4
M172DCL portrait 659.4

M172P 596.7 -
2 Select one of the target devices listed in the combo box.
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Step

Action

Click Change to confirm your choice, Cancel to discard.

If you confirm, click Yes button to complete the conversion or No button to quit.

If you click Yes button, EcoStruxure Machine Expert - HVAC updates the project to work
with the new target.

It also makes a backup copy of the project files in a subdirectory inside the project
directory. Therefore you can roll back the operation by manually (that is, using Windows
Explorer) replacing the project files with the backup copy.

AWARNING

UNINTENDED EQUIPMENT OPERATION

* Always verify that your application program operates as it did prior to the
conversion, having all the correct configurations, parameters, parameter
values, functions, and function blocks as required.

* Modify the application as necessary such that it conforms to its previous
operation.

* Thoroughly test and validate the newly compiled version prior to putting your
application into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Build All

Overview

W
To compile your project, click k= Build All icon in the project toolbar.

The result of the compilation is displayed in the Output window, page 95.

Download a Project to The Target

Overview

A project can be downloaded in different ways depending on the controller.

The following is a table of correspondence indicating possible connection types
with the controllers:

Control- TTL port USB A usB usBC RS-485 Ethernet
ler port Mini-B port port
port
Modbus
TM171A- | TM171A- USB A USB A/ USB A/ | USB/RS- | Ethernet
DMI MFK Memory usB usBC 485 Cable
program- | program- key Mini-B Cable adapter
ming ming Cable
cable stick
M1710 v v - - - - -
M171P - - v v - v V)
M1720 - - - v - v v
M172P - - v v - v v
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Control- TTL port USB A USB UsB C RS-485 Ethernet
ler port Mini-B port port
port
Modbus
TM171A- | TM171A- USB A USB A/ USB A/ | USB/RS- | Ethernet
DMI MFK Memory usB usBC 485 Cable
program- | program- key Mini-B Cable adapter
ming ming Cable
cable stick
M1730 - - - - v v -
(1) An Ethernet communication module must be connected to the controller, except for M171P Flush
Mounting which has integrated Ethernet communications.

Download Controller Project onto Target

Steps to download the project onto the target:

Step

Action

1

Configure the communication with the Device Link Manager Config, accessible in:

* On-line > Set up communication... menu of Configuration tab or
Programming tab.

» Or Target > Communication settings menu of Commissioning tab.
The properties are visible and can be edited by clicking Properties. The protocol must
be activated beforehand.

For more information, refer to Setting Up the Communication, page 177

Connect the target physically to the computer.

For more information on the hardware connection, refer to the related hardware guides.

[ 1}
Connect the target using Y On-line > Connect menu of Configuration tab or
Programming tab.

For more information, refer to Connect to a Device, page 182 and On-Line Status, page
183

Download the project from Configuration tab or Programming tab:
+ Select On-line > Download code
*  Orpress F5
Itis also possible to use the Download all button in the project toolbar.

Follow the dialog boxes instructions.

If you remove power to the device, or there is a power outage or communication
interruption during the transfer of the application, your device may become
inoperative. If a communication interruption or a power outage occurs, reattempt
the transfer. If there is a power outage or communication interruption during a
firmware update, or if an invalid firmware is used, your device will become
inoperative. In this case, use a valid firmware and reattempt the firmware update.

AWARNING

AUTOMATIC RESTART OF CONTROLLER

» Do not download your application without first accessing the state of your
machine or process.

« Do not download your application without first ascertaining that there is no
risk of injury to anyone in or around your machine or process.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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NOTICE

INOPERABLE EQUIPMENT

» Do not interrupt the transfer of the application program or a firmware change
once the transfer has begun.

* Re-initiate the transfer if the transfer is interrupted for any reason.

* Do not attempt to place the device into service until the file transfer has
completed successfully.

Failure to follow these instructions can result in equipment damage.

Installer Software

Description

A stand-alone software, Installer software, is delivered in addition with
EcoStruxure Machine Expert - HVAC.

You can run it via the Windows start menu or the icon on the desktop after
installing EcoStruxure Machine Expert - HVAC.

Watch 2 X output 8 X Oscloscope 2 x

>
Ready 3_DISCONNECTED

The Installer software allows you to:
* Manage the maintenance of systems by downloading projects.
+ Manage the configuration of bound controllers.
» Configure the devices.
* Modify the BIOS parameters.

« Detect on which port the target device is connected (via the Network scan
area).

+ Manage parameters files of the project (import and export throughout
controllers).

» Create a programming USB key to upload projects in various controllers.
» Generate and preview an HTML page with project parameters.

The Installer software is dedicated for maintenance use. The project code cannot
be modified.
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Menu Access Level

In Installer software, it is possible to change access level in order to view hidden
parameters by clicking on: File > Change Menu Access Level.

The following window will be triggered.

Select Menu Access Level

Select menu access level:
Base (Current) A4

Insert password:

OK Cancel

NOTE: For Admin and Supervisor access levels, a password may be
required.

Change Access Password

To change access level password click on File > Change Menu Access Level
Password

Once the following window will be triggered it will be possible to change the
password.

Change Password

Select passord level to change:
Admin v
Current password:

New password for specified level:

Confirm password:

[ XXX XXX ]
Change Password Close

NOTE: It is recommended to change password regularly.

Replace the preset password

It is necessary to change the preset password the first time of use. The user
should also carefully consider the implications of allowing other people to access
it.

50
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NOTICE

UNAUTHORIZED ACCESS TO DATA
* Immediately change the preset password with a secure new password.

» Do not communicate the password to unauthorized or otherwise unqualified
personnel.

Failure to follow these instructions can result in equipment damage.

NOTE: A secure password is a password which has not been shared or
circulated amongst unauthorized personnel and which does not contain
personal or obvious information. Furthermore, a combination of upper-case
and lower-case letters and numbers offers greater security. Choose a
password that is at least five characters long.

Close EcoStruxure Machine Expert - HVAC

Overview

To exit EcoStruxure Machine Expert - HVAC, click the Close button in the top
right-hand corner of the EcoStruxure Machine Expert - HVAC window.

You can also click the Exit button on the Welcome page window.
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Overview of the Configuration Window

General Description

Configuration is the entry point for starting to develop projects.

The following illustration presents the default Configuration window:

3

C:\My Project\My Project.plcprj
Y w 1
DEE S S
Commisonrs

S8SF0022)

= EEPROM Parameters
& Status variables
[B Enums
78 BIOS Parameters
B Menus 1)
B B2 1/0 Mapping
Local
B2 Field
A\ Aarms
Q@ Web site
B " BACnet Objects
2 Device
Z4 Analog Value Objects ]
24 Binary Value Objects

5 calendar Objects
B Mult State Value Objects
5 schedule Objects
2§ Notification Class Objects

Schneider - g X

8 Contguraton M172 28-42 1/0S CONFIGYRATION " Ve,s:n"
8 B w17228-421/0s
8 & Modbus objects RS

S) 4

@) LON Profile
N CAN Exp bus
. Rs485-1 Data export Export
. RS4852 e
¥ Ethemet
2 pugins ® Resources 4bvx
Output & x
Application leted B
Preprocessing Communication completed.
Preprocessing Pumping completed.
ing display leted =
0 warnings, 0 errors =
Build | Find in project Debug ' Resources HMI Output < " »
Ready EDIT MODE NOT|CONNECTED

Item Description
1 Toolbar This toolbar shows the tools in form of icons.
For more information, refer to Toolbars, page 54.
2 Resources This window shows the configurable parameters of the device.
window
For more information, refer to Content of the Resources Window, page 55.
3 Editor window This window allows you to edit the content of the current selection in Resources window.
4 Catalog window This window shows the devices available from the catalog.
NOTE: Dynamic visibility of devices based on selections (for example communication modules).
5 Output window This window shows the messages relating to the development of the project (file opening, reading/
writing errors, status of connection to device, and so on).
NOTE: The connection to the device is also visible in the status bar, page 34.
For more information, refer to Download and Upload Applications, page 47.
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Menu Bar
Overview
The menu bar of Configuration tab is composed of these menus:
+ File, page 27
+ View, page 32
* Project, page 29
* On-line, page 28
* Developer, page 26
* Help, page 27
Toolbar
Introduction

The toolbar appears at the top of the EcoStruxure Machine Expert - HVAC window
to provide access to frequently used functions.

For generalities of toolbars, refer to Toolbars description, page 33.

Configuration Toolbar

The Configuration toolbar has the following buttons:

Icon Description

Compile

fe

Launches the compiler.

Connects to the target

Starts the communication with the device.

Code download

gl "

Download the configuration and PLC application of the project to the device.

54 EI00000003412.05



Managing Resources Elements

Managing Resources Elements

What’s in This Chapter
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Overview

Resources Window

Overview

The

Resources window allows you to configure the device:

Define parameters and variables.

Create and configure the embedded website (for M171P and M172 only).
Configure the hardware structure of the project.

Configure communication protocols.

Content of the Resources Window

The

Resources window consists of the following items:

Item Icon

Description

Target device, page 58

Shows the picture of the target device and allows you to configure some settings.

Modbus objects, page 59

=1

Define the EEPROM parameters (non-volatile memory parameters) and Status variables
which may then be used in the application code.

Defines EEPROM parameters (non-volatile memory parameters) and Status variables
which can be displayed on the target device and read using the Modbus protocol (RTU or
TCP) or the CAN protocol.

Menus, page 62

il

Manages menus where you can group the Modbus objects that are shown in
Commissioning.

1/0 Mapping, page 65

Defines the links between variables and physical I/O of the target device.

Alarms, page 65

Defines alarm variables which status must be managed by the developer.

Web Site, page 67

Defines website pages to monitor the device from a web browser.

BACnet Objects BAC Configures the BACnet objects.
Ak

LON Profile o Configures the LonWorks protocol.
i

CAN Exp bus, page 68 CAM Configures the CAN Expansion bus.
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Item Icon Description

RS-485-1, page 79 .rl: Configures the first RS-485 port.
RS-485-2, page 79 .rl: Configures the second RS-485 port.
Master Modbus RTU, page 79 .rl: Configure the RS-485 port.

It only applies to M1710 Modbus master/slave.

Ethernet, page 86 w Configures the Ethernet port.
Sl
—

Plugins, page 88 Configures protocols using communication modules.

Help {'E_;..w Shows LED reference for the developer. For M1710 only.

NOTE: The Resources window content depends on the selected device.

Match Software and Hardware Configuration

The 1/O that may be embedded in your controller is independent of the I/O that you
may have added in the form of I/O expansion. It is important that the logical /0O
configuration within your program matches the physical 1/0 configuration of your
installation. If you add or remove any physical I/O to or from the I/O expansion
bus, then you must update your application configuration. This is also true for any
field bus devices you may have in your installation. Otherwise, there is the
potential that the expansion bus or field bus no longer function while the
embedded I/O that may be present in your controller continues to operate.

AWARNING

UNINTENDED EQUIPMENT OPERATION

Update the configuration of your program each time you add or delete any type
of 1/0 expansions on your I/O bus, or you add or delete any devices on your
field bus.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Expansion Bus

You must monitor within your application the state of the bus and the error state of
the module(s) on the bus, and to take the appropriate action necessary given your
particular application.

AWARNING

UNINTENDED EQUIPMENT OPERATION

* Include in your risk assessment the possibility of unsuccessful
communication between the logic controller and any 1/0O expansion modules.

* Monitor the state of the I/O expansion bus using the dedicated %SW system
words and take appropriate actions as determined by your risk assessment.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Supported Protocols

Overview

Each device has the following resources, which are shown as nodes of the target.
Select the Mode and add the device from the catalog:

Target Communication Description
Bus
M171P CAN expansion On-board
bus For 1/0 expansion and remote display
RS-485 On-board
Modbus RTU (master/slave)
Ethernet Optional with communication module:
Modbus TCP (Server), BACnet IP (Server), HTTP
Plugins Optional modules available separately
M171P Flush CAN expansion On-board
Mounting bus
For 1/0 expansion
RS-485 On-board
Modbus RTU (master/slave) or BACnet MS/TP (Server)
Ethernet On-board
Modbus TCP (client/server), BACnet IP (Server), FTP,
HTTP
M1720 CAN expansion On-board
bus For I/O expansion and remote display
RS-485-1 On-board
Modbus RTU (Slave only) or BACnet MS/TP (Server)
RS-485-2 On-board
Modbus RTU (master/slave) or BACnet MS/TP (Server)
Ethernet Optional with communication module:
Modbus TCP (client/server), BACnet IP (Server), FTP,
HTTP
Plugins Optional modules available separately
M172P CAN expansion On-board
bus For 1/0 expansion and remote display
RS-485-1 On-board
Modbus RTU (Slave only) or BACnet MS/TP (Server)
RS-485-2 On-board
Modbus RTU (master/slave) or BACnet MS/TP (Server)
Ethernet On-board
Modbus TCP (client/server), BACnet IP (Server), FTP,
HTTP
Plugins Optional modules available separately
M1730 CAN expansion On-board
bus For 1/0 expansion and remote display
RS-485-1 On-board
Modbus RTU (Slave only) or BACnet MS/TP (Server)
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Target Communication Description
Bus
RS-485-2 On-board

Modbus RTU (master/slave) or BACnet MS/TP (Server)

Providing HMI Pages

NOTE: The Catalog window shows the devices that can be added (by
dragging them) to the corresponding protocol.

NOTE: On the RS-485 protocol, you can also connect generic Modbus
devices.

M172P supports HMI Remote so its pages can be downloaded and displayed in
Display tab for M171P displays.

This feature is not supported by M171P Flush Mounting. No linked device can
upload HMI pages from M171P Flush Mounting device.

Target Device

Overview

In the Resources window, double-click the title of the project to display the editor
window.

The editor window presents the graphic of the target device and lets you access
some settings.

M171 Configuration

In the editor window, you have the possibility to:

M172 Configuration

Define the parameter value shown on the main display on idle state by
selecting a value in the Fundamental state display box.

NOTE: Only available for M1710.

Set the execution time of the project in milliseconds (ms).

The default setting is 100 ms. The available range is 20...100 ms.
NOTE: Only available for M1710.

Export parameters and variables defined in .csv format.

For more information, refer to Export CSV Files, page 46.

-

Consult the hardware guide of the device by clicking the " icon.

In the editor window, you have the possibility to:

Export parameters and variables defined in .csv format.
For more information, refer to Export CSV Files, page 46.

-

Consult the hardware guide of the device by clicking the " icon.
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M1730 Configuration

In the editor window, you have the possibility to:
» Export parameters and variables defined in .csv format.
For more information, refer to Export CSV Files, page 46.

» Consult the hardware guide of the device by clicking the 0 icon.

Modbus Objects

Overview

Address Range

Modbus objects allow you to define EEPROM parameters (non-volatile memory
parameters) and Status variables, which can be displayed on the target device
and read using the Modbus protocol, page 90.

EEPROM parameters (non-volatile memory parameters) and Status variables
can be used in the application code. They appear in the Project window: Project
> Aux Variables > Global Shared.

It is possible to add or remove parameters and variables (with Add and Remove
buttons) in the same way as for variables in the Project window.

The Recalc button allows you to recalculate the addresses of the selected rows.

In the targets prior to M1730 there is a Modbus address defined for the Status
Variables and the Parameters, for M1730 however the range of Modbus
addresses is extended:

+ 1-8191
+ 8960-15523
+ 16384 - 64999
* Up to 65000 are reserved for the PLC Runtime
When invalid Modbus addresses are set, the warning message appears:

Application X

I Invalid address value! Must be in
8960..15523, 1..8191, 16384..24322, 24338..64999 range

EEPROM Parameters

EEPROM Parameters allows you to create the variables which the
developer intends to save in non-volatile memory even if the device is powered
off.

Refer to Status Variables, page 60 for details about the columns of the editor
window.
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Status Variables

This table presents the columns of the editor window:

Column Description

Address Resource Modbus address

Name Resource name which may be used by the developer in the controller
application.

Display label Name displayed in the application menu of the M1710 target (4-digit 7

segments).

Installer type

Type of data displayed on target and Installer.

IEC type Type of data used in controller application.

Size Significant only in the case of STRING type. Dimension (Length) of the string.
Default and max= 31 characters.

Read only Enables/disables editing of Status variables.

Default value

Default value of the object.

Min Minimum value of the object.

Max Maximum value of the object.

Scale Conversion coefficients between Installer type and IEC type.

Offset IEC type = scale x Installer type + offset.

Unit Unit of measurement of Installer type displayed on Installer and if available with
icon on target.

Format Display format for Default Value / Min / Max.

For example, XXX.Y display of whole number with decimal point.

Installer Access
Level

Here can be set the level of visibility of a parameter in Installer Software.

There are 4 different level of access:

*  Admin

*  Supervisor

» Base (no password required)

* Never Visible (never visible only in Installer Software)
Refer to Visibility of Menu Resources, page 63.

Description

Note

Free text.

NOTE: Columns can be hidden or shown by right-clicking its name and
selecting Hide column or Show columns command.

EEPROM memory is limited, there is a limitation in the amount of read and write
operations on this block set at 100k write cycles.

Using the non-volatile memory for a cyclic write operation may result in quickly
exceeding its life cycle limits resulting in an inoperative memory.

NOTICE

Do not use non-volatile memory registers for cyclic write operations.

Failure to follow these instructions can result in equipment damage.

Status variables allow you to define the status variables which can be
displayed in the menu of the device.
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NOTE: For M1710 / M1730, each variable has a transcoding on the controller
due to the 4-digit / 7-segment display. In the Display label box, you can select
the transcoding and see a preview on the display by clicking the ellipsis (...).

Some letters are not displayed (for example x and z) so there is a blank space
on the display. If the display label is SET, 5 E £ appears on the display.

Name Display label
Setting Status variable SET

Close

This table presents the columns of the editor window:

Column Description

Address Resource Modbus address

NOTE: For M1730 there are two different Address Columns:
* Address (dec)
+ Address (hex)

Name Resource name which may be used by the developer in the controller
application.

Display label Name displayed in the application menu of the M1710 target (4-digit 7
segments).

Installer type Type of data displayed on target and Installer.

IEC type Type of data used in controller application.

Size Significant only in the case of STRING type. Dimension (Length) of the string.
Default and max= 31 characters.

Read only Enables/disables editing of Status variables.

Default Value Default value of the object.

Min Minimum value of the object.

Max Maximum value of the object.

Scale Conversion coefficients between Installer type and IEC type.

Offset IEC type = scale x Installer type + offset.

Unit Unit of measurement of Installer type displayed on Installer and if available with

icon on target.

Format Display format for Default Value / Min / Max.

For example, XXX.Y display of whole number with decimal point.

Display Access | User access level required to see and modify related parameter via Display.
Level
Refer to Visibility of Menu Resources, page 63.

Installer Access | User access level required to see and modify related parameter via Installer.

Level

Refer to Visibility of Menu Resources, page 63.
Description Free text.
Note

NOTE: Columns can be hidden or shown by right-clicking its name and
selecting Hide column or Show columns command.
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Enums

BIOS Parameters

Target Menus

1
EE Enums allows you to define enumeration elements which can be used in the
Installer Type column of the editor window.

For more information about Enums, refer to Enumerations, page 132.

Enums, which are generated and managed in Programming window can be
viewed in Web Site pages as all the other parameters.

j BIOS Parameters allows you to define variations in the default BIOS

parameters map which is factory-set by Schneider Electric.

This table presents the columns of the editor window:

Column Description
Name Resource name which may be used by the developer in the controller
application.
New value New value of the object.
New min New minimum value of the object.
NOTE: Only for M1730.
New max New maximum value of the object.
NOTE: Only for M1730.
New um New unit of measurement of the object.
NOTE: Only for M1730.
New level New user access level required to see and modify related parameter.

Refer to Visibility of Menu Resources, page 63.
NOTE: Only for M1730.

Default value

Default value of the object.

Min Minimum value of the object.
NOTE: Only for M1730.
Max Maximum value of the object.
NOTE: Only for M1730.
Um Unit of measurement of the object.
NOTE: Only for M1730.
Level User access level required to see and modify related parameter.
Refer to Visibility of Menu Resources, page 63.
NOTE: Only for M1730.
Description Description of the object.

Target Menu M171P/M172

Overview

The target menu can be created by using the Configuration tab. In the
Resources window, right-click Menus and select Add Menu command.
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The BIOS menu is factory-set and is visible from Device.

The main functions of the keys/LEDs of the target device can be programmed by
using the Display. LEDs are also programmable from in the Operators and
blocks window from the Programming.

In this section, you can define a menu (not visible on the display) and the folders/
variables of which it is composed.

The menu can consist of one or more folders, defined by the developer, into which
are entered:

+ EEPROM parameters (non-volatile memory parameters).
» Status variables.

Target Menu M1710

Overview

The target menu consists of a BIOS menu and an Application menu.
The BIOS menu is factory-set.

The following table defines the main functions of the keys/LEDs of the target
device.

Key Press Description

F5 Short Switch from BIOS menu to Application menu and conversely.

F1orF3 Short Navigate folders and edit values.

F2 Short Cancel operation (ESC function).

F4 Short Access to set menu.

F2+F4 Short Access to Prg menu.

F1/F2/F3/F4 | Long Managed by developer (by using target variable sysKeyFunctionsf]).

The LEDs are managed by the developer by using target variable sysLocallLeds.

The elements entered in the table in this section are displayed on Device.

Menu Prg

The Prg menu can consist of one or more folders, defined by the developer, into
which are inserted:

+ EEPROM parameters (non-volatile memory parameters).
+ Status variables.

» BIOS parameters.

* Inputs and outputs.

Menu Set

The Set menu is created in the same way as the Prg menu.

The Set menu contains the AL folder.

Visibility of Menu Resources

The visibility of the resources created by the developer is indicated in the following
table:
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Display Access Level Installer Access Level Visibility on Installer Visibility on target Note
column column
Always visible Always visible Yes Yes Object assigned to a Prg
or Set menu
Level 1 Supervisor Yes Yes
Supervisor
Level 2 Admin Yes Yes
Admin
Never visible Never visible Yes No Object NOT assigned to
any Prg or Set menu
Never visible Never visible Yes No
Visible in the folder ALL
PARAMETERS

Target Menu M1730

Overview

Menu Prg

Menu Set

The target menu consists of a BIOS menu and an Application menu.

The BIOS menu is factory-set.

The following table defines the main functions of the keys/LEDs of the target

device.
Key Press Description
F5 Short Switch from BIOS menu to Application menu and conversely.
F1orF3 Short Navigate folders and edit values.
F2 Short Cancel operation (ESC function).
F4 Short Access to set menu.
F2+F4 Short Access to Prg menu.
F1/F2/F3/F4 | Long Managed by developer (by using target variable sysKeyFunctions|]).

The LEDs are managed by the developer by using target variable sysLocalleds.

The elements entered in the table in this section are displayed on Device.

The Prg menu can consist of one or more folders, defined by the developer, into
which are inserted:

+ EEPROM parameters (non-volatile memory parameters).

« Status variables.

+ BIOS parameters.

* Inputs and outputs.

The Set menu is created in the same way as the Prg menu.

The Set menu contains the AL folder.
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Visibility of Menu Resources

The visibility of the resources created by the developer is indicated in the following

table:
Display Access Level Installer Access Level Visibility on Installer Visibility on target Note
column column
Always visible Always visible Yes Yes Object assigned to a Prg
or Set menu
Level 1 Supervisor Yes Yes
Supervisor
Level 2 Admin Yes Yes
Admin
Never visible Never visible Yes No Object NOT assigned to
— — any Prg or Set menu
Never visible Never visible Yes No
Visible in the folder ALL
PARAMETERS

I/0O Mapping

M1710 1/0O Mapping

You can define the links between variables and physical I1/0 of M1710:
* Local: local variables of the controller module.
+ Extended: variables of the expansion module.
* Remote: variables on the displays.

M171P/M172/M1730 1/O Mapping

You can define the links between variables and physical /0 of M171P/M172/
M1730:

* Local: local variables of the M171P/M172/M1730 base module.
» Field: variables of I/O expansion.

To map variables with physical I/Os, enter the name of the PLC variable in 1/O
Mapping > Local > Variable column.

NOTE: If correctly defined, the variables defined in Resources are located in
Project window: Project > Aux Variables > Global shared automatically.The
project must be saved without errors for the variables.

Alarms

M1710 Alarms

It is possible to define alarm variables which status must be managed by the
developer.

Alarm variables can be used in the application code. They appear in the Project
window: Project > Aux Variables > Global shared.

If the variable assumes a value other than zero, the label is displayed in the
Alarms folder (AL) of the set menu in M1710.
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In the Resources window, click Alarm to display the Alarm variable list.

This table presents the columns of the editor window:

Column Description

Name Resource name which may be used by the developer in the controller
application.

Short name Name displayed in the application menu of the M171 target (4-digit).

NOTE: If not filled, the text displayed on the controller will be the 4 first
characters of the variable.

Description Description of the variable.

NOTE: Each variable has a transcoding on the controller due to the 4-digit/ 7-
segment display. In the Short name label box, you can see a preview on the
display by clicking the ellipsis (...).

Some letters are not displayed (for example x and z) so there is a blank space
on the display. If the text is SET, 5 E £ appears on the display.

M171P/M172 Alarms

M1730 Alarms

In the M171P/M172 target, it is only a Global type USINT declaration.

The alarms for M171P/M172 are only defined to enable the portability of an
M1710 project.

It is possible to define alarm variables which status must be managed by the
developer.

Alarm variables can be used in the application code. They appear in the Project
window: Project > Aux Variables > Global shared.

If the variable assumes a value other than zero, the label is displayed in the
Alarms folder (AL) of the set menu in M1730.

In the Resources window, click Alarm to display the Alarm variable list.

This table presents the columns of the editor window:

Column Description

Name Resource name which may be used by the developer in the controller
application.

Short name Name displayed in the application menu of the M1730 target (4-digit).

NOTE: If not filled, the text displayed on the controller will be the 4 first
characters of the variable.

Description Description of the variable.

NOTE: Each variable has a transcoding on the controller due to the 4-digit/ 7-
segment display. In the Short name label box, you can see a preview on the
display by clicking the ellipsis (...).

Some letters are not displayed (for example x and z) so there is a blank space
on the display. If the text is SET, 5 £ £ appears on the display.
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Web Site

Web Functionalities

The M172 features web functionalities, offering makers of machinery and systems
integrators remote access. Having a web-based connection in machines reduces
support and maintenance by minimizing call-out charges. End users also benefit,
as they can monitor their own systems both locally and from distance, using the
graphics interface of any browser.

Main web functionalities:
*  Web-based access.
* Remote reading.
* Local and remote system control, including alarms management.
* Preventive and predictive maintenance.
* Email alarm alerts.

‘WEB MENU TITLE' WEB TABLE PAGE

4+ Add ||— Remove || AN Up || ¥ Down [ Enable build

Refresh (ms): 1000 (O=disable refresh)  Password:

Page title: Filename:

Site template: Choose...
# Name Control Label Section Text size = Img filename Img X Img Y Enum values

Care must be taken and provisions made for use of this product as a control
device to avoid inadvertent consequences of commanded machine operation,
controller state changes, or alteration of data memory or machine operating
parameters.

AWARNING

UNINTENDED EQUIPMENT OPERATION

» Configure and install the mechanism that enables the remote HMI local to
the machine so that local control over the machine can be maintained
regardless of the remote commands sent to the application.

* You must have a complete understanding of the application and the machine
before attempting to control the application remotely.

» Take the precautions necessary to assure that you are operating remotely on
the intended machine by having clear, identifying documentation within the
application and its remote connection.

Failure to follow these instructions can result in death, serious injury, or

equipment damage.

NOTE: Schneider Electric adheres to industry best practices in the
development and implementation of control systems. This includes a
"Defense-in-Depth" approach to secure an Industrial Control System. This
approach places the controllers behind one or more firewalls to restrict access
to authorized personnel and protocols only.
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AWARNING

UNAUTHENTICATED ACCESS AND SUBSEQUENT UNAUTHORIZED
MACHINE OPERATION

+ Evaluate whether your environment or your machines are connected to your
critical infrastructure and, if so, take appropriate steps in terms of prevention,
based on Defense-in-Depth, before connecting the automation system to
any network.

« Limit the number of devices connected to a network to the minimum
necessary.

+ Isolate your industrial network from other networks inside your company.

» Protect any network against unintended access by using firewalls, VPN, or
other, proven security measures.

» Monitor activities within your systems.

* Prevent subject devices from direct access or direct link by unauthorized
parties or unauthenticated actions.

» Prepare arecovery plan including backup of your system and process
information.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

AWARNING

UNINTENDED EQUIPMENT OPERATION

» Define a secure password for the Web Functionalities, and do not allow
unauthorized or otherwise unqualified personnel to use the features therein.

» Ensure that there is a local, competent, and qualified observer present when
operating on the controller from a remote location.

» Configure and install the mechanism that enables the remote HMI local to
the machine so that local control over the machine can be maintained
regardless of the remote commands sent to the application.

* You must have a complete understanding of the application and the machine
before attempting to control the application remotely.

+ Take the precautions necessary to assure that you are operating remotely on
the intended machine by having clear, identifying documentation within the
application and its remote connection.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

CAN Expansion Bus

CAN Expansion Bus Overview

Description

M171P/M172/M1730 have one on-board CAN Expansion bus port, plus another
one available as an external plugin. Each port can be configured as Not used
(disabled), or Master (for field).

M171P Flush Mounting can be connected using CAN Expansion bus for field
mode or for network mode.
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Master (for Field)

Slave (for Binding)

CAN EXPANSION BUS

Mode Not used

® Master (for field)

Baud rate

® 500 Kb/s
250 Kb/s
125 Kb/s
50 Kb/s
Master Settings
Node ID (1...122,125): ' 125 ?
Heartbeat time (ms): 0
Sync COBID: 128
Sync Cycle (ms): 0

When you configure the CAN Expansion bus port as Master (for field), the
controller acts as a CAN Expansion bus master on this port. You can attach CAN
Expansion bus slave devices and exchange data with remote 1/0.

For a CAN Expansion bus master port, you have to configure:
+ Baud rate used in this CAN Expansion bus network (in kb/s).
* Node ID for the master (1...127), by default is 125.
* Heartbeat time in ms, by default O (heartbeat producer disabled).
+ The SYNC COBID to use, by default 128.
» The period for the SYNC cycle in ms, by default 0 (sync disabled).

« The parameter which represents the maximum number of expansions used
by PLC application.

After you added and configured the various CAN Expansion bus slaves, you can
link the remote objects of the slave and the internal PLC variables to read or write.

The set of controller objects you can read or write is made of:
« Status variables, created with Configuration.
» Field variables, created with Configuration.

The binding mode can be configured with the Installer software, page 49.

When you configure the CAN Expansion bus port as Slave, the M171P/M172P
bus port acts as a CAN Expansion bus slave. You can exchange data by Binding I/
O with other devices on the CAN Expansion bus network.

Configuring the port:

For a CAN Expansion bus slave port, you have to configure:
» Baud rate used in this CAN Expansion bus network (in kb/s).
* Node ID for the slave (1...127), by default is 1.

* The “virtual network” where this M171P Display is attached; in the tree
appears a small colored circle of same color of the chosen network (same
color means same network).
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* The maximum number of devices that can be bound is 10
The Binding object:
Once a CAN Expansion bus port has been configured as Slave, the device is able

to SEND objects on the network. To make the device able to READ objects from
other devices, it is necessary to add a Binding object to the port.

The set of PLC objects you can send or receive is made of:

+ EEPROM parameters (non-volatile memory parameters), created with
Configuration.

» Status variables, created with Configuration.

Clicking the Binding object displays its configuration page: here is a grid where
you want to insert the remote objects to read, and link them to the local
destinations.

To do this, click the Add button. A window displaying the “public” objects from the
other devices on the network appears. Here you can apply search filters and
choose which objects to read (multi-selection is also supported).

Once you have inserted the remote objects to read, you have to assign the local
destination locations to write, choosing from the list in the Dest parameter column
or manually inserting the Address.

NOTE: It is necessary to rebuild the PLC project to update the list of public
objects.

Example:

* M171 Perf Display_1 reads from M171 Perf Display_2 the M171_2 par1
object and puts itin its local M171_1_par1 object.

* M171 Perf Display_1 reads from M171 Perf Display_2 the M171_2 par2
object and puts itin its local M171_1_par2 object.

In the Period field, you can configure the period for each parameter; the object is
updated every “period” in ms.

Using an Expansion Module as CAN Expansion Bus Field Slave

CAN Expansion Bus with M172 Expansion Modules and M172 Controllers

In this configuration example, you want to use M172 Expansion 28 |/Os as
expansion of a M172P device. The same can be done for other logic controllers.

Configure M172P CAN Expansion Bus in Master (for field) mode. From the
Catalog window, select M172 Expansion 12&28 1/0Os node and drop it on the
CAN Expansion Bus node.

M172 Expansion 12&28 1/Os configuration is divided into four tabs:
* GENERAL: to configure the network parameters.
» DIGITAL I/O: to configure the digital I/Os.
+ ANALOG I/O: to configure the analog I/Os.
+ ADVANCED SETTINGS: to add and remove variables.
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GENERAL tab of M172 Expansion 12&28 1/Os:

M172 EXPANSION GENERAL CONFIGURATION

GENERAL DIGITAL I/O ANALOG 1I/0 ADVANCED SETTINGS
Network setings Node number (1...122) 1
Node Guard Period (ms) 200
Life time Factor 3
Boot time elapsed (ms) 2000

® USER DEFINED Mode
O SYNC Mode
O EVENT Mode

O CYCLIC Mode 0 ms

DIGITAL I/O tab of M172 Expansion 12&28 1/Os:

M172 EXPANSION DIGITAL 1/O CONFIGURATION

GENERAL DIGITAL I/0 ANALOG I/0 ADVANCED SETTINGS
I0s Configuration @®@1210s  (O2810s
Digital INPUTS PLC Var DataBlock
DI AL
DI2 A LN
Digital OUTPUTS PLC Var DataBlock
DO1 ALY
DO2 VLY
DO3 ALY
DO4 ALY
DO5 ALY
DO6 AR

EcoStruxure Machine Expert - HYAC knows the M172 Expansion 12&28 1/Os
dictionary. Each object can be assigned to a PLC variable.

Follow this procedure do assign an object to a PLC variable:

Step Action
1 A"
Click Assign button.
2 Select the PLC variable that you want to assign to the PLC object:
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Step

Action

Choose PLC variable X

Filter:

MyProject: DI_xDIE1 (BOOL) — DIE1 digital input
MyProject: DI_xDIE2 (BOOL) — DIE2 digital input
MyProject: DI_xDIE3 (BOOL) — DIE3 digital input
MyProject: DI_xDIE4 (BOOL) — DIE4 digital input

(

(

(

[IE

MyProject: DI_xDIE5 (BOOL) — DIES5 digital input
MyProject: DI_xDIE6 (BOOL) — DIEG6 digital input
MyProject: DI_xDIE7 (BOOL) — DIE7 digital input
MyProject: DI_xDIE8 (BOOL) — DIES8 digital input
MyProject: xCmdConsumReset (BOOL)

[ OK ] [ Cancel ]

NOTE: It is possible to apply a filter to the choice list by entering a string of
characters.

Click OK button to validate.

The PLC Var name is added and its address is displayed in the DataBlock field.

NOTE: Click R Unassign button to remove the assignment.

ANALOG 1/0 tab of M172 Expansion 12&28 I/Os:

M172 EXPANSION ANALOG 1/0 CONFIGURATION

GENERAL DIGITAL I/O ANALOG I/0 ADVANCED SETTINGS

Analog INPUTS

10s Configuration (0O1210s @ 2810s

Analog OUTPUTS #1, #2

PLC Var DataBlock

AO1 AL
AO2 s [

Analog INPUTS Frequency and Counter #1, #2

Analog INPUT #1

PLC Var DataBlock
FDI1 Counter ALY
FDI1 Frequency AL N
FDI2 Counter AR
FDI2 Frequency ALY
Temp UM 0=°C v
Configuration 0 =NTC(NK103) \Y4
PLC Var DataBlock
Al A LS

Full Scale Min 0
Full Scale Max | 1000

Calibration 0

Sub

. . 3 = Low Pass Filter enabled, analog value converted A4
Configuration
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ADVANCED SETTINGS tab of M172 Expansion 12&28 1/Os:

M172 EXPANSION CONFIGURATION

GENERAL DIGITAL I/O ANALOG 1/0 ADVANCED SETTINGS

+ Add | == Remove

# Label Index Sublndex Type Value Timeout
1 FullScaleMin_Al1 3d78 0 INT 100
2  FullScaleMax_Al1 3d79 0 INT 100

CAN Expansion Bus with M171P Expansion Module and M171P

In this configuration example, you want to use TM171EP27R as expansion of a
M171P device. The same can be done for other logic controllers.

Configure M171P CAN Expansion Bus in Master (for field) mode. From the
Catalog window, it is possible to select M171P EXPANSION 27 1/0S node and
drop it on the CAN Expansion Bus node.

M171P EXPANSION 27 I/OS configuration is similar to CAN Custom configuration
(Using a CAN Custom Device, page 75) with dynamic PDO mapping feature
disabled. Available Input/Output objects that can be mapped on PLC variables via
PDO are listed in PDO TX - INPUT and PDO RX - OUTPUT.

CAN Expansion Bus for M171P Flush Mounting

Description

Field Mode

M171P Flush Mounting can be connected using CAN Expansion bus in field mode
or in network mode.

To connect M171P Flush Mounting in this mode select M171P Display or M171
Perf. Blind CAN Expansion bus node and select the option Master (for field) then
take M171P Flush Mounting device from Catalog tab and drop it over CAN
Expansion bus node.

Select M171 Perf. Flush Mounting_1 child node and configure Network settings.
Probes:

M171 Perf. Display_1 can access to M171 Perf. Flush Mounting_1 on-board
probes. To do so select Probes - Input tab then it is possible to map a M171 Perf.
Display_1 parameter to let it obtain the value of an on-board M171 Perf. Display
probe.

Choose one of the probes and click Assign button. Take one of the M171 Perf.
Display_1 INT parameter and click OK button.

HMI:

It is possible to associate to a M171P Flush Mounting (configured as CAN
Expansion bus field slave) an HMI project with local pages. M171P Flush
Mounting would be able to show its own target variables and parameters of the
CAN Expansion bus master to which it belongs.
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Network Mode

The HMI remoting and binding mode can be configured with the Installer
software, page 49.

In this connection mode, M171P Flush Mounting can be linked to one of the
remote devices that are available on the network to navigate HMI Remote pages
provided by other devices.

Using the Installer software, it is possible to do so by indicating one of the
available HMI Remote devices of the network.

For example:

You have a CAN Expansion bus network with M171 Perf. Display_1 and M171
Perf. Blind_1 then add as first-level node M171 Perf. Flush Mounting_1 to the
network taking it from Catalog panel.

Click CAN Exp bus node of M171 Perf. Flush Mounting_1 and select Master
(for HMI remoting and binding) node, assign unique Node ID and select network
CAN Exp bus1.

Binding of variables between M171 Perf. Flush Mounting_1 and M171 Perf.
Blind_1 and M171 Perf. Display_1 is allowed in a network of this type (see
chapter CAN Expansion bus - Binding, page 69 for more details).

HMI Remote pages:

In CAN Expansion bus network mode, it is possible to configure M171P Flush
Mounting in order to be linked to 0 to 10 remote devices that can provide HMI
Remote pages to the keyboard.

To add HMI Remote pages select M171 Perf. Flush Mounting_1 node, then
press Add on the HMI Remote pages box thus all available devices will be
displayed and the user can select the pages to navigate.

CAN Custom Device

Description

CAN custom device can be created and added to the Catalog by importing its
EDS file. Therefore, you can use any third-party CAN Expansion bus device as a
slave, as long as it provides a standard, compliant EDS file (Electronic Data
Sheet) that follows the DS402 CiA specification.

Importing a New CAN Custom Device

To import a new CAN custom device, choose Developer > Import EDS
command.
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The Import EDS window appears:

Import EDS X

Source EDS: ' C:\ATV600_CANopen_EDS_V2.1\SEATV6x0_0102 Choose...

New Name: ATV6x0_V2.1 1.513
Short Name: ATV6x0_V2p1_1p513
Has dynamic PDO mapping: |Z|

Vendor Name: | Schneider Electric

Product Name: = ATV6x0_V2.1 Revision: ' 1.513
Description: EDS for ATV6x0
Comments:

Conforamnce class = S20 -

Product function = Frequency Converter
Supported profiles = 402 V3

Boot-up time = 100ms v
Number of Objects
Mandatory: | 3 Optional: = 39 Manufacturer: ' 87
[ OK ] [ Cancel ]

Here you have to configure:
» The source EDS file to import, using the Choose... button.
» The full name of the device (by default is Product name + Revision).
+ The short name must not include any special characters or spaces.

» Dynamic PDO mapping: if you activate this option, you are able to configure
manually and modify the default PDO mapping read from the EDS to match
the actual mapping of the slave, otherwise the PDO mapping is read-only and
determined only by the EDS default values.

After you have chosen the EDS file, the window will show a resume of the device
characteristic and number of objects (detailed in mandatory, optional,
manufacturer).

Deleting a CAN Custom Device

When the device you want to delete is visible in the Catalog window (for example
when a CAN Expansion bus port is selected and is in Master mode), you can
right-click on it and choose the Delete from catalog command.

Using a CAN Custom Device

Description

When you insert a CAN custom device as a CAN Expansion bus slave (for
example under a CAN Expansion bus slave port) and click it on the Resources
window, the editor window displays four tabs.
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General Tab

ATV6X0_V2.1 1.513 CONFIGURATION

GENERAL SDO SET PDO TX - INPUT ~ PDO RX - OUTPUT
Network Settings Node number (1...122) 3 PDO Tx communication ~ ysgR DEFINED Mode

settings

Node Guard Period (ms) | 200 O SYNC Mode
O EVENT Mode

Life time Factor 3

@ CYCLIC Mode 1000 | ms

Boot time elapsed (ms) 10000

PDO Rx communication

settings O USER DEFINED Mode

Node heartbeat producer 0

time (ms)
O SYNC Mode
Node heartbeat consumer 0

time (ms) @® EVENT Mode

Master heartbeat

consumer time (ms) 0

Identity object check g

In the General tab, you can configure:

Node number (1...122).

Node guard period in ms (default 200 ms). Value 0 disables node guard for
this slave. If not zero, it is the interval of node guarding packets sent by the
master to the slave.

Life time factor (default 3x). Value 0 disables node guard for this slave. If not
zero, multiplied by the Node guarding period, it is the maximum amount of
time the master waits for the slave answer for the node guard.

Boot time elapsed: this is the maximum amount of time in ms that the master
waits for the slave to become pre-operational at boot (default 10 s) before
signaling an error.

Node heartbeat producer time in ms, default is value 0 (heartbeat disabled).
If not zero, the master enables the heartbeat error handling for this node.

Node heartbeat consumer time in ms, default is value 0 (heartbeat
disabled). If not zero, it is the maximum amount of time the slave waits for the
heartbeat produced by the master before timing out. This should be greater
than the Heartbeat time of the master.

Master heartbeat consumer time in ms, default is value O (heartbeat
disabled); it is the maximum amount of time the master waits for the heartbeat
sent by the slave before timing out. This should be greater than the Node
heartbeat producer time.

Identity object check: when this option is enabled (the default) the master at
boot verifies the slave for its identity, verifying that the Identity object fields
(object 1018 hex) match with EDS default values (Vendor ID, Product code,
Revision, Serial). If the option is not enabled, no verification is done.

PDO Tx comm settings: configure here the transmission mode for PDO Tx;
depending on the device features (determined from EDS values), not all
options may be available.

PDO Rx comm settings: configure here the transmission mode for PDO Rx;
depending on the device features (determined from EDS values), not all
options may be available.
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SDO Set Tab

ATV6X0_V2.1 1.513 CONFIGURATION

GENERAL SDO SET PDO TX - INPUT PDO RX - OUTPUT

[ 4 Add |[ = Remove |

# Label Index SublIndex Type Value Timeout
1 i Transmission Type 1800 2 USINT 255 100
2 Event Timer 1800 5 UINT 1000 100
3 Transmission Type 1802 2 USINT 255 100
4 Event Timer 1802 5 UINT 1000 100
5 Transmission Type 1400 2 USINT 255 100
6 Transmission Type 1402 2 USINT 255 100

In this page, you can insert a list of objects and values to send to the slave at boot
for configuration purposes, using SDO packets.

Press the Add button, choose the objects to send, and then insert their Value in
the grid.

Some objects are handled automatically, for example the Transmission type and
Event timer are configured automatically depending on the PDO Tx comm
settings and PDO Rx comm settings in the General tab.

PDO Tx - Input and PDO Rx - Input Tabs

In the PDO Tx - Input tab, you configure the PDOs (Process Data Object) that the
slave transmits, and so the master receives in input. In the PDO Rx - Output tab,
you configure the PDOs that the slave receives, and so the master sends the
output.

If the CAN custom device was imported with the Dynamic PDO mapping
enabled, you are able to edit the PDO mapping by adding and removing objects
and manually edit the PDO and Bit columns. Otherwise, the Add and Remove
buttons are not available and you have to use the PDO configuration as-is.

If you check the Split single bits option, the object you choose is inserted as
single bits to be linked to BOOL variables (that is the default for digital I/0 objects
in the DS401 standard).

NOTE: This PDO mapping configuration is not sent to the device, its only
purpose is to match a configured PDO mapping on the device.

Then with the Assign button you can link each CAN object with the PLC variable
to read (PDO Tx) or write (PDO Rx).

NOTE: It is necessary to rebuild the PLC project with Programming to update
the list of PLC variables.

PDO TX - INPUT tab of ATV6X0_V2.1.1.513 CONFIGURATION:

ATV6X0_V2.1 1.513 CONFIGURATION

GENERAL SDO SET PDO TX - INPUT PDO RX - OUTPUT

[+ Add ”— Remove ”s Assign HR UnAssign l

# ldx | Sub | PDO | Bit COBID Object Name Type Size Label DataBlock
1 %041 o | o o Statusword UINT 16
2 6044 |0 1 16 |0 Control Effort INT 16
3 2061 |2a 3 0 0 NM1 (12741) UINT 16
4 2061 |(2b 3 16 |0 NM2 (12742) UINT 16
5 2061 |2¢ |3 32 |0 NM3 (12743) UINT 16
6 2061 |2d 3 48 |0 NM4 (12744) UINT 16
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PDO RX - OUTPUT tab of ATV6X0_V2.1.1.513 CONFIGURATION:

ATV6X0_V2.1 1.513 CONFIGURATION

GENERAL SDO SET PDO TX - INPUT PDO RX - OUTPUT

[-'- Add ][— Remove ][s Assign ][R UnAssign ]

# ldx | Sub | PDO | Bit, COBID Object Name Type Size Label Data Block
1 16040 10 1 o o Controlword UINT 16
2 6042 |0 1 16 |0 Target Velocity INT 16
3 2061 |3e 3 0 0 NC1 (12761) UINT 16
4 2061 |3f 3 16 |0 NC2 (12762) UINT 16
5 2061 |40 3 32 |0 NC3 (12763) UINT 16
6 2061 (41 3 48 |0 NC4 (12764) UINT 16

CAN Expansion Bus Field - Virtual Master Channels

Overview

Description

This paragraph describes the criteria used by Configuration to assign virtual
node IDs due to the network configuration.

When CAN Expansion bus is in use on a M171P device in Master mode (field),
three master channels are opened.

First master channel is used to process requests that arrive to its physical node 1D
(the ID assigned by you in the configuration box). Supervisor PC should be
connected using this node ID. CAN Expansion bus physical node ID addr must be
chosen in a range between 1 to 122 or 125.

Two other virtual master channels are opened on this device and are dedicated to
the communication with keyboards (max 2 for each CAN Expansion bus network).

Virtual master node IDs have fixed values:
ch 1 =123
ch 2 124

Example: M171P + 2 x M171 Display Graphic

The two M171 Graphic displays are both connected to the CAN expansion bus.

The CAN expansion bus has two default virtual channels that can be connected to
a maximum of 2 x M171 Display Graphic.

The default virtual channels are 124 for the first display and 123 for the second
M171 Display Graphic.

Click ? button from the CAN expansion bus to view the values.

The default address of the Display for M171 Perf_2 display is 127, the default
virtual channel 124 and the default CAN baudrate 500 kb/s.

Thus, when physically connecting an M171 Display Graphic to an M171P with the
default settings, upload HMI from the M171 Display Graphic BIOS menu.

In other cases, such as for Display for M171 Perf_1 (which has the address 126),
set the address 126 and the virtual canal 123 from the M171 Display Graphic
BIOS menu.
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RS-485

Overview

Description

Field

M171P Display / M171P Flush Mounting has one on-board RS-485 port, plus
another one available as an external plugin. Each port can be configured as Not
used (disabled) or Modbus Master (field).

M1730 / M172 has two on-board RS-485 ports.

The first port (RS-485-1) is used for Modbus Slave - BACnet MS/TP. The RS-485-
2 port can be configured as Modbus Slave - BACnet MS/TP or Modbus Master
(for field).

RS485 CONFIGURATION

Mode Modbus Slave — BACnet MS/TP
® Modbus Master (for field)

Baud rate 9600 b/s
19200 b/s
® 38400 b/s
57600 b/s
115200 b/s

Serial Mode E,8,1 (Even parity, 8 data bits, 1 stop bit)

When you configure the RS-485 port as Master the target acts as a Modbus RTU
master on this port. So you can connect Modbus slave devices.

For a Modbus master port, you must configure:
+ Baud rate used in this Modbus network (in b/s).
» Serial mode (parity, data bits, stop bits).

To add a Modbus slaves, right-click RS-485 and select Add command. You can
also drag a Modbus slave from the Catalog window to the RS-485 item in the
Resources window.

After you added and configured the Modbus slaves, page 80, you can link the
remote objects of the slave and the internal PLC variables to read or write.

The set of PLC objects you can read or write is made of:
» Status variables.
» Field variables declared in I/0 Mapping > Field.
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Using a TM171E 27 I/O as RS-485 Slave

Description
In this configuration example, you want to use Modicon M171 Perf. Expansion
27 1/0s as expansion of a M171P Display device. The same can be done for other
logic controllers.
Configure M171P Display RS-485 in Modbus Master (for field) mode. From the
Catalog window, it is possible to select Modicon M171 Perf. Expansion 27 1/Os
node and drop it on the RS-485 node.
Modicon M171 Perf. Expansion 27 I/Os configuration is similar to a (Modbus
Custom device configuration, page 85). It is possible to assign available Modicon
M171 Perf. Expansion 27 1/Os dictionary I/O objects to M171 Perf. Display PLC
variables.
Configuration knows the Modicon M171 Perf. Expansion 27 1/Os dictionary.
Input and Output objects can be added, removed, assigned, unassigned, or
changed in position. Only assigned objects are requested by M171 Perf. Display
device.
GENERAL tab of M171P EXPANSION 27 I/0S CONFIGURATION:
M171P EXPANSION 27 1/0OS CONFIGURATION
GENERAL INPUT OUTPUT
Settings Modbus address: |1 (1...247)
Node number: 0 (0...127)
Polling time: 0 Ms (0 = continuous read/write on variation)
TimeOut: 1000 ms
Wait before send: |10 ms
INPUT tab of M171P EXPANSION 27 I/OS CONFIGURATION:
M171P EXPANSION 27 1/OS CONFIGURATION
GENERAL INPUT OUTPUT
[+ Add J[ -_ Remove”ﬂ Assign”R UnAssign ][*Up ][ ¥ Down]
Parameter Address Type Variable Type | DataBlock
DIL1 1 BOOL
SW1 9 BOOL
AIL1 8336 INT
Counter 8752 UDINT
Frequency 8754 UDINT
OUTPUT tab of M171P EXPANSION 27 1/0S CONFIGURATION:
M171P EXPANSION 27 1/0S CONFIGURATION
GENERAL INPUT OUTPUT
[+ Add ][ - Remove][& Assign][R UnAssign ][*Up ][* Down]
Parameter Address Type Variable Type | DataBlock
DOL1 1 BOOL
AOL1 8448 UINT
LED1 8640 USINT
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Generic Modbus Object Overview

Description

The Generic Modbus object is a generic Modbus slave that can be inserted
under the RS-485 port of the logic controller, when configured as Modbus

master.
GENERIC MODBUS NODE
GENERAL
Settings Name: Generic Modbus_1
Modbus address: 1 (0 ... 247, O=broadcast)
Node number: 1 (0...127)

To add a Generic Modbus object:

Step Action
1 In the Resources window, click RS-485.
2 + Drag Generic Modbus from the Catalog window to RS-485 item in the

Resources window.
Or you can right-click RS-485 and select Add command.
Generic Modbus appears under RS-485 item.

You can use the Generic Modbus when you want to configure manually and have
full control over the single Modbus messages to send to the slave.

Another typical usage is for third-party devices that you plan to use once in your
project, and you do not want to put in the catalog for future reuse.

In the main page of the Generic Modbus you can configure:
* A name for the object in the project.
* Its Modbus address (in the range 1...247).

+ Its Node number (node ID)(in the range 0...127): this value is incremented
automatically, and can be used in the PLC program to index the
SysMbMRtuNodeStatus[] array that contains diagnostic information about
each slave node.

Generic Modbus Object Messages

Description

The Generic Modbus object alone does nothing; you have to add under it one or

more Modbus messages that are specific Modbus function requests that are sent
on the bus.
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To add a function to a Generic Modbus object, drag a Modbus function from the
Catalog window to Generic Modbus item in the Resources window. You can
also right-click Generic Modbus and select Add command.

Catalog X

Device name Version = Description

i\‘ Modbus FC-01 1 Read Coils - Function 01 (0x01)

:\ Modbus FC-02 1 Read Discrete Inputs - Function 02 (0x02)

.\‘ Modbus FC-03 1 Read Holding Register - Function 03 (0x03)

i; Modbus FC-04 1 Read Input Registers - Function 04 (0x04)

:\ Modbus FC-05 1 Write Single Coil - Function 05 (0x05)

-‘; Modbus FC-06 1 Write Single Register - Function 06 (0x06)

:; Modbus FC-15 1 Write Multiple Coils - Function 15 (OxOF)

.\ Modbus FC-16 1 Write Multiple Register - Function 16 (0x10)
Function | Description Details Objects

length
1 0x01 | Read Coils Reads one or more read-only discrete output 1-bit
coils
2 | 0x02 | Read Discrete Inputs Reads one or more read-only digital inputs 1-bit
3 | 0x03 | Read Holding Reads one or more read/write registers 16-bit
Registers

4 | 0x04 | Read Input Registers Reads one or more read-only registers 16-bit
5 | 0x05 | Write Single Coil Writes one discrete output coil 1-bit
6 | 0x06 | Write Single Register Writes single analog output holding register 16-bit
15 | OxOF | Write Multiple Coils Writes one or more digital outputs 1-bit
16 | 0x10 | Write Multiple registers | Writes one or more registers 16-bit

The messages are processed in the order they are inserted in the tree.

General Tab

Select the Modbus function added to the tree to display its configuration window:

GENERAL

Settings Start address: 0 (1... 65536)
Polling time: 0 ms (0 = Continuous Read)
Time out: 1000 ms
Wait before send: 10 ms

For each message, in its General tab you can configure:
» Start address: address of the first Modbus object to read or write (1...65536).
» Polling time: the message is processed with this period (ms):

o For writing operations: value 0 means to write it only on variation of the
value.

o Forreading operations: value 0 means maximum speed.
» Time out: the operation is unsuccessful when this time-out expires (ms).
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* Wait before send: this is the wait time before sending another request to the
salve device.

Coils Tab

Beside the General tab, each different message has a second tab where you can
configure the list of objects to read or write.

MODBUS FC 01(0X01) — READ COILS

GENERAL COILS

[+ Add ][— Remove ][s Assign ][R UnAssign ]

# Name ObjType Label Address DataBlock Description
1 Coll Bool 0

Using the Add button, insert one row for each Modbus object to read or write, up
to 16 elements. The first row has the address configured in the Address box in
the General tab, and the other rows increment and follow.

For each row, press the Assign button to choose the PLC object to link and to be
read or written with this Modbus message; you cannot leave unassigned rows in
the message.

NOTE: Remember to rebuild the PLC project to see an updated list of PLC
variables here.

Modbus Custom Devices

Description

You can create and edit Modbus custom devices directly.

Therefore, you can use in your project and add in the catalog for future reuse any
third-party Modbus slave, characterizing its Modbus map only the first time and
simplifying its further use, because you do not have to care about Modbus
messages and functions anymore.

Creating a New Modbus Custom Device

To create a new Modbus custom device, choose Developer > Run Modbus
custom Editor; the external ModbusCustomEditor tool is launched, with a new
empty document.
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(H 9 ModbusCustomEditor - o X
[ ™ New H [ Open ”E Save ]
Device Version
Name: ModbusCustomDeviceName
Version: 1.0
Description: Modbus custom device description
Modbus RTU /1 Modbus TCP
Device Info
Max message size (bit): 2000
Max message size (reg.): 120
Enable overlap of Bit and Reg maps
[+ Add "— Remove ”*Up "* Down ]
# Address Label Type Read only Modbus type Description
1 [1 ' Labelt CINT  False ' Holding Register (16 bit),

Here you can configure:
» Name of the device.
» Long description for the device.
* Aversion number.

» Overlapping of bit and register maps: check this if the device has both a 0
register and a 0 bit (in other words it has different addressing of 16-bit and 1-
bit objects). Uncheck this if the address is unique and so duplicated are not

allowed, even if the type is different.

+ Max message size: insert here the maximum number of registers per

message supported by the device.

Then, using the Add button, add one row for each Modbus object of the device.
You have to insert its address, name, type (note that Type and Read only
columns are linked with the Modbus type column) and optionally a long

description.

When you finish, save the current device definition; you are prompted for a file
name with .PCT extension, by default it is proposed the current name+version.

The file is saved in the special ModbusCustom folder in the catalog; now you can
close the ModbusCustomEditor and go back in Configuration to use the new

device.

Editing an Existing Modbus Custom Device

To edit an existing Modbus custom device, you can:

* Run the ModbusCustomEditor with the Developer > Run Modbus custom
Editor command, and then manually open the PCT file with the standard File

> Open command.

*  When the device you want to edit is visible in the Catalog window (for
example when an RS-485 node is selected and is in Master mode), you can
right-click on it and choose the Edit device command; the
ModbusCustomEditor is launched and the selected device opened.
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Deleting a Modbus Custom Device

To delete an existing Modbus custom device when the device is visible in the
Catalog window, do a right-click on it and choose Delete from catalog.

Using a Modbus Custom Device

Description

When you insert the Modbus custom device as a Modbus slave (for example
under an RS-485 port) and click it on the Resources window, the Editor window
displays three tabs.

General Tab

In the General tab you can configure:

Its Modbus address (in the range 1...247).

Its Node number (in the range 0...127); this value is incremented
automatically, and can be used in the PLC program to index the
SysMbMRtuNodeStatus[] array that contains diagnostic information about
each slave node.

Polling time: the Modbus messages are processed with this period (ms); for
writing operations, value 0 means to write it only on variation of the value, for
reading operations value 0 means maximum speed.

Timeout: the operation is unsuccessful when this time-out expires (ms).

Wait before send: this is an additional timeout (to be used with slow slaves
that do not answer if the messages are sent too fast).

GENERAL tab of MODBUS CUSTOM CONFIGURATION:

MODBUS CUSTOM CONFIGURATION

GENERAL INPUT OUTPUT
Settings Modbus address: 1 (1...247)
Node number: 2 (0...127)
Polling time: 0 Ms (0 = continuous read/write on variation)
TimeOut: 1000 ms
Wait before send: |10 ms

Here you can note that for Modbus custom the Polling time, Timeout, and Wait
before send are generic for the whole device while for the Generic Modbus you
can put specific different values for each single message. This is because with the
Modbus custom the low-level Modbus messages are automatically calculated.
However, you cannot “fine-tune” them because these settings are global.

Input and Output Tabs

In the Input and Output tabs, you can insert one row for each Modbus object to
read or write. Press the Add button and choose the parameters to exchange
(multi-selection is supported). Use the Assign button to link them to the PLC
object to be read or written to.
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Ethernet

Description

INPUT tab of MODBUS CUSTOM CONFIGURATION:

MODBUS CUSTOM CONFIGURATION

GENERAL INPUT OUTPUT

(3 7od (= Romore) (S Assion (R Unssan | (4105 [ Dowr]

Parameter Address Type Variable Type  DataBlock
Label1 K CINT \ |

OUTPUT tab of MODBUS CUSTOM CONFIGURATION:

MODBUS CUSTOM CONFIGURATION

GENERAL INPUT OUTPUT

[+ Add ][— Remove][& Assign][R UnAssign ][¢Up ][woown]

Parameter Address Type Variable Type | DataBlock
Label1 E CINT \ \ \

Insert in the Input tab the Modbus objects to READ from the Modbus slave (and to
put into PLC variables). Insert in the Output tab the Modbus objects to WRITE to
the Modbus slave (and to get from the PLC variables).

NOTE: Remember to rebuild the PLC project with Application to see an
updated list of PLC variables here.

Configuration creates the correct Modbus messages analyzing the sequence of
addresses and types. If the addresses are consecutive and the types are
homogeneous, different objects are grouped in single messages to optimize the
communication.

The maximum number of registers configured with the ModbusCustomEditor is
also considered, along with the maximum number of registers per message of the
master (16 for the M171P/M172).

The grouping and generation of the Modbus messages is automatic and
recalculated at each compilation.

M171P Flush Mounting / M172P are provided with an integrated Ethernet port.

M171P/M1720 can have one Ethernet port, available as an external
communication module.

The Ethernet port can be configured as a Modbus TCP in two ways:

» Server only: the controller supports communication from other controller
requests.

» Client/Server: the controller supports Modbus TCP communication from
other controller requests as well as making requests to other controllers.

NOTE: Schneider Electric adheres to industry best practices in the
development and implementation of control systems. This includes a
"Defense-in-Depth" approach to secure an Industrial Control System. This
approach places the controllers behind one or more firewalls to restrict access
to authorized personnel and protocols only.
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Configuration

Client/Server

AWARNING

UNAUTHENTICATED ACCESS AND SUBSEQUENT UNAUTHORIZED
MACHINE OPERATION

» Evaluate whether your environment or your machines are connected to your
critical infrastructure and, if so, take appropriate steps in terms of prevention,
based on Defense-in-Depth, before connecting the automation system to
any network.

« Limit the number of devices connected to a network to the minimum
necessary.

» Isolate your industrial network from other networks inside your company.

» Protect any network against unintended access by using firewalls, VPN, or
other, proven security measures.

* Monitor activities within your systems.

* Prevent subject devices from direct access or direct link by unauthorized
parties or unauthenticated actions.

* Prepare a recovery plan including backup of your system and process
information.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

To configure the Ethernet port:
+ Select Client/Server or Server only.
» Enter the additional Modbus TCP sockets (0 by default).
The IP address is stored in Modbus objects > BIOS Parameters.

The Client/Server configuration allows the controller to send requests and to read
responses from or to other devices connected on the same Ethernet network.

You can attach Modbus devices and exchange data.

You can add generic Modbus devices, page 81, or custom devices created with
the Modbus custom Editor, page 83 in the same way as for RS-485.

After you added and configured the Modbus nodes, you can add Generic Modbus
Objects Messages, page 81 to define the READ or WRITE functions.

The set of controller objects you can send or receive is made of:
+«  EEPROM Parameters (non-volatile memory parameters)
» Status variables

The configuration page for the Binding object in Modbus TCP is the same as the
CAN Expansion bus. Refer to chapter CAN Expansion bus - Binding, page 69 for
a description and usage of this page.
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GENERAL

Settings Start address: 0 (1...65536)
Polling time: 0 ms (0 = Continuous Read)
Time out: 1000 ms

The only difference from CAN Expansion bus Binding is that here you have one
more column named Timeout, where you can configure the specific time-out in
ms for each object exchanged.

Plugins

Communication Modules Range Overview
The communication modules (plugins) that can be added are displayed in the
Catalog window.
Drag the communication module into the Plugins element.

Example of RS-232 configuration window:
RS232 CONFIGURATION

Mode (O Modbus Slave
@ Modbus Master (for field)

Baud rate O 9600 b/s
O 19200 b/s
@ 38400 b/s
(O 57600 b/s
O 115200 b/s

Serial Mode E,8,1 (Even parity, 8 data bits, 1 stop bit)

Example of Profibus DP configuration window:

PROFIBUS DPV0 CONFIGURATION

GENERAL PB MST TX - INPUT  PB MST RX- OUTPUT  PIDIAG TX - INPUT  PIDIAG RX - OUTPUT

Profibus Station Settings

DP Address (1...126) 1
Identification Nr. 65535
Consistency El
Word Swap ™

Service Mode Enabled [ |

88 EI00000003412.05



Managing Resources Elements

Communication Modules References

Reference Description Terminal type Compatible
controllers
TM171ACAN CAN 2 screw terminal blocks M172P
TM171ALON LonWorks 1 screw terminal block M1720
TM171AMB Modbus SL (RS-485) 2 screw terminal blocks M171P(1)
TM171ARS232 RS-232 serial link, Relay output 1SUB-D 9 @

1 screw terminal block

TM171ARS485 Modbus SL, and BACnet MS/TP 2 screw terminal blocks
TM171AETH Ethernet, Modbus TCP, and BACnet/IP 1 RJ45 M1720
TM171AETHRS485 Ethernet, Modbus TCP, BACnet/IP, Modbus SL, 1 RJ45 M171P()

and BACnet MS/TP
2 screw terminal blocks

TM171APBUS PROFIBUS 1SUB-D9 M171P()

(1) Not applicable to M171P Flush Mounting
(@) Not applicable to TM171AMB

For further information about communication modules, refer to the Modicon
M171A Communication Modules Instruction Sheet EAV96007.
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Technical Reference
What’s in This Chapter

MOADUS ProtOCOI ... ..eeii e et e e e aaaaas 90

Modbus Protocol

Overview

Introduction

The transmission mode used is RTU. The frame does not contain message
header and end of message bytes.

Slave address Request code Data CRC16

The data is transmitted in binary code.
CRC16: cyclic redundancy check.

The end of the frame is detected on a silence greater than or equal to three
characters.

Principle

Only one device can transmit on the line at a time.

The master manages the exchanges and only it can take the initiative.
It interrogates each of the slaves in succession.

No slave can send a message unless it is asked to do so.

The master repeats the question when there is an incorrect exchange, and
declares the interrogated slave unavailable if no response is received within a
given time period.

If a slave does not receive a message, it sends an exception response to the
master. The master may or may not repeat the request.

Direct slave-to-slave communications are not possible.

For slave-to-slave communication, the application software must therefore be
designed to interrogate a slave and send back data received to the other slave.

The 2 types of dialogue are possible between master and slaves:
» The master sends a request to a slave and waits for its response

+ The master sends a request to all slaves without waiting for a response
(broadcasting principle)

Addresses

Address specification:
» The device Modbus address can be configured from 1 to 247.

» Address 0 coded in a request sent by the master is reserved for broadcasting.
Slave devices take account of the request, but do not respond to it.
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Data Types

Description

Function Codes

Description

Information is stored in the Slave device in four different types: two types are on/
off discrete values (coils and contacts) and two are numerical values (registers).

Discrete Input Contacts (read only), 1-bit.

Discrete Output Coils (read/write), 1-bit.

Analog Input Registers (read only), 16-bit.

Analog Output Holding Registers (read/write), 16-bit.

To handle more complex data types (like 32-bit integers or floating point), you
have to use two or more consecutive registers and read or write them together.

The Modbus protocol specifies different “function codes” for each Modbus
message:

01 (01 hex): Read Discrete Output Coils.

05 (05 hex): Write single Discrete Output Coil.

15 (OF hex): Write multiple Discrete Output Coils.

02 (02 hex): Read Discrete Input Contacts.

04 (04 hex): Read Analog Input Registers.

03 (03 hex): Read Analog Output Holding Registers.

06 (06 hex): Write single Analog Output Holding Register.

16 (10 hex): Write multiple Analog Output Holding Registers.
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The Programming Tab

What’s in This Chapter
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TOOIDAIS ... 96

Overview of the Programming Window

Start-up and Test

Before using electrical control and automation equipment for regular operation
after installation, the system should be given a start-up test by qualified personnel
to verify correct operation of the equipment. It is important that arrangements for
such a verification be made and that enough time is allowed to perform complete
and satisfactory testing.

AWARNING

UNINTENDED EQUIPMENT OPERATION
» Verify that the installation and set up procedures have been completed.

» Before operational tests are performed, remove the blocks or other
temporary holding means used for shipment from the component devices.

* Remove tools, meters, and debris from equipment.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

General Description

The Programming work environment has various windows for developing the
controller application (for example programming in IEC 61131-3 compatible
languages), testing, debugging, and controller application downloading to the
target device.

In the Programming, you have two download possibilities:

+ Download only the controller application by clicking L)i On-line > Download
code.

» Download the project (which includes the controller application, the BIOS and

Z

=

PLC parameters, and their value by default) by clicking Download all

icon in the project toolbar.

AWARNING

AUTOMATIC RESTART OF CONTROLLER

» Do not download your application without first accessing the state of your
machine or process.

» Do not download your application without first ascertaining that there is no
risk of injury to anyone in or around your machine or process.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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The windows are listed below:

EcoPtruxure C:\My ProjectiMy Project.plcprj Schoeider[ = 8 X
Machine Expert - HYAC

File Edit View| Project Onfine Debug  Variables Window Tools  Help -0 x

_ Local variables Library tree 2 x
My Project

v Name Type Address Array init vafie Attribute
main
Global_vars © @ Project libraries
Tasks © @ Operators and blocks
© g Target
© g, Application
© gl basic
‘Communication
< i 3 O ik
Watch 2 x Ol display
~ Ol Pumping
fprt := cnt + 1; © @, Regul and Control
Symbol Value
v
< >
“« " > v
Output 8 X Operators and blocks a2 x
Preprocessing Regul anfi Control completed. a ABS ATAN2 EQ
Preprocessing Applicatiqn completed. ACOS CEIL EXP
Preprocessing (I;ump\ng oompleted ADD CONCAT FIND
Preprocessing display cgmpleted. ADR cos FLOOR
- AND COSH GE
0 warnings, 0 errors L ASIN DELETE GT
ATAN DIV IMOVE
MEK i >
Build [Find in project | pebug | Resources HMI Output Operator and standard blocks | Target variables|| Target blocks
Ready EDIT MODE NOT CONNECTED

7 5 8

Item

Description

Toolbars

Many functions available in menus are displayed here in form of icons in toolbars.

These icons help you to create the application. The most used are in Main and Project
toolbars.

For information about how to manage the toolbars, refer to Toolbars, page 35.

Local variables window The global and local variables of the code displayed in the source code editor (programs,

function blocks, and functions) appear here.

For more information about how to use the Local variables window, refer to Variables, page
118.

Project window

This window enables you to:
* Manage the application code.
* Manage and define complex variables defined by you.
* Manage the target device menu.
For information about how to use the Project window, refer to Project Window, page 115.

Source code editor

This window enables you to manage, edit, and use file/print source to write in any of the five
programming languages defined by the IEC 61131-3 standard.

The definition of both global and local variables is supported by specific spreadsheet-like
editors.

For information about how to use the source code editor, refer to Editing the Source Code,
page 144.

Watch window

This window enables you to manage variables debugging by displaying their status in
numerical format when the application is running and connected to the target device.

For more information about how to use the Watch window, refer to Watch Window, page 195.

Library Tree window

The Library Tree window contains a set of different library objects, excepts for two generic
folders which are default for any project. These two folders are Operator and Blocks folder
and Target folder which are colored in green.

Each object is grouped into the folder to which it belongs. These folders are useful to group the
library elements logically.

To display the properties of an object, right-click its name and select Object Properties
command. The Properties Window appears and displays its properties.

For information about how to manage libraries, refer to Working with Libraries, page 110.
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Item Description
7 Output window This tool window shows the messages relating to the development of the project. For more
details, refer to Output window description, page 95.
8 Operators and blocks This tool enables you to manage default function libraries or function libraries created by you.
window

The window is divided into various tabs, one for each library.

The following tabs are always available:
» Operator and standard blocks: operators (AND, OR, and so on).
» Target variables: specific variables of the target device.
« Target blocks: specific functions of the target device.
Additional tabs are managed by using the menu Project > Library manager.

Output Window

This tool window shows the messages relating to the development of the project.

The window is divided into five tabs:

« Build: information related to the file opening, compilation errors, and
downloading code to a device.

* Find in project: result of the Find in project activity.
+ Debug: information about debugging activities (for example breakpoints).
* Resources: messages related to the target device.
« HMI Output: messages related to Display activity.

NOTE: The connection to the target device is also visible in the status bar,
page 34.

Menu Bar

Overview

The menu bar of Programming tab is composed of these menus:
* File, page 27
+ Edit, page 26
* View, page 32
* Project, page 29
* On-line, page 28
* Debug, page 25
» Scheme, page 30
» Variables, page 31
*  Window, page 33
* Tools, page 31
* Help, page 27

NOTE: Programming has a multi-document interface (MDI), so you may find
some disabled commands or even some unavailable menus, depending on
what kind of document is currently active.
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Toolbars

Introduction

The toolbars appear at the top of the EcoStruxure Machine Expert - HVAC window
to provide access to frequently used functions.

The description of commands is displayed in the lower left corner of the main
window when you place the mouse tracker on the command icon.

Main Toolbar

The main toolbar has the following buttons:

Icon Description Shortcut
9 Undo Ctrl+Z
Click once to undo the most recent action in the program editor.
Click the down arrow and select an action from the list to undo all
actions up to and including the selected action.
You can undo up to 10 actions.
e Redo Ctrl+Y
Click once to cancel the most recent Undo action.
Click the down arrow and select an action from the list to redo all
actions up to and including the selected action.
You can redo up to 10 actions.
J% Cut Ctrl+X
|:||—_| Copy Ctrl+C
Paste Ctrl+V
il
P Find Ctrl+F
-},,l:l Find next F3
Find in project Ctrl+Shift+F
Ju
£ Go to symbol Shift+F12
|
E Print Ctrl+P
Print the content of the current editor window.
‘Ej Print preview -
Workspace Ctrl+W
m Output Ctrl+R
Operators and blocks Ctrl+L
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Description Shortcut

Show or hide Library Tree bar

Watch Ctrl+T

Oscilloscope Ctri+K

Cross reference window -

Object Properties window -

Full screen Ctrl+U

o
T
£l
)
o | :
e
£i]
f=

Project Toolbar

The project toolbar has the following buttons:

Icon Description Shortcut

Compile F7

Simulation mode -

1] Connects to the target -

¥
r_)_i Code download F5

Halt -

Cold restart -

Warm restart -

Hot restart -

Reboot target -

Object browser -

FAiNDd & @

Library manager -

-
1]
o

Refresh all libraries -

k-

Object properties -

[zl
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Debug Toolbar

FBD Toolbar

Icon Description Shortcut
mEm Insert record -
L1 L]
mi-
ﬁ Delete record -
The debug toolbar has the following buttons:
Icon Description Shortcut
..EE Live debug mode -
a Add/remove trigger F9
m Add/remove graphic trigger Shift+F9
H Remove all triggers Ctrl+Shift+F9
_'__ Triggers list Ctrl+l
. Add/remove a breakpoint F12
G Remove all breakpoints -
P Run -
# Step -
."'-_:J Breakpoint list -
The FBD toolbar has the following buttons:
Icon Description Shortcut
h_“ Move/Insert -
._|-. Connection -
q Watch -
! New block -
ﬂ Variable -
m_ Constant -
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SFC Toolbar

Icon Description Shortcut

ﬂ Expression -

ﬂ Return -

» | '

I:l Comment -
Increase pins Ctrl++

+4 P

- ! Decrease pins Ctrl+-

EEL,F Add Enable Input/Output pins -

Hix
m FBD properties -
e View source -
The SFC toolbar has the following buttons:

Icon Description Shortcut

New step -

New transition

New jump

Add a step and a transition above the selected step

Add a step and a transition below the selected step

Add pin to divergent position

Remove pin from divergent position

Add pin to convergent position

Remove pin from convergent position

Add pin to simultaneous divergent transition

Remove pin from simultaneous divergent transition

Add pin to simultaneous convergent transition

ELS IS e = i = D= e e [ VR R R

Remove pin from simultaneous convergent transition
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LD Toolbar

Network Toolbar

Icon Description Shortcut
i+ Remove space before rightmost pin -
11
—+ Add space before rightmost pin -
1
. [:] Move a transition up -
Lige
Rh Move a transition down -
4
New action -
% New transition code -
The LD toolbar has the following buttons:
Icon Description Shortcut
T[H:l_ Parallel contact before -
F:“:I_ Parallel contact after Shift+P
Tl' Serie contact before -
_I—I_|- Serie contact after Shift+C
{ } Call Shift+O
|:| Open object (0]
|E| Negated object C
|E| Positive object P
E Negative object N
|E| Reset object R
Set object S
Er Set output line -
_t New branch -

The Network toolbar has the following buttons:
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Description Shortcut

Insert top -

Insert bottom

Insert after -

Insert before -

View grid

|00 |00 W | (¢

Auto connect -

™
i
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Project Options

What’s in This Chapter
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Project Options

General Information

You can edit significant project options choosing Project > Options....

General Tab

Overview

General tab of the Project options window:

Project options X

| Build events || Cross Reference || Run-time checks || Advanced |

| General | Code generation || Build output || Download || Debug |
Project info
Project: (max 10 chars)
Version: (example: 1.0)
Author:
Note:

Legacy options
[¥] Use legacy LD editor
[#] Use customizable workspace

Main features

You can set general project information:
* Project name
* Project version
» Project author name
* Project note
In addition, you can set compatibility options:

+ Use legacy LD editor: the new Ladder Diagram editor is easier to use, by
helping you in common operations working on the diagram is faster and more
efficient. By default, this option is active. For more information, refer to Ladder
Diagram (LD) Editor, page 151.

+ Use customizable workspace: allows you to manage your project tree in
order to reach a more efficient workspace. By default, this option is active. For
more information, refer to Project Custom Workspace, page 140.

In addition, you can set compatibility options:
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Use legacy LD editor: the new Ladder Diagram editor is easier to use, by

helping user in common operations working

on the diagram is faster and

more efficient. By default, this option is active. For more information, refer to

Ladder Diagram (LD) Editor, page 151.

Use customizable workspace: allows user to manage the project tree in
order to reach a more efficient workspace. By default, this option is active. For
more information, refer to Project Custom Workspace, page 140.

Multiple files project: allows user to save project in *.xplc format.

Custom sort of project folders: enables Move up and Move down

commands in the context menu of the folder,

Code Generation Tab

Overview

in the project tree.

Code generation tab of the Project options window:

Project options X

Build events Cross Reference Run-time checks

Advanced

General || Code generation || Build output || Download Debug

Case sensitivity (IEC default=no)

Check functions and function blocks external variables
VAR_IN_OUT by reference (IEC standard=yes)

Allow only integer indexes for arrays

Strict pointers check

Strict enumerations check

Enable SFC control flags (extension to IEC standard)
Init to zero of functions internal variables

Data copy size warning threshold (bytes, O=disable)
Enable preprocessor directives (extension to IEC standard)
Enable Verbose warning mode

Disable warning emission

Disabled warning codes:

[ OK ] [ Cancel ] Apply

O

oonoW

O

° g

20

I B Booo

You can edit some properties about code generation:

Case sensitivity: you can set the project as
option.

case-sensitive checking this

NOTE: By default, this option is not active.

Check function and function block external variables: if this option is
disabled, all functions and function blocks can access to global variables

without declaring them as external variables

NOTE: By default, this option is enabled
standard.

respecting the IEC 61131-3
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VAR_IN_OUT by reference: if this option is checked the variables declared
as VAR_IN_OUT of a function block will be treated as reference variables,
accordingly to IEC standards.

Allow only integer indexes for arrays: if this option is checked you cannot
use BYTE, WORD or DWORD as array indexes.

Strict pointers check: if this option is checked, it is not possible to mix
different pointer types and integer values.

Strict enumerations check: if this option is checked, it is not possible to mix
enumerative variables and integer types.

Enable WAITING statement (extension to standard): if this option is
checked the WAITING construct for the ST language is added as IEC 61131-
3 extension. For more information, refer to Waiting Statement, page 301.

Enable SFC control flags (extension to standard): if this option is checked,
HOLD and RESET flags for SFC POU are enabled.

Init to zero of function internal variables: if this option is checked, the initial
value of the internal variables of the functions will be set to zero as default.

Data copy size warning threshold (bytes, 0=disable): when arrays or
structures are copied, if their dimensions exceed the specified threshold, a
message is emitted in order to inform the possible loss of performance of the
PLC. If the threshold is set to 0, no messages are emitted.

Enable preprocessor directives (extension to IEC standard): if this option
is checked, IFDEF feature is enabled (user can allow build of portion of code
verifying if a certain symbol has been defined).

Enable verbose warning mode: if this option is checked, several minor
warning, related to operation between signed and unsigned variables, are
emitted (for example, a>=b, where a is INT and b is UINT, will raise a warning
if this option is enabled); if this option is disabled those warnings are not
emitted.

Disable warning emission: if this option is checked message emissions are
not displayed on the output window.

Disable warning codes: if this option is checked some specified message
emissions are not displayed on the output window.
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Build Output Tab

Overview

Build output tab of the Project options window:

Build events Cross Reference Run-time checks Advanced
General | Code generation Build output || Download Debug

Downloadable target files

Create downloadable target files ]

PLC application:
Source code:

Debug

Listings, reports etc:

Generate code listing file (.Ist)

Generate mapped variables export file (.exp)
Generate unused elements report (.unu .xml)

KUK

[ OK ][ Cancel ]

Here you can edit some significant properties of the output files generated by
compiling operation.

Downloadable target files section:

+ Create downloadable target files: if this option is checked the compiler
generates the binary files that can be downloaded to the target. You can
specify custom filenames or use the default names.

Only valid Windows filename are accepted.

+ PLC application (active only if Create downloadable target files is
checked): this field specifies the name of the PLC application binary file. The
default name is projectname.bin.

« Source code (active only if Create downloadable target files is checked):
this field specifies the name of the Source code binary file. The default name
is projectname._source.bin.

» Debug (active only if Create downloadable target files is checked): this
field specifies the name of the Debug symbol binary file. The default name is
projectname._debug.bin

Listing, reports etc section:

* Generate code listing file (.Ist): if this option is checked the compiler
generates a listing file named as projectname.lst.

* Generate mapped variables export file (.exp): if this option is checked the
compiler generates an EXP file named as projectname.exp.

* Generate unused elements report (.unu .xml): if this option is checked the
compiler generates two reports of unused elements named as projectname.
unu and projectname.xml.
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Debug Tab

Overview

Debug tab of the Project options window:

Build events Cross Reference Run-time checks Advanced
General | Code generation | | Build output || Download Debug

Polling period for debug functions (ms) 20

Number of displayed array elements 0
without alert message

Polling period between more variables (ms) 20
Autosave watch list

Enable memory dump (%MW-<address> syntax)

Watch internal variables of function blocks

Automatically dereference pointers and references in watch

Print debug informations

Here user can edit some significant properties of the debug behavior:

» Polling period for debug function (ms): set the active sampling period of
the debug status.

* Number of displayed array elements without alert message: specifies the
maximum number of array elements to be added in the watch window without
being alerted.

» Polling period between more variables (ms): set the delay between
sampling of variables.

« Autosave watch list: if checked the watch list status is saved into a file when
the project is closed.

+ Enable memory dump: enables the memory dump function for advanced
debugging.

» Watch internal variables of function blocks: allows user to view internal
variables of “VAR” class.

+ Automatically dereference pointers and references in watch: if this option
is checked, when adding the pointer variable in the watch window, the pointed
value will be directly shown; if it is disabled, the watch window will show the
content of the pointer which need to be expanded to see the pointed value.

» Print debug informations: when compiling, additional information are shown
in the output window.
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Build Events Tab

Overview

Build events tab of the Project options window:

Project options X

General || Code generation || Build output || Download Debug
Build events Cross Reference Run-time checks Advanced

Environment variables
PRJTITLE PRJPATH PRIBASENAME IMGNAME APPLPATH
TARGETDEFNAME FIRMWAREFILENAME PRJRELEASE
PRJVERSION PRJAUTHOR PRJCONN SIMUL

Post-build commands:
Pre-download commands:

Post-download commands:

[ OK ][ Cancel ] Apply

Here you can specify commands that run before the build starts or after the build
finishes. You can also use a set of defined environment variables listed on the top
of the window.

The environment variables are:
*  PRJTITLE: project name.
*  PRJPATH: project folder.
* PRJBASENAME: project full path without extension.
*  PRJFULLNAME: project full path.
+ IMGNAME: .imgx image file name.
« TARGETDEFNAME: project target name.
* PRJRELEASE: project name as defined in General tab of Project options.
*  PRJVERSION: project version as defined in General tab of Project options.
* PRJAUTHOR: project author as defined in General tab of Project options.
*  PRJCONN: current communication settings.
« APPLPATH: full application path.
+ SIMUL: if simulation mode 1, else 0.
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Cross Reference Tab

Overview

Cross Reference tab of the Project options window:

Project options X

| General || Code generation | | Build output || Download || Debug |
| Build events || Cross Reference || Run-time checks || Advanced |

Generate cross-reference [V/]

Options

Trace Global Vars M  TracelocalVars  []
Trace Programs Trace Functions ]
Trace Function Blocks Trace Tasks O
Trace Macros O Trace Structs O
Trace Enums O Trace Subrs O
Trace TypeDefs ]

Trace in Programs M  Tracein Functions [ ]
Trace in Functions Blocks [&/]

[ OK ] [ Cancel ] [ Apply ] [ ? ]

Here you can activate the Generate cross-reference function and set the related
options.

The cross-reference trace options can be set for:

* Global Vars: Global variables

* Local Vars: Local variables

* Programs: Programs

* Functions: Functions

* Function Blocks: Function blocks

+ Tasks: Tasks

* Macros: Macros

» Structs: Structures

*  Enums: Enumerations

* Subrs: Subranges

+ TypeDefs: Typedefs, used to create an alias name for another data type.
The cross-reference trace options can be set in:

* Programs

* Functions

* Function Blocks
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Run-time Checks Tab

Overview

Run-time Checks tab of the Project options window:

Project options X

General || Code generation || Build output || Download Debug
Build events Cross Reference Run-time checks Advanced

Run-time check of array bounds []
Run-time check of pointers :El
Run-time check of division by zero []
Run-time check of references []

o ) o)

These options allow the user to enable specific controls made at execution time.

The run-time check options can be set for:

* Run-time check of array bounds: if this option is checked some check code
is added to verify that array indexes are not out of bounds during run-time.
This option can be set depending on target device.

* Run-time check of pointers: this combo allows you to choose if and when
the pointer will be tested for their validity before their use.

o Selecting NONE, the check will never be done.

o Selecting ONLY IF NOT NULL, the check will verify that the pointer value
is not NULL; if it is NULL, it will return value zero but will not stop the
running application. So the PLC execution will never be interrupted due to
a NULL pointer, but you'll never get an error notification.

o Selecting FULL, the check will verify that the pointer value is not NULL and
that the pointed address is within a validity range (this last control requires
the user-defined function checkptr on target; if it is not defined, only the
first control is executed). If one of this two controls fail, the PLC execution
is interrupted and an error message is raised.

* Run-time check of division by zero: if this option is checked some check
code is added to verify that divisions by zero are not performed on arrays
during run-time. This option can be set depending on target device.

* Run-time check of interfaces: if this option is checked, allows a references
validity check within a method call. This option can be set depending on
target device (Object Oriented supported)

* Run-time check of references: if this option is checked, allows a references
validity check; if a reference is dereferenced to null, a runtime error is
generated.
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Advanced Tab

Overview

Advanced tab of the Project options window:

Project options X

General | Code generation | | Build output || Download Debug
Build events Cross Reference Run-time checks Advanced

LD: evaluate edges on each network D

External access to local vars of function blocks D

[ OK ] [ Cancel ] Apply

These options allow the user to specify specific behaviors, suggested only for
expert users.

+ LD evaluate edges on each network: this option allows the user to change
edges evaluation timing (high/low). If it is NOT checked, the edges of an LD2
program are evaluated only once, at the beginning of the program execution.
If it is checked, the edges of an LD2 program are evaluated at the beginning
of every LD network.

+ External access to local vars of function blocks: if this option is NOT
checked, the local variables of a function block, are considered private and
accessible only inside the function block. (standard IEC behavior). If this
option is checked, the local variables of a function block are considered as IN/
OUT variables; so they are visible and accessible also from the caller of the
function block instance.

Working with Libraries

General Information

Library Manager

Overview

Libraries are a powerful tool for sharing objects between the projects. Libraries are
stored in dedicated source file, whose extension is .pll.

The library manager lists the libraries currently included in the project. It also
allows you to include or remove libraries.

To access the library manager, click Project > Library manager.
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m 9 Project library list X
Name Link Add
Application C:\program files (x86)\schneider electric\ecostr...
Basic C:\program files (x86)\schneider electric\ecostr...
Communication C:\program files (x86)\schneider electric\ecostr...

Pumping C:\program files (x86)\schneider electric\ecostr...
Regul and Control C:\program files (x86)\schneider electric\ecostr...

Including a Library

The following procedure presents how to include a library in a project, which
results in the library’s objects becoming available to the current project.

Including a library means that a reference to the library’s .pll file is added to the
current project, and that a local copy of the library is made. You cannot edit the
elements of an included library, unlike imported objects.

To copy or move a project which includes one or more libraries, make sure that
references to those libraries are still valid in the new location:

Step Action

1 Click Project > Library manager, which opens the Library manager dialog box.

2 Click the Add button, which causes an explorer dialog box to appear, to let you select
the .pll file of the library you want to open.

3 When you have found the .pll file, open it either by double-clicking it or by clicking the
Open button. The name of the library and its absolute pathname are now displayed in a
new row at the bottom of the list.

4 Repeat step 1, 2, and 3 for the libraries you wish to include.

5 When you have finished including libraries, click the Close button.

Removing a Library

Removing a library does not delete the library itself, but removes the reference to
it in the project.

The following procedure presents how to remove an included library from the
current project:

Step Action

1 Click Project > Library manager menu of the Programming main window, which
opens the Library manager dialog box.

2 Select the library you wish to remove by clicking its name once. The Remove button is
now enabled.
3 Click the Remove button, which causes the reference to the selected library to be

deleted from the Project library list.

4 Repeat for the libraries you wish to remove. Alternatively, if you want to remove the
libraries, you can click the Remove all button.

5 When you have finished removing libraries, click the Close button.
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Exporting to a Library

Overview

You may export an object from the currently open project to a library in order to
make that object available to other projects.

The following procedure presents how to export objects to a library:

Step

Action

1

Select the object you want to export in the tree structure of the project tab.

2

Click Project > Export object to library.
You can also right-click the object and select Export object to library command.

A dialog box appears:

Export PLC objects to library X

File name E]

Code encryption | |
Version 1.0.0

Description

4 »

[ OK ] [ Cancel ]

Enter the destination library by specifying the location of its .pll file. You can do this by:
*  Typing the full pathname in the text box.

NOTE: If you enter the name of a non-existing .pll file, EcoStruxure Machine
Expert - HVAC creates a new library.

*  Clicking the """ Browse button in order to open an explorer dialog box which
allows to browse your disk and the network.

You may optionally choose to encrypt the source code of the POU you are exporting in
order to protect your intellectual property.

You can also modify the version number and add a description.

Click OK to confirm the operation, otherwise, click Cancel to quit.

Importing from a Library or Another Source

Overview

You can import an object from a library in order to use it in the current project.
When you import an object from a library, the local copy of the object loses its
reference to the original library and it belongs exclusively to the current project.
You can edit imported objects, unlike objects of included libraries.

Import Example

The following procedure presents how to import objects from a library:
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Step Action

1 Click Project > Import objects. This causes an explorer dialog box to appear, which
lets you select the .pll file of the library you want to open.

)

Objects filter
™M Programs
™ Functions

M Variables
M User types

] Function Blocks

( Checkall

] [ Check none ]

Other filters

A dialog box of the library explorer appears:

Object browser

Name

§F AHUPlanModeStrategy
 AHUTempCntriStrategy
& CompAlarmMgmt

¥ CompAppLimit

£ CompCntrl_OnOff

& CompCntrl_Slider

& CompCntrl_VS

& CompMgmt

£F CompMgmtVs

£ COPCalculation

2 When you have found the .pll or .plclib file, open it either by double-clicking it or by
clicking the Open button.

Type

Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks

g Counter2Energy Function blocks

Name 1 OK T Doublelnterpo_5x8 Function blocks

Location g EcFanMgmt Function blocks
: ¥ EnergyTrend Function blocks

Library T FanMgmt Function blocks

Vars type All v

Vars group

Close Import objects

[ Select all ] [Selectnone]

3 Select the objects you want to import. You can also make simple queries on the objects
by using Filters. However, only the Name filter currently applies to libraries. To use it,
enter the name of the desired objects, even using the * wildcard, if necessary.

4 Select the objects you want to import then click the Import objects button.

5 When you have finished importing objects, click indifferently OK or Cancel to close the

browser.

Undoing Import from a Library

Merge Function

When you import an object in a project, you currently make a local copy of that
object. You need to delete the local object in order to undo import.

When you import objects in a project or insert a copied mapped variable, you may
encounter an overlapping address or duplicate naming error.

You can choose the behavior that EcoStruxure Machine Expert - HVAC should
keep when encountering those problems by setting the corresponding
environment options, page 39.

The possible actions are:

Behavior Ask Automatic Take from library | Do nothing
Naming If different types v v - v
behavior

If same type but v v v -

not variables

If both variables v v v -
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mapped variable

Behavior Ask Automatic Take from library | Do nothing
Address If address v v v -
behavior | overlaps

Copy/paste - v - v

Ask (default): User has to decide every time an action is required

Automatic: A valid name or address is automatically generated by EcoStruxure Machine Expert -
HVAC and assigned to the imported object.

Take from library: The name or the address is taken from the imported object.

Do nothing: The name or the address of the objects in the project are not modified.

After importing objects, EcoStruxure Machine Expert - HVAC generates a log file

in the project folder with detailed info.

Updating Existing Libraries

Overview

If you edit a linked library file, you can refresh its content on the project without
closing EcoStruxure Machine Expert - HVAC:

Step

Action

1

Click Project > Refresh all libraries.

2

If the file is correct, EcoStruxure Machine Expert - HVAC updates the linked library
content and displays a successful message in the output window, otherwise no

modifications are made on the existing linked library.
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Managing Project Elements

What’s in This Chapter

ProjeCt WINAOW ... e e e e ees 115
Program Organization UNits ..o, 116
ValADIES ... e 118
L2 32 PP 126
Derived Data TYPES .. .ccuviieieeiii e 128
Browse the Project ..o 134
Project Custom WOrKSPACE .........coivuuiiieiiiiii et 140

Project Window

Overview

This chapter explains how to manage with the elements which compose a project,
namely: Program Organization Units (POUs), tasks, derived data types, and

variables.

The Project window allows you to:

+ Manage the application code.

+ Manage and define complex variables that you define.

* Manage the tasks.

Content of the Project Window

The default Project window consists of the following items:

Item

Icon

Description

Project

Name of the project.

main, page 116

Initial program.

Var1, page 123

Local variable.

Ungrouped_vars,
page 119

O

Group of global variables.

Aux Variables

The shared global resources appear in the Project window
but are defined in the Resources window.

EEPROM Parameters, Status variables, and I/O Mapping
appear here (as they are auto-generated).

Tasks, page 126

Creates tasks.

NOTE: The Project window content depends on the selected device.
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Program Organization Units

Overview

Description

A POU is a Program Organization Unit of type Program, Function, or Function

block.

This section presents how to add, edit, and remove POUs in the project.

Creating a Program

Description

To create a program:

Step Action
1 Select the target in the Project Window tree view.
Click Project > New Object > New program.
2
A dialog box is displayed:
Language
Ol QOFBD QLD @sST QOSsFc
Name
Task
Assignto | - v
[ OK ] [ Cancel ]
Select the specific language.
3 Enter its name.
4 Optionally, select a task in the list to associate the program to the selected task.
- - con L
NOTE: If you do not select a task at this step, an alert icon === appears below the
program icon to indicate that the program is not yet associated to a task.
Refer to Associating a Program to a Task, page 126 to assign the program to the
desired task.
5 Click the OK button to confirm.

Alternatively, you can create a new POU from the context menu by selecting a
folder or the root element of the project. For more information, refer to Custom
Workspace Operations, page 142.

Creating a Function Block/Function

Description

To create a Function Block/Function:
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Step Action

1 Select the target in the Project Window tree view.
For Function Block, click Project > New Object > New function.

For Function, click Project > New Object > New function block.

A dialog box is displayed:

Language

Ol OFBD OLD @ST OSsFC

Name

[ OK ] [ Cancel ]

Select the specific language.

NOTE: Creating functions is available in four programming languages. SFC language
is not supported for functions.

3 Enter its name.

4 Click the OK button to confirm.

A function or function block is a (sub)program with inputs and outputs:

» A function requires n inputs and a single output (RESULT) with the same
name as the function. The local memory of the function is initialized each time
the function is called.

The function is used within the program by passing the input variables.

» A function block requires n inputs and m outputs. The local memory of each
instance of the function block is kept between one call and the next (static
memory).

The function block is used within the program as an instance in the same way
as the declaration of a variable.

Each function or function block can be used within a program by dragging and
dropping the icon into the editor window of the program.

Editing POUs

Overview

To edit a POU, open it by double-clicking it from the project tree. The relative
editor opens and lets you modify the source code of the POU.

Changing the Name of the POU

Select a POU from the project tree, then right-click and select Rename program,
Rename function block, or Rename function depending on the POU.

Duplicating a POU

Select a POU from the project tree, then click Project > Duplicate object.

Enter the name of the new duplicated POU and confirm the operation.
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Deleting POUs

Select a POU from the project tree, then click Project > Delete Object.

Confirm the operation to delete the POU.

Source Code Encryption/Decryption

Overview

Encrypting a POU

Decrypting a POU

Encrypting all POUs

Decrypt all POUs

Variables

Overview

Programming can encrypt POUs and require a password to decrypt them, hiding
the source code of the POU.

Select a POU from the project tree, right-click, then select Crypt in the context
menu

Double enter the password and confirm the operation.

Programming displays in the project tree a special marker icon that overlays the
standard POU icon in order to inform you that the POU is encrypted.

Select a POU from the project tree, right-click, then select Decrypt in the context
menu

Select the target from the project tree, right-click, then select Crypt all objects in
the context menu.

All POUs are encrypted with the same password.

Select the target from the project tree, right-click, then select Decrypt all objects
in the context menu.

There are two classes of variables in Programming: global variables and local
variables.

This section presents how to add to the project, edit, and remove both global and
local variables.
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Global Variables

Description

Global variables can be seen and referenced by any POU of the project.

Classes of Global Variables

Global variables are organized in special folders of the project tree called Global
variables group.

Those variables are classified according to their properties as:

Automatics: the compiler automatically allocates them to an appropriate
location in the target device memory.

Mapped: they have an assigned address in the target device logical
addressing system, which you specify.

Constants: are declared having the CONSTANT attribute; their values cannot
be altered by the programming logic.

Retains: they are declared having the RETAIN attribute; their values are
stored in a persistent, non-volatile memory area of the target device.

Creating a New Global Variable

Creating a New Global Variable

Step Action
1 In order to create a new global variable, you need to define at least one Global
variables group in your project. Afterward select it from the project tree then choose
the appropriate item of the menu Project > New Object > New variable. Refer to
Custom Workspace Operations, page 142.
Programming presents a dialog box:
Name Type
Group Ungrouped_vars v Array No
Attribute Auto Init values
Description
[ OK ] [ Cancel ]
2 Enter the name of the variable. The variable name must be a valid IEC 61131-3

identifier.

Valid variable names can consist of any combination of letters, numbers, and
underscores, though they cannot begin with a number.
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Step Action
3
Specify the type of the variable either by typing it or by selecting it from the list that
Programming displays when you click the *——-" Browse button:
Object browser
Objects filter
Name Type Description -
BOOL Basic types
[ Function Blocks [b] BYTE Basic types =
DINT Basic types
@4 DWORD Basic types
. 52 eCompTyp User Types Kind of values
B User types 8 Basic types i’g ePrtyMode User Types Priority Mode Enumeration
[ Check all ] [ Check none ] &? eStage User Types Define of the Staging Methode
&° eType User Types
[ INT Basic types
Other filters [5 MBMNODESTATUS  User Types
[] REAL Basic types
Name * OK SINT Basic types
y [E5 stAlIrmCtrl User Types Alarm Control Structure
Location Al M [ stAna User Types Real Value + Status
Library Al v [F5 stAuxPumpAIrm User Types Auxiliary Pump Alarm Status
[ stAuxPumpCom User Types Command Status
Vars type - (=5 stAuxPumpCtrilnit User Types Structure of Auxiliary Pump Initialisa...
Vars group v [F5 stAuxPumpCtriSta User Types Auxiliary Pump Control Status
stAvai User Types Available status
[+ stCavtAlrm User Types -
4
. B . . . -1
If you want to declare an array, you must specify its size by clicking the ———' Browse
button next to the Array field:
Size of variable X
(O Scalar
@ Array / Matrix
Dimensions | 2,3,3
[ OK ] [ Cancel ]
Enter the length of the array. Use comma to separate the length of each dimension (up
to 3).
For example: 2 or 2,3 or 2,3,3.
NOTE: A dimension should be greater than 1. For example, entering 2,1 or 1,2 is
equivalent to entering 2.
5
You may optionally assign the initial value to the variable or to the single elements of
. . 4 0e - .
the array by clicking the “——— Browse button next to the Init values field:
A i .
2] Init values for: () X
[0,1,2,1]
[ OK ] [ Cancel ]
NOTE: Initial values must be separated by a comma.
6 Click the OK button to validate.

Creating a New Global Mapped Variable:
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Step Action
1 To create a newly global mapped variable, you need to define at least one Global
variables group in your project. Afterward select it from the project tree then choose
the menu Project > New Object > New variable > Mapped Variable.
Programming presents a dialog box:
Mapped variable declaration X
Name Data type UNDEF
Group Ungrouped_vars v Size No
Data block Subindex
Location | |/O data block Base addr. Size Unused |*
Backlight Status. 0 = Off. 1... ~ %QB3.0 1 1 =
Expansion Digital Inputs %I1X10.0 96 96
Expansion Digital Outputs %QX11.0 84 84
Local ADC values %IW2.0 12 12
Local ADC values adjusted %IW20.0 12 12
Local Analog Inputs %IW1.0 12 12 -
« i ’
Description
[ OK ] [ Cancel ]
2 Enter the name of the variable. The variable name must be a valid IEC 61131-3
identifier.
Valid variable names can consist of any combination of letters, numbers, and
underscores, though they cannot begin with a number.
3
Specify the type of the variable either by typing it or by selecting it from the list that
. . . T
Programming displays when you click the “——-' Browse button:
Object browser
Objects filter
Name Type Description -
BOOL Basic types
[ Function Blocks [b] BYTE Basic types =
DINT Basic types
[dy DWORD Basic types
. 59 eC T User T Kind of val
B User types M Basic types 2’3 ZPz;"l;ogz Ui:: ngzz P‘r?ori?y \ﬁozstnumeraiion
[ Check all ] [ Check none ] @? eStage User Types Define of the Staging Methode
@? eType User Types
[ INT Basic types
Other filters [/ MBMNODESTATUS  User Types
[r] REAL Basic types
Name * OK SINT Basic types
B || B LT e
Library All v [5) stAuxPumpAlrm User Types Augxiliary Pump Alarm Status
[F5 stAuxPumpCom User Types Command Status
Vars type - [F5 stAuxPumpCtrlinit User Types Structure of Auxiliary Pump Initialisa...
Vars group v [ stAuxPumpCtriSta User Types Auxiliary Pump Control Status
[F5) stAvai User Types Available status
[ stCavtAIrm User Types ~
o
4 You can select the group in the Group list.
5 You are required to specify the address of the variable by doing one of the following

operations:
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Step Action

+  Click the Data block ' browser button to open the editor of the address;
then enter the desired value:

Variable address X

Automatic address

Size Location
@ Bit Olnput

O Byte (8 bit) QO Output
O Word (16 bit) @ Memory

(O Double word (32 bit)

Data block  Index

Click OK.

*  Select, from the Location list, the memory area you want to use: the tool
automatically calculates the address of the first free memory location of that area.

Depending on the selected location, you can specify its size by clicking the
Browse button next to the Size field:

Size of variable X

O Scalar
@ Array / Matrix

Dimensions | 2,3,3

[ OK ] [Cancel]

Enter the length of the array. Use comma to separate the length of each dimension (up
to 3).
For example: 2 or 2,3 or 2,3,3.

NOTE: A dimension should be greater than 1. For example, entering 2,1 or 1,2 is
equivalent to entering 2.

7 You can enter the subindex value.

8 Click the OK button to validate.

Editing a Global Variable

To edit the definition of an existing global variable, open it by double-clicking it, or
the folder that it belongs to, from the project tree. The global variables editor
opens and lets you modify its definition.
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f £ x
B -] HMI samples
Function blocks
---- =P Elevator
gp Loops Name Type | Address | HH
B ©6 Elevator vars 1 |hmiTargetPosition DINT | %MB1.58
) - — P
~[T] hmiAcceleration 2 hmiActualPosition DINT | %MD1.62
p— . )
ST hmiActualPosition 3 |hmiHighSpeed REAL | %MB1.66 |
3 i 1 0
[T ] hmiActualSpeed 4 hmiAcceleration REAL | %MD1.70 as
" H H 0,
[T ] hmiDeceleration 5 |hmiDeceleration REAL | %MD1.74
~[% ] hmiElevatorOn
-[ %] hmiElevatorStanding
L r] hmiSpeed

Changing the name of the variable:

Select the variable you want to rename from the project tree then right-click its
name and select Rename variable command. You can also double-click the
variable name and modify its name in the editor window. The new name must be
updated in all locations where the renamed variable is used.

Duplicating a variable:

Select the variable you want to duplicate from the project tree then right-click its
name and select Duplicate variable command.

Enter the name of the new duplicated variable and confirm.

Deleting a Global Variable

Local Variables

Select the variable you want to delete from the project tree then right-click its
name and select Delete variable command.

Confirm the operation to delete the variable.

Description
Local variables are declared within a POU (either program, function, or function
block), the POU itself being the only project element which can refer to and access
them.
Local variables are listed in the project tree under the POU which declares them
(only when that POU is open for editing). The local variables are further classified
according to their class (for example, as input or output variables):
a Function blocks
B =11, LinearProfileGen
a Input variables
r | nomDec
s | stop
di | targPos
B  H Local variables
di | actTargPos
Y | decel
di | decSpace
a Output variables
r | actAcc
r | actSpeed
| b | enableOut
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In order to create, edit, and delete local variables, you have to open the POU for
editing and use the local variables editor. The project needs to be saved in order
to update the POU branch structure of the project tree, including the modifications
applied to the local variables.

For more information, refer to Opening a Local Variables Editor, page 168.

Creating Local Variables

Click Variables > Insert command or click the Insert record ﬁ icon in the
Project toolbar. You can also create multiple variables, page 125.

The variable appears in yellow in the Local variables window, and you can define
its characteristics by clicking the respective boxes.

Created variables can be displayed in table format by selecting the icon on the
upper right corner of the window:

Local variables

Name Type Address Array Init value Attribute %
1 VAR1_OUT INT Auto No
2 |VAR2_OUT INT Auto No B
3 VAR3_OUT INT Auto No
4 VAR4_OUT INT Auto No |
5 VAR5_OUT INT Auto No
6 VAR6_OUT INT Auto No
7 VAR7_OUT INT Auto No
8 VAR8_OUT INT Auto No
9 VAR9_OUT INT Auto No
10 VAR10_OUT INT Auto No
4 »

The characteristics of the local variables of a program are:
» Name: to choose the name of the variable.
+ Type: to choose from one of the preset options or variables defined by you.
» Address: the default setting is Auto.

+ Array: defines whether the variable is array type (if so, define its dimension)
or not.

+ Init value: initial value. It is the value of the variable after each power cycle.

» Attribute: to set the variable as CONSTANT (variable cannot be overwritten)
or RETAIN.

» Description: to write a description for the variable.

NOTE: Local variable table has different formats for program and function
blocks.
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Created variables can be displayed also in code format by selecting the second
icon on the upper right corner of the window:

Local variables

0001
0002
0003
0004
0005
0006
0007
0008
0009
0010
0011
0012
0013
0014
0015
0016

The local variables appear in the Project window, below the program folder,

PROGRAM main - HH
VAR
VARL OUT : INT; )
VAR2_OUT : INT; El
VAR3_OUT : INT;
VAR4_OUT : INT;
VAR5_OUT : INT;
VAR6_OUT : INT;
VAR7_OUT : INT;
VARS8 OUT : INT;
VAR9 OUT : INT;
VAR1O OUT : INT;
END_VAR
v

identified by an icon.

NOTE: The local variables are reinitialized each time the POU is executed.

Creating Multiple Variables

Description

Programming allows you to create multiple variables simultaneously.

Creating Multiple Variables:

Step Action
1 Open the POU for editing.
2 Select Variables > Create multiple.
A dialog box appears:
Name
Prefix: VAR
Suffix: _ouT
Type
Type: INT
Attribute
Attribute: | .- v
Counter
From: 1 To: | 10 Step: | 1
Example: VAR1_OUT VAR2_OUT VAR3_OUT VAR4_OUT
[ OK ] [ Cancel ]
3 Specify the prefix and the suffix of the new variables names.
4 Specify the type of the variables either by typing it or by selecting it from the list that is

displayed when you click the """ Browse button.
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Step Action

5 If needed, select the Attribute in the list.

6 Insert the number of the variables you want to create specifying the start index, the end
index, and the step value.

You can see an example of the generated variable names at the bottom of the dialog.

Tasks

Associating a Program to a Task

Overview

For a program to run, it must be associated to a task.

The following types of task are available:
+ Boot task is executed only once at PLC start up.

+ Init task executed at each download of the application and on starting up the
system (after Boot).

NOTE: The associated program initializes slaves and messages
according to the configuration, with fixed values that are independent of
the run time.

AWARNING

AUTOMATIC RESTART OF CONTROLLER

» Do not download your application without first accessing the state of
your machine or process.

» Do not download your application without first ascertaining that there is
no risk of injury to anyone in or around your machine or process.

Failure to follow these instructions can result in death, serious injury,
or equipment damage.

» Timed task runs at regular intervals which you can set. The default setting
depends on target type.

NOTE: Modbus messages do not interfere with this task.

» Background task runs with low priority after the execution of the Timed
tasks.

* Modbus task executed to implement Modbus Master, calling relative function
blocks, and to send messages (Only for M1710).

Associating a Program to a Task Type

Each new project has the main program associated to the Background task. The
main program can be removed and/or associated to other tasks.

To associate a program to a task:
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Step Action

1 Right-click on the task where you want to add the program from the project tree then
choose the Add program command.

2 Select the program you want to be executed by the task from the list which shows up
and confirm your choice.

3

The program has been assigned to the task:

B [ Tasks

a Timed
°@ Elevator
Background

Boot
Init

v

VDY

Managing a Program into a Task

You can assign more than one program to a task.

Programs are executed sequentially, as they are assigned and visible in the tree.

When you right-click a program associated to a task, three actions are available:

Remove program (Delete)
Move up (Ctrl+Shift+Up)
Move down (Ctrl+Shift+Down)

Move up and Move down allow you to change the execution order of the program
within the same task:

80

Task Configuration

Description

Tasks

~»
v

P
v
P
v
P
v

Timed
'@ Elevator
‘A
Backgro

Boot
Init

Remove program Delete

Move up Ctrl+Shift+UP
Move down Ctrl+Shift+Down

Depending on the target device, it is possible to modify settings of the controller
tasks.

Task Configuration

To configure a task:

Step Action
1 Right-click on the tasks element from the project tree.
2 Select Task configuration in the contextual menu.
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Step Action
Result: The Tasks configuration window is displayed:

2] Tasks configuration X
ID Name Type | Set period | Period (ms) Description
0 |Timed Cyclic | No 100 Timed task - execution time can be configured between 20 and 100 ms
1 |Background |Cyclic Background task - executes continuously at low priority
2 |Boot Single Boot task - executes once at system startup
3 |Init Single Init task - executes once at every PLC full restart

3 Select Yes in Set period list.

4 Enter a new value of period of the task.

5 Click Ok to validate

NOTE: For all other targets than M172, the duration of timed task can be set
on Configuration, clicking the target name on the tree. There is a checkbox
Set execution time in the main window.

Derived Data Types

Overview

Description

The Definitions section of the Workspace window lets you define derived data
types.

The derived data type is a complex classification that identifies one or various data
types and is composed of primitive data types.

You have the flexibility to create those specific types that have advanced
properties and uses in addition to the primitive data types.

Programming can manage:
+ Typedefs, page 128
» Structures, page 130
* Enumeration, page 132
* Subranges, page 133

Typedefs

Description

The following paragraphs present how to manage TypeDef.

For more information about TypeDefs, refer to TypeDefs description, page 250.

Creating a New Typedef

To create a new TypeDef:
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Step Action
1 New TypeDef can be added in the Project window tree:
* Right-click on the name of the project.
* Click Add > New Definition > TypeDef.
A dialog box is displayed:
& New Typedef X
Name
Type (] it value )
Array No [B Title
Description -
< »
[ OK ] [ Cancel ]
2 Enter the name of the TypeDef. The TypeDef name must be a valid IEC 61131-3
identifier.
Valid names can consist of any combination of letters, numbers, and underscores,
though they cannot begin with a number.
3 Specify the type of the TypeDef either by typing it or by selecting it from the list that is
displayed when you click the """ Browse button.
4
If you want to declare an array, you must specify its size by clicking the "' Browse
button next to the Array field:
Size of variable X
O Scalar
@ Array / Matrix
Dimensions @ 2,3,3
[ OK ] [ Cancel ]
Enter the number of elements of the array. Use comma to separate the number of
elements of each dimension (up to 3 dimensions).
For example: 2 or 2,3 or 2,3,3.
NOTE: A dimension must be greater than 1 to be relevant. For example, entering
2,1 0or 1,2 is equivalent to entering 2.
5
You may optionally assign the initial value to the variable or to the single elements of
the array by clicking the """ Browse button next to the Init values field:
%)) Init values for: () X
[0,1,2,1]
[ OK ] [ Cancel ]
NOTE: Initial values must be separated by a comma.
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Editing a Typedef

Deleting a Typedef

Structures

Description

Step Action

6 You can specify:
An optional title.
An optional description.

7 Click Ok to validate.

To edit a TypeDef, double-click it from the Project window tree. The TypeDef is
displayed in the window where you can modify the values:

-roje B X Name Type | Array | Initvalue | Description
=- 2] Project 1 |UINT8_T USINT | No 0 8-bit
t--[JJ] UINT8_T

To modify a value, select it in the table then
» Enter a new value, or
» Click the browser button. A window appears to enter a new value.

To edit the properties of an existing TypeDef, right-click it from the Project window
tree and select Edit properties to open the associated editor.

To directly modify the name of the TypeDef, click it in the Project window tree
then click it again to open the name field. Enter the new name and press Enter to
validate.

To edit the properties of an existing TypeDef, right-click it from the Project window
tree and select Edit properties.

To display the properties of an existing TypeDef, right-click it from the Project
window tree and select View properties to open the associated Properties
Window.

To delete an existing TypeDef, right-click it from the Project window tree and
select Delete.

The following paragraphs present how to manage structures.

For more information about Structure, refer to Structures description, page 251.

Creating a New Structure

To create a new Structure in the Project window tree:
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Editing a Structure

Deleting a Structure

Step Action

1 To create a new Structure, do one of the following operations:

* Right-click on the name of the project then click Add > New Definition >
Structure.

»  Select the project in the Project window tree then, in the menu, click Project >
New object > New Definition > Structure

A dialog box is displayed:

2l New Structure X
Name COMPLEX
Title Complex Number
Version 1.0.0
Description
Complex Number -

[ OK ] [ Cancel ]

2 Enter the name of the Structure.

3 You can specify:

*  An optional title.

* An optional version number.
« An optional description.

4 Click Ok to validate.

To edit an existing Structure, double-click it from the Project window tree.

m Name Pos. Type Array Init value

B &1 Project 1 |Re 0 REAL | No 0
t----[®1g] COMPLEX 2 | Im 1 REAL | No 0

Right-click to insert or delete elements.

To modify a value, select it in the table then:
« Enter a new value, or
» Click the browser button. A window appears to enter a new value.

To edit the properties of an existing Structure, right-click it from the Project
window tree and select Edit properties to open the associated editor.

To directly modify the name of the Structure, click it in the Project window tree
then click it again to open the name field. Enter the new name and press Enter
validate.

To display the properties of an existing Structure, right-click it from the Project
window tree and select View properties to open the associated Properties
Window.

To delete an existing Structure, right-click it from the Project window tree and
select Delete.

to
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Enumerations

Description

The following paragraphs show you how to manage enumerations.

For more information about Enumeration, refer to Enumerated Data Types, page
250.

Creating a New Enumeration

To create a new Enumeration:

Step Action

1 To create a new Enumeration, do one of the following operations:

* Right-click on the name of the project then click Add > New Definition >
Enumeration.

+ Select the project in the Project window tree then, in the menu, click Project >
New object > New Definition > Enumeration

A dialog box is displayed:
& New Enumeration X

Name HYDROCARBON

Title

Description

[ OK ] [ Cancel ]

2 Enter the name of the Enumeration.

3 You can specify:
* Anoptional title.
»  An optional description.

4 Click Ok to validate.

Editing an Enumeration

To edit an existing Enumeration, double-click it from the Project window tree.

Em Project 1 Methane 1
HYDROCARBON 2 |Butane 4
3 |Octane 8

Right -click to insert or delete element.

To modify a value, select it in the table then:
» Enter a new value, or
* Click the browser button. A window appears to enter a new value.

To edit the properties of an existing Enumeration, right-click it from the Project
window tree and select Edit properties to open the associated editor.
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To directly modify the name of the Enumeration, click it in the Project window
tree then click it again to open the name field. Enter the new name and press
Enter to validate.

To display the properties of an existing Enumeration, right-click it from the
Project window tree and select View properties to open the associated
Properties Window.

Deleting an Enumeration

To delete an existing Enumeration, right-click it from the Project window tree and
select Delete.

Subranges

Description

The following paragraphs present how to manage subranges.

For more information about Subrange, refer to Subranges description, page 251.

Creating a New Subrange

To create a new Subrange:

Step Action

1 To create a new Subrange, do one of the following operations:
» Right-click on the name of the project then click Add > New Definition >
Subrange.

» Select the project in the Project window tree then, in the menu, click Project >
New object > New Definition > Subrange

A dialog box is displayed:

& New Subrange x
Name WATER_TEMPERATURE
Type INT (] Tite
Min. Value 0 Max. Value 100

Description | Temperature|

OK ] [ Cancel ]
2 Enter the name of the Subrange.
3 Specify the type of the Subrange either by typing it or by selecting it from the list that is
displayed when you click the """ Browse button.
4 You can specify:

*  The minimum value.
¢ The maximum value.
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Editing a Subrange

Deleting a Subrange

Step Action

5 You can specify:
An optional title.
An optional description.

6 Click Ok to validate.

To edit an existing Subrange, double-click it from the Project window tree.

2 x Name Type Min | Max | Description
Em Project 1 'WATER_TEMPERATURE | INT 0 100 Temperature
WATER_TEMPERATURE

To modify a value, select it in the table then:
» Enter a new value, or
» Click the browser button. A window appears to enter a new value.

To edit the properties of an existing Subrange, right-click it from the Project
window tree and select Edit properties to open the associated editor.

To directly modify the name of the Subrange, click it in the Project window tree
then click it again to open the name field. Enter the new name and press Enter to
validate.

To display the properties of an existing Subrange, right-click it from the Project
window tree and select View properties to open the associated Properties
Window.

To delete an existing Subrange, right-click it from the Project window tree and
select Delete.

Browse the Project

Overview

Description

Programming provides two tools to search for an object within a project: the
Object browser and the Find in project feature.
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Object Browser

Description

Programming provides a tool for browsing the objects of your project: the Object

Browser.

Objects filter

M Programs

M Function Blocks
M Functions

M Variables

M User types

[ Check all ] [ Check none ]

Other filters
Name ’1
Location
Library
Vars type All

Vars group

Import objects

Object browser

Name

§# AHUPlanModeStrategy
§# AHUTempCntriStrategy
f# CompAlarmMgmt

¥ CompAppLimit

& CompCntrl_OnOff

& CompCntrl_Slider

ﬁ CompCntrl_VS

f CompMgmt

ﬁ CompMgmtVsS

F COPCalculation

ﬁ Counter2Energy

ﬁ Doublelnterpo_5x8

E EcFanMgmt

¥ EnergyTrend

T FanMgmt

Type

Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks
Function blocks

[ Select all ] [Selectnone]

This tool is context-dependent, this implies that the kind of selectable objects and
the available operations on objects depend on the context.

Object browser can be opened in the following ways:

 Browser mode:

In Programming, click the menu command Project > Object Browser.

* Import object mode:

Right-click the project name in the Project window and select Import
objects, the Object browser opens after opening the selected object.

» Select object mode:

For example, to add a program to a task, right-click a task item in the Project

window and select Add program command. It opens the Object browser

window.

User interaction with Object browser is similar for the three modes and is

presented in the next paragraph.

Common Features and Usage of Object Browser

This section presents the features and the usage of the Object browser.
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Objects filter:
Objects filter

M Programs

M Function Blocks
M Functions

[ variables

[1 User types

[ Check all ] [ Check none ]

This is the main filter of the Object browser. You can select one of the available
(enabled) object items.

In this example, Programs, Function Blocks, Functions are selected, so objects
of this type are displayed in the object list. Variables and User types objects can
be selected, but objects of that type are not currently displayed in the object list.

You can also click the Check all button to select the available objects at one time
or can click the Check none button to deselect the objects at one time.

Other filters:
Other filters

Name * OK
Location

Library

Vars type All v
Vars group

Selected objects can be also filtered by name, symbol location, specific library,
type of variable, and group of variables.

Filters are all additive and are immediately applied after setting.

Name

Function Filters objects on the base of their name.

Allowed values All the strings of characters.

Use Type a string to display the specific object whose name matches the
string. Use the * wildcard if you want to display all the objects whose
name contains the string in the Name text box. Type * if you want to
disable this filter.

Press Enter when edit box is focused or click the OK button to apply
the filter.

Applies to All object types.

Symbol location

Function Filters objects on the base of their location.

Allowed values All, Project, Target, Library, Aux. Sources.

Use All= Disables this filter.
Project= Objects declared in the Programming project.
Target= Firmware objects.
Library= Objects contained in a library. In this case, use
simultaneously also the Library filter.
Aux sources= Displays auxiliary sources only.

Applies to All objects types.
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Library

Function

Filters objects contained in library. The value of this filter is relevant
only if the Symbol location filter is set to Library.

Allowed values

All, libraryname1, libraryname?2, ...

Use All= Displays objects contained in any library.
LibrarynameN= Displays only the objects contained in the library
named librarynameN.

Applies to All objects types.

Vars Type

Function Filters global variables and system variables (also known as firmware

variables) according to their type.

Allowed values

All, Normal, Constant, Retain

Use All= Displays all the global and system variables.
Normal= Displays normal variables only.
Constant= Displays constants only.
Retain= Displays retain variables only.

Applies to Variables.

Vars Group

Function Filters variables according to their group.

Allowed values

Analog_inputs, Anlog_Outputs, ...

Use Displays the variables that belongs to the selected group.
Applies to Variables.
Object list:

Object list shows all the filtered objects. The list can be ordered in ascending or
descending order by clicking the header of the column. It is possible to order items
by Name, Type, or Description.

Double-clicking an item allows you to perform the default associated operation
(the action is the same as the OK, Import object, or Open source button

actions).

When item multiselection is allowed, Select all and Select none buttons are

visible.

It is possible to select all objects by clicking the Select all button. Select none

deselects all objects.

If at least one item is selected on the list operation, buttons are enabled.

Resize:

Object browser window can be resized, the cursor changes along the border of

the window and allows you to resize it. When reopened, Object browser window
keeps the same size and position of the previous usage.

Using Object Browser

In order to use the object browser to look over through the elements of the project,
choose the menu item Project > Object Browser.

Available objects:

In this mode, you can list objects of these types:
* Programs.

EIO0000003412.05

137



Managing Project Elements

* Function Blocks.
* Functions.

» Variables.

+ Usertypes.

These items can be checked or unchecked in the Objects filter section to show or
to hide the objects of the chosen type in the list.

Other types of objects (Operators, Standard functions, Local variables, Basic
types) cannot be browsed in this context, therefore they are unchecked and
disabled.

Available operations:

Open source, default operation for double-clicking an item

Function Opens the editor by which the selected object was created and
displays the relevant source code.

Use If the object is a program, or a function, or a function block, this button
opens the relevant source code editor.

If the object is a variable, then this button opens the variable editor.

Select the object whose editor you want to open, then click the Open
source button.

Export to library

Function Exports an object to a library.
Use Select the objects you want to export, then click the Export to library
button.

Delete objects

Function Allows you to delete an object.
Use Select the object you want to delete, then click the Delete object
button.

Using Object Browser for Import

Object browser is also used to support object importations in the project from an
external library.

In order to use the object browser to import external library to the project, choose
the menu item Project > Import objects.

Available objects:

In this mode you can list objects of these types:
* Programs.
» Function blocks.
» Functions.
» Variables.
+ Usertypes.

These items can be checked or unchecked in Objects filter section to show or to
hide the objects of the chosen type in the list.

Other types of objects (Operators, Standard functions, Local variables, Basic
types) cannot be imported so they are unchecked and disabled.

Available operations:

Import objects is the only operation supported in this mode. It is possible to
import selected objects by clicking the Import objects button or by double-clicking
one of the objects in the list.
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Using Object Browser for Object Selection

Object browser dialog is useful for many operations that require the selection of a
single PLC object. The Object browser can be used to select the program to add
to a task, to select the type of a variable, to select an item, to find in the project,
and so on.

Available objects:

Available objects are strictly dependent on the context. For example, in the
program assignment to a task operation, the only available objects are program
objects.

Not all available objects may be selected by default.
Available operations:

In this mode, it is possible to select a single object by double-clicking the list or by
clicking the OK button; then the dialog is automatically closed.

Search with the Find in Project Command

Description

The Find in project command retrieves all the instances of a specified character
string in the project.

In order to use this functionality, choose the menu item Edit > Find in project.

Programming displays the following dialog box:

Find in project X

Find what: v [I] Find & close

Location: | All v Find

Cancel
Object type filters

M Programs M Functions M Macros [ Variables
M Function blocks [ Methods M User Types
Find options

M Find in description [J Match whole word only
M Find in types [1 Match case

[ Use Regular Expressions

Step Action

1 In the Find what box, type the name of the object you want to search.

Otherwise, click the "’ Browse button on the right of the box, and select the name
of the object from the list of all the existing items.

2 Select one of the values listed in the Location box to specify a constraint on the
location of the objects to be monitored.

3 The frame named Object type filters contains 7 check boxes, each of which, if ticked,
enables research of the string among the object it refers to.
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Step Action
4 Tick the relevant options check boxes in the Find options frame.
5 Click Find to start the search; otherwise click Cancel to quit.

The results are displayed in the Find in project tab of the Output window.

Searching for ‘cnt’

Pulse (7) - ST
Pulse (14) - LD
Pulse (16) - ST
Pulse (18) - LD
Pulse (26) - ST

Pulse (LV) - cnt : UINT

6 occurrence (s) have been found.

Build Find in project Debug Resources HMI Output

cnt
cnt
cnt
cnt
cnt

Project Custom Workspace

Overview

Description

The custom workspace functionalities allow you to organize your Project window
tree according to your needs, in order to obtain more efficiency in the
management of the project.

The organizational units of the custom workspace are logical having no effects on
the PLC code.

140

EI00000003412.05



Managing Project Elements

Project

a8 m MyProject Project
H .| Counters and timers
L. P LadderLogic
=~ m Counters and timers params
[ i | parCtDownPreset
[ i | parCtUpPreset
i [ud| parPulseValue
- [ud| parPulseWidth
... [ud| parTimOnDelay
- [ud| parTimOnValue
PID
& - Function Blocks
. [=1F; LowPassFilter
L-----BEP pidControl
‘i—ép PidModeSelector

& EO PDhmi
# [ | hmiPidTest
“-[r] hmiPIDThreshold

--EB(® PID params

Aux Variables

L
TR -

Tasks
-2 Timed

i@ PidControl

@ PidModeSelector
- 4 Background

“@ LadderLogic
i 4 Boot

e 2 It

Enable Custom Workspace Into an Existing Project

Description

To enabile this feature, click the Use customizable workspace check box in
Project > Options... > General tab. Once enabled, the project needs to be
reloaded.

For more information, refer to Project Info, page 102.

By default this feature is enabled and customized according to the target device.

Workspaces Migration

Description

Whenever Custom Workspace feature is switched, Programming reorders the
workspace maintaining the user customization by this logic:

Static (old) workspace to custom (new)

Fixed logic units (for example function blocks folder) are converted into new
dynamic folders with the same names. Fixed global group units (for example:
Mapped variables) are converted into new global dynamic groups with the same
names. The global variables that do not belong to any group are grouped into a
new group called Ungrouped global vars.

Custom (new) workspace to static (old)
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The custom units are destroyed and the POUs and global variables are grouped
into the default fixed units (for example: function blocks folder and Mapped
Variables).

Custom Workspace Basic Units

Description

In the new custom workspace you can work using two different main logic units:

. Folder: this is an optional logical unit that can contain POUs, folders (you
can nest folders into another one), and global variables group.

. % Global variables group: this is a mandatory logical unit that can only
contain global variables. In order to create a global variable, you need to have
almost one global variables group defined into your custom workspace.

Custom Workspace Operations

Description

Different operations can be performed in order to optimize the organization of your
project.

Creating a folder:

In order to create a folder select the root item of the project tree or, if you want to
nest it, an existing folder then right-click Add > New folder.

This operation adds a new customizable folder unit ready to be renamed. Default
folder name is New folder.

Creating a Global variables Group:

To create a global variables group, select the root item of the project tree or, if you
want to nest it, an existing folder, select it, then right-click and select Add > New
global variables group.

This operation adds a new customizable folder unit ready to be renamed. Default
folder name is New var group.

Rename a unit (folder or Global variables group:)

In order to rename a global variables group or a folder, select it, then right-click
and select Rename.

This operation makes the name of the unit ready to be renamed.
Deleting a unit (folder or Global variables group):

In order to delete a global variables group or a folder, select it, then right-click and
select Delete.

If the units contains any child, you are prompted for three possibilities:

Step Action
1 Delete all child elements too (this may impact the PLC).
2 Do not delete child elements, they are moved upwards following the project tree.
3 Cancel the operation and do nothing.

Export all children to library:
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To export all elements of a global variables group or a folder, select it, then right-
click and select Export all children to library.

This operation allows you to export recursively all child elements of the selected
item into a library. For more information about new library, refer to Exporting to a
Library, page 112.

Moving Unit:

You can simply drag units to a different location of the tree in order to organize
your project workspace. All children are moved if the parent item is moved,
following the original structure.

Moving variables is also possible both from project tree (single selection) and from
the variable grid (single and multiple selections). For more information about
variables editor, refer to Variables Editor, page 167.

Workspace Elements with Limitations

Description

Some elements of the workspace are fixed and not customizable. They are
automatically generated by Programming and no special custom operations are
allowed on:

* Root Project Element:

You cannot move, rename, or delete this element. It can contain customizable
units as children.

* POUs Children Elements:

These elements are generated following the structure of the POU they belong
to. You cannot move, rename, or delete these elements directly from the tree.
For more information about POUs, refer to Program Organization Units, page
116.

* SFC Children Elements:

These elements follow the previously mentioned rules but especially for the
SFC children nodes the rename or delete operations are not allowed also on
the POUs that belong to Actions or Transitions elements. For more
information about SFC language, refer to Sequential Function Chart (SFC)
Editor, page 162.

¢ Aux Variables Element:

You cannot move, rename, or delete this element and its children. They are
automatically generated by Programming.

¢ Tasks Element:

You cannot move, rename, or delete these elements. They are automatically
generated by Programming. For more information, refer to Tasks, page 126.
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Editing the Source Code

Overview

PLC Editors

What’s in This Chapter

OVEBIVIBW ...ttt ettt e e ettt e e e et e e e e e eeta e e e eeetaaaeeees 144
Instruction List (IL) EQItOr ........couuiiiii e 144
Function Block Diagram (FBD) Editor...........ccoovviiiiiiiiiiieeeeeieeeee e 146
Ladder Diagram (LD) EditOr .........oooeuuniiiiiiiie e 151
Structured Text (ST) EditOr... ..o 160
Sequential Function Chart (SFC) Editor ..........c.uoviiiiiiiiiiirii e 162
Variables EditOr.... ... 167

Programming includes five source code editors, which support the whole range
of programming languages according to the IEC 61131-3 Standard:

» Instruction List (IL), page 144.

* Function Block Diagram (FBD), page 146.

* Ladder Diagram (LD), page 151.

» Structured Text (ST), page 160.

» Sequential Function Chart (SFC), page 162.

The editors, both graphical and text one, support tooltips. By enabling them, page
38, Programming shows some information about symbols on mouse-over.

Instruction List (IL) Editor

Overview

Description

Editing Functions

The IL editor allows you to write code and modify POUs using Instruction List (IL):

HUL =v=Ig
SHE 1leg04
ADD addIgSg

ML =w=Ig
SHE 16#04
ADD addIgSg

Description
The IL editor is endowed with functions common to most editors running on a
Windows platform, namely:
» Text selection.
+ Edit>Cut CE‘
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+ Edit> Copy E'l—'l

+ Edit > Paste Ej
+ Edit > Replace
» Drag-and-drop of selected text.

Reference to PLC Objects

Description

If you need to add a reference to an existing PLC object, you have two options:
* You can type directly the name of the PLC object.

* You can drag it to a suitable location. For example, global variables can be
taken from the Workspace window, whereas standard operators and
embedded functions can be dragged from the Libraries window, whereas
local variables can be selected from the local variables editor.

Automatic Error Location

Description
The IL editor also automatically displays the location of compiler errors. To know
where a compiler error occurred, double-click the corresponding error line in the
Output bar.

Bookmarks

Description

You can set bookmarks to mark frequently accessed lines in your source file. You
can remove a bookmark when you no longer need it.

Setting a Bookmark
Move the insertion point to the line where you want to set a bookmark, then press
Ctrl+F2.

The line is marked in the margin by a light-blue circle.

O

Bookmarks are managed in Edit > Bookmarks.... The available commands are:
+ Add/toogle (Ctrl+F2)
* Next (F2)
* Prev (Shift+F2)
* Remove all
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Jumping to Next Bookmark

Press F2 repeatedly until you reach the desired line.

Jumping to Previous Bookmark

Press Shift+F2 repeatedly until you reach the desired line.

Removing a Bookmark

Move the cursor to anywhere on the line containing the bookmark, then press Ctrl
+F2.

Function Block Diagram (FBD) Editor

Overview

Description

The FBD editor allows you to code and modify POUs using Function Block Diagram (FBD):

PID regulator

foPid PID regulation is OK if target is inside threshold

For more details, refer to Function Block Diagram language reference, page 275.

Creating a New FBD Document

Description

For creation and modification of FBD documents, refer to:
* Creating a Program Organization Unit, page 116.
» Creating a Function Block/Function, page 116.
+ Editing POUs, page 117.
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Adding/Removing Networks

Description

Every POU coded in FBD consists of a sequence of networks. A network is
defined as a maximal set of interconnected graphic elements. The upper and
lower bounds of every network are fixed by two straight lines while each network is
delimited on the left by a gray area containing the network number:

0006

You can perform the following operations on networks:

* To add a new blank network, click Scheme > Network > New and select the
position of the new network: Top, Bottom, Before, or After.

* To delete a network, select it and press Delete.
+ To display a background grid which helps you to align objects, click View >

Grid .

» To add a comment, click Scheme > Object > New > Comment.

Labeling Networks

Description

You can modify the usual order of execution of networks through a jump
statement, which transfers the program control to a labeled network.

To assign a label to a network:

Step | Action

1 Select the network.

2 Apply one of the following operations:
* Click Scheme > Network > Label.
* Double-click the gray area containing the network number.
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Step | Action

A dialog box appears, which lets you enter the label you want to associate with the selected
network:

Network label X

New network label
Label_X

0006

Click OK.
The label is displayed in the top left-hand corner of the selected network.

Label _X:

Inserting and Connecting Blocks

Overview

This paragraph presents how to build a network.

Inserting Blocks

Add a block to the blank network, by applying one of the following operations:

Open the Object browser window, by applying one of the following
operations:

o In the menu, click Scheme > Object > New > Function Block.

o In the FBD toolbar, click '

If the block is a constant, a return statement, or a jump statement, you can
directly click the relevant buttons in the FBD toolbar, page 98

Then choose one item from the list and click OK.

Drag the selected object from the suitable location. For example, global
variables can be taken from the Workspace window, whereas standard
operators and embedded functions can be dragged from the Libraries
window, whereas local variables can be selected from the local variables
editor.

Repeat until you have added all the blocks to the network.

Connecting Blocks

To connect blocks manually:

148
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» Enable the manual connection mode by applying one of the following
operations:

o |n the menu, click l-r. Edit > Connection mode.

- Inthe FBD toolbar, click /.
> Press Space key.

» Click once the source pin, then move the mouse pointer to the destination pin:
the FBD editor draws a logical wire from the former to the latter.

To connect blocks automatically:

» Enable the automatic connection mode by applying one of the following
operations:

o In the menu, click E"—L Scheme > Auto connect.

o In the code editor, right-click and click ETL Auto connect.

* Then select one block, drag it close to the other one to let the corresponding
pins coincide. The FBD editor automatically draws the logical wires.

MUX

Deleting Blocks

To delete a block, select it and press Delete key.

When you delete a block, its connections are not removed automatically, but they
become invalid and they are redrawn red. Click Scheme > Delete invalid
connection.
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Editing Networks

Description

The FBD editor is endowed with functions common to most graphic applications
running on a Windows platform, namely:

« Selection of a block.

» Selection of a set of blocks by pressing Shift+Left button and by drawing a
frame including the blocks to select.

« Edit> Cut ':E' , Edit > Copy E'I—'l , Edit > Paste E'I—'l operations of a single
block as well as of a set of blocks.

» Drag-and-drop.

Modifying Properties of Blocks

Description

* Click +! Scheme > Increment pins to increment the number of input pins
of some operators and embedded functions.

E
* Click %"J'; Scheme > Enable EN/ENO pins to display the enable input and
output pins.

+ Click Scheme > Object > Instance name or click Scheme > Object
properties to modify the name of an instance of a function block.

For more information, refer to Modifying Properties of Blocks, page 156 in Ladder
Diagram (LD) Editor section.

Getting Information on a Block

Description

You can always get information on a block by selecting it and then applying one of
the following operations:

=

+ Click Scheme > Object > Open source = to open the source code of a
block.

+ Click Scheme > Object properties to see properties and input/output pins of
the selected block.

Automatic Error Retrieval

Description

The FBD editor also automatically displays the location of compiler errors. To
reach the block where a compiler error occurred, double-click the corresponding
error line in the Output bar.
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Ladder Diagram (LD) Editor

Overview

Description

The LD editor allows you to code and modify POUs using Ladder Diagram (LD):

0003

flagEnable inpLogicData inpLogicData? ™ outPulze
| I | | s
I 1T 10 N Q i,
inpLogicDatal cutCountlp
| | hmiPulseWidth hmiPulzeValue —

0o04
fbDelay
inpLogicData TON outDelayed
[ N a {

hmiTimOnDelay hmiTimOnValue

For more details, refer to Ladder Diagram language reference, page 279.

Creating a New LD Document

Description

For creation and modification of FBD documents, refer to:
» Creating a Program Organization Unit, page 116.
» Creating a Function Block/Function, page 116.
» Editing POUs, page 117.

Adding/Removing Networks

Description

Each POU coded in LD consists of a sequence of networks. A network is defined
as the set of interconnected graphic elements. The upper and lower bounds of
every network are fixed by two straight lines while each network is delimited on the
left by a gray area containing the network number.

oot

On each LD network, the right and the left power rail are represented, according to
the LD language indication.

On the new LD network, a horizontal line links the two power rails. It is called the
“power link”. On this link, all the LD elements (contacts, coils, and blocks) of the
network are placed.
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You can perform the following operations on networks:

» To add a new blank network, click Scheme > Network > New, or click one of
o

the equivalent buttons H™ = in the Network toolbar.

+ To display a background grid which helps you to align objects, click View >

Grid .

» To add a comment, click Scheme > Object > New Comment I'V__l or press
Shift+M.

Labeling Networks

Description

You can modify the usual order of execution of networks through a jump
statement, which transfers the program control to a labeled network.

To assign a label to a network:

Step | Action
1 Select the network.
2 Apply one of the following operations:

Click Scheme > Network > Label.
Double-click the gray area containing the network number.

3

A dialog box appears, which lets you enter the label you want to associate with the selected

network:

Network label X
New network label 7)
—
Label_X
0002

4 Click OK.

The label is displayed in the top left-hand corner of the selected network:

Label_X:

? ?

I {

Inserting Contacts

Description

To insert new contacts on the network, apply one of the following procedures:

» Drag a boolean variable to the desired place over an object. For example,
global variables can be taken from the Workspace window, whereas local
variables can be selected from the local variables editor. Contacts inserted
with drag and drop will always be inserted in series after the destination
object.
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+ Select a contact, a block, a pin of block, or a connection point that acts as the
insertion point. Insert the new contact choosing between the connection type

(serial or parallel) and choosing the position (before or after the currently

selected object) by using the Scheme > Object > New.

For serial insertion, the new contact is inserted on the left or right side of the
selected contact/block or in the middle of the selected connection depending on

the element selected before the insertion. Examples of serial insertion:

cni
|
cni cn
cn2
0001
timer

For parallel insertions, several contacts can be selected before performing the
insertion; the new contact is inserted above or below the group of selected

|

=

|
cni
I
|
cni cn
— | |
cn2
0001
timer1
TON
EN END
7
—— a
PT ET
e —

contacts. Examples of parallel insertions
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]

i}

|
cn cni
— i
|
cn cnl cn2
— | |
cn3 cnd
— il

cn cni
| |l
[ (I
7
0o
cn cni cnZ
— | | | |
?
cnd cnéd
___4 I ||

Inserting Coils

Description

To insert new coils on the network, apply one of the following operations:

Drag a boolean variable on the network, over an existing output of the
network (coil, return, jump). For example, global variables can be taken from
the Workspace window, whereas local variables can be selected from the

local variables editor.

Click { } Scheme > Object > New > Coil.

The new coil is inserted to the right power rail. If other coils, return or jumps
are already present in the network, the new coil is added in parallel with the

previous ones.

out1

154

EI00000003412.05



Editing the Source Code

Inserting Blocks

Description
To insert blocks on the network, apply one of the following operations:

+ Select a contact, connection, or block then click I Scheme > Object >
New > Block, then the Browser object window appears. Choose one item
from the list.

» Drag the selected object (from the Workspace window, the Libraries window
or the local variables editor) over the desired connection.

If the object has at least one BOOL input and one BOOL output pins, they are
connected to the power link (and it will possible to add EN/ENO pins later with the
provided command); otherwise the EN/ENO pins are automatically added.

Operators, functions, and function blocks can only be inserted into an LD network
on the main power link, or on the power link of a branch (so they cannot be
inserted in parallel of a contact); it is also not possible to create a contact in
parallel of a block.

If a block has a BOOL input pin, it is possible to create another logical sub-
network of contacts and blocks before it; otherwise, you can connect only
variables, constants, or expressions (that nevertheless can be connected to
BOOL pins) to non-BOOL input pins.

Editing Coils and Contacts Properties

Description

The type of a contact (normal, negated, positive, negative) or a coil (normal,
negated, set, reset, positive, negative) can be changed by one of the following
operations:

» Double-click the element (contact or coil).
+ Select the element and then press the Enter key.
» Select the element, activate the pop-up menu, then select Properties.

A relevant dialog box appears. Select the desired element type from the list
displayed and then click OK.

Contact Coil
®) Normal Normal
Negate
Negate ® Set
Positive Reset
Positive
Negative Negative
Name
[ ok | [ cancel |

Otherwise, select the desired contact or coil, and modify its type using the six
provided buttons in the LD toolbar or the six commands in the Scheme menu.
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Editing Networks

Description

The LD editor is endowed with functions common to most graphic applications
running on a Windows platform, namely:

« Selection of a block.

» Selection of a set of adjacent contacts by pressing Ctrl+Left button on each
contact to select; if the selection spans across different parallel branches,
more contacts are automatically added in the selection.

» Edit>Cut CE‘ , Edit > Copy Ij—'l , Edit > Paste Ij—'l operations of a single
block as well as of a set of blocks.

» Drag-and-drop of the selected object or group to move it inside or outside
the current network.

Adding, moving, deleting, or copy/pasting objects will automatically recalculate the
layout of the network objects; because of this, it is not possible to manually “draw”
connection lines or freely placing objects without connecting them to the network.

Modifying Properties of Blocks

Description

* Click Scheme > Increment pins +I to increment the number of input pins
of some operators and embedded functions.

NOTE: You can also remove pins by clicking Decrease pins -I.

KUK MUK
K K
] + ! (]
1 1
[2

E
* Click "EH? Scheme > Enable EN/ENO pins to display the enable input and
output pins.

EN/ENO pins can be removed only if the selected block has at least one
BOOL input and one BOOL output; otherwise, they are automatically added
when creating the block and it will not be possible to remove them (the
Enable EN/ENO pins command is disabled).

If a block has more than one BOOL output pin, it is possible to choose which
pin brings the signal out of the block and so continue the power link: select

the desired output pin and click the Scheme > Set output line EI' menu

command.
E
TON ’EF‘F';
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» Click Scheme > Object properties to modify the name of an instance of a
function block.

FBD object properties X

Instance name | TON_1 [J En/Eno Function blocks
1/0 Neg Name Type Description

In IN BOOL Timer input source

In n/a PT UDINT Preset time value [ms]

Out Q BOOL Timer output

Out  n/a ET UDINT Timer current value [ms]

4 »

[ OK ] [ Cancel ]

Getting Information on a Block

Description

You can always get information on a block that you added to an LD document, by
selecting it and then applying one of the following operations:

==
+ Click Scheme > Object > Open source = to open the source code of a
block.

» Click Scheme > View PLC Object properties in the menu to see properties
and input/output pins of the selected block.

Automatic Error Retrieval

Description

The LD editor also automatically displays the location of compiler errors. To reach
the block where a compiler error occurred, double-click the corresponding error
line in the Output bar.

Inserting Variables

Description

To connect a variable to an input or output pin of a block, apply one of the
following procedures:

+ Select the pin of a block, and then click the ﬂ Scheme > Object > New >
Variable menu command; then double-click the new variable object (or
press Enter key) and enter the variable name.

» Drag the selected variable (from the Workspace window, the Libraries
window or the local variables editor) over the desired pin of a block.
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Inserting Constants

Description
To connect a numeric constant to an input pin of block, select the pin and click the

K
[ Scheme > Object > New > Constant menu command; then double-click the
new constant object (or press Enter key) and enter the numeric constant value.

Inserting Expression

Description
To connect a complex expression to an input pin of block, select the pin and click
the E Scheme > Object > New > Expression menu command; then double-
click the new expression object (or press Enter key) and enter any ST expression.
For example:
(a+b) *c
TO_INT (n)
ADR (x)
0005
ADD »
EN ENO {
+
[t > —_resut]
s 1
(axb)te )
Comments
Description

It is possible to insert two types of comments:
* Network comments: activate the network by clicking the header on the left or

inside the grid (but without selecting any object), and then click the I‘"__l
Scheme > Object > New > Comment menu command. The network
comment is displayed at the top of the network, and if necessary is expanded
to show all the text lines of the comment.

* Object comments: they are activated with the menu command in View >
Show comments for objects. Above any contact, function block, or coil, the
description of the associated PLC variable (if present) is initially displayed.
With the Comment command, you can modify it to enter a specific object
comment that overrides the PLC variable description.
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0008 This is a network comment,
that can span multiple lines

Comment for timer

timer1 Comment for the coil

Enable flag

enable | TON | outt
[} N Q { }

Branches

Description

The main power line can be branched to create sub-networks that can be further
branched themselves. To add a branch, select the object after you want to create

the branch and then click the T Scheme > Object > New > Branch menu
command.

The start of the new branch is marked as a large dot on the source line; deleting
the objects on a branch deletes the branch itself.

Selecting an object on a branch effectively selects the branch, so for example

selecting a contact on a branch and then clicking the { } Scheme > Object >
New > Coil adds the coil on the branch instead of adding it on the main power
line.

cn cni cn cni

I T (y— I T i B (y—
— |

b
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Structured Text (ST) Editor

Overview

Description

The ST editor allows you to code and modify POUs using Structured Text (ST):

s
IgDW = =svy=lg * =y=Ig :
addIgSg := addIgSg + SHE({ IgDW. 1604 )

IdDW = =y=Id * =y=Id :
addIdSg = addIdSg + SHE( I4dDW, 1e#04 )

IF a b THEH

< >

For more details, refer to Structured Text language reference, page 281.

Creating and Editing ST Objects

Description

For creation and modification of FBD documents, refer to:
* Creating a Program Organization Unit, page 116.
» Creating a Function Block/Function, page 116.
+ Editing POUs, page 117.

Editing Functions

Description

The ST editor is endowed with functions common to most editors running on a
Windows platform, namely:

» Text selection.

Edit > Cut ':!I{' .

+ Edit> Copy Ij—'l

+ Edit > Paste Ej .
- Edit > Replace.
» Drag-and-drop of selected text.

160 EI00000003412.05



Editing the Source Code

Reference to PLC Objects

Description

If you need to add to your ST code a reference to an existing PLC object, you have
two options:

* You can type directly the name of the PLC object.

* You can drag it to a suitable location. For example, global variables can be
taken from the Workspace window, whereas embedded functions can be
dragged from the Libraries window, whereas local variables can be selected
from the local variables editor.

Automatic Error Location

Description

Bookmarks

Description

Setting a Bookmark

The ST editor also automatically displays the location of compiler errors. To know
where a compiler error has occurred, double-click the corresponding error line in
the Output bar.

You can set bookmarks to mark frequently accessed lines in your source file.
Once a bookmark is set, you can use a keyboard command to move to it. You can
remove a bookmark when you no longer need it.

Move the insertion point to the line where you want to set a bookmark, then press
Ctrl+F2.

The line is marked in the margin by a light-blue circle:

O

Bookmarks are managed in Edit > Bookmarks.... The available commands are:
+ Add/toogle (Ctrl+F2)
* Next (F2)
* Prev (Shift+F2)
* Remove all

Jumping to Next Bookmark

Press F2 repeatedly until you reach the desired line.

Jumping to Previous Bookmark

Press Shift+F2 repeatedly until you reach the desired line.
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Removing a Bookmark

Move the cursor to anywhere on the line containing the bookmark, then press Ctrl
+F2.

Sequential Function Chart (SFC) Editor

Overview

Description

The SFC editor allows you to code and modify POUs using Sequential Function
Chart (SFC):

For more information about SFC editor features, refer to SFC Toolbar, page 99.

For more details, refer to Sequential Function Chart language reference, page
290.

Creating a New SFC Document

Description

For creation and modification of FBD documents, refer to:
» Creating a Program Organization Unit, page 116.
» Creating a Function Block/Function, page 116.
» Editing POUs, page 117.

Inserting a New SFC Element

Description
You can insert three type of SFC elements:
* Click ::I Scheme > Object > New > Step.

+ Click I'JI:I Scheme > Object > New > Transition.

. Click %= scheme > Object > New > Jump.
In either case, the mouse pointer changes to:

for steps;
for transitions;
for jumps.

s
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Connecting SFC Elements

Description

Follow this procedure to connect SFC blocks:

+ Click ..I" Edit > Connection mode, or simply press the space bar on your
keyboard. Click once the source pin, then move the mouse pointer to the
destination pin: the SFC editor draws a logical wire from the former to the
latter.

+ Alternatively, you can enable the auto connection mode by clicking E"—L
Scheme > Auto connect. Then take the two blocks, and drag them close to
each other to let the respective pins coincide, which makes the SFC editor
draw automatically the logical wire.

Assigning an Action to a Step

Description

This paragraph explains how to implement an action and how to assign it to a
step.

Writing the Code of an Action
Start by opening an editor, applying one of the following procedures:
+ Click Lifl Scheme > Code object > New action.

* Right-click on the name of the SFC POU in the Workspace window I-—T!IEI
New action.

In either case, Programming displays a dialog box:

SFC code type X

Languages

A
OFeo
OLD
OsT
(® SFC

Name

Select one of the languages and type the name of the new action in the text box at
the bottom of the dialog box. Then either confirm by clicking OK, or quit by clicking
Cancel.

If you click OK, Programming opens automatically the editor associated with the
language you selected in the previous dialog box and you are ready to type the
code of the new action.

You are not allowed to declare new local variables, as the module you are now
editing is a component of the original SFC module, which is the POU where local
variables can be declared. The scope of local variables extends to all the actions
and transitions making up the SFC diagram.
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Assigning an Action to a Step

When you have finished writing the code, double-click the step you want to assign
the new action to. This causes the following dialog box to appear.

SFC Action Properties X

Setpoint10Negative[J] Code P [No code] v

Code N ManualMode v

Test_2

[No code]
AnaloglnputMode
[ Jend Manual| | \ae [T AutoModelnit
Idle
Comment
Setpoint10Negative
Setpoint10Positive
Test 2
TestModelnit

From the list displayed in the Code N box, select the name of the action you want
to execute if the step is active. You may also choose, from the list displayed in the
Code P (Pulse) box, the name of the action you want to execute each time the
step becomes active (that is, the action is executed only once per step activation,
regardless of the number of cycles the step remains active). Confirm the
assignments by clicking OK.

In the SFC schema, actions to step assignments are represented by letters on the
step block:
» Action N by letter N;
+ Action P by letter P.
]
Test_2

AutoModelnit| P |
Setpoint10Negative|N|

end_Manual

If later you need to edit the source code of the action, you can double-click these
letters. Alternatively, you can double-click the name of the action in the Actions
folder of the Workspace window.

Specifying a Conditional Transition

Description

A transition condition can be assigned through a constant, a variable, or a piece of
code. This paragraph explains how to use the first two means while conditional
code is discussed in the next paragraph.
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First of all, double-click the transition you want to assign a condition to. This
causes the following dialog box to appear:

SFC Transition Properties X

Value

.
O Tus
(O False

@ Variable hmiPidTest (-]

() Expression

(O Code

Select True if you want this transition to be constantly cleared, False if you want
the PLC program to keep executing the preceding block.

Instead, if you select Variable the transition depends on the value of a boolean
variable. Click the corresponding bullet to make the text box to its right available,
and to specify the name of the variable.

You can also make use of the objects browser, that you can invoke by clicking the

Browse button.

Click OK to confirm, or Cancel to quit without applying changes.

Assigning Conditional Code to a Transition

Description

This paragraph explains how to specify a condition through a piece of code, and
how to assign it to a transition.

Writing the Code of a Condition
Start by opening an editor, applying one of the following procedures:
+ Click ﬁ] Scheme > Code object > New transition code.

+ Right-click on the name of the SFC POU in the Workspace window lkll:| New
transition.

In either case, Programming displays a dialog box:

SFC code type X
Languages
OK
oL SN
Ore
O LD
®ST
Name
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Select one of the languages and type the name of the new condition in the text
box at the bottom of the dialog box. Then either confirm by clicking OK, or quit by
clicking Cancel.

If you click the OK button, Programming opens automatically the editor
associated with the language you selected in the previous dialog box and you can
type the code of the new condition.

You are not allowed to declare new local variables, as the module you are now
editing is a component of the original SFC module, which is the POU where local
variables can be declared. The scope of local variables extends to all the actions
and transitions making up the SFC diagram.

Assigning a Condition to a Transition

When you have finished writing the code, double-click the transition you want to
assign the new condition to. This causes the following dialog box to appear:

»oint inpAutomatic o
SFC Transition Properties X
Auto_Phase _0 Value
- - OK
AutoModelnit [P] v -
Setpoint10Positive [N] O True
() False
end_AutoPhase
- (O Variable @

Auto_Phase _1 (O Expression
Setpoint10Positive [N] @ Code end_AutoPhase0 .
[No code]
| end_Analog
end_Automatic
| | end_AutoPhase end_A end_AutoPhase0 sstPhasel
end AutoPhase1
end_Manual
Init | end_TestPhase0
end_TestPhase1
end_TestPhase2 [N]
|

Select the name of the condition you want to assign to this step. Then confirm by
clicking OK.

If later you need to edit the source code of the condition, you can double-click the
name of the transition in the Transitions folder of the Workspace window.

Specifying the Destination of a Jump

Description

To specify the destination step of a jump, double-click the jump block in the Chart
area. This opens the dialog box presented below, listing the name of all the
existing steps. Select the destination step, then either click OK to confirm or
Cancel to quit.

SFC Jump properties X

Analog_setpoint OK l
Auto_Phase_0

Auto Phase 1 Cancel
Manual_setpoint
Test_Phase_0
Test_Phase_1
Test_Phase_2
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Editing SFC Networks

Description

The SFC editor is endowed with functions common to most graphic applications
running on a Windows platform, namely:

« Selection of a block.

+ Selection of a set of blocks by pressing Ctrl + left button.

o
+ Edit> Cut CE‘ , Edit > Copy O , Edit > Paste Ej operations of a single
block as well as of a set of blocks.

+ Drag-and-drop.

Variables Editor

Overview

Description

Programming includes a graphical editor for both global and local variables that
supplies an interface for declaring and editing variables: the tool takes care of
translating the contents of these editors into syntactically correct IEC 61131-3

source code.

As an example, consider the contents of the Global variables editor represented in

the following figure:

Name
gA
gB
gC
gD

AWOWN =

Type
BOOL
REAL
REAL
INT

Address Array Init value Attribute
Auto No TRUE -
Auto [0...4] -
%MD60.20 | No 1.0
Auto No -74 CONSTANT

The corresponding source code is represented like this:

VAR GLOBAL
gA : BOOL := TRUE;
gB : ARRAY[ 0..4 ] OF REAL;
gC AT %MD60.20 : REAL := 1.0;
END VAR
VAR GLOBAL CONSTANT
gh : INT := -74;
END VAR
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Opening a Variables Editor

Opening the Global Variables Editor

To open the Global variables editor, double-click Global variables in the project

tree:
Project X Name Type Address
a 2] MyProject Project 1 | parCtDownPreset = UDINT Auto
Programs 2 | parCtUpPreset UDINT Auto
Function blocks 3 | parPulseValue UDINT Auto
Functions 4 | parPulseWidth UDINT Auto
e G'Ob' porabe-2 y 5  parTimOnDelay ~ UDINT  Auto
utomatic variables 6 | parTimOnvalue  UDINT Auto
Mapped variables -
7 | pidkD REAL Auto
Constants i .
Retain variables 8 | pidK REAL %MD1

NOTE: If you use the customizable workspace, page 102, the global variables

are accessible under the icon m Global variables group.

Opening a Local Variables Editor

To open a local variables editor, double-click the Program Organization Unit that
contains the local variables you want to edit:

Project Il X Local variables
)
B 2] MyProject Project Name Type Address
8 - Progams 1 | foDelay TON Auto
g LadderLogic 2 | fbCtu CTU_DINT  Auto
B PidControl
% PidModeSelector 3 | fbCtd CTU_DINT  Auto
= Temperature_Control 4 | bTp TP Auto
Function blocks 5 | ettp UDINT Auto

NOTE: If you use the customizable workspace, page 102, the local variables
are accessible under the POU, in the Local variables group.

Creating a New Variable

Description

Create a new variable, by applying one of the following operations:
* Inthe menu, click Variables > Insert.

* In the Project toolbar, click .
* Press the CtrI+Shift+Iinsert keys.

Editing Variables

Description

Follow this procedure to edit the declaration of a variable in a variables editor (the
following steps are optional and you will skip most of them when editing a
variable):
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Step Action
1
Edit the name of the variable by entering the new name in the corresponding cell:
Name Type | Address Group Array
1 BOOL | Auto Ungrouped_vars No
2 gB REAL | Auto Ungrouped_vars [0...4]
3 | gC REAL | %MD60.20 MyMapped_vars No
4 | gb INT Auto MyConstants_vars | No
2
Modify the variable type, either by editing the type name in the corresponding cell or by
clicking the button in that cell and select the desired type from the list that pops up:
Name Type Address Group
1 gA BOOL Auto Ungrouped_vars
2 gB REAL Auto Ungrouped_vars
3 gC REAL %MD60.20 MyMapped_vars
4 gD INT Auto MyConstants_vars
3
Edit the address of the variable by clicking the button in the corresponding cell and
entering the required information in the window that shows up. In the case of global
variables, this operation may change the position of the variable in the project tree:
Name Type Address Group
1 gA BOOL | Auto Ungrouped_vars
2 | ¢gB REAL | Au Ungrouped_vars
3 g¢C REAL P OD MyMapped_vars
4 | gb INT Auto MyConstants_vars
Variable address X
Automatic address
Size Location
OBit QO Input
O Byte (8 bit) O Output
OWord (16 blt) @Memory
@ Double word (32 bit)
OK
Data block  Index -
4
In the case of global variables, you can assign the variable to a group, by selecting it
from the list which opens when you click the corresponding cell. This operation changes
the position of the variable in the project tree:
Name Type | Address Group Array
1 gA BOOL  Auto Ungrouped_vars w | No
2 | gB REAL | Auto [0...4]
3| gc REAL | %MD60.20 mthAO”S‘agts_Vafs No
yMapped_vars
4|90 INT | Auto Ungrouped_vars No
5

Choose whether a variable is an array or not. If it is, edit the size of the variable:

Name Type Address Group Array Init value
1 dgA BOOL | Auto Ungrouped_vars No TRUE
2 gB REAL = Auto Ungrouped_vars |
3 gC REAL | %MD60.20 MyMapped_vars No 1.0
4 gD INT Auto MyConstants_vars | No -74
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Deleting Variables

Description

Step Action
Size of variable X
O Scalar
@ Array / Matrix
Dimensions | 5
[ OK ] [ Cancel ]
6
Edit the initial values of the variable: click the button in the corresponding cell and enter
the values in the window that pops up:
72 Init values for: gB (REAL) X
[0,1,2,1,0]
[ OK ] [ Cancel ]
7
Assign an attribute to the variable (for example, CONSTANT or RETAIN), by selecting it
from the list which opens when you click the corresponding cell:
Name Type | Address Group | Array Init value Attribute
1 gA BOOL | Auto Ungrouped_vars No TRUE
2  gB REAL | Auto Ungrouped_vars [0...4] [0,1,2,1,0] |
3| gC REAL | %MD60.20 MyMapped_vars | No 1.0 CONSTANT
4 | gD INT Auto MyConstants_vars | No -74 TAIN
8
Type a description for the variable in the corresponding cell. In the case of global
variables, this operation may modify the position of the variable in the project tree:
Name | Type | Address Group | Array Init value Attribute Description
1] gA BOOL ' Auto Ungrouped_vars No TRUE = Global variable I
2 gB REAL | Auto Ungrouped_vars [0...4] [0,1,2,1,0] @ -- Global variable B
3 gC REAL | %MD60.20 |MyMapped_vars No 1.0 Global variable C
4  gb INT Auto MyConstants_vars | No -74 CONSTANT | Global variable D
9 Save the project to persist the changes you made to the declaration of the variable.

In order to delete one or more variables, select them in the editor. You can use the
Ctrl or the Shift keys to select multiple elements:

Name | Type @ Address Group Array Init value
1 |G_I_iTe/INT Auto Ungrouped_vars No
2 G_l_iSe INT Auto Ungrouped_vars No
3 |G_LiDi INT Auto Ungrouped_vars No 1
4 |G_I_iC BOOL | Auto Ungrouped_vars No
5 G_I_iAl | BOOL | Auto Ungrouped_vars No
6 gA BOOL ' Auto Ungrouped_vars No TRUE
7 gB REAL | Auto Ungrouped_vars [0...4] [0,1,2,1,0]
8 gC REAL | %MD60.20 MyMapped_vars No 1.0
9 gb INT Auto MyConstants_vars = No -74

Delete selected variable(s), by applying one of the following operations:
* Inthe menu, click Variables > Delete.
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* In the Project toolbar, click ﬁ
* Press the Delete key.
You cannot delete the RESULT of an IEC 61131-3 FUNCTION.

Sorting Variables

Description

You can sort the variables in the editor by clicking the column header of the field
you want to use as the sorting criterion.

Copying Variables

Description

The variables editor allows you to copy and paste elements. You can either use

keyboard shortcuts or the Edit > Copy Ij—'l , Edit > Paste Ej menu.

NOTE: Overlapping addresses problems may occur by copying mapped
variables. Programming can automatically assign available address to the
pasted variable and fix the overlap. In order to enable this functionality, refer to
Software Options, page 38 and Merge Function, page 113 for further details.

Creating an Error Variable

Description

Error variables are implemented only in the M1730 controllers.

Create an error variable by choosing from the error messages available:

sysErrMsg Error ID Error Message Blink Mode

sysErrMsg0 -1000 OUT OF RANGE () 0 = Blink OFF ®
1 =Blink ON
2 = Blink Fast

SysErrMsg1 -32768 PROBE ERROR (1) 0 = Blink OFF ©®)
1 =Blink ON
2 = Blink Fast

sysErrMsg2 -32767 REMOTE PROBE 0 = Blink OFF ®
ERROR ™
1=Blink ON

2 = Blink Fast

sysErrMsg3 -32766 PROBE CONFIG 0 = Blink OFF ®
ERROR ™
1 =Blink ON

2 = Blink Fast

sysErrMsg4 -32765 Al PAIRS ERROR (1) 0 = Blink OFF ®)
1 =Blink ON
2 = Blink Fast

sysErrMsg5 -32764 -@ 0 = Blink OFF )
1 =Blink ON
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sysErrMsg Error ID Error Message Blink Mode
2 = Blink Fast
sysErrMsg6 -32763 -@ 0 = Blink OFF 3
1=Blink ON
2 = Blink Fast
sysErrMsg7 -32762 -@ 0 = Blink OFF @)
1=Blink ON
2 = Blink Fast

(1) Editable default message (max 20 characters). The meaning of the error does not change but
the text message displayed can be changed.

(2) Default empty string, to be modified with the error you want to display (max 20 characters)

(3) Default Blink Mode

The Error Message is displayed when the variable to be shown has a value equal
to the Error ID.

NOTICE

Do not modify the Error ID value. Error ID represents the value associated with
the sysErrMsg.

Failure to follow these instructions can result in equipment damage.

Watch 4 x Library tree & x
BB e mER| ¢+ |a W
Symbol Value Type Location ° gl Project libraries
— il -32768 INT global © ¢l Operators and blocks
—i2 0 INT global © i Target
Te t block:
ot O @ rmiece
== ErrorlD -1000 DINT
rer @ & Targetvariables
ErrorMsg ‘OUT OF RANGE’ STRING
© e Analog_Inputs
— BlinkMode 0 DINT © 6 Analog_Outputs
[=] sysErrMsg1 - TypeErrMsg © e Digital_Inputs
== ErrorlD -32768 DINT © @ Digital_Outputs
ErrorMsg ‘PROBE ERROR’ STRING © e Display
== BlinkMode 0 DINT isEditWhiticon
ol C tM ID
[5=] sysErrMsg2 - TypeErrMsg % :ZE':;\ZI;O enu
== ErrorlID -32767 DINT =
ErrorMsg ‘REMOTE PROBE ERROR’ STRING [&=] sysErrMsg2
— BlinkMode 0 DINT [] sysErrMsg3
sysErrMsg4
[&=] sysErrMsg3 - TypeErrMsg % sstrrMsgs
== ErrorlD -32766 DINT [==] sysErrMsg6
ErrorMsg ‘PROBE CONFIG ERROR’ STRING [&=] sysErrMsg7
= BlinkMode 0 DINT = sysGoToMenulD
syslcons
[5=] sysErrMsg4 - TypeErrMsg % s;,sKeyboard
== ErrorlD -32765 DINT sysKeyFunctions
ErrorMsg ‘Al PAIRS ERROR’ STRING [B] sysLogicalKeys

To insert a new error message:

» Inthe Library Tree click Target > Target Variables > Display and choose the
appropriate sysErrMsg.

» Load sysErrMsg on the Watch Window (Refer to Watch Window, page 195 for
details) and modify, if necessary, the description of the error you want to
display with double-click on the ErrorMsg in the Value column.

* Modify the parameter with the value of the Error ID associated with the
chosen sysErrMsg.
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Compiling

What’s in This Chapter

OVEIVIEW ...ttt ettt e ettt e et et e e e e e et e e e e eataeeaeees 173
Compiling the Project...... ..o 173
ComPpiler OULPUL.....coeu e 174
Command-Ling COMPIIET ........coouueiii e 176

Overview

Description

Compilation consists of transforming the PLC source code into another
programming language (the target language) such as binary code, which can be
executed by the processor on the target device.

Compiling the Project
Overview

Prerequisite

Before starting the compilation, make sure that at least one program has been
assigned to a task:

= ﬂ Tasks
B 2 Timed
ﬂ :‘, Background
© @ MyMain

Boot

Init

Otherwise, compilation aborts with a meaningful error message:

Output

error P2068: No task defined for the application

0 warnings, 1 errors.

Build  Find in project Debug Resources HMI Output

Compiling the Project
Start compiling the project, by applying one of the following operations:
* Inthe menu, click sl Project > Compile.

.
* In the Project toolbar, click il
* Pressthe F7 key.

NOTE: Programming automatically saves the changes to the project before
starting the compilation.
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Image File Loading

Description

Before performing the compilation, the compiler needs to load the image file (*.
img file), which contains the memory map of the target device. If the target is
connected when compilation is started, the compiler seeks the image file directly
on the target. Otherwise, it loads the local copy of the image file from the working
folder. If the target device is disconnected and there is no local copy of the image
file, compilation cannot be carried out: you are then required to connect to a
working target device.

PlcExample.img - error IO0001:
Invalid memory image file.
Please upload memory image from the target

Build  Find in project Debug Resources HMI Output

Compiler Output

Overview

Description

As the previous step is accomplished, the compiler performs the compilation, then
displays a report in the Output window. The last string of the report has the
following format:

m warnings, n errors

Condition Description

n>0 Compiler error(s). The PLC code contains one or more serious detected errors,
which require intervention. No executable code was generated.

n=0, m>0 Emission of warning(s). The PLC code contains one or more minor detected
errors, which the compiler automatically worked around. However, you are
informed that the PLC program may act differently from what you intend.

You should correct these minor errors by editing and recompiling the application
until no other messages are reported.

n=m=0 The compilation was successful in that no errors or warnings were detected.
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Compiler Errors

Description

When your application contains one or more errors, information is displayed in the

Output window for each of those detected errors.

Output

Preprocessing Global shared completed.

0 warnings, 0 errors.

Preprocessing user defined data .. completed.
Compiling programs .. completed.

Compiling function blocks .. completed.
Compiling functions .. completed.
Preprocessing user defined data .. completed.

Code generation ..

Preprocessing EmbeddedElements completed.
aborted.

MAIN(1l) - error A4097: N1 => Object not found

0 warnings, 1 errors.

Build  Find in project Debug Resources HMI Output

For each detected error, the information includes:
» The name of the Program Organization Unit affected by the error;
» The number of the source code line which procured the error;
» The type of error:
° error: serious error
o warning: minor error
¢ The error code;
* The error description.

For more information, refer to Compile Time Error Messages, page 302.
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If you double-click the error message in the Output window, Programming opens
the source code and highlights the line containing the detected error:

Project a4 x

@ & MyProject Project
Al \1yMain

EB® Ungrouped_vars
g Aux Variables
[] Tasks

R+ )]+ ]

Local variables | gz] Project

< >
MyMain

Output a1 x
Preprocessing user defined data .. completed.
Compiling programs .. completed.

Compiling function blocks .. completed.

Compiling functions .. completed.

Preprocessing user defined data .. completed.

Code generation ..

Preprocessing EmbeddedElements completed.
aborted.

MYMAIN (2) - error A4097: CNT2 => Object not found

0 warnings, 1 errors.

Build = Find in project Debug Resources HMI Output

Command-Line Compiler

Description

The compiler can be used independently from the integrated software
environment: in the directory of EcoStruxure Machine Expert - HVAC, you can find
an executable file, EWc.exe, which can be invoked (for example, in a batch file)
with a number of options.

In order to get information about the syntax and the options of this command-line
tool, launch the executable without parameters.

176 EI00000003412.05



Launching the Application

Launching the Application

Overview

Description

What’s in This Chapter

OVEBIVIBW .. et 177
Setting Up the Communication ............cc.oiiiiiiiiiii e 177
CoNNECE IO @ DBVICE .. .eeceeeeiiee e 182
ON-LINE STAtUS ...eeee 183
Downloading the Application ..., 184
Control the PLC EXECULION ......cvviiiiii e 185

In order to download and debug the application, you have to establish a
connection with the target device. This chapter focuses on the operations required
to connect to the target and to download the application. A separate chapter is
dedicated to Debugging, page 195.

Setting Up the Communication

Overview

Description

In order to establish the connection with the target device, verify all connections
and network communication.

Follow this procedure to set up and establish the connection to the target device:

Step Action
1
Click On-line > Set up communication... menu of the Programming tab. This causes
the following dialog box to appear.
Device Link Manager Config X
Selected protocol: Modbus
Protocols Active
¥ Can
¥ GDB
Active
¥ ModbusTCP
¥ TM171ADMI
Description
Modbus Protocol
[ OK ] [ Cancel ]
2 Select the appropriate protocol:
« CAN, page 178
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Step Action

+ GDB, page 178

* Modbus, page 178

*  ModbusTCP, page 179
«  TM171ADMI, page 181

3 Click Activate button to active the protocol.
4 Click Properties button to modify the properties of the activated protocol.
5 Fill in all the protocol-specific settings.

For example: the address or the communication
timeout (that is how long Programming must wait for an answer from the target before
displaying a communication error message).

6 Click OK button to apply the changes you made to the communication settings.

Now, you can establish communication with the target, page 182.

Select CAN in the case of CAN connection:
Parameter Description Values Default Note
Baud_CAN_OB CAN protocol baud rate | 2 =500 kbaud 2 -
On-board 3 =250 kbaud
4 =125 kbaud
5 =125 kbaud
6 =50 kbaud
Addr_CAN_OB On-board CAN serial 1...127 1 The address is determined by the sum of
address this value the value of the DIP switches
The GDB protocol is not implemented in the M171/M172/M1730 controllers.
The GDB protocol is reserved for internal software use.
Modbus
Select Modbus in the case of USB/RS-485 connection:
Parameter Description Values Default Note
Baud_RS485_0OB Modbus protocol baud 0 =9600 baud 2 -
rate On-board
1=19200 baud
2 =38400 baud
3 =57600 baud
4 =76800 baud
5=115200 baud
Addr_RS485 OB On-board RS-485 serial 1...255 1 The address is determined by the
address sum of this value the value of the DIP
switches
Proto_RS485_0OB On-board RS-485 2 =uNET 3 -
protocol selection
3 = Modbus/RTU
4 =BACnet MS/TP
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Parameter Description Values Default Note
Databit_RS485_0OB RS-485 data bit number 8 8 Fixed at 8
On-board
Stopbit_ RS485_0OB On-board RS-485 stop bit | 1 =1 stop bit 1 -
number
2 =2 stop bit
Parity_RS485_0OB On-board RS-485 0=NULL 2 -
protocol parity
1=0DD
2 =EVEN

Modbus TCP

Select the ModbusTCP protocol in the case of Ethernet connection, using the
relevant communication module if necessary.

In the protocol properties window:

+ The IP or hostname box is for entering either an |IP address (the default
setting for M171P/M172P is 10.0.0.100) or a host name on a local network.

« The TCP/IP communication Port box is set by default to 502.
Connect the PC Ethernet cable to M171P/M172P.

Configure the TCP/IPv4 connection in the Ethernet port properties of your PC with
the address (10.0.0.101):

Internet Protocol Version 4 (TCP/IPv4) Properties X

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(O Obtain an IP address automatically

@ Use the following IP address:
IP address: 10.000 .000 .101
Subnet mask: 255 .255 .255 .255

Default gateway:

@ Use the following DNS server addresses:
Preferred DNS server:

Alternate DNS server:

[ Validate settings upon exit

[ OK ][ Cancel]

NOTE: The default M171P/M172P configuration is 10.0.0.100: the PC
Ethernet port is thus configured with an address different to the default
address (for example 10.0.0.101, the first three fields must be the same, the
fourth different).

Click the OK button: the PC is configured to dialog with M171P/M172P via the
Ethernet port.

M171P/M172P has a number of BIOS parameters for managing the connection
between the target and EcoStruxure Machine Expert - HVAC but, unlike M1710, it
does not have a default menu displayed on the on-board or remote display.

Passive Ethernet Plugin:
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The Ethernet passive plug-in configuration parameters involve the configuration of
the TCP/IP communication port (for example 502), the IP address, the gateway,
and the subnet mask.

The “Default Gateway” parameters are not relevant in the local point-to-point

network.

For connections via a router the “Default Gateway”, parameters must be set
according to the network configuration, as in the following example:

Parameter Description Value Parameter Description Value
Ip_1_ETH_PI Ethernet passive Plug-in 192 DefGtwy_1_ETH_PI Default Gateway 192
IP address (first part) (first part)
Ip_2_ETH_PI Ethernet passive Plug-in IP 168 DefGtwy_2_ETH_PI Default Gateway 168
address
(second part)
(second part)
Ip_3_ETH_PI Ethernet passive Plug-in IP 0 DefGtwy_3_ETH_PI Default Gateway 0
address
(third part)
(third part)
Ip_4_ETH_PI Ethernet passive Plug-in IP 100 DefGtwy_4 _ETH_PI Default Gateway 1
address
(fourth part)
(fourth part)
M171P Flush Mounting Specific HMI Management:
In addition to the BIOS parameters, M171P Flush Mounting manages the HMI
menu:
Parameter Description Values Default Note
Hmi_language Display language 0...65535 0 -
(local or remote)
HMIList_current Current HMI 0 = Remote HMI 1/ 1 = Remote HMI 2 11 Local HMI is identified on
the display as network In
2 = Remote HMI 3/ 3 = Remote HMI 4 Connection as HMI
4 = Remote HMI 5/ 5 = Remote HMI 6 Remote HMI is identified
In Connection as
6 = Remote HMI 7 / 7 = Remote HMI 8 Remote HMI
8 = Remote HMI 9/ 9 = Remote HMI 10
10 = not used
11 = Local HMI
Ten remote menus are available. The first menu parameters are listed below. The
others are similar:
Parameter Description Values Default Note
HmiList_ID_1 Remote HMI 1 navigation ID list 0...254 0 -
HmiList_Res_1 Remote HMI 1 navigation resource 1=RTU (RS-485 Modbus 3=CAN -
type RTU)
2 =TCP (Modbus TCP)
3 =CAN (CAN)
HmiList_Addr_1 Remote HMI 1 navigation resource 0...255 0 For example:
address for CAN, RTU, and TCP (IP
part 1) CAN:
HmiList_Addr_2 Remote HMI 1 navigation resource 0...255 0 2.500000
address for TCP
IP part 2
(Pp ) RS-485:
HmiList_Addr_3 Remote HMI 1 navigation resource 0...255 0
HIStAdAL vigat ! 1.38400.P81

address for TCP
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Parameter Description Values Default Note
(IP part 3) Modbus TCP:
HmiList_Addr_4 Remote HMI 1 navigation resource 0...255 0 010.000.000.100
address for TCP
(IP part 4)
HmiList_File_1 Remote HMI navigation file 1 (DOS Alphanumeric string, 8 b The default name is
8.3 uppercase format) characters HMIREM.KBD

Select TM171ADMI in the case of connection with the M1710 with the

TM171ADMI programming cable.

M1710 has parameters in the CF folder in the controller for managing the
connection between the target and EcoStruxure Machine Expert - HVAC.

If the target is “empty”, for example there is no controller application on the device,
M1710 displays the message F r E E. Otherwise, a controller application exists
on M1710 and the message PLC appears on the display. Simultaneously press
the UP and DOWN keys to view the message.

Follow this procedure to modify a parameter:

Step | Action

Result

1
From the main display, press the set key
and the esc key simultaneously to open the
programming menu:

The programming menu is opened.

The label of the first subfolder is displayed
(PAr in this case):

£ Wt Schneider
A - - -
é'. ;.r.}.F org
@ "tt e
3 0000000 F

T Sceider
I' ,-, ,-, 'I
i cor e
R <
B 00000006 F4

2 Press set key to open the Parameters
menu.

The label of the first subfolder is displayed
(CL).

3 Press the UP and DOWN keys to scroll the
other labels until you find the one indicated
by CF.

4 Press set key to open the folder.

The label of the first parameter is displaye

d.

5 Press the UP and DOWN keys to scroll
through the various parameters until you
find the connection parameters.

6 Press set key to view the value of the
parameter.

The value of the parameter is displayed.

7 Press the UP and DOWN keys to modify this
value.

8 Press set key to validate the new value of
the parameter.

NOTE: Press esc to take you back to
the previous folder without saving the
value entered.

9 Press esc key to go back to the main
display.

10 Use the UP and DOWN keys to scroll the
other parameters and repeat the procedure
(step 5 to 9) to view the values and - if
necessary - edit them.

EIO0000003412.05

181




Launching the Application

The parameters values needed for correct connection between the M1710 target

and EcoStruxure Machine Expert - HVAC:

Parameter Description Values Default Parameter Note
Visibility
Level
CFO1 (M Select COM1 0 = reserved 1 2 Must be set to 1
(TTL) protocol
1 =Modbus
CF30 Modbus protocol 1...255 1 3 Check that the set values correspond
controller address to those defined by the tab
CF31@ Modbus protocol 0, 1, 2 = not used 3 3 On-line > Set up > Communication
baud rate :
3 = 9600 baud > Properties
4 =19200 baud
5 =38400 baud
6 = 57600 baud
7 = 115200 baud
CF32 Modbus protocol 1=EVEN 1 3
controller parity
2 =NONE
3=0DD

(1) COM1 = The TTL port and the RS-485 port cannot be used simultaneously.

(2) CF31

5 = 38400 baud (RS-485: not supported)
6 = 57600 baud (RS-485: not supported)
7 = 115200 baud (RS-485: not supported)

For other parameters and to manage parameter visibility levels, refer to Modicon

M171 Optimized Logic Controller Hardware Guide.

Saving the Last Used Communication Port

Description

When you connect to target devices using a serial port (COM port), you usually
use the same port for all devices (many PCs have only one COM port). You may
save the last used COM port and let Programming use that port to override the
project settings: this feature is useful when you share projects with other
developers, which may use a different COM port to connect to the target device.

In order to save your COM port settings, enable the Use last port option in File >

Options... > General tab.

Connect to a Device

Prerequisite
You have to set up the communication, page 177.

Procedure
To launch the connection to the physical device, perform one of the following
operations:
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¢ |In the dedicated toolbar, click Y

[ N
* In the menu, click T On-Line > Connect.

Information Messages

Before establishing the connection, the software could display an information

message:
Message Cause Risk Solution
“Target Device ID The firmware of the Unintended * Update the BIOS
indicated for the device in the Equipment Operation of the physically
project is different application is different connected
from the value from from the firmware of device.
W terge, Proceed | thephysically - Change e

yway « : device in the

“Could not correctly application
identify the connected + Change the
device: found a physical device.
M172 668.11 instead.
Connect anyway?”

Click OK to continue the connection process.

On-Line Status

Connection Status

Description

The state of communication is displayed in a box next to the right border of the
Status bar.

If you have not yet attempted to connect to the target, the state of communication
is set to Not connected.

NOT CONNECTED

When you connect to the target device, the state of communication becomes one
of the following:

. ERROR

Error: the communication cannot be established. You should verify both the
physical link and the communication settings, page 177.

. CONNECTED

Connected: the communication has been established.

Project Status

Description

Next to the communication status there is another box which indicates the status
of the project currently executing on the target device.

EI00000003412.05 183



Launching the Application

When the connection status is Connected, the project status takes on one of the
following values (depending on source code):
NO CODE

No code: no project is executing on the target device.

DIFF. CODE

Diff. code: the project currently executing on the target device differs from the
one currently open in the software; moreover, no debug information
consistent with the running project is available: thus, the values displayed in
the watch window or in the oscilloscope are not reliable and the debug mode
cannot be activated.

DIFF. CODE (SYM)

Diff. code, Symbols OK: the project currently executing on the target device is
not the same as the one currently open in the software; however, some debug
information consistent with the running project is available (for example, the
project has been previously downloaded to the target device from the same
PC): the values displayed in the watch window or in the oscilloscope are
reliable, but the debug mode still cannot be activated.

. SOURCE OK

Source OK: the project currently executing on the target device is the same
as the one currently open in the software: the debug mode can be activated.

Downloading the Application

Description
A compiled PLC application must be downloaded to the target device in order to
have the processor execute it. The steps presents how to download an application
code into a target device.
Step Action
1 Connect the target device to the PC where EcoStruxure Machine Expert - HVAC is
running.
2
Click L,i On-line > Download code.
Result:
Programming verifies whether the project has unsaved changes. If so, it automatically
starts the compilation of the application.
The binary code is sent to the target device.
After the end of the download, the controller automatically resets.
Then the downloaded code is executed by the processor on the target device.
AUTOMATIC RESTART OF CONTROLLER
+ Do not download your application without first accessing the state of your
machine or process.
» Do not download your application without first ascertaining that there is no
risk of injury to anyone in or around your machine or process.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Control the PLC Execution

Overview

Halt

Cold Restart

The PLC application execution can be controlled using the related functions.

These functions are accessible in the Project toolbar, page 97 and in the On-line
menu, page 28.

The controller will start executing program logic when power is applied to the
equipment. It is essential to know in advance how the outputs will affect the
process or machine being controlled.

At start up, the controller will attempt to start executing program logic when power
is applied to the equipment, regardless of the reason the controller had previously
stopped. It is essential to know in advance how an unconditional start will affect
the process or machine being controlled.

AWARNING

UNINTENDED MACHINE START-UP

» Conduct a thorough risk analysis to determine the effects, under all
conditions, of an unconditional start of the application.

« Verify the state of security of your machine or process environment before
applying power to the controller or starting the application with EcoStruxure
Machine Expert - HVAC software.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

AWARNING

UNINTENDED EQUIPMENT OPERATION

* Never assume that your controller is in a certain controller state before
commanding a change of state, configuring your controller options, or
modifying the physical configuration of the controller and its connected
equipment.

» Before performing any of these operations, consider the effect on all
connected equipment.

» Before acting on a controller, always positively confirm the controller state,
checking for the presence of output forcing, and reviewing the controller
status information via EcoStruxure Machine Expert — HVAC.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

You can stop the PLC execution by clicking B On-line > Halt.

The PLC application execution will be restarted and both retain and non-retain
variables will be reset.

You can cold restart the PLC execution by clicking @ On-line > Cold restart.
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Warm Restart

The PLC application execution will be restarted and only non-retain variables will
be reset.

You can warm restart the PLC execution by clicking @ On-line > Warm restart.

Hot Restart

The PLC application execution will be restarted and no variables will be reset.

You can hot restart the PLC execution by clicking @ On-line > Hot restart.

Reboot Target

You can reboot the target by clicking * On-line > Reboot target.
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Simulation

What’s in This Chapter

SIMUIAtion FUNCHON ......coeiei e 187
Simulation Operating Modes ............ooiiiiiiiiii e 188
Simulation with EcoStruxure Machine Expert- HVAC.............cccooeiiiiiiiieeennn.. 189
SIMUIAtioN INtEIfACE.......ceie i 190

Simulation Function

Overview

Main Purpose

The main purpose of the simulation function is to execute PLC applications and
HMI pages simultaneously in a simulated environment.

Simulation can simulate execution of:
» PLC applications, IEC 61131-3 (made in Programming tab).
« HMI pages (made in Display tab).

The execution can thus take place on the same PC used for the development
process with the advantage of a faster and simpler testing and debugging phase
because the real final hardware is not necessary.

NOTE: The simulation is not intended as a substitute for real, empirical testing
during commissioning. It is a means for the programmer to submit its
application, or parts of application, to unit testing and verification. Only
empirical testing with live equipment in the complete application can be
considered a valid mechanism for validation.

AWARNING

UNINTENDED EQUIPMENT OPERATION

Always empirically test your application during commissioning before placing
your application and associated equipment into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Simulation Environment Components

Description

The following diagram shows the main components of the simulated environment:

il

Item | Description

1 Simulation Simulation function allows you to execute PLC applications and
HMI pages simultaneously in a simulated environment.

2 Programming PLC development environment.

3 Display HMI development environment.

4 TCP/IP Server Assignment to the simulated controller of a local IP address for
communication with development environments.

5 Catalog Repository of the target definitions, used by the software
components.

6 Target file (TGSX) Catalog components that define the targets to simulate. These

files have TGSX extension.

7 Workspace file (WKSX) | User file with WKSX extension that contains the elements of a
working session of the simulator (1/O panels, source PLC, HMI
project, and so on). The project can have multiple simulation
workspace files, and you can manage them.

Simulation Operating Modes

Overview

Simulation is activated when the target simulation file (TGSX) is available in the
catalog.

The correct TGSX file is selected automatically by the calling program, depending
on the current active target in the PLC or HMI project.
Simulation has the following features:

» Simultaneous simulation of both PLC application and HMI pages.

+ Availability of the target panel to have a visual and realistic representation of
the target to run and interact with HMI pages.

» Execution of the simulated application tasks handled by a scheduler that can
reproduce the real target scheduler policy.
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» The simulated target can have some parts implemented in C and/or IEC to
implement the real target behavior and characteristics to react to PLC
application as the real target would do.

+ Use of the I/O panels, that you can configure to view and/or modify the
simulated status and I/O variables of the target.

Simulation with EcoStruxure Machine Expert - HVAC

Start the Simulation

To carry out a simulation session:

Step Action

1 Write your PLC code in Programming or your HMI pages in Display.

2
Click hﬂ to compile the project and to check the correctness of the code.

3 According to the tab:
* In Programming tab, click Debug > Simulation mode to activate the simulation.

- F
» In Display tab, click Simulation mode icon.

You can choose to open a recently used simulator workspace (WKSX) or create a new
one if it is the first simulation session with this project. The last used workspace is then
proposed as the default choice. The list of the used workspaces is saved inside the
project itself.

Choose workspace X

Create new workspace
Name:

Directory:

®) Open existing workspace Choose other... Delete

simESME11.WKSX

OK Cancel

Click OK.

Result: The simulation control panel is displayed, page 191.

5 Compile and download the code inside the simulated target.

NOTE: EcoStruxure Machine Expert - HVAC can activate the simulation
status that is similar to the normal connection to a physical target device, with
a different connection status indicator. While in simulation status, the project
will be built for the x86 processor and the connection will take place using the
GDB protocol over TCP/IP on the local host (127.0.0.1).

Use the Simulation

The simulation mode makes it possible to verify that the behavior of the controller
conforms to your expectations.
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If not, you must correct any anomalies present in the project before its actual
commissioning.

To test your project, you can:

» Simulate local I/O and work on pages (with mouse and keyboard) in the target
panel (if there is one).

* Modify the values of the application parameters with the 1/0 panels.
For more details, refer to Simulator Interface, page 190.

NOTE: You can debug with the Programming debugging features, page 195,
independently of the real target.

Stop the Simulation

The simulation session is terminated when you deactivate the simulation mode
inside EcoStruxure Machine Expert - HVAC (and the simulator is automatically
closed).

You can also manually close simulation. In this case, the communication or the
next downloads in EcoStruxure Machine Expert - HVAC go in the timeout state, as
in the real situation when the physical target is powered off or disconnected.

When the simulation is stopped, everything is saved inside the current workspace
(I/O panels, window positions, and so on).

EcoStruxure Machine Expert - HVAC saves the list of recently used workspaces
inside the project for further use.

Simulation Interface

Simulation Interface Overview

Overview

Control Panel

[ simulation - SMESME11.WKSX -

File Help

o=
8

[}

Workspace:  imESME11.WKSX

Targetname: 172 performance 599

PLCproject: 5 \HVAC_Projects\ESME_Thermostat_M172iThermsotat_M172.picprj

HMIprojoct. DHVAC

1/0 panels.

| | s

. Thermostat ! L M172 paix

Output window.

Simulation is dialog-based Windows program that is one or more independent
windows that can be moved and placed on the screen.

The following pictures show the main windows:

Target Panel 1/0 panels

580

OO

*+ Starting to load PLC for runtime 0 (typeOfStart
++ PIC loaded into memory

” 1] e —— e —

7] S UUOOO0IO= 00000000 W ——

- s ——
Wi ——

e —

e —

g —

) e ——
Ehs ——

OOO0CT00000=00I0000000 e ool R

@ —r—

gz —F—

, Sl a— B —
O T a— B R—

o] I C—

o — B C—

[T — I —

o T — ] —
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Control Panel

Overview

Target Panel

Overview

ElfFori vave -
EfForvave -

This is the main window of the simulator. When you launch the simulator, the
control panel is shown in a compacted form, with 5 main buttons and no menu bar.

When you click the Expand button, it is expanded to show:
* The menu bar with the standard new/load/save/exit commands.
« A central panel showing the main characteristics of the current workspace.
* An output window showing execution logs.
* The I/O panels list.

With the control panel, you can control and monitor the state of the simulated PLC
runtime, choose which other windows to show or hide (and their topmost
behavior), and manage I/O panels.

Compacted Control Panel Expanded Control Panel
2 3 4 5 B simulation - SMESME11.WKSX - X
b )
. Q==
Simyl.. T X P
orapse: et ik
Targetname: 172 Performance 596.9
1‘% b | O
’ HMI project:  D\HVAC. Thermostat, M172.paix

O panels

ui

Add_| Removel Rename| % Loading) orce
- P e
- tas

1 Stop PLC code
2 Run PLC code

3 Show Target Panel, page 191 - .
4 Show |/O Panels, page 192

5 Expand Control Panel

6 Target Panel topmost (foreground)

7 1/0O Panel topmost (foreground)

This is a floating window that shows a visual representation of the simulated
physical target. Its presence and layout is defined inside the target definition file
(TGSX).

This panel has an image of the real target, with some sensible areas that show
simulated inputs or outputs (for example LEDs for digital outputs) and a simulated
LCD graphic display where the HMI pages are drawn.
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1/0 Panels

Overview

You can interact with this panel with the mouse or with the PC keyboard that

emulates the real device keys.

You can right-click on it and select:

+ Topmost: place the panel in foreground (it stays always above any other

window).

* Locked: you can no more move the panel on your screen.

* Close: close the panel.

1 Simulated buttons

2 Simulated LEDs

3 Simulated LCD screen
4 Simulated 1/0Os

These small floating windows lets you monitor and modify the values of the
various |/O and status variables of the simulated target; the only requirement is

that the object to watch is allocated on data-block.

You can create as many I/O Panels as you want. You can also decide which
objects to put on each panel freely. They are complementary to the target panel
because with them you can watch and edit the /O modules that are not already

visible there.

The 1/O panels can be put in Topmost mode (always above the visible windows).
This is useful for example while debugging with Programming at full screen. The

configuration is then saved inside the workspace file.

192
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Adding Elements to Panels

To add an element (or “signal”) to an existing I/O panel to watch or edit its value,
you can drag it from Programming inside the panel itself. You can drag it from the
target variables panel, from the workspace tree, or from a variables grid inside an
editor.

@ o Btruxe C:\My Project\My Project.plcprj Schneider — 8 X
Machine Expert - HVA( DEE &

Dor ] comimono I
m File Edit View Project Ondine Debug Variables Window Tools Help _0x
|2< Arplved REOERED M S
L@ ¥ 909 F SN AE @ E
|72 0od0im=® ve
. B —_——
Iy LU SDBOODH-IW @ B[z —F— 0
| nalo0e ot oS ——
B[R —_— 0
Project # X Local variables fns L 0
B8 - Progams ~ BlfAis —
& e ATC_Control Name Type Address Array Init value Attribute H Bl —_——
0 £ Local variables E[ALs — D
[P EVE_Comm HEIm —F—f
*3P Thermostat Blfaio —_—r
[ - I Au:Vanab\es ﬁ B[aitt —
B & Gilobal shared B/Az —_—
B #8Aams
O ®8  ROM_Param < m S

B ©810_Mapping

TALE = ~| BlfRoti 0
(&) Alarm BlfRo2 . [
- Di1_E B[rors O
BlfroLe . [
BfaoLs T [
| Blros -
> |
< n > - BJ[Foi_counter —_

e OperaTTEnL ‘=5 [Foin_frequency —D

Elrera— |
Loading target image .. completed - [ ABS Bl [Foi2_counter e

File PLCM172.imgx.simul updated [£] Acos

B ‘B [Fo2_frequency —
Loading target image .. completed [#] ADD )
File PLCM172.imgx.simul updated [?] ADR A cos

_ AND [ COSH
~ K AsIN [= DELETE
[£] ATAN [F owv

MK " >
i Find in project Debug Resources HMI Output Target variables = Target blocks

Ready EDIT MODE NOT RUNNING CONNECTED

Depending on the type of the source variables, an analog (slider or progress bar)
or digital (LED or button) control is generated, and associated with the original
signal.

It is possible to add only PLC variables that reside on a DataBlock, with an explicit
address (for example %MW1.0); you cannot add to an I/O panel automatic, local,
or global variables.

Editing I/O Panel Elements

You can edit the advanced options of each signal by clicking the small icon on the
left of each name.

For a digital I/O, the options are:
+ Label to be viewed on the panel;
+ Name of the associated source variable, and its index if it is an array;

* Read-only attribute: the control is an LED (output, read-only) or a button
(input,read/write);

+ Selector attribute: it is valid only for read/write variables (buttons), if active the
button keeps its value (pressed or not pressed), otherwise it keeps the new
value only as long as the mouse button is pressed, then it goes back to its
previous value.

For an analog 1/O, the options are:
+ Label to be viewed on the panel;
» Name of the associated source variable, and its index if it is an array;

* Read-only attribute: the control is a progress-bar (output, read-only) or a
slider (input, read/write);

*  Minimum and maximum limits: if not set, absolute minimum and maximum
limits of the original data type is used. The progress and slider uses these
limits; they can be individually activated or not.
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Signal label |AIL6

Variable name |sysLocaIAnangInputs

Indexes 5 Move up

Read only

Move down

Min. value

Max. value

Remove OK | Cancel |

Removing Elements from 1/O Panels

To remove a signal, edit the element, page 193 and click Remove button.

I/O Panels List

Overview

When the control panel is expanded, you can manage (add/remove/rename) the I/
O panels.

Adding a New /O Panel

To add a new empty panel, click the relevant Add button in the control panel.

A new empty panel without name is created and opened.

Editing an I/O Panel

In order to rename the panel, select it in the list and click the Rename button. You
are asked for the name to give to the window that is shown in its title bar.

Any panel can be drag around the screen in any place. To temporary hide it you
can toggle the check next to its name in the list.

You can also toggle the topmost button to bring the panels above the other
windows (this is a global setting that applies to the panels).

Removing an I/O Panel

In order to remove a panel, select it in the list and click the remove button; the
panel and its signals and settings are permanently removed.
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Debugging

Overview

Description

Watch Window

Overview

Description

What’s in This Chapter

L0 1YY 1P 195
WatCh WINAOW ... e 195
OSCIIOSCOPE .. 201
Editand Debug MOdE ..........iiiiii e 212
LiVE DEDUG ...t 213
11 T =T PP 216
(€1 = To] a1 Toa I e o =Y U 231

Programming provides several debugging tools, which help you to verify whether
the application behaves as intended.

All these debugging tools basically allow you to watch the value of selected
variables while the PLC application is running.

Programming debugging tools can be gathered in two classes:

« Asynchronous debuggers. They read the values of the variables you selected
with successive queries issued to the target device. Both the manager of the
debugging tool (that runs on the PC) and, potentially, the task which is
responsible to answer those queries (on the target device) run independently
from the PLC application. The values of two distinct variables being sampled
in the same moment are not necessarily in concordance with each other with
respect to the PLC application execution (one or more cycles may have
occurred). For the same reason, the evolution of the value of a single variable
is not consistent with its actual value in the controller memory, especially
when it is updated rapidly within the application.

» Synchronous debuggers. They require the definition of a trigger in the PLC
code. They refresh simultaneously all the variables they have been assigned
every time the processor reaches the trigger, as no further instruction can be
executed until the value of all the variables is refreshed. As a result,
synchronous debuggers obviate the limitations affecting asynchronous ones.

This chapter presents how to debug your application using both asynchronous
and synchronous tools.

The Watch window allows you to monitor the values of a set of variables. Being an
asynchronous tool, the Watch window does not establish synchronization of
values. Values of the variables in the Watch window may refer to different
execution cycles of the corresponding task.

The Watch window contains an item for each variable that you added to it. The
information displayed in the Watch window includes the name of the variable, its
value, its type, and its location in the PLC application.
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EF R e OB &«

Symbol Value Type Location
== HMIPIDTEST FALSE BOOL global
— HMIPIDTHRESHOLD 0.2 REAL global
— PARCTDOWNPRESET 100 INT global
— BASETIME 0 UDINT @FAST:PIDMODESELECTOR

Opening and Closing the Watch Window

Description

Openl/close the Watch window, by applying one of the following operations:
* In the menu, click View > Tool windows > Watch.

* In the Main toolbar, click m
* Press the Ctri+T key.

Closing the Watch window means simply hiding it, not resetting it. If you close the
Watch window and then open it again, you will see that it still contains all the
variables you added to it.

Adding Items to the Watch Window

Description

To display a variable in the Watch window, you need to add it to the watch list.

NOTE: All the variables of the project can be added to the Watch window,
regardless of where they were declared.

Adding a Variable from a Textual Source Code Editor

To add a variable to the Watch window from a textual (IL or ST) source code
editor:

Step Action

1 Double-click the variable you wish to display in the Watch window.
001l |lx = ® + hmiFregquency;
aooz

0003 [ hniSin¥al
0004 | hniCosVal

SIH{ = ) #* hmiAmplitude:
COS{ = ) * hmidmplitude:

Q006 (hmiStep = hmiStep + 1:

Drag the selected variable in the Watch window:

B e RN ¥
Symbol Value Type  Location

A HMISINVAL 0.982414 REAL @FAST:LOOPS
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Adding a Variable from a Graphical Source Code Editor

To add a variable to the Watch window from a graphical (LD, FBD, or SFC) source
code editor:

Step Action

Click I:k Edit > Watch mode.

2 Click the variable to display in the Watch window.

Local variables

Name Type Address Array HH
1 | start1 BOOL AUTO NO o
2 | start2 BOOL AUTO NO
3 | ready BOOL AUTO NO _
4 |run BOOL AUTO NO &s
5 |x BOOL AUTO  NO |
o001

start1
run
3 A dialog box appears listing all the currently existing instances of debug windows, and asking you which one is to receive

the object you have just clicked.

Debug windows list X

Symbol to add:
start1

Debug windows

Oscilloscope

[ OK ] [Cancel]

To add the variable in the Watch window, select Watch and click OK.

Once you have added to the Watch window all the variables you want to display, click Edit > Insert/Move mode, the
mouse cursor turns to its original shape.

Adding a Variable from a Variables Editor

To add a variable to the Watch window, select the corresponding record in the
variables editor and drag it in the Watch window:

Name Type Address Array @ Uil B &
1 | startt BOOL Auto NO Bl e WBEOR ¢
2 start2 BOOL Auto NO Symbol Value Type
3 | read BOOL Auto NO

Y Y == G_|_IALARM TRUE BOOL
4 | run BOOL Auto NO &8
5 [x BOOL Auto NO ‘ == G_|_IDIFFERENTIATION 28264 INT

f4]
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Adding a Variable from the Project Tree

To add a variable to the Watch window, select it in the project tree and drag it in

the Watch window:
wate o
B & Project ' B e WD ¢

Function blocks
Symbol Value Type

Functions
8- Global variables == G_|_IALARM TRUE  BOOL
i ﬂ Automatic variables = G_|_IDIFFERENTIATION 28264 INT

i am New_var_group1
i ready E,
run
o [
----- [ start1
b (U] start2

Adding a Variable from the Watch Window Toolbar

To add a variable to the Watch window, click +ﬂ Insert new item in the Watch
window toolbar.

You shall type (or select by browsing the project symbols) the name of the variable
and its location (where it has been declared).

Add item to watch window X

Symbol name ’ Browse l [ Address l
Location
[ OK ] [ Cancel ]

Removing a Variable

Description

If you want to remove a variable from the Watch window, select it by clicking its
name once, then press the Delete key.

Refreshment of Values

Normal Operation

The watch window manager reads periodically from memory the value of the
variables.

B e BRNRE ¢
Symbol Value Type  Location

A HMISINVAL 0.982414 REAL @FAST:LOOPS

However, this action is carried out asynchronously. It may happen that a higher-
priority task modifies the value of some of the variables while they are being read.
Thus, at the end of a refreshment process, the values displayed in the window
may refer to different execution states of the PLC code.
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Target Disconnected

Object Not Found

If the target device is disconnected, the Value column contains three dots.

Bl BER |« 4
Symbol Value Type  Location
HMISINVAL ... REAL @FAST:LOOPS

If the PLC code changes and Programming cannot retrieve the memory location
of an object in the Watch window, then the Value column contains three dots.

If you try to add to the Watch window a symbol which has not been allocated,
Programming gives the following error message:

EcoStruxure™ Machine Expert - HVAC X

| X symbol not found. Can’t add to watch

Changing the Format of Data

Description

When you add a variable to the Watch window, Programming automatically
recognizes its type (unsigned integer, signed integer, floating point, hexadecimal),
and displays its value consistently. Also, if the variable is floating point,
Programming assigns it a default number of decimal figures.

However, you may need the variable to be displayed in a different format.
To impose another format than the one assigned by Programming, select the
variable and click the Value format button in the toolbar.

Choose the format and confirm your choice.

Value format X

Format

OK
O Signed -
OBinary

QO Octal

(O Hexadecimal

Float format

Number of decimal | 3
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Working with Watch Lists

Description

You can store to file the set of all the items in the Watch window in order to easily
restore the status of this debugging tools in a successive working session.

Follow this procedure to save a watch list:

Step Action

]
Click the Hj

2 Enter the file name and choose its destination in the file system.

Save watch list button in the Watch window toolbar.

You can load a watch list from file, removing the opened one, following this
procedure:

Step Action

1
Click the E Load (no appends) watch list button in the Watch window toolbar.

2 Browse the file system and select the watch list file.

The set of symbols in the watch list is added to the Watch window.

You can load a watch list from file, appending to the opened one, following this
procedure:

Step Action

1 E
Click the Load watch list button in the Watch window toolbar.

2 Browse the file system and select the watch list file.

The set of symbols in the watch list is added to the Watch window.

You can clear the current opened watch list by clicking the #" Remove all items
from the watch list button.

You can modify the place of a selected item in the current open watch list by

clicking the T Move up item into the list button or the b Move down item into
the list button.

Autosave Watch List

Description

By selecting the associated option in the project options dialog (refer to Debug,
page 106 for more information), the watch list is automatically saved on the project
closing.

The saved watch list is automatically loaded on the first connection to target when
the project is reopened.
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Oscilloscope

Overview

Description

The Oscilloscope allows you to plot the evolution of the values of a set of
variables. Being an asynchronous tool, the Oscilloscope cannot establish
synchronization of samples.

Oscilloscope window is an interface for accessing the debugging functions that
the Oscilloscope makes available:

BEHENE/aH RRAMG =« v » =

1983.22 39596.5
e

Min value Max value Cur value Value/Div

@TIMED:LOOPS.HMISTEP 102216.000 106173.000 106173.000 470.25
@TIMED:LOOPS.X 1034.199 1058.058 1058.058 2.741...

The Oscilloscope consists of three elements:

» The toolbar allows you to control the Oscilloscope. A detailed description of
the function of each control is given later in this chapter.

* The Chart area includes several items:
o Plot: area containing the curve of the variables.

o Vertical cursors: cursors identifying two distinct vertical lines. The values
of each variable at the intersection with these lines are reported in the
corresponding columns.

o Scroll bar: if the scale of the x-axis is too large to display all the samples in
the Plot area, the scroll bar allows you to slide back and forth along the
horizontal axis.

EIO0000003412.05 201



Debugging

» The lower section of the Oscilloscope is a table consisting of a row for each
variable.

Opening and Closing the Oscilloscope

Description

To open, close the Oscilloscope, click E] View > Tool windows >
Oscilloscope.

Closing the Oscilloscope means simply hiding it, not resetting it. If you open again
the Oscilloscope after closing it, you will see that plotting of the curve of all the
variables you added to it starts again.

Adding Items to the Oscilloscope

Description

In order to plot the evolution of the value of a variable, you need to add it to the
Oscilloscope.

Unlike trigger windows and the Graphic trigger window, you can add to the
Oscilloscope all the variables of the project, regardless of where they were
declared.

Adding a Variable from a Textual Source Code Editor

To add a variable to the Oscilloscope from a textual (that is, IL or ST) source code
editor, select a variable by double-clicking it, and then drag it into the
Oscilloscope window.

X = %= + hmiFregquency:

hmiSinVal = SIHN{ = ) #® hmiimplitude;

hmiCo=sVal = COS{ = ) * hmidmplitude; 1983.98
hmiStep := hmiStep + 1:

Track Um

@TIMED:LOOPS.HMISTEP
@TIMED:LOOPS.X

The same procedure applies to all the variables you wish to monitor.

Adding a Variable from a Graphical Source Code Editor

Follow this procedure to add a variable to the Oscilloscope from a graphical (that
is, LD, FBD, or SFC) source code editor:
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Step Action

Click l:L' Edit > Watch mode.

2
Click the block representing the variable you wish to trace in the Oscilloscope:
1023
PIDCONTROL.PI...
3

A dialog box appears listing all the currently existing instances of debug windows, and
asking you which one is to receive the object you have just clicked:

Symbol to add:
start1

Debug windows

Oscilloscope

[ OK ] [Cancel]

Select Oscilloscope, then click OK. The name of the variable is now displayed in the
Track column.

The same procedure applies to all the variables you wish to monitor.

Once you have added to the Oscilloscope all the variables you want to observe,

k

you should click Edit > Insert/Move mode: the mouse cursor turns to its

original shape.

Adding a Variable from a Variables Editor

In order to add a variable to the Oscilloscope, you can select the corresponding
record in the variables editor and then either drag-and-drop it in the Oscilloscope:

Class Pin Name Type Array Init value Attribute A %
1 VAR absSpeed REAL NO
2 VAR T REAL NO =
3 VAR remSpace DINT NO
4 | VAR T2 REAL NO &3
5) VAR sign REAL NO
6 VAR prevSpeed REAL NO
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i RME Q@ QK REA =

¢ - B00.00

or press the F10 key and choose Oscilloscope from the list of debug windows
which pops up.

Adding a Variable from the Project Tree

In order to add a variable to the Oscilloscope, you can select it in the project tree
and then either drag-and-drop it in the Oscilloscope:

T e
B 5@ PID hmi

T s [%] hmiPidTest

T [ 1] hmiPIDThreshold
Hﬁ{:} PID params

....... [ud]| parPIDAutoPeriod
....... [i] parPIDMode

....... [ 1] parPIDSetpoint
....... [b | parPidTest

....... [ 1] parPIDThreshold

....... [ 1] pidQutput
....... [ 1] pidSetpoint

or press the F10 key and choose Oscilloscope from the list of debug windows
which pops up.

Removing a Variable

Description

If you want to remove a variable from the Oscilloscope, select it by clicking its
name once, then press the Delete key.

Variables Sampling

Normal Operation

The Oscilloscope manager periodically reads from memory the value of the
variables.

However, this action is carried out asynchronously. It may happen that a higher-
priority task modifies the value of some of the variables while they are being read.
At the end of a sampling process, data associated with the same value of the x-
axis may refer to different execution states of the PLC code.
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Target Disconnected

If the target device is disconnected, the curves of the dragged-in variables are
frozen until communication is restored.

Controlling Data Acquisition and Display

Description

The Oscilloscope includes a toolbar with several commands, which can be used to
control the acquisition process and the way data are displayed. This paragraph
focuses on these commands.

The commands in the toolbar are disabled if no variable has been added to the
Oscilloscope.

Starting and Stopping Data Acquisition

When you add a variable to the Oscilloscope, data acquisition begins immediately.

However, you can suspend the acquisition by clicking Il pause acquisition.

The curve freezes (while the process of data acquisition is still running in the

background) until you click b Restart acquisition.

In order to stop the acquisition, you may click u Stop acquisition.

In this case, when you click - Restart acquisition, the plot is reset and restarts
with the actual value of the variable.

Setting the Scale of the Axes

When you open the Oscilloscope, Programming applies a default scale to the
axes.

Follow this procedure to modify the scale value:
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Step Action
1
Open the Oscilloscope settings by clicking the Graph properties button in the
toolbar.
2
Set the scale of the horizontal axis, which is common to all the tracks:
Oscilloscope settings X
Show grid M Sample polling rate | 20 ms Real rate
Show time bar M Horizontal scale 500 msidiv 4597
Show tracks list [ Buffer size 40000 samples
Tracks list
Name Unit Value/div Offset Hide
(@TIMED:SR_PUMPCNTRL. 0.2 0 O
[ OK ] [ Apply ] [ Cancel ]
3
For each variable, you may specify a distinct scale for the vertical axis:
Oscilloscope settings X
Show grid M Sample polling rate | 20 ms Real rate
Show time bar M Horizontal scale 500 ms/div 4597
Show tracks list [ Buffer size 40000 samples
Tracks list
Name Unit Value/div Offset Hide
(@TIMED:SR_PUMPCNTRL. 100 0 ]
[ ok | [ Appy | [ Cancel
4 Confirm your settings. The graph adapts to reflect the new scale.

You can also zoom in and out with respect to both the horizontal and the vertical
axes:

AeE|EE

Finally, you may also adapt the scale of the horizontal axis, the vertical axis, or
both to include all the samples, by clicking the corresponding item of the toolbar:

= (] B
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Vertical Split

When you are watching the evolution of two or more variables, you may want to

split the respective tracks. For this purpose, click the @ Vertical split item in the
Oscilloscope toolbar:

BHEEBE A AH RRAE = v » B &l HHEHEBRAaH |RAag « v » B &H
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Viewing Samples

If you click the E Show samples item in the Oscilloscope toolbar, the tool
highlights the single values detected during data acquisition:

HHEH e REAQ| =« n» = i

You can click the same item again in order to go back to the default view mode.

Taking Measures

The Oscilloscope includes two measure bars, which can be exploited to take

some measures on the chart. In order to show and hide them, click the Show
measure bars item in the Oscilloscope toolbar.

If you want to measure a time interval between two events, you have to move one
bar to the point in the graph that corresponds to the first event and the other to the
point that corresponds to the second one:

4 8 a1 1R [T u » E =
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The time interval between the two bars is displayed in the top left corner of the
chart:

You can use a measure bar also to read the value of all the variables in the
Oscilloscope at a particular moment: move the bar to the point in the graph which
corresponds to the instant you want to observe:

BHEE S - ’RAD

E7e+006

In the following table (below the graphic), you can now read the values of all the
variables at that particular moment:

N

S

H red cursor  H blue cursor

6.990 10.60

1023.000 1023.00
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Oscilloscope Settings

You can further customize the appearance of the Oscilloscope by clicking the
Graph properties item in the toolbar.

In the window that pops up you can choose whether to display or not the
Background grid, the Time slide bar, and the Track list:

Oscilloscope settings

Show grid D*
Show time bar ]
Show tracks list [

Changing the Polling Rate

Description

Programming periodically sends queries to the target device in order to read the
data to be plotted in the Oscilloscope.

Follow this procedure to configure the polling rate:

Step Action
1
Click the Graph properties item in the toolbar.
2
In the window that pops up, edit the Sampling polling rate:
Oscilloscope settings X
Show grid M Sample polling rate = 40 ms Real rate
Show time bar M Horizontal scale 1000 ms/div  45.97
Show tracks list [ Buffer size 40000 samples
3 Confirm your decision.

The rate depends on the performance of the target device (in particular, on the
performance of its communication task). You can read the rate in the
Oscilloscope settings window.

Saving and Printing the Graph

Description

Programming allows you to persist the acquisition either by saving the data to a
file or by printing a view of the data plotted in the Oscilloscope.

Saving Data to a File

You can save the samples acquired by the Oscilloscope to a file in order to further
analyze the data with other tools:
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Step Action
Stop the acquisition before saving data to a file.
’ [
Click the Save tracks data into file in the Oscilloscope toolbar.
3 Choose between the available output file formats:
« OSC is a simple plain-text file, containing time and value of each sample.
*« OSCXis an XML file that includes more complete information, which can be
further analyzed with another tab.
4 Choose a file name and a destination directory, then confirm the operation.

Printing the Graph

Follow this procedure to print a view of the data plotted in the Oscilloscope:
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Edit and Debug Mode

Description

Click the E Print graph item.

Step Action
1 [
Either suspend or stop u the acquisition.
2
Move the time slide bar and adjust the zoom in order to include in the view the elements
you want to print:
4 x
BEHEE B RRAME [ » =
ms/div :500.00
5.10443e+006 5.10943e+006
Min value Max value Cur value Value/Div
@TIMED:LOOPS.HMISTEP 302.000 77090.000 10691.000 137
@TIMED:LOOPS.HMIFRE 0.010 0.010 0.010 1
3

While both the Watch window and the Oscilloscope do not make use of the
source code, all the other debuggers do: when debug mode is on, changes to the
source code are inhibited and debug tools become active.

Programming automatically enables debug mode when at least one of the
following conditions are met:

+ Atleast one breakpoint is correctly set.

» Atleast one trigger (graphic or textual) is correctly set.
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Live Debug

Overview

Description

SFC Simulation

Description

* Live debug mode is on.

If or when all the conditions are not met, the debug mode is automatically disabled
and Programming enters in edit mode.

The status bar shows whether the debug mode is active or not:

DEBUG MODE SOURCE OK CONNECTED

You cannot enter the debug mode if the connection status differs from Connected
and the application in the software and the controller are the same as indicated by
SOURCE OK.

Programming can display meaningful animation of the current and changing
state of execution over time of a Program Organization Unit (POU) coded in any
IEC 61131-3 programming language.

[
To enable and disable the live debug mode, you may click EE Debug > Live
debug mode.

The controller allows you to force the state of selected outputs and variables to a
defined value for the purposes of system testing, commissioning, and
maintenance. You can force the value of an output and/or variable while your
controller is connected to EcoStruxure Machine Expert - HVAC.

AWARNING

UNINTENDED EQUIPMENT OPERATION

* You must have a thorough understanding of how forcing will affect the
outputs relative to the tasks being executed.

» Do not attempt to force I/O that is contained in tasks that you are not certain
will be executed in a timely manner, unless your intent is for the forcing to
take affect at the next execution of the task whenever that may be.

» If you force an output and there is no apparent affect on the physical output,
do not exit EcoStruxure Machine Expert - HVAC without removing the
forcing.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

As explained in the relevant section of the language reference, an SFC POU is
structured in a set of steps, each of which is either active or inactive at any given
moment. Once started up, this SFC-specific debugging tool animates the SFC
documents by highlighting the active steps.
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Animation OFF

Animation ON

Animation ON in hold status

Init

é:‘ TRUE

51 53

21[P] 21[P]

A2[N] A2[N]
# Scrivival # CiriDown
52 sS4

21[P] 42[N]

i i

Init

[] scrivival

s2
21[P]

i i

é:‘ TRUE

a1 53

21[P] 21[P]

Az[N] Az[N]
# Scrivival # CirlDown
52 sS4

41[P] 42[N]

i i

diagram animation being off.

A portion of an SFC network is displayed,

The same portion of network is displayed
when the live debug mode is active. The
picture shows that steps S7 and S3 are
currently active, whereas Init, S2, and S4
are inactive.

The same portion of network is displayed
with steps S7 and S3 that are currently
active but in hold status.

This may occur in SFC blocks when they

are children of a parent in inactive status.

The SFC animation manager tests periodically the state of all steps, you are not
allowed to edit the sampling period. A step may remain active too briefly to be
displayed. The fact that a step is never highlighted does not imply that its action is
not executed. It may simply mean that the sampling rate is too slow to detect the
execution.

Debugging Actions and Conditions

LD Simulation

Description

As explained in the SFC language reference, a step can be assigned to an action,
and a transition can be associated with a condition. Actions and conditions can be
coded in any of the IEC 61131-3 languages. General-purpose debugging tools
can be used within each action/condition, as if it was a stand-alone POU.

In live debug mode, Ladder Diagram schemes are animated by highlighting the contacts and coils whose value is

true (in the example, i1 and i2):

inpLogicData
|

feDelay
TOH outDelayed
'

IM a L

1000

parTimonDelay parTimonvalue

The LD animation manager tests periodically the state of all the elements. It may
happen that an element remains true too briefly to be displayed. The fact that an
element is never highlighted does not imply that its value never becomes true (the
sampling rate may be too slow).
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FBD Simulation

Description

In live debug mode, Programming displays the values of all the visible variables directly in the graphical source

code editor:

o001

-10.7082| pidFeedback
-10| pidSetpoint

-]
.
.

-]

FALSE [pPaResel >
1000.0 I—
e
0.1
B>

0.5

.

PID regulator

foPid

FT_PID

actual
diff
lim

=set_point
noise
offset
manual_in
manual

overflow

rst
int_band
KP

™

™
firnit_L.
limit_H

’—( pidQutput [-10.6732
ABS

PID regulation iz OK if target is ingide threghold

0z

outPidOverflow |FALSE

hmiPIDThreshold

FALSE

This works for both FBD and LD programming language.

The FBD animation manager tests periodically the state of all the elements. It may
happen that an element remains true too briefly to be displayed. The fact that an
element is never highlighted does not imply that its value never becomes true (the
sampling rate may be too slow).

IL and ST Simulation

Description

The live debug mode also applies to textual source code editors (the ones for IL
and ST). You can watch the values of a variable by hovering with the mouse over
it;

nool
nooz
noo3
noo4
noos
nooe
noo?
noog
noog
noin
0011
no1z
no13
no14

(#®# Analog output 0 = analog inp 0 + analog inp 1 *)

aoutl ainpl + ainpl:

([ *

SFC =tate logic =)

fbStati{ enab

cit

inpll, run inpll, =top inpl2 J;

cnt + 1:
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Triggers

Trigger Window

Description

The Trigger window tool allows you to select a set of variables and to have them
updated synchronously in a special pop-up window.

Pre-Conditions to Open a Trigger Window

Memory availability

A trigger window takes a segment in the application code sector, having a well-
defined length. Obviously, in order to start up a trigger window, it is necessary that
a sufficient amount of application memory is available, otherwise an error
message appears.

Incompatibility with graphic trigger windows

A graphic trigger window takes the whole free space of the application code
sector. Once such a debugging tool has been started, it is not possible to add any
trigger window, and an error message appears if you attempt to start a new
window. Once the graphic trigger window is closed, trigger windows are enabled
again.

All the trigger windows existing before the starting of a graphic trigger window
keep working normally. You are not allowed to add new ones.

Trigger Window Toolbar

Trigger window icons are part of the Debug toolbar and are enabled only if
Programming is in debug mode.

Icon Command Description

Add/remove text To start a trigger window, select the point of the PLC code where to
ﬂ trigger insert the relative trigger and then click this button. The same
procedure applies to trigger window removal: in order to definitely
close a debug window, click once the instruction/block where the
trigger was inserted, then click this button again.

Shortcuts key: F9.

m Add/remove g
hic tri
graphic trigger This button operates exactly as the Add/remove text
trigger, except for that it opens a graphic trigger window. It can be

used likewise also to remove a graphic trigger window.

Shortcuts key: Shift + F9.
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Icon Command Description

Remove all triggers | Clicking this button causes all the existing trigger windows and the
H graphic trigger window to be removed simultaneously.

Shortcuts key: Ctrl+Shift+F9.

Trigger list

¥

This button opens a dialog listing all the existing trigger windows:

Trigger list

X

Type  Module Line
T RMS -1
T Init -1
T Slow -1

Shortcut key: Ctri+l.

Each record refers to a trigger window, either graphic or textual. The following
table explains the meaning of each field.

Field Description

Type T: trigger window.

G: graphic trigger window.

Module Name of the program, function, or function block where the trigger is placed. If the
module is a function block, this field contains its name, not the name of its instance
where you put the trigger.

Line For the textual languages (IL, ST) indicates the line in which the trigger is placed.
For the other languages, the value is always -1.

Trigger Window Interface

Setting a trigger causes a pop-up window to appear, which is called Interface
window: this is the interface to access the debugging functions that the trigger
window makes available. It consists of three elements, as presented below:

Trigger n°0 at F_CALCFREQSETPERC#2 n
2 Y sop
Condition
Trigger E
Symbol Value Type
J >

Caption bar

The Caption bar of the pop-up window shows information on the location of the
trigger which causes the refresh of the Variables window, when reached by the
processor.

The text in the Caption bar has the following format:
Trigger n° X at ModuleName#Location

EI00000003412.05 217




Debugging

where
X Trigger identifier.
ModuleName Name of the program, function, or function block where the trigger was
placed.
Location Exact location of the trigger, within module ModuleName.

If ModuleName is in IL, Location has the following format:
N1

Otherwise, if ModuleName is in FBD, it becomes:
N2$BT:BID

where:

N1 = instruction line number

N2 = network number

BT = block type (operand, function, function block, and so on)

BID = block identifier

Controls section

This dialog box allows you to control the refresh of the trigger window to get more
information on the code under scope. A detailed description of the function of each
control is given in the Trigger window controls section. Refer to Using Controls
description, page 228.

All controls are not accessible until at least one variable is dragged into the debug
window.

The Variables section

This lower section of the Debug window is a table consisting of a row for each
variable that you dragged in. Each row has several fields: the name of the
variable, its value, its type, its location (@task:ModuleName), and its description
read from memory during the last refresh:

Trigger n°0 at F_CALCFREQSETPERC#2 n
&z Cnt: [ Triggered
Condition

® None
Trigger For =
After
Symbol Value Type
—A 10 UINT
m B TRUE BOOL
N »

Trigger Window: Drag and Drop Information

To watch a variable, you need to copy it to the lower section of the Debug window.

This section is a table consisting of a row for each variable you dragged in. You
can drag into the trigger window only variables local to the module where you
placed the relative trigger, or global variables, or parameters. You cannot drag
variables declared in another program, or function, or function block.
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Refresh of the Values

Let consider the following example:

D 1
5T a

1o 2
5T a

1D 3
5T a

The value of variables is refreshed every time the window manager is triggered
that is every time the processor executes the instruction marked by the green
arrowhead. However, you can set controls in order to have variables refreshed
only when triggers satisfy the more limiting conditions you define.

Trigger n°0 at F_CALCFREQSETPERC#2 n
= ont 0
Condition
Trigger =
Symbol Value Type

— A 1 UINT

The value of the variables in column Symbol is read from memory just before the
marked instruction (in this case: the instruction at line 5) and immediately after the
previous instruction (the one at line 4) has been performed.

Thus, in the previous example the second ST statement has not been executed
yet when the new value of a is read from memory and displayed in the trigger
window. Thus the result of the second ST ais 1.

Trigger Window Controls

Trigger window controls allow you to supervise the working of this debugging tool.

Trigger window controls act in a well-defined way on the behavior of the window,
regardless for the type of the module (either IL or FBD) where the related trigger
has been inserted.

All controls are not accessible until at least one variable is dragged into the
Variables window.

Window controls are made accessible to you through the gray top half of the
debug window:

Button

Command

Description

~
==

Start/Stop

This control is used to start a triggering session. While triggering,
you can click this button to stop the session. Otherwise, the
session automatically stops when conditions are reached. You
can click this button to resume the triggering session.

I

Set step Trigger

This control is used to execute a single step trigger. It is enabled
only when there is no active triggering session and None is
selected. The defined condition specified then is active. After the
single step trigger is done, triggering session automatically stops.
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Trigger counter

A read-only control Cnt counts how many times the debug window manager has
been triggered since the window was installed.

The window manager automatically resets this counter every time a new triggering
session is started.

Trigger state

This read-only control displays the state of the Debug window. It can assume the
following values.

Ready The trigger has not occurred during the task execution.

Triggered The trigger has occurred during the task execution.

m System is not triggering. It has been stopped by you or a halt condition has been

reached.
Communication with target interrupted, the state of the trigger window cannot be
determined.

User-defined condition

If you define a condition by using this control, the values in the Debug window are
refreshed every time the window manager is triggered and the user-defined
condition is true.

After you have entered a condition, the control displays its simplified expression:
Condition |A GT 100 ()

Counters

These controls allow you to define conditions on the trigger counter:

@® None

Trigger QO For
O After

4‘»

The trigger window can be in one of the following three states.

* None: no counter has been started up, thus no condition has been specified
upon the trigger.

For: assuming that you gave the counter limit the value N, the window
manager adds 1 to the current value of the counter and refreshes the value of
its variables, each time the debug window is triggered. However, when the
counter equals N, the window stops refreshing the values, and it changes to
the Stop state.

After: assuming that you gave the counter limit the value N, the window
manager resets the counter and adds 1 to its current value each time it is
triggered. The window remains in the Ready state and does not update the
value of its variables until the counter reaches N.

Debugging with Trigger Windows

Introduction

The trigger window tool allows you to select a set of variables and to have their
values displayed and updated synchronously in a pop-up window. Unlike the
Watch window, trigger windows refresh simultaneously all the variables they
contain, every time they are triggered.
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Opening a Trigger Window from an IL Module

For this example, assume that you have an IL module containing the following
instructions:

D
ADD
ST

[ ]

D
ADD
ST

0o/n

D
ADD
ST

S

You want to know the value of b, d, and k, just before the ST k instruction is
executed.

To do so, move the cursor to line 12:

ID k
ADD 1
ST |

Then you can click E Debug > Add/remove text trigger.

In both cases, a green arrowhead appears next to the line number, and the related
trigger window pops up.

Not all the IL instructions support triggers. For example, it is not possible to place
a trigger at the beginning of a line containing a JMP statement.

Adding a Variable to a Trigger Window from an IL Module

In order to watch the value of a variable, you need to add it to the trigger window.

Select a variable by double-clicking it, and then drag it into the Variables window
that is the lower white box in the pop-up window:

LD
ATD
ST

oo

LD
ATD
ST

0nan

1D
ADD
- ST

=

EI00000003412.05 221



Debugging

The name of the variable is now displayed in the Symbol column:

~
Lo

Condition

Trigger

Trigger n° 0 at F_CALCFREQSETPERC#2

Cnt:

[ x|

Symbol
—B

Value

Type
UINT

The same procedure applies to all the variables you wish to monitor.

Opening a Trigger Window from an FBD Module

For this example, assume that you have an FBD module containing the following

instructions:

Qoo

7

ADD

;

nooz

ADD

;

ADD

¢ 91¢ 90

;

You want to know the values of C, D, and K, just before the ST k instruction is

executed.

Provided that you can never place a trigger in a block representing a variable such

as @ you must select the first available block preceding the selected
variable. In the example of the previous figure, you must move the cursor to
network 3, and click the ADD block.

You can click E Debug > Add/remove text trigger.
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In both cases, the color of the selected block turns to green, a white circle with a
number inside appears in the middle of the block, and the related trigger window

pops up:
oo
ADD
+ -
6>
oooz
D ADD
-
-
== [
(A
-

When preprocessing FBD source code, the compiler translates it into IL
instructions. The ADD instruction in network 3 is expanded to:

1D k

ADD 1

ST k

When you add a trigger to an FBD block, you place the trigger before the first
statement of its IL equivalent code.

Adding a Variable to a Trigger Window from an FBD Module

To watch the value of a variable, you need to add it to the trigger window. For
example, you want to monitor the value of variable k of the FBD code:

Click I:l‘ Edit > Watch mode.

The cursor will become as follows: I""!'.-

Now you can click the block representing the variable you wish to be displayed in
the trigger window.

In the example, click the button block: D
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A dialog box appears listing all the currently existing instances of debug windows,
and asking you which one is to receive the object you have just clicked:

Symbol to add:
k

Debug windows
Watch
Oscilloscope

Graphic trace

[ OK ] [Cancel]

In order to display the variable k in the trigger window, select its reference in the
Debug windows column, then click OK. The name of the variable is now
displayed in the Symbol column:

Trigger n°0 at TRIGGERS#3$0:1 n
o Cnt: 1610 [l
Condition

® None
Trigger For :
After
Symbol Value Type
A K 61830 UINT
b >

The same procedure applies to all the variables you wish to monitor:

Once you have added to the Graphic watch window all the variables you want to

h

observe, you can click Edit > Insert/Move mode, to let the cursor take back
its original shape.
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Opening a Trigger Window from an LD Module

For this example, assume that you have an LD module containing the following
instructions:

.

You can place a trigger on a block such as follows:

In this case, the same rules apply as to insert a trigger in an FBD module on a

contact—| |'oracoil"t( J"

In this case, follow the SE instructions. Let also assume that you want to know the
value of some variables every time the processor reaches network number 1.

First you must click one of the items making up network number 1. Now you can

click a Debug > Add/remove text trigger.

In both cases, the gray area containing the network number turns to green, and a
white circle with the number of the trigger inside appears in the middle of the area
while the related trigger window pops up:

.
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Trigger n°0 at F_CALCFREQSETPERC#2 n
> oo [T
Condition
Trigger =
Symbol Value Type

Unlike the other languages supported by Programming, LD does not allow you to
insert a trigger into a single contact or coil, as it lets you select only an entire
network. Thus the variables in the trigger window will be refreshed every time the
processor reaches the beginning of the selected network.

Adding a Variable to a Trigger Window from an LD Module

To watch the value of a variable, you need to add it to the trigger window. For
example, you want to monitor the value of variable b in the LD code:

Click I:l‘ Edit > Watch mode.

The cursor becomes as follows: &

Now you can click the item representing the variable you wish to be displayed in
the trigger window.

A dialog box appears listing all the currently existing instances of debug windows,
and asking you which one is to receive the object you have just clicked.

Debug windows list X

Symbol to add:
b

Debug windows
Watch
Oscilloscope

Trigger n°0 at TRIGGERS#1$

[ OK ] [Cancel]

To display variable B in the trigger window, select its reference in the Debug
window column, then click OK.
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The name of the variable is now displayed in the Symbol column:

Trigger n°0 at TRIGGERS#1$ n
- ot 0
Condition

@ None
Trigger For =]
After
Symbol Value Type
== B FALSE BOOL
N »

The same procedure applies to all the variables you wish to monitor.

Opening a Trigger Window from an ST Module

For this example, assume that you have an ST module containing the following

instructions:
a = h % h;
- = c + SHR{ a. 1loi0d 3
d = e % 2;
f = f + SHRE{ d. 1e#04 }:

Let us also assume that you want to know the value of e, d, and f, just before the
instruction
f := f+ SHR( d, 16#04 )

is executed. To do so, move the cursor to line 6.

Then you can click E Debug > Add/remove text trigger.

In both cases, a green arrowhead appears next to the line number,

a := b= b;
c = c + SHR{ a. 1lo¥04d4 3
d = e *® =;

[ f :=f + SHRE{ d. 1lo#04 ):
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and the related trigger window pops up:

Trigger n°0 at F_CALCFREQSETPERC#2 n
- o o SN
Condition
Trigger =
Symbol Value Type

Not all the ST instructions support triggers. For example, it is not possible to place

a trigger on a line containing a terminator such as END_IF, END_FOR, END _
WHILE, and so on.

Adding a Variable to a Trigger Window from an ST Module

In order to watch the value of a variable, you need to add it to the trigger window.
Select a variable, by double-clicking it, and then drag it into the Variables window
that is the lower white box in the pop-up window. The variable name now appears
in the Symbol column:

Trigger n°0 at TRIGGERS#3$0:1 n
4 Cnt: 1610 Rl
Condition

® None
Trigger For =
After
Symbol Value Type
—F 0 UDINT
4 »

The same procedure applies to all the variables you wish to monitor.

Removing a Variable from the Trigger Window

If you want to remove a variable from the trigger window, select it by clicking its
name once, then press the Delete key.

Using Controls

Trigger windows controls allow you to supervise the working of this debugging
tool. The main purpose of trigger window controls is to let you define more limiting
conditions so that variables in the Variables window are refreshed when the
processor reaches the trigger location and these conditions are satisfied. If you do
not use controls, variables are refreshed every time the processor reaches the
relative trigger.
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Enabling controls

When you set a trigger, all the elements in the Control window are disabled:

[

Condition

Trigger 52

You cannot access any of the controls until at least one variable is dragged into
the Debug window. When you do triggering automatically starts and the Controls
window changes as follows:

- o o I
Condition

@ None
Trigger O For =

QO Atter

Triggering can be started/stopped with the relevant button: e
Fixing the number of refresh

If you want the values to be refreshed the first time the window is triggered, select

None, and press the - single step button, otherwise select For and set the
eventsto 1.

If you want the values to be refreshed the first X times the window is triggered,
select For and set the events to X.

If you want the values to be refreshed after Y times the window is triggered, select
After and setthe eventsto Y.

Trigger and condition settings become the settings when the triggering is (re)
started.

Defining a condition

This control enables you to set a condition on the occurrences of a trigger. By
default, this condition is set to TRUE, and the values in the debug window are
refreshed every time the window manager is triggered.

If you want to put a restriction on the refreshment mechanism, you can specify a
condition by clicking the button

Then a text window appears where you can write the IL code that sets the
condition:

ID a a
GT 100

Once you have finished writing the condition code, click the OK button to install it,
or press the Esc key to cancel. If you choose to install it, the values in the debug
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window are refreshed every time the window manager is triggered and the user-
defined condition is true.

A simplified expression of the condition now appears in the control:

Condition |A GT 100 (]

To modify it, click the button -*** again.

The Trigger condition window appears, containing the IL code you originally wrote,
which you can now edit.

To completely remove a condition, delete all of the IL code in the window, then
click OK.

The result of the condition code must be of type boolean (TRUE or FALSE),
otherwise a compiler error occurs.

Only global variables and dragged-in variables can be used in the condition code.
Namely, all variables local to the POU where the trigger was originally inserted are
not valid if they have not been dragged into the debug window. No new variables
can be declared in the condition window.

Closing a Trigger Window and Removing a Trigger

There are a number of actions you can take when you finish a debug session with
a trigger window:

Type Module Line
T RMS -1
T Init -1
T Slow -1

Closing the trigger window:

If you have finished watching a set of variables by using a trigger window, you may
want to close the Debug window, without removing the trigger. If you click the
button in the top right-hand corner, you hide the interface window while the
window manager and the relative trigger keep working.

To resume debugging with a trigger window that you previously hid, you need to
open the Trigger list window, select the record referred to that trigger window,
and click the Open button.

The interface window appears with value of variables and trigger counter updated,
as if it had not been closed.

Removing a trigger:

If you choose this option, you completely remove the code both of the window
manager and of its trigger. Open the Trigger list window, select the record
referred to the trigger window you want to eliminate, and click the Remove button.

Alternatively, you can move the cursor to the line (if the module is in IL or ST), or
click the block (if the module is in FBD or LD) where you placed the trigger. Now

click the E Add/remove text trigger button in the Debug toolbar.

Removing all the triggers:
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Alternatively, you can remove all the existing triggers at once, regardless for which

records are selected, by clicking the E Remove all triggers button.

Graphic Triggers

Graphic Trigger Window

Description

The graphic trigger window tool allows you to select a set of variables, to have
them sampled synchronously, and to have their curve displayed in a special pop-
up window.

Sampling of the dragged-in variables occurs every time the processor reaches the
position (that is, the instruction - if IL, ST - or the block - if FBD, LD) where you
placed the trigger.

Pre-Conditions to Open a Graphic Trigger Window

Memory availability

If the available free memory space in the application code sector is insufficient, an
error message to that effect is display. You must then remove some objects from
memory to make the feature available.

Graphic Trigger Window Interface

Setting a graphic trigger causes a pop-up window to appear, which is called the
Interface window. This is the main interface for accessing the debugging
functions that the graphic trigger window makes available. It consists of several
elements, as presented below:

1 2

Min valug Max value Cur value Value/Div Description
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1. Caption bar

2. Controls bar

3. Chart area

4. Variables window

The caption bar

The Caption bar at the top of the pop-up window shows information on the
location of the trigger which causes the variables listed in the Variables window to
be sampled.

The text in the caption has the following format:
ModuleName#Location

Where

ModuleName Name of program, function, or function block where the trigger was placed.

Location Exact location of the trigger within module ModuleName.
If ModuleName is in IL, ST, Location has the format:

N1

Otherwise, if ModuleName is in FBD, LD, it becomes:
N2$BT:BID

N1 = instruction line number

N2 = network number

BT = block type (operand, function, function block, and so on)

BID = block identifier

The Controls bar

The Controls bar allows you to control the working of the graphic trigger window. A
detailed description of the function of each control is given in the Graphic trigger
window controls section. Refer to Graphic Trigger Window Controls description,
page 233.

The Chart area

The Chart area includes six items:
» Plot: area containing the plot of the curve of the dragged-in variables.

+ Samples to acquire: number of samples to be collected by the graphic trigger
window manager.

» Horizontal cursor: cursor identifying a horizontal line. The value of each
variable at the intersection with this line is reported in the column horz
cursor.

» Blue cursor: cursor identifying a vertical line. The value of each variable at the
intersection with this line is reported in the column left cursor.

* Red cursor: cursor identifying a vertical line. The value of each variable at the
intersection with this line is reported in the column left cursor.

» Scroll bar: if the scale of the x-axis is too large to display all the samples in the
Plot area, the scroll bar allows you to slide back and forth along the horizontal
axis.

The Variables window

This lower section of the Debug window is a table consisting of a row for each
variable that you have dragged in.
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Graphic Trigger Window: Variables Window

To watch a variable, you need to copy it to the lower section of the Debug window:

Track Min value Max value  Cur value Value/Div

PIDOUTPUT -11.963 11.964 -11.952 2.99089
PIDFEEDBACK -10.710 10.710 -7.685 2.67756

This lower section of the Debug window is a table consisting of a row for each
variable that you dragged in. Each row has several fields, as presented in the
following table:

Field Description

Track Name of the variable.

Um Unit of measurement.

Min value Minimum value in the record set.

Max value Maximum value in the record set.

Cur value Last sampled value of the variable.

Value/Div How many engineering units are represented by a unit of the y-axis (that is, the
space between two ticks on the vertical axis).

V blue curs Value of the variable at the intersection with the line identified by the vertical blue
cursor.

Vred curs Value of the variable at the intersection with the line identified by the vertical red
cursor.

H blue curs Value of the variable at the intersection with the line identified by the horizontal
blue cursor.

H red curs Value of the variable at the intersection with the line identified by the horizontal
red cursor.

You can drag into the graphic trigger window only variables local to the module
where you placed the relative trigger, or global variables, or parameters. You
cannot drag variables declared in another program, function, or function block.

Sampling of Variables

The value of the variables is sampled every time the graphic trigger window
manager is triggered, that is every time the processor executes the instruction
marked by the green arrowhead. However, you can set controls in order to have
variables sampled when triggers also satisfy further limiting conditions that you
define.

The value of the variables in the column Track is read from memory just before
the marked instruction and immediately after the previous instruction.

Graphic Trigger Window Controls

Controls allow you to specify in detail when Programming samples the variables
added to the Variables window.

Graphic trigger window controls act on the behavior of the window regardless for
the type of the module (IL, ST, FBD, or LD) where the related trigger has been
inserted.

Window controls are made accessible to you through the Controls bar of the
debug window:
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Command

Description

Start graphic trace

When you click this button, the acquisition starts. If acquisition is running and you click the
button again, you stop the sample collection process, and you reset all the data you have
acquired so far.

Show measure bars

The two cursors (red cursor, blue cursor) may be seen and moved along their axis as long
as this button is clicked. Click the button again if you want to hide all the cursors.

Show samples

This control is used to put in evidence the exact point in which the variables are triggered
at each sample.

Vertical split

When clicked, this control splits the y-axis into as many segments as the dragged-in
variables, so that the diagram of each variable is drawn in a separate band.

Show all values

Itis used to fill in the graph window all the values sampled for the selected variables in the
current record set.

Horizontal zoom +
and

Horizontal zoom -

Zooming in is an operation that makes the curves in the Chart area appear larger on the
screen, so that greater detail may be viewed. Zooming out is an operation that makes the
curves appear smaller on the screen so that it may be viewed in its entirety.

Horizontal zoom acts only on the horizontal axis.

Horizontal show all

This control is used to horizontally center record set samples. So first sample is placed on
the left margin, and last is placed on the right margin of the graphic window.

Vertical zoom +
and

Vertical zoom -

Zooming in is an operation that makes the curves in the Chart area appear larger on the
screen so that greater detail may be viewed. Zooming out is an operation that makes the
curves appear smaller on the screen so that it may be viewed in its entirety.

Vertical Zoom acts only on the vertical axis.

Vertical show all

This control is used to vertically center record set samples. So max value sample is placed
near top margin and low value sample is placed on the bottom margin of the graphic
window.

JEERE R NEEE

Stop acquisition

This control is used to stop the acquisition.

Pause acquisition

Click this button to suspend the acquisition.

Re-start acquisition

Click this button to restart the acquisition.

m‘l"

Graph properties

Clicking this button causes a tabbed dialog box to appear, which allows you to set general
user options affecting the action of the graphic trigger window. For more information, refer
to Graphic Trigger Window Properties, page 235.

Print chart

Click this button to print both the Chart area and the Variables window.

) §

Save chart

Click this button to save the chart.

Trigger counter

This read-only control displays two numbers with the following format: Cnt: X/Y.

+ Xindicates how many times the debug window manager has been triggered
since the graphic trigger was installed.

* Yrepresents the number of samples the graphic window has to collect before
stopping data acquisition and drawing the curves.

Trigger state

This read-only control displays the state of the Debug window. It can assume the
following values:

No sample(s) taken, as the trigger has not occurred during the current task
execution.

Sample(s) collected, as the trigger has occurred during the current task
execution.
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The trigger counter indicates that a number of samples has been collected
satisfying the user request or memory constraints, thus the acquisition
process is stopped.

m Communication with target interrupted; the state of the trigger window cannot

be determined.

Graphic Trigger Window Properties

In order to open the properties window, you must click the Graph properties
button in the Controls bar. The Synchronous oscilloscope settings dialog box

appears.
General
Synchronous oscilloscope settings X
Show grid M Horizontal scale 500 Samples/div
Show time bar M Buffer size 65535 Samples (max. 65535)

Show tracks list | Condition

Tracks list
Name Unit Value/div Offset Hide
F2C_PROBE_CONVERTER 1 0 O
oK | | | [ cancel |
Control
Control Description
Show grid Select this control to display a grid in the Chart area background.
Show time bar The scroll bar at the bottom of the Chart area is available as long as this box
is selected.
Show tracks list The Variables window is displayed as long as this box is selected, otherwise
the Chart area extends to the bottom of the graphic trigger window.

Values

Control Description

Horizontal scale Number of samples per unit of the x-axis. The unit x-axis is the space
between two vertical lines of the background grid.

Unit of the x-axis

—
B Ramaaaaaassan st e

Buffer size Number of samples to acquire. When you open the Synchronous
oscilloscope settings window, after having previously dragged-in all the
variables you want to watch, a default number appears in this field,
representing the maximum number of samples you can collect for each
variable.

User-defined condition

If you define a condition by using this control, the sampling process does not start
until that condition is satisfied. Unlike trigger windows, once data acquisition
begins, samples are taken every time the window manager is triggered,
regardless whether the condition continues to be true.
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After you enter a condition, the control displays its simplified expression:
Condition |A GT 100 ()

Tracks list

This section allows you to define some graphic properties of the plot of each
variable. To select a variable, click its name in the Name column:

Control Description
Unit Unit of measurement, displayed in the table of the Variables window.
Value/div Values per unit of the y-axis. The unit y-axis is the space between two

horizontal lines of the background grid.

Offset Set a value to apply an offset value on the graph.

Hide Select this flag to hide the selected track on the graph.

Click Apply to make your changes effective, or click OK to apply your changes
and to close the Synchronous oscilloscope settings window.

Debugging with the Graphic Trigger Window

Description

The graphic trigger window tool allows you to select a set of variables and to have
them sampled synchronously and plotted in a special pop-up window.

Opening the Graphic Trigger Window from an IL Module

For this example, assume that you have an IL module containing the following
instructions:

LD
ATD
=T

oo

LD
ATD
=T

0 o0

LD
ATD
=T

e

Further, assume that you want to know the value of b, d, and k, just before the ST
k instruction is executed. To do so, move the cursor to line 12:

I Lk
ADD 1
ST W

Then click m Debug > Add/remove graphic trigger.
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A green arrowhead appears next to the line number, and the graphic trigger
window pops up:

D
ADD
ST

oo

D
ATD
ST

nan

1D
ADD
[ = ST

e

Not all the IL instructions support triggers. For example, it is not possible to place
a trigger at the beginning of a line containing a JMP statement.

Adding a Variable to the Graphic Trigger Window from an IL Module

In order to get the diagram of a variable plotted, you need to add it to the graphic
trigger window. Select a variable, by double-clicking it, and then drag it into the
Variables section. The variable now appears in the Track column:

HUL =w=Ig
SHE 1e#04
ADD addIgSg

HUL =v=Ig
SHE 1a#04
ADD addIgSg

G HHEE & aAH RAQD| -

The same procedure applies to all the variables you wish to monitor.

Once the first variable is dropped into a graphic trace, the Graphic properties
window is automatically displayed and allows you to setup sampling and
visualization properties.

EIO0000003412.05 237



Debugging

Opening the Graphic Trigger Window from an FBD Module

For this example, assume that you have an FBD module containing the following
instructions:

0o

9

oooz

0003

N

¢ 91¢ 90

Further, assume that you want to know the values of ¢, d, and k, just before the ST
k instruction is executed.

You can never place a trigger in a block representing a variable such as @ .
You must select the first available block preceding the selected variable. In the
example of the previous figure, you must move the cursor to network 3, and click
the ADD block.

Now click m Debug > Add/remove graphic trigger.

This causes the color of the selected block to turn to green, a white circle with the
trigger ID number inside to appear in the middle of the block,

|

9

noo2

0003

¢ 9¢ 90
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and the related trigger window to pop up:

G HERE SO (SN S mou > [E|=E Cnt:

Min value Max value Cur value Value/Div Description

When preprocessing the FBD source code, the compiler translates it into IL
instructions. The ADD instruction in network 3 is expanded to:

LD k

ADD c

ST k

When you add a trigger to an FBD block, you place the trigger before the first
statement of its IL equivalent code.

Adding a Variable to the Graphic Trigger Window from an FBD Module

To watch a variable, you need to add it to the trigger window. As stated, assume
that you want to see the plot of the variable k of the FBD code.

Click q Edit > Watch mode.

The cursor becomes as follows: g

Now you can click the block representing the variable you wish to be displayed in
the graphic trigger window.

In this example, click the button block: ID_.
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A dialog box appears listing all the currently existing instances of debug windows,
and asking you which one is to receive the object you have just clicked:

Symbol to add:
k

Debug windows
Watch
Oscilloscope

Graphic trace

[ OK ] [Cancel]

In order to plot the curve of variable k, select Graphic Trace in the Debug
windows column, then click OK. The name of the variable is now displayed in the
Track column:

6 BNH Qa0 RAMD = «» |@ 8 k8o s TN

Min value Max value  Cur value Value/Div
1

The same procedure applies to all the variables you wish to monitor.

Once you have added to the Graphic watch window all the variables you want to

k

monitor, you can click Edit > Insert/Move mode in order to restore the

original cursor.

Once the first variable is dropped into a graphic trace, the Graphic properties
window is automatically displayed and allows you to setup sampling and
visualization properties.
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Opening the Graphic Trigger Window from an LD Module

For this example, assume that you have an LD module containing the following
instructions:

.

You can place a trigger on a block such as follows:

In this case, the same rules apply as to insert the graphic trigger in an FBD
module.

Further, assume that you want to know the value of some variables every time the
processor reaches network number 1.

Click one of the items making up network number 1, then click m Debug > Add/
remove graphic trigger

This causes the gray area containing the network number to turn to green, a white
circle with a number inside to appear in the middle of the area,

.
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and the graphic trigger window to pop up.

G| H R ® & & mou » |[[E &= Cnt:

Min value Max value Cur value Value/Div Description

NOTE: Unlike the other languages supported by Programming, LD does not
allow you to insert a trigger before a single contact or coil, as it lets you select
only an entire network. Thus the variables in the Graphic trigger window will
be sampled every time the processor reaches the beginning of the selected
network.

Adding a Variable to the Graphic Trigger Window from an LD Module

In order to watch the diagram of a variable, you must add it to the Graphic trigger
window. In this example, assume that you want to see the plot of the variable b in
the LD code.

Click O" Edit > Watch mode.

The cursor becomes as follows: I!"‘-&

Now you can click the item representing the variable you wish to be displayed in
the Graphic trigger window.

A dialog box appears listing all the currently existing instances of debug windows,
and asking you which one is to receive the object you have just clicked.
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In order to plot the curve of variable b, select Graphic trace in the Debug
windows column, then click OK. The name of the variable is now displayed in the
Track column:

Symbol to add:
b

Debug windows
Watch

Oscilloscope
[ OK ] [ Cancel ]

The same procedure applies to all the variables you wish to monitor.

Once you have added to the Graphic watch window all the variables you want to
monitor, you can click h:
of the cursor.

Edit > Insert/Move mode to restore the original shape

Once the first variable is dropped into a graphic trace, the Graphic properties
window is automatically displayed and allows you to setup sampling and
visualization properties.

Opening the Graphic Trigger Window from an ST Module

For this example, assume that you have an ST module containing the following

instructions:
a = h = h;
c = o + SHR{ a., 1604 }:
d = 2 * =;
f = f + SHRE{ d. 1604 }:

This example assumes that you want to know the value of e, d, and f, just before
the instruction
f := £+ SHR( d, 16#04 )

is executed. To do so, move the cursor to line 6.

Then click m Debug > Add/remove graphic trigger.

A green arrowhead appears next to the line number, and the Graphic trigger
window pops up:

a := b = h;
c = o + SHRE{ a, lo#04 3
d = e *® =;

3 f := £ + SHRE({ 4, le#04 3.
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o RlEE =R ® & & & LI TR S = == Cnt: Om

Min value Max value Cur value Value/Div Description

Not all the ST instructions support triggers. For example, it is not possible to place
a trigger on a line containing a terminator such as END_IF, END_FOR, END _

WHILE, and so on.

Adding a Variable to the Graphic Trigger Window from an ST Module

In order to get the diagram of a variable plotted, you need to add it to the Graphic
trigger window.

Select a variable, by double-clicking it, and then drag it into the Variables window
that is the lower white box in the pop-up window:

G HHERaaaH RER[| -

gample
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The variable now appears in the Track column:

G HODHERAME @aa8 R[RRAE| = n» =W U RIS,  Stop |

Min value Max value Cur value Value/Div Description

The same procedure applies to all the variables you wish to monitor.

Once the first variable is dropped into a graphic trace, the Graphic properties
window is automatically displayed and allows you to setup sampling and
visualization properties:

Show grid M Horizontal scale 500 Samples/div
Show time bar M Buffer size 65535 Samples (max. 65535)
Show tracks list ] Condition

Tracks list
Name Unit Value/div Offset Hide

F 1 0 O

OK Cancel

Removing a Variable from the Graphic Trigger Window

If you want to remove a variable from the Graphic trigger window, select it by
clicking its name once, then press the Delete key.
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Using Controls

Graphic trigger window controls allow you to supervise the working of this
debugging tool and to get more information on the application.

Enabling controls
When you set a trigger, all the elements in the Control bar are enabled. You can
start data acquisition by clicking the [ o Start graphic trace button.

If you defined a user condition, which is currently false, data acquisition does not
start.

On the contrary, once the condition becomes true, data acquisition starts and
continues until the [ o Start graphic trace button is released, regardless for the

condition being or not still true.

If you release the = Start graphic trace button before all the required samples
have been acquired, the acquisition process stops and all the collected data get
lost.

Defining a condition

This control enables you to set a condition on when to start acquisition. By default,
this condition is set to true, and acquisition begins as soon as you click the
Enable/Disable acquisition button. From that moment on, the value of the
variables in the Debug window is sampled every time the trigger occurs.

In order to specify a condition, open the Condition tab of the Options dialog box,
then click the relevant button:

A text window pops up, where you can write the IL code that sets the condition:

ID a A
GT 100

Once you have finished writing the condition code, click OK to install it, or press

the Esc key to cancel. The collection of samples will not start until the o Start
graphic trace button is clicked and the user-defined condition is true. A simplified
expression of the condition now appears in the control:

Condition |A GT 100 ()

To modify it, click again the browser button:

The text window appears, containing the text you originally wrote, which you can
now edit.

To remove a user-defined condition, click again the button, delete the whole IL
code in the text window, then click the OK button.

The result of the condition code must be of type boolean (TRUE or FALSE),
otherwise a compiler error occurs.

Only global variables and dragged-in variables can be used in the condition code.
Namely, all variables local to the module where the trigger was originally inserted
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are out of scope if they have not been dragged into the Debug window. Also, no
new variables can be declared in the condition window.

Setting the scale of axes

* x-axis
When acquisition is completed, Programming plots the curve of the dragged-in
variables adjusting the x-axis so that all the data fit in the Chart window. If you
want to apply a different scale, open the General tab of the Graph properties
dialog box, type a number in the horizontal scale edit box, then confirm by clicking
Apply.

+ y-axis
You can change the scale of the plot of each variable through the Tracks list tab

of the Graph properties dialog box. Otherwise, if you do not need to specify
exactly a scale, you can use the Zoom In and Zoom Out controls.

Closing the Graphic Trigger Window and Removing the Trigger

At the end of a debug session with the graphic trigger window, you can choose
between the following options:

» Closing the graphic trigger window:

If you have finished plotting the diagram of a set of variables by using the
Graphic trigger window, you may want to close the Debug window without
removing the trigger. If you click the button in the top right-hand corner, you
hide the Interface window while the window manager and the relative trigger
keep working.

To restore the Graphic trigger window that you previously hid:
o Open the Trigger list window;

o Select the record (having type G);

o Click the Open button.

The Interface window appears with the trigger counter properly updated, as if
it had never been closed.

* Removing the trigger:

If you choose this option, you completely remove the code both of the window
manager and of its trigger:

o Open the Trigger list window;
o Select the record (having type G);
o Click the Remove button.

Alternatively, you can move the cursor to the line (if the module is in IL), or
click the block (if the module is in FBD) where you placed the trigger. Now
click the Graphic trace button in the Debug toolbar.

* Removing all the triggers:
Alternatively, you can remove all the existing triggers at once, regardless for

which records are selected, by clicking the H Remove all triggers button.
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Language Reference

Description

What’s in This Chapter
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EcoStruxure Machine Expert - HVAC Language Extensions ..........c.....ccocuuunn.. 300

EcoStruxure Machine Expert - HVAC languages are IEC 61131-3 standard-
compliant:

+  Common elements
* Instruction list (IL)
» Function block diagram (FBD)
» Ladder diagram (LD)
» Structured text (ST)
» Sequential Function Chart (SFC)
Moreover, EcoStruxure Machine Expert - HVAC implements some extensions:
» Pointers
* Macros

Common Elements

Overview

Description

Basic Elements

Character Set

Common elements are textual and graphic elements shared by all the
programmable controller programming languages specified by IEC 61131-3
standard.

NOTE: The definition and editing of most of the common elements (variables,
structured elements, function blocks definitions, and so on) are managed by
EcoStruxure Machine Expert - HVAC through specific editors, forms, and
tables. EcoStruxure Machine Expert - HVAC does not allow you to edit directly
the source code related to these common elements.

NOTE: The following information was derived directly from the copyrighted
IEC standards.

Textual documents and textual elements of graphic languages are written by using
the standard ASCII character set.
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Comments
User comments are delimited at the beginning and end by the special character
combinations “(*”and “*)”, respectively. Comments are allowed anywhere in the
program, and they have no syntactic or semantic significance in any of the
languages defined in this standard.
The use of nested comments, for example (* (* NESTED *) *), is treated as an
error.

Elementary Data Types

Description

A number of elementary (pre-defined) data types is made available by
EcoStruxure Machine Expert - HVAC;

Elementary data types, keyword for each data type, number of bits per data
element, and range of values for each elementary data type are presented in the
following table.

Keyword Data type Bits Range

BOOL Boolean U] 0...1

SINT Short integer 8 -128...127

USINT Unsigned short integer 8 0...255

INT Integer 16 -32768...32767

UINT Unsigned integer 16 0...65536

DINT Double integer 32 -231...2311

UDINT Unsigned long integer 32 0...232

BYTE Bit string of length 8 8 -

WORD Bit string of length 16 16 -

DWORD Bit string of length 32 32 -

REAL Real number 32 -3.40E+38...+3.40E+38

LREAL Long real number 64 -1.7E+308...+1.7E+308

STRING String of characters encoded - Characters are delimited by single
with UTF-8 quotes (‘abc’)

WSTRING String of characters encoded - Characters are delimited by double
with UTF-16 quotes (“abc”)

DATE Date expressed in seconds 32 1970-01-01...2038-01-19
represented with format YYY'Y-
MM-DD

LDATE Date expressed in 64 1970-01-01...2262—-04-11
nanoseconds represented with
format YYYY-MM-DD

TIME Time expressed in milliseconds | 32 -24d_20h_31m_23s_648ms...
represented with format dd_ +24d_20h_31m_23s_647ms
hh_mm_ss_ms

LTIME Time expressed in 64 -106751d_23h_47m_16s_854ms_
nanoseconds represented with 775us_808ns...+106751d_23h_
format dd_hh_mm_ss_ms_us_ 47m_16s_854ms_775us_807ns
ns

DATE_ Date expressed in seconds 32 1970-01-01-00:00:00...2038-01-

AND_TIME represented with format YYY'Y- 19-03:14:07
MM-DD-hh:mm:-ss

LDATE_ Date expressed in 64 1970-01-01-00:00:00...2262—-04-

AND_TIME nanoseconds represented with 11-23:47:16.854
format YYYY-MM-DD-hh:mm:
ss.us
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Keyword Data type Bits Range
TIME_OF_ Time of day expressed in 32 00:00:00...23:59:59.999
DAY milliseconds represented with
format hh:mm:ss.ms
ITIME_OF_ | Time of day expressed in 64 00:00:00...23:59:59.999999999
DAY nanoseconds represented with
format hh:mm:ss.ns
@ANY_ Pointer to a variable of any 32/64 Refer to Pointers, page 300.
TYPE type (NOT IEC standard)
PVOID Pointer to a generic variable, 32/64 Refer to Pointers, page 300.
without type specified (NOT
IEC standard)

(1) The implementation of the BOOL data type depends on the processor of the target device, for
example, it is 1 bit long for devices that have a bit-addressable area.

Derived Data Types

Description

Typedefs

Derived data types can be declared using the TYPE...END_TYPE construct. They
can be used in variable declarations, in addition to the elementary data types.

Both single-element variables and elements of a multi-element variable, which are
declared to be of derived data types, can be used anywhere where a variable of its
parent type can be used.

The purpose of typedefs is to assign alternative names to existing types. There
are not any differences between a typedef and its parent type, except the name.

Typedefs can be declared using the following syntax:
TYPE

<enumerated data type name> : <parent type name>;
END TYPE

For example, consider the following declaration, mapping the name LONGWORD
to the IEC 61131-3 standard type DWORD:
TYPE
LONGWORD : DWORD;
END TYPE

Enumerated Data Types

An enumerated data type declaration specifies that the value of any data element
of that type can only be one of the values given in the associated list of identifiers.
The enumeration list defines an ordered set of enumerated values, starting with
the first identifier of the list, and ending with the last.

Enumerated data types can be declared using the following syntax:
TYPE

<enumerated data type name> : ( <enumeration list> );
END TYPE

For example, consider the following declaration of two enumerated data types.
When no explicit value is given to an identifier in the enumeration list, its value
equals the value assigned to the previous identifier augmented by one.
TYPE
enuml: (

vall, (* the value of vall is 0 *)

val2, (* the value of val2 is 1 *)

val3 (* the value of val3 is 2 *)
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Subranges

Structures

Literals

Numeric Literals

)7

enum?2: (
k := -11,
i =0,
j, (* the value of j is (1 + 1 ) =1 *)
1l :=5
) ;
END TYPE

Different enumerated data types may use the same identifiers for enumerated
values. To be uniquely identified when used in a particular context, enumerated
literals may be qualified by a prefix consisting of their associated data type name
and the # sign.

A subrange declaration specifies that the value of any data element of that type is
restricted between and including the specified upper and lower limits.

Subranges can be declared using the following syntax:
TYPE
<subrange name> : <parent type name> ( <lower limit>..
<upper limit> );
END TYPE

For example, consider the following declaration:
TYPE

int 0 to 100 : INT (0..100);
END TYPE

A STRUCT declaration specifies that data elements of that type shall contain
subelements of specified types which can be accessed by the specified names.

Structures can be declared using the following syntax:
TYPE
<structured type name> : STRUCT
<declaration of structurestructure elements>
END STRUCT;
END TYPE

For example, consider the following declaration:
TYPE
structurel : STRUCT
eleml : USINT;
elem?2 : USINT;
elem3 : INT;
elem3 : REAL;
END STRUCT;
END TYPE

External representation of data in the various programmable controller
programming languages consists of numeric literals.

There are two classes of numeric literals: integer literals and real literals. A
numeric literal is defined as a decimal number or a based number.

Decimal literals are represented in conventional decimal notation. Real literals are
distinguished by the presence of a decimal point. An exponent indicates the
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integer power of ten by which the preceding number needs to be multiplied to
obtain the represented value. Decimal literals and their exponents can contain a
preceding sign (+ or -).

Integer literals can also be represented in base 2, 8 or 16. The base is in decimal
notation. For base 16, an extended set of digits consisting of letters A through F is
used, with the conventional significance of decimal 10 through 15, respectively.
Other than base 10 numbers do not contain any leading sign (+ or -).

Boolean data are represented by the keywords FALSE and TRUE.

Numerical literal features and examples are presented in the following table:

Feature description Examples
Integer literals -12
0
123
+986
Real literals -12.0
0.0
0.4560
Real literals with exponents -1.34E-12 or -1.34e-12

1.0E+6 or 1.0e+6
1.234E6 or 1.234e6
Base 2 literals 2#11111111 (256 decimal)

2#11100000 (240 decimal)

Base 8 literals 8#377 (256 decimal)
8#340 (240 decimal)

Base 16 literals 16#FF or 16#ff (256 decimal)
16#E0 or 16#e0 (240 decimal)

Boolean FALSE and TRUE FALSE

TRUE

For more details, refer to Two-character strings, page 253.

Character String Literals

A character string literal is a sequence of zero or more characters prefixed and
terminated by the single quote character (').

Example Explanation

Empty string (length zero)

‘A’ String of length one containing the single character A

String of length one containing the space character

" String of length one containing the single quote character ()

"

String of length one containing the double quote character

'$RSL’ String of length two containing CR and LF characters (1)

'$0A’ String of length one containing the LF character (2)

(1) For more details, refer to Two-character strings, page 253.

(2) The three-character combination of the dollar sign ($) followed by two hexadecimal digits shall
be interpreted as the hexadecimal representation of the ASCII eight-bit character code.
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Two-character Combinations

Two-character combinations beginning with the dollar sign shall be interpreted as
presented in the following table when they occur in character strings:

Combination Interpretation when displayed
$$ Dollar sign

$' Single quote

$Lor $1 Line feed

$Nor $n Newline

$Por $p Form feed (page)

SR or $r Carriage return

$Tor $t Tab

Variables

Foreword

Variables provide a means of identifying data objects whose contents may
change, for example, data associated with the inputs, outputs, or memory of the
programmable controller. A variable must be declared to be one of the elementary
types. Variables can be represented symbolically, or alternatively in a manner
which directly represents the association of the data element with physical or
logical locations in the programmable controller’s input, output, or memory
structure.

Each program organization unit (POU) (program, function, or function block)
contains at its beginning at least one declaration part. This declaration part
consists of one or more structuring elements, which specify the types (and, if
necessary, the physical or logical location) of the variables used in the
organization unit. This declaration part has the textual form of one of the keywords
VAR, VAR_INPUT, or VAR_OUTPUT as defined in the keywords section, followed
in the case of VAR by zero or one occurrence of the qualifiers RETAIN, NON_
RETAIN or the qualifier CONSTANT, and in the case of VAR _INPUT or VAR _
OUTPUT by zero or one occurrence of the qualifier RETAIN or NON_RETAIN,
followed by one or more declarations separated by semicolons and terminated by
the keyword END_VAR. A declaration may also specify an initialization for the
declared variable when a programmable controller supports the declaration by the
user of initial values for variables.

Structuring Element

The declaration of a variable must be performed within the following program
structuring element:
KEYWORD [RETAIN] [CONSTANT]

Declaration 1

Declaration 2

Declaration N
END VAR

Keywords and Scope

Keyword Variable usage
VAR Internal to organization unit.
VAR_INPUT Externally supplied.
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Qualifiers

Keyword Variable usage

VAR_OUTPUT Supplied by organization unit to external entities.

VAR_IN_OUT Supplied by external entities, can be modified within organization unit.

VAR_EXTERNAL | Supplied by configuration via VAR_GLOBAL, can be modified within
organization unit.

VAR_GLOBAL Global variable declaration.

The scope (range of validity) of the declarations contained in structuring elements
is local to the program organization unit (POU) in which the declaration part is
contained. That is, the declared variables are accessible to other program
organization units except by explicit argument passing via variables which have
been declared as inputs or outputs of those units. The one exception to this rule is
the case of variables which have been declared to be global.

Global variables are accessible to programs in any case, or via a VAR_
EXTERNAL declaration to function blocks. The type of a variable declared in a
VAR_EXTERNAL must agree with the type declared in the VAR_GLOBAL block.

To give access to these variables to all types of POU, without using any keyword,
you must enable this option in the Code generation tab of the Project Options
window, page 103.

An error is detected if:

* Any POU attempts to modify the value of a variable that has been declared
with the CONSTANT qualifier;

* Avariable declared as VAR_GLOBAL CONSTANT in a configuration element
or POU (the “containing element”) is used in a VAR_EXTERNAL declaration
(without the CONSTANT qualifier) of any element contained within the
containing element.

Qualifier Description

CONST The attribute CONST indicates that the variables within the structuring
elements are constants, that is, they have a constant value, which cannot be
modified once the PLC project has been compiled.

RETAIN The attribute RETAIN indicates that the variables within the structuring
elements are retentive, that is, they keep their value even after the target
device is reset or switched off.

Single-Element Variables and Arrays

Declaration Syntax

A single-element variable represents a single data element of either one of the
elementary types or one of the derived data types.

An array is a collection of data elements of the same data type; in order to access
a single element of the array, a subscript (or index) enclosed in square brackets
has to be used. Subscripts can be either integer literals or single-element
variables.

To represent data matrices, arrays can be multi-dimensional; in this case, a
composite subscript is required, one index per dimension, separated by commas.
The maximum number of dimensions allowed in the definition of an array is three.

Variables must be declared within structuring elements, using the following syntax:
VarNamel : Typenamel [ := InitialVall 1;

VarName2 AT Location2 : Typename2 [ := Initialval2 ];
VarName3 : ARRAY [ 0..N ] OF Typename3;
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Where:
Keyword Description
VarNameX Variable identifier, consisting of a string of alphanumeric characters, of length 1
or more. It is used for symbolic representation of variables.
TypenameX Data type of the variable, selected from elementary data types.
InitialValX The value the variable assumes after reset of the target.
LocationX Refer to Location description, page 255.
N Il\r;de;( of the last element, the array having length
+1.

Location

Variables can be represented symbolically, that is, accessed through their
identifier, or alternatively in a manner which directly represents the association of
the data element with physical or logical locations in the input, output, or memory
structure of the programmable controller.

Direct representation of a single-element variable is provided by a special symbol
formed by the concatenation of the percent sign “%”, a location prefix and a size
prefix, and one or two unsigned integers, separated by periods (.).

%location.size.index.index
1) location

The location prefix may be one of the following:

Location prefix Description

I Input location

Q Output location
Memory location

2) size

The size prefix may be one of the following:

Size prefix Description

X Single bit size

B Byte (8 bits) size

w Word (16 bits) size

D Double word (32 bits) size

3) index.index

This sequence of unsigned integers, separated by dots, specifies the position of
the variable in the area specified by the location prefix.

Example:
Direct representation Description
%MW4.6 Word starting from the first byte of the seventh element of memory
data block 4.
%1X0.4 First bit of the first byte of the fifth element of input set 0.

The absolute position depends on the size of the data block elements, not on the
size prefix. %aMWH4.6 and %MD4.6 begin from the same byte in memory, but the
former points to an area which is 16 bits shorter than the latter.
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For advanced users only: if the index consists of one integer only (no dots), then it
loses any reference to data blocks, and it points directly to the byte in memory
having the index value as its absolute address.

Direct representation Description
%MW4.6 Word starting from the first byte of the seventh element of datablock
4 in memory.
%MW4 Word starting from byte 4 of memory.
Example:

VAR [RETAIN] [CONSTANT]
XQuote : DINT;

Enabling : BOOL := FALSE;
TorqueCurrent AT $MW4.32 : INT;
Counters : ARRAY [ O .. 9 ] OF UINT;
Limits: ARRAY [0..3, 0..9]

END_ VAR

» Variable XQuote is 32 bits long, and it is automatically allocated by the
EcoStruxure Machine Expert - HVAC compiler.

» Variable Enabling is initialized to FALSE after target reset.

» Variable TorqueCurrent is allocated in the memory area of the target device,
and it takes 16 bits starting from the first byte of the 33rd element of data
block 4.

» Variable Counters is an array of 10 independent variables of type unsigned
integer.

Declaring Variables in EcoStruxure Machine Expert - HVAC

Whatever the PLC language you are using, EcoStruxure Machine Expert - HVAC
allows you to disregard the previous syntax, as it supplies the local variables
editor, the global variables editor, and the parameters editor, which provide an
interface to declare all kinds of variables.

Program Organization Units

Description

Functions

Program organization units (POU) are functions, function blocks, and programs.
Program organization units can be delivered by the manufacturer, or programmed
by you through the means defined in this part of the standard.

Program organization units are not recursive; that is, the invocation of a program
organization unit cannot cause the invocation of the same program organization
unit.

Introduction

For the purposes of programmable controller programming languages, a function
is defined as a program organization unit (POU) which, when executed, yields
exactly one data element, which is considered to be the function result.

Functions contain no internal state information, that is, invocation of a function
with the same arguments (input variables VAR_INPUT and in-out variables VAR _
IN_OUT) always yields the same values (output variables VAR_OUTPUT, in-out
variables VAR _IN_OUT, and function result).

Declaration syntax
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The declaration of a function must be performed as follows:
FUNCTION FunctionName : RetDataType
VAR INPUT
declaration of input variables (see the relevant
section)
END VAR
VAR EXTERNAL
declaration of external variables
END VAR
VAR
declaration of local variables (see the relevant
section)
END VAR
Function body
END_ FUNCTION

Keyword Description

FunctionName Name of the function being declared.

RetDataType Data type of the value to be returned by the function.

VAR_EXTERNAL . . | Afunction can access global variables only if they are listed in a VAR
END VAR EXTERNAL structuring element. Variables passed to the FB via a VAR _

EXTERNAL construct can be modified from within the FB.

Function body Specifies the operations to be performed upon the input variables in order to
assign values dependent on the function’s semantics to a variable with the
same name as the function, which represents the function result. It can be
written in any of the languages supported by EcoStruxure Machine Expert -
HVAC

Declaring functions

Whatever the PLC language you are using, EcoStruxure Machine Expert - HVAC
allows you to disregard the previous syntax, as it supplies a friendly interface for
using functions.

Function Blocks

Introduction

For the purposes of programmable controller programming languages, a function
block is a program organization unit which, when executed, yields one or more
values. Multiple, named instances (copies) of a function block can be created.
Each instance has an associated identifier (the instance name), and a data
structure containing its input, output, and internal variables. All the values of the
output variables and the necessary internal variables of this data structure persist
from one execution of the function block to the next. Invocation of a function block
with the same arguments (input variables) does not always yield the same output
values.

Only the input and output variables are accessible outside of an instance of a
function block, that is, the function block’s internal variables are hidden from the
user of the function block.

In order to execute its operations, a function block needs to be started by another
POU. Invocation depends on the specific language of the module calling the
function block.

The scope of an instance of a function block is local to the program organization
unit in which it is instantiated.

Declaration syntax

The declaration of a function must be performed as follows:
FUNCTION BLOCK FunctionBlockName
VAR INPUT
declaration of input variables (see the relevant
section)
END VAR
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VAR OUTPUT
declaration of output variables
END VAR
VAR EXTERNAL
declaration of external variables
END VAR
VAR
declaration of local variables
END VAR
Function block body
END FUNCTION BLOCK

Keyword Description

FunctionBlockName Name of the function block being declared (note: name of the
template, not of its instances).

VAR_EXTERNAL .. END_VAR | A function block can access global variables only if they are listed
ina VAR_EXTERNAL structuring element. Variables passed to
the FB via a VAR_EXTERNAL construct can be modified from
within the FB.

Function block body Specifies the operations to be performed upon the input variables
in order to assign values to the output variables - dependent on
the function block’s semantics and on the value of the internal
variables. It can be written in any of the languages supported by
EcoStruxure Machine Expert - HVAC.

Declaring functions

Whatever the PLC language you are using, EcoStruxure Machine Expert - HVAC
allows you to disregard the previous syntax, as it supplies a friendly interface for
using function blocks.

Programs

Introduction

A program is defined in IEC 61131-1 as a “logical assembly of all the programming
language elements and constructs necessary for the intended signal processing
required for the control of a machine or process by a programmable controller
system”.

Declaration syntax

The declaration of a program must be performed as follows:

PROGRAM < program name>
Declaration of variables (see the relevant section)
Program body

END_ PROGRAM

Keyword Description
Program Name Name of the program being declared.
Program body Specifies the operations to be performed to get the intended signal

processing. It can be written in any of the languages supported by
EcoStruxure Machine Expert - HVAC.

Writing programs

Whatever the PLC language you are using, EcoStruxure Machine Expert - HVAC
allows you to disregard the previous syntax, as it supplies a friendly interface for
writing programs.
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Operator and Standard Blocks

Description

The availability of the following functions depends on the target device.

These functions are common to the whole set of programming languages and can
be used in any programmable organization unit (POU). They are accessible from
Operators and blocks window in Operator and standard blocks window tab.

Operators and standard blocks are sorted in groups:

* Arithmetic Functions and Operators, page 259

» Bistable Operators, page 263
« Bit Shift Functions, page 263
» Comparison Operators, page 264

» Conversion Functions, page 265

* Logic Functions, page 268

» Selection Functions, page 268

» String Functions, page 270

Arithmetic Functions and Operators

ABS

Description

Absolute value. Computes the absolute value of input #0

Number of operands

1

Input data type

Any numerical type

Output data type

Same as input

Examples

OUT := ABS( -5 ); (* OUT = 5 *)
OUT := ABS( -1.618 );(* OUT = 1.618 *)
OUT := ABS( 3.141592 ); (* OUT = 3.141592 *)

ACOS

Description

Arc cosine. Computes the principal arc cosine of input #0; result is
expressed in radians

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

ouT :
ouT :

ACOS( 1.0 ); (* OUT = 0.0 *)
ACOS( -1.0 ); (* OUT = PI *)

ADD

Description

Arithmetic addition. Computes the sum of the two inputs.

Number of operands

2

Input data type

Any numerical type

Output data type

Same as Inputs

Examples

OUT := ADD( 20, 40 ); (* OUT = 60 *)

ASIN

Description

Arc sine. Computes the principal arc sine of input #0; result is
expressed in radians

Number of operands

1

Input data type

LREAL where available, REAL otherwise

EI00000003412.05

259



Language Reference

ASIN

Output data type LREAL where available, REAL otherwise

Examples OUT := ASIN( 0.0 ); (* OUT = 0.0 *)
OUT := ASIN( 1.0 ); (* OUT = PI / 2 *)

ATAN

Description Arc tangent. Computes the principal arc tangent of input #0; result is
expressed in radians

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := ATAN( 0.0 ); (* OUT = 0.0 *)
OUT := ATAN( 1.0 ); (* OUT = PI / 4 *)

ATAN2*

Description Arc tangent (with two parameters). Computes the principal arc tangent
of Y/X; result is expressed in radians

Number of operands 2

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := ATAN2( 0.0, 1.0 ); (* OUT = 0.0 ¥*)
OUT := ATAN2( 1.0, 1.0 ); (* OUT = PI / 4 *)
OUT := ATAN2( -1.0, -1.0 ); (* OUT = ( -3/4 ) * PI
:)[)JT := ATAN2( 1.0, 0.0 ); (* OUT = PI / 2 *)

CEIL*

Description Rounding up to integer. Returns the smallest integer that is greater
than or equal to input #0

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := CEIL( 1.95 ); (* OUT = 2.0 *)
OUT := CEIL( -1.27 ); (* OUT = -1.0 *)

COs

Description Cosine. Computes the cosine function of input #0 expressed in radians

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := COS( 0.0 ); (* OUT = 1.0 *)
OUT := COS( -3.141592 ); (* OUT ~ -1.0 *)

COSH*

Description ggperbolic cosine. Computes the hyperbolic cosine function of input

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := COSH( 0.0 ); (* OUT = 1.0 *)
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DIV

Description Arithmetic division. Divides input #0 by input #1

Number of operands 2

Input data type Any numerical type

Output data type Same as Inputs

Examples OUT := DIV( 20, 2 ); (* OUT = 10 *)

EXP

Description Natural exponential. Computes the exponential function of input #0

Number of operands

1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := EXP( 1.0 ); (* OUT ~ 2.718281 ¥*)

FLOOR*

Description Rounding down to integer. Returns the largest integer that is less than
or equal to input #0

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := FLOOR( 1.95 ); (* OUT = 1.0 *)
OUT := FLOOR( -1.27 ); (* OUT = -2.0 *)

LN

Description Natural logarithm. Computes the logarithm with base e of input #0

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := LN( 2.718281 ); (* OUT = 1.0 *)

LOG

Description Common logarithm. Computes the logarithm with base 10 of input #0

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := LOG( 100.0 ); (* OUT = 2.0 *)

MOD

Description Module. Computes input #0 module input #1

Number of operands 2

Input data type Any numerical type

Output data type Same as Inputs

Examples OUT := MOD( 10, 3 ); (* OUT = 1 ¥*)

MUL

Description Arithmetic multiplication. Multiplies the two inputs.

Number of operands

2
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MUL

Input data type Any numerical type

Output data type Same as Inputs

Examples OUT := MUL( 10, 10 ); (* OUT = 100 *)

POW

Description Exponentiation. Raises Base to the power Expo

Number of operands 2

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := POW( 2.0, 3.0 ); (* OUT = 8.0 *)
OUT := POW( -1.0, 5.0 ); (* OUT = -1.0 *)

SIN

Description Sine. Computes the sine function of input #0 expressed in radians

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := SIN( 0.0 ); (* OUT = 0.0 *)
OUT := SIN( 2.5 * 3.141592 ); (* OUT ~ 1.0 *)

SINH*

Description Hyperbolic sine. Computes the hyperbolic sine function of input #0

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := SINH( 0.0 ); (* OUT = 0.0 *)

SQRT

Description Square root. Computes the square root of input #0

Number of operands 1

Input data type LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

Examples OUT := SQRT( 4.0 ); (* OUT = 2.0 *)

SuB

Description Arithmetic subtraction. Subtracts input #1 from input #0

Number of operands 2

Input data type Any numerical type

Output data type Same as Inputs

Examples OUT := SUB( 10, 3 ); (* OUT = 7 *)

TAN

Description Tangent. Computes the tangent function of input #0 expressed in
radians

Number of operands 1

Input data type LREAL where available, REAL otherwise

262

EI00000003412.05



Language Reference

Bistable Operators

Bit Shift Functions

TAN
Output data type LREAL where available, REAL otherwise
Examples OUT := TAN( 0.0 ); (* OUT = 0.0 *)
OUT := TAN( 3.141592 / 4.0 ); (* OUT ~ 1.0 *)
TANH*
Description :gperbolic tangent. Computes the hyperbolic tangent function of input
Number of operands 1
Input data type LREAL where available, REAL otherwise
Output data type LREAL where available, REAL otherwise
Examples OUT := TANH( 0.0 ); (* OUT = 0.0 *)

* function provided as extension to the IEC 61131-3 standard.

R

Description

Boolean reset.

Number of operands

1

Input data type BOOL
Output data type BOOL
Examples LD x

Ry

ST z
S
Description Boolean set.
Number of operands 1
Input data type BOOL
Output data type BOOL
Examples LD x

Sy

ST z
ROL
Description Input #0 left-shifted of Input #1 bits, circular.

Number of operands

2

Input data type Any numerical type

Output data type Same as Input #0

Examples OUT := ROL( IN := 16#1000CAFE, 4 );
(* OUT = 16#000CAFE1l *)

ROR

Description Input #0 right-shifted of Input #1 bits, circular.

Number of operands

2

Input data type

Any numerical type
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ROR

Output data type

Same as Input #0

Examples

OUT := ROR( IN := 16#1000CAFE, 16 );
(* OUT = 16#CAFE1000 *)

SHL

Description

Input#0 left-shifted of Input #1 bits, zero filled on the right.

Number of operands

2

Input data type

Any numerical type

Output data type

Same as Input #0

Examples

OUT := SHL( IN := 16#1000CAFE, 16 );
(* OUT = 16#CAFE0000 *)

SHR

Description

Input #0 right-shifted of Input #1 bits, zero filled on the left.

Number of operands

2

Input data type

Any numerical type

Output data type

Same as Input #0

Examples

OUT := SHR( IN := 16#1000CAFE, 24 );
(* OUT = 16#00000010 ¥*)

Comparison Operators

Comparison operators can be also used to compare strings if this feature is
supported by the target device.

EQ
Description Equal to. Returns TRUE if Input #0 = Input #1, otherwise FALSE.
Number of operands 2
Input data type Any
Output data type BOOL
Examples OUT := EQ( TRUE, FALSE ); (* OUT = FALSE *)
OUT := EQ( ‘AZ’, ‘ABC’ ); (* OUT = FALSE *)
GE
Description Greater than or equal to. Returns TRUE if Input #0 >= Input #1,
otherwise FALSE.
Number of operands 2
Input data type Any but BOOL
Output data type BOOL
Examples OUT := GE( 20, 20 ); (* OUT = TRUE *)
OUT := GE( ‘AZ’, ‘ABC’ ); (* OUT = FALSE *)
GT
Description Greater than. Returns TRUE if Input #0 > Input #1, otherwise FALSE.
Number of operands 2
Input data type Any but BOOL
Output data type BOOL
Examples OUT := GT( 0, 20 ); (* OUT = FALSE *)
OUT := GT( ‘AZ’, ‘ABC’ ); (* OUT = TRUE ¥*)
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LE
Description Less than or equal to. Returns TRUE if Input #0 <= Input #1, otherwise
FALSE.
Number of operands 2
Input data type Any but BOOL
Output data type BOOL
Examples OUT := LE( 20, 20 ); (* OUT = TRUE ¥*)
OUT := LE( ‘AZ’, ‘ABC’ ); (* OUT = FALSE *)
LT
Description Less than. Returns TRUE if Input #0 < Input #1, otherwise FALSE.
Number of operands 2
Input data type Any but BOOL
Output data type BOOL
Examples OUT := LT( 0, 20 ); (* OUT = TRUE ¥*)
OUT := LT( ‘AZ’, ‘ABC’ ); (* OUT = FALSE *)
NE
Description Not equal to. Returns TRUE if Input #0!= Input #1, otherwise FALSE.
Number of operands 2
Input data type Any
Output data type BOOL
Examples OUT := NE( TRUE, FALSE ); (* OUT = TRUE *)
OUT := NE( ‘AZ’, ‘ABC’ ); (* OUT = TRUE *)

Conversion Functions

According to the IEC 61131-3 standard, type conversion functions shall have the
form *_TO_**, where “* is the type of the input variable, and “** the type of the
output variable (for example, INT_TO_REAL). EcoStruxure Machine Expert -
HVAC provides a more convenient set of overloaded type conversion functions,
relieving you to specify the input variable type.

TO_BOOL

Description Conversion to BOOL (boolean)

Number of operands 1

Input data type Any numerical type

Output data type BOOL

Examples out := TO BOOL( 0 ); (* out = FALSE *)
out := TO BOOL( 1 ); (* out = TRUE *)
out := TO BOOL( 1000 ); (* out = TRUE *)

TO_BYTE

Description Conversion to BYTE (8-bit string)

Number of operands 1

Input data type Any numerical type or STRING

Output data type BYTE

Examples out := TO BYTE( -1 ); (* out = 16#FF *)
out := TO BYTE( 16#100 ); (* out = 16#00 *)
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TO_DINT

Description Conversion to DINT (32-bit signed integer)

Number of operands 1

Input data type Any numerical type or STRING

Output data type DINT

Examples out := TO DINT( 10.0 ); (* out = 10 *)
out := TO DINT( 16#FFFFFFFF ); (* out = -1 *)

TO_DWORD

Description Conversion to DWORD (32-bit string)

Number of operands 1

Input data type Any numerical type or STRING

Output data type DWORD

Examples out := TO DWORD( 10.0 ); (* out 16#0000000A *)
out := TO DWORD( -1 ); (* out = 16#FFFFFFFF *)

TO_INT

Description Conversion to INT (16-bit signed integer)

Number of operands 1

Input data type Any numerical type or STRING

Output data type INT

Examples out := TO INT( -1000.0 ); (* out = -1000 *)
out := TO INT( 16#8000 ); (* out = -32768 ¥*)

TO_LREAL

Description Conversion to LREAL (64-bit floating point)

Number of operands 1

Input data type Any numerical type or STRING

Output data type LREAL

Examples out := TO LREAL( -1000 ); (* out -1000.0 *)
out := TO LREAL( 16#8000 ); (* out -32768.0 *)

TO_REAL

Description Conversion to REAL (32-bit floating point)

Number of operands 1

Input data type Any numerical type or STRING

Output data type REAL

Examples out := TO REAL( -1000 ); (* out -1000.0 *)
out := TO REAL( 16#8000 ); (* out -32768.0 *)

TO_SINT

Description Conversion to SINT (8-bit signed integer)

Number of operands 1

Input data type Any numerical type or STRING

Output data type SINT

Examples out := TO SINT( -1 ); (* out = -1 %)
out := TO SINT( 16#100 ); (* out = 0 *)
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TO_STRING

Description Conversion to STRING

Number of operands 1

Input data type Any numerical type

Output data type STRING

Examples str := TO _STRING( 10.0 ); (* str = ‘10,0’ *)
str := TO STRING( -1 ); (* str = ‘-1’ *)

TO_STRINGFORMAT

Description Conversion to STRING, with format specifier

Number of operands 2

Input data type Any numerical type, STRING

Output data type STRING

Examples str := TO STRINGFORMAT (10, ‘%04d’); (* str = ‘0010’
*)

TO_UDINT

Description Conversion to UDINT (32-bit unsigned integer)

Number of operands 1

Input data type Any numerical type or STRING

Output data type UDINT

Examples out := TO UDINT( 10.0 ); (* out = 10 ¥*)
out := TO UDINT( 16#FFFFFFFF ); (* out = 4294967295
*)

TO_UINT

Description Conversion to UINT (16-bit unsigned integer)

Number of operands

1

Input data type Any numerical type or STRING

Output data type UINT

Examples out := TO_UINT( 1000.0 ); (* out = 1000 *)
out := TO UINT( 16#8000 ); (* out = 32768 *)

TO_USINT

Description Conversion to USINT (8-bit unsigned integer)

Number of operands 1

Input data type Any numerical type or STRING

Output data type USINT

Examples out := TO USINT( -1 ); (* out = 255 *)
out := TO USINT( 16#100 ); (* out = 0 *)

TO_WORD

Description Conversion to WORD (16-bit string)

Number of operands 1

Input data type Any numerical type or STRING

Output data type WORD

Examples out := TO_WORD( 1000.0 ); (* out = 16#03E8 *)
out := TO WORD( -32768 ); (* out = 16#8000 *)
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Logic Functions

Selection Functions

AND

Description Logical AND if both Input #0 and Input #1 are BOOL, otherwise bitwise
AND.

Number of operands 2

Input data type Any but STRING

Output data type Same as Inputs

Examples OUT := TRUE AND FALSE; (* OUT = FALSE *)
OUT := 16#1234 AND 16#5678; (* OUT = 16#1230 *)

NOT

Description Logical NOT if Input is BOOL, otherwise bitwise NOT.

Number of operands 1

Input data type Any but STRING

Output data type Same as Inputs

Examples OUT := NOT FALSE; (* OUT = TRUE *)
OUT := NOT 16#1234; (* OUT = 16#EDCB *)

OR

Description I(_)ogical OR if both Input #0 and Input #1 are BOOL, otherwise bitwise

Number of operands 2

Input data type Any but STRING

Output data type Same as Inputs

Examples OUT := TRUE OR FALSE; (* OUT = FALSE *)
OUT := 16#1234 OR 16#5678; (* OUT = 16#567C *)

XOR

Description Logical XOR if both Input #0 and Input #1 are BOOL, otherwise bitwise
XOR.

Number of operands 2

Input data type Any but STRING

Output data type Same as Inputs

Examples OUT := TRUE OR FALSE; (* OUT = TRUE *)
OUT := 16#1234 OR 16#5678; (* OUT = 16#444C ¥*)

LIMIT

Description Limits Input #0 to be equal or more than Input#1, and equal or less
than Input #2.

Number of operands 3

Input data type Any numerical type

Output data type Same as Inputs

Examples OUT := LIMIT( IN := 4, MN := 0, MX := 5 ); (* OUT =
gU;):= LIMIT( IN := 88, MN := 0, MX := 5 ); (* OUT =
gU;):= LIMIT( IN := -1, MN := 0, MX := 5 ); (* OUT =
0 *)
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Standard Operators

MAX

Description

Maximum value selection

Number of operands

2...30

Input data type Any numerical type

Output data type Same as max Input

Examples OUT := MAX( -8, 120, -1000 ); (* OUT = 120 *)
MIN

Description Minimum value selection

Number of operands

2...30

Input data type Any numerical type

Output data type Same as min Input

Examples OUT := MIN( -8, 120, -1000 ); (* OUT = -1000 *)

MUX

Description Multiplexer. Selects one of N inputs depending on input K

Number of operands 3...30

Input data type Any numerical type

Output data type Same as selected Input

Examples OUT := MUX( 0, A, B, C); (* OUT = A *)

SEL

Description Binary selection

Number of operands 3

Input data type BOOL, Any, Any

Output data type Same as selected Input

Examples OUT := SEL( G := FALSE, INO := X, INl :=5 );
(* OUT = X *)

ADR

Description Address of

Number of operands 1

Input data type Any type

Output data type Pointer to type

Examples ptr x := ADR(x)

IMOVE

Description Query interface

Number of operands

1

Input data type Any interface type
Output data type Any interface type
Examples intfl ?= objl;
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String Functions

JMP

Description Jump (conditioned/negated)
Number of operands 0

Input data type Input

Output data type Label name

Examples JMP mylabel;

MOVE

Description Move

Number of operands 1

Input data type Any type

Output data type -

Examples MOVE x, y;

REF

Description Reference to

Number of operands 0

Input data type Any type

Output data type Reference to type

Examples ref x = REF(x);

RET

Description Return (conditioned/negated)
Number of operands 0

Input data type -

Output data type -

Examples RET;

SIZEOF

Description Size of

Number of operands 1

Input data type Any type

Output data type Numeric output

Examples mysize := SIZEOF (myvar);
CONCAT

Description Character string concatenation
Number of operands 2

Input data type STRING

Output data type STRING

Examples OUT := CONCAT( ‘AB’, ‘CD’ (* OUT = ‘ABCD’ ¥*)
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DELETE

Description Delete L characters of IN, beginning at the P-th character position

Number of operands 3

Input data type STRING, UINT, UINT

Output data type STRING

Examples OUT := DELETE( IN := ‘ABXYC’, L := 2, P := 3 );
(* OUT = ‘ABC’ *)

FIND

Description Find the character position of the beginning of the first occurrence of
IN2 in IN1. If no occurrence of IN2 is found, then OUT := 0.

Number of operands 2

Input data type STRING

Output data type UINT

Examples oug := FIND( IN1 := “ABCBC’, IN2 := ‘BC’ ); (* OUT
=2 *)

INSERT

Description Insert IN2 into IN1 after the P-th character position

Number of operands

3

Input data type STRING, STRING, UINT

Output data type STRING

Examples OUT := INSERT( IN1l := ‘ABC’, IN2 := ‘XY’, P := 2 );
(* OUT = ‘ABXYC’ *)

LEFT

Description Leftmost L characters of IN

Number of operands 2

Input data type STRING, UINT

Output data type STRING

Examples O[)JT := LEFT( IN := ‘ASTR’, L := 3 ); (* OUT = “AST’

LEN

Description String length function

Number of operands

1

Input data type STRING

Output data type UINT

Examples OUT := LEN( IN := ‘ASTR’ ); (* OUT = 4 *)
MID

Description L characters of IN, beginning at the P-th

Number of operands

3

Input data type STRING, UINT, UINT
Output data type STRING
Examples OUT := MID( IN := ‘ASTR’, L := 2, P := 2 );

(* OUT = ‘ST’ *)
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REPLACE

Description Replace L characters of IN1 by IN2, starting at the P-th character
position

Number of operands 4

Input data type STRING, STRING, UINT, UINT

Output data type STRING

Examples OUT := REPLACE( IN1 := ‘ABCDE’, IN2 := ‘X’, L := 2,
P := 3 ); (* OUT = ‘ABXE’' ¥*)

RIGHT

Description Rightmost L characters of IN

Number of operands 2

Input data type STRING, UINT

Output data type STRING

Examples OUT := RIGHT( IN := ‘ASTR’, L := 3 ); (* OUT =
‘STR’ *)

Instruction List (IL)

Overview

Description

This section defines the semantics of the IL (Instruction List) language.

Syntax and Semantics

Syntax of IL Instructions

IL code is composed of a sequence of instructions. Each instruction begins on a
new line and contains an operator with optional modifiers, and, if necessary for the
particular operation, one or more operands separated by commas. Operands can
be any of the data representations for literals and for variables.

The instruction can be preceded by an identifying label followed by a colon (;).

Empty lines can be inserted between instructions.

Example:

START:
LD %IX1
ANDN

ST %0X2

(* Push button *)
$MX5.4
(* Fan out *)

(* Not inhibited ¥*)

The elements making up each instruction are classified as follows:

Label Operator Operand Comment
[+ modifier]

START: LD %IX1 (* Push button *)
ANDN %MX5.4 (* Not inhibited *)
ST %QX2 (* Fan out *)
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Semantics of IL Instructions

Standard Operators

Description

Accumulator

Accumulator is a register that contains the value of the current result.
Operators

Unless otherwise specified, the semantics of the operators is:
accumulator := accumulator OP operand

That is, the value of the accumulator is replaced by the result yielded by
operation OP applied to the current value of the accumulator itself, with
respect to the operand.

For instance, the instruction “AND %IX1” is interpreted as:
accumulator := accumulator AND %IX1

The instruction “GT %/W10” will have the boolean result TRUE if the current
value of the accumulator is greater than the value of input word 10, and the
boolean result FALSE otherwise:

accumulator ;= accumulator GT %IW10
Modifiers
The modifier “N” indicates bitwise negation of the operand.

The modifier “C” indicates that the associated instruction can be performed
only if the value of the currently evaluated result is boolean 1 (or boolean 0 if
the operator is combined with the “N” modifier).

The left parenthesis modifier “(” indicates that evaluation of the operator must
be deferred until a right parenthesis operator “)” is encountered. The form of a
parenthesized sequence of instructions is presented below, referred to the
instruction:

accumulator := accumulator AND (%MX1.3 OR %MX1.4)

Standard operators with their allowed modifiers and operands are as listed below:

Opera- Modifiers | Supported operand types: | Semantics
tor Acc_type, Op_type
LD Any, Any Sets the accumulator equal to operand.
ST Any, Any Stores the accumulator into operand
location.
S BOOL, BOOL Sets operand to TRUE if accumulator is
TRUE.
R BOOL, BOOL Sets operand to FALSE if accumulator is
TRUE.
AND N, ( Any but REAL, Any but Logical or bitwise AND
REAL
OR N, ( Any but REAL, Any but Logical or bitwise OR
REAL
XOR N, ( Any but REAL, Any but Logical or bitwise XOR
REAL
NOT Any but REAL Logical or bitwise NOT
ADD ( Any but BOOL Addition
SuB ( Any but BOOL Subtraction
MUL ( Any but BOOL Multiplication
DIV ( Any but BOOL Division
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Opera- Modifiers | Supported operand types: | Semantics

tor Acc_type, Op_type

MOD ( Any but BOOL Modulo-division

GT ( Any but BOOL Comparison: greater than

GE ( Any but BOOL Comparison: greater or equal

EQ ( Any but BOOL Comparison: equal

NE ( Any but BOOL Comparison: not equal

LE ( Any but BOOL Comparison: equal or less

LT ( Any but BOOL Comparison: less than

JMP C,N Label Jumps to label

CAL C,N FB instance name Calls function block

RET C,N Returns from called program, function, or
function block.

) Evaluates deferred operation.

Calling Functions and Function Blocks

Calling Functions

Functions (as defined in the relevant section) are invoked by placing the function
name in the operator field. This invocation takes the following form:

ID 1

MUX 5, var0O, -6.5, 3.14

ST VRES

The first argument is not contained in the input list, but the accumulator is used as
the first argument of the function. Additional arguments (starting with the second),
if required, are given in the operand field, separated by commas, in the order of
their declaration. For example, operator MUX in the previous table takes 5
operands, the first of which is loaded into the accumulator, whereas the remaining
4 arguments are orderly reported after the function name.

The following rules apply to function invocation:

* Assignments to VAR_INPUT arguments may be empty, constants, or
variables.

» Execution of a function ends upon reaching a RET instruction or the physical
end of the function. When this happens, the output variable of the function is
copied into the accumulator.

Calling Function Blocks

Function blocks (as defined in the relevant section) can be invoked conditionally
and unconditionally via the CAL operator. This invocation takes the following form:
LD A

ADD 5

ST INST5.IN1

LD 3.141592

ST INST5.IN2

CAL INST5

LD INST5.0UT1

ST VRES

LD INST5.0UT2

ST vVALID

This method of invocation is equivalent to a CAL with an argument list, which
contains only one variable with the name of the FB instance.

Input arguments are passed to / output arguments are read from the FB instance
through ST /LD operations performed on operands taking the following form:
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FBInstanceName.lO_var

where
Keyword Description
FBinstanceName Name of the instance to be invoked.
10_var Input or output variable to be written / read.

Function Block Diagram (FBD)

Overview

Description

This section defines the semantics of the FBD (Function Block Diagram)
language.

Representation of Lines and Blocks

Description

The graphic language elements are drawn using graphic or semi-graphic
elements, as presented in the following table:

Feature Example

Lines

Line crossing with connection

Blocks with connecting lines and unconnected

pins [ LinearProfileGen
—] enable pos0k =
= stop actPos —
— targPos actSpeed |-
— nomSpeed actice =

No storage of data or association with data elements can be associated with the

use of connectors; hence, to avoid ambiguity, connectors cannot be given any
identifier.
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Direction of Flow in Networks

Description

A network is defined as a maximal set of interconnected graphic elements. A
network label delimited on the right by a colon (:) can be associated with each
network or group of networks. The scope of a network and its label is local to the
program organization unit (POU) where the network is located.

Graphic languages are used to represent the flow of a conceptual quantity through
one or more networks representing a control plan. Namely, in the case of function
block diagrams (FBD), the “Signal flow” is typically used, analogous to the flow of
signals between elements of a signal processing system. Signal flow in the FBD
language is from the output (right-hand) side of a function or function block to the
input (left-hand) side of the function or function blocks so connected.

Evaluation of Networks

Order of Evaluation of Networks

The order in which networks and their elements are evaluated is not necessarily
the same as the order in which they are labeled or displayed. When the body of a
program organization unit (POU) consists of one or more networks, the results of
network evaluation within the aforesaid body are functionally equivalent to the
observance of the following rules:

* No element of a network is evaluated until the states of all of its inputs have
been evaluated.

» The evaluation of a network element is not complete until the states of all of
its outputs have been evaluated.

» As stated when describing the FBD editor, a network number is automatically
assigned to every network. Within a program organization unit (POU),
networks are evaluated according to the sequence of their number: network N
is evaluated before network N+17, unless otherwise specified by using the
execution control elements.

Combination of Elements

Elements of the FBD language must be interconnected by signal flow lines.

Outputs of blocks shall not be connected together. In particular, the “wired-OR”
construct of the LD language is not allowed, as an explicit boolean “OR” block is
required.

Feedback

A feedback path is said to exist in a network when the output of a function or
function block is used as the input to a function or function block which precedes it
in the network; the associated variable is called a feedback variable.

Feedback paths can be utilized subject to the following rules:

» Feedback variables must be initialized, and the initial value is used during the
first evaluation of the network. Look at the global variables editor, the local
variables editor, or the parameters editor to know how to initialize the
respective item.

» Once the element with a feedback variable as output has been evaluated, the
new value of the feedback variable is used until the next evaluation of the
element.

For instance, the boolean variable RUN is the feedback variable in the following
example:
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Explicit loop:

AND
or &
|

Implicit loop:

AND
B &

Execution Control Elements

EN/ENO Signals

Additional boolean EN (Enable) input and ENO (Enable Out) characterize
EcoStruxure Machine Expert - HVAC blocks, according to the declarations:

EN ENO

VAR INPUT VAR OUTPUT
EN: BOOL := 1; ENO: BOOL;

END VAR END VAR

Refer to the Modifying properties of blocks section, page 150 to know how to add
these pins to a block:

TON TON
1M n] EM END
PT ET IM ]
PT ET

When these variables are used, the execution of the operations defined by the
block are controlled according to the following rules:

» Ifthe value of EN is FALSE when the block is invoked, the operations defined
by the function body are not executed and the value of ENO is reset to FALSE
by the programmable controller system.

+ Otherwise, the value of ENO is set to TRUE by the programmable controller
system, and the operations defined by the block body are executed.
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Jumps

Conditional Returns

Jumps are represented by a boolean signal line terminated in a double arrowhead.
The signal line for a jump condition originates at a boolean variable, or at a
boolean output of a function or function block. A transfer of program control to the
designated network label occurs when the boolean value of the signal line is
TRUE; thus, the unconditional jump is a special case of the conditional jump.

The target of a jump is a network label within the program organization unit within
which the jump occurs.

Symbol / Example Explanation

Unconditional Jump

TRUE 7> Labels ¥

Conditional Jump

@ - Labeld 3

Example:

Jump Condition Network

» Conditional returns from functions and function blocks are implemented using
a RETURN construction as presented in the following table. Program
execution is transferred back to the invoking entity when the boolean input is
TRUE, and continues in the normal fashion when the boolean input is FALSE.

» Unconditional returns are provided by the physical end of the function or
function block.

Symbol / Example Explanation

Conditional Return

@ RET

Example:

B Return Condition Network
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Ladder Diagram (LD)

Overview

Description

Power Rails

Description

This section defines the semantics of the LD (Ladder Diagram) language.

The LD network is delimited on the left side by a vertical line known as the left
power rail, and on the right side by a vertical line known as the right power rail.
The right power rail may be explicit in the EcoStruxure Machine Expert - HVAC
implementation and it is always displayed.

The two power rails are always connected with a horizontal line named signal link.
The LD elements must be placed and connected to the signal link.

Description Symbol

Left power rail (with attached horizontal link)

Right power rail (with attached horizontal link)

Power rails connected by the signal link ‘ ‘

Link Elements and States

Description

Link elements may be horizontal or vertical. The state of the link elements shall be
denoted “ON” or “OFF”, corresponding to the literal boolean values 1 or O,
respectively. The term link state shall be synonymous with the term power flow.

The following properties apply to the link elements:

« The state of the left rail shall be considered ON at all times. No state is
defined for the right rail.

* A horizontal link element is indicated by a horizontal line. A horizontal link
element transmits the state of the element on its immediate left to the element
on its immediate right.

» The vertical link element consists of a vertical line intersecting with one or
more horizontal link elements on each side. The state of the vertical link
represents the inclusive OR of the ON states of the horizontal links on its left
side, that is, the state of the vertical link is:

o OFF if the states of all the attached horizontal links to its left are OFF.

o ON if the state of one or more of the attached horizontal links to its left is
ON.
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» The state of the vertical link is copied to all of the attached horizontal links on

its right.

» The state of the vertical link is not copied to any of the attached horizontal

links on its left.

Description Symbol
Vertical link with attached horizontal links
rd
rd
Contacts
Description
A contact is an element which imparts a state to the horizontal link on its right side
which is equal to the boolean AND of the state of the horizontal link at its left side
with an appropriate function of an associated boolean input, output, or memory
variable.
A contact does not modify the value of the associated boolean variable. Standard
contact symbols are given in the following table:
Name Description Symbol
Normally open The state of the left link is copied to the right link if the
contact state of the associated boolean variable is ON. —| |—
Otherwise, the state of the right link is OFF.
Normally closed The state of the left link is copied to the right link if the
contact state of the associated boolean variable is OFF. -| 2’; |—
Otherwise, the state of the right link is OFF.
Positive transition- The state of the right link is ON from one evaluation of
sensing contact this element to the next when a transition of the —I P |—
associated variable from OFF to ON is sensed at the
same time that the state of the left link is ON. The state
of the right link shall be OFF at all other times.
Negative transition- The state of the right link is ON from one evaluation of
sensing contact this element to the next when a transition of the —I M |—
associated variable from ON to OFF is sensed at the
same time that the state of the left link is ON. The state
of the right link shall be OFF at all other times.
Coils
Description
A coil copies the state of the link on its left side to the link on its right side without
modification, and stores an appropriate function of the state or transition of the left
link into the associated boolean variable.
Standard coil symbols are presented in the following table:
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Name Description Symbol
Call The state of the left link is copied to the associated
boolean variable. —{ _:l—
Negated coil The inverse of the state of the left link is copied to the
associated boolean variable, that is, if the state of —{/Ijl—
the left link is OFF, then the state of the associated
variable is ON, and vice versa.
SET (latch) coil The associated boolean variable is set to the ON
state when the left link is in the ON state, and —{ = :l—
remains set until reset by a RESET coil.
RESET (unlatch) coil

The associated boolean variable is reset to the OFF
state when the left link is in the ON state, and —{ R _:l—
remains reset until set by a SET coil.

Positive transition-
sensing coil

The state of the associated boolean variable is ON
from one evaluation of this element to the next when —{ F' _:l—
a transition of the left link from OFF to ON is sensed.

Negative transition-
sensing coil

from one evaluation of this element to the next when

The state of the associated boolean variable is ON _{ N _:I—
a transition of the left link from ON to OFF is sensed.

Operators, Functions, and Function Blocks

Description

The representation of functions and function blocks in the LD language is similar
to the one used for FBD. At least one boolean input and one boolean output shall
be displayed on each block to allow for power flow through the block as presented

in the following figure:

timeExe1
sy=[Dl1 TOH sy=D02
| | I a {
zyaDlZ
|| 100 et ET|—
—

Structured Text (ST)

Overview

Description

This section defines the semantics of the ST (Structured Text) language.

Structured Text is a textual high-level programming language, similar to PASCAL
or C. The program code is composed of expressions and instructions. In contrast
to IL (Instruction List), you can use numerous constructions for programming
loops, thus allowing the development of complex algorithms.
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Expressions

Description
An expression is a construct which, when evaluated, yields a value corresponding
to one of the data types listed in the elementary data types table, page 249.
EcoStruxure Machine Expert - HVAC does not set any constraint on the maximum
length of expressions.
Expressions are composed of operators, operands, and/or assignments. An
operand can be a constant, a variable, a function call, or another expression.

Operands
An operand can be a literal, a variable, a function invocation, or another
expression.

Operators

Open the table of operators to see the list of all the operators supported by ST.
The evaluation of an expression consists of applying the operators to the
operands in a sequence defined by the operator precedence rules.

Operator Precedence Rules

Operators have different levels of precedence, as specified in the table of
operators. The operator with highest precedence in an expression is applied first,
followed by the operator of next lower precedence, and so on, until evaluation is
complete. Operators of equal precedence are applied as written in the expression
from left to right.

For example if A, B, C, and D are of type INT with values 1, 2, 3, and 4,
respectively, then:
A+B-C*ABS (D)

yields -9, and:
(A+B-C) *ABS (D)

yields 0.

When an operator has two operands, the leftmost operand is evaluated first. For
example, in the expression
SIN (A) *COS (B)

the expression SIN(A) is evaluated first, followed by COS(B), followed by
evaluation of the product.

Functions are invoked as elements of expressions consisting of the function name
followed by a parenthesized list of arguments, as defined in the relevant section.
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Operators of the ST Language

Statements in ST

Description

Assignments

Semantics

Syntax

Operation Symbol Precedence
Parenthesization (<expression>) HIGHEST
Function evaluation <fname> (<arglist>)

Negation Complement -

NOT
Exponentiation * Kk
Multiply Divide Modulo *

oD
Add Subtract
Comparison < >, <=, >=
Equality Inequality =
<>
Boolean AND AND
Boolean Exclusive OR XOR
Boolean OR OR

LOWEST

All statements comply with the following rules:
» they are terminated by semicolons;

+ unlike IL, a carriage return or new line character is treated the same as a
space character;

+ EcoStruxure Machine Expert - HVAC does not set any constraint on the
maximum length of statements.

ST statements can be divided into classes, according to their semantics.

The assignment statement replaces the current value of a single or multi-element
variable by the result of evaluating an expression.

The assignment statement is also used to assign the value to be returned by a
function, by placing the function name to the left of an assignment operator in the
body of the function declaration. The value returned by the function is the result of
the most recent evaluation of such an assignment.

An assignment statement consists of a variable reference on the left-hand side,
followed by the assignment operator “:=", followed by the expression to be
evaluated. For instance, the statement

A := B ;
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Examples

would be used to replace the single data value of variable A by the current value of
variable B if both were of type INT.

Assignment:
a :=b ;

Assignment:
pCV := pCV + 1 ;

Assignment with function invocation:
c := SIN( x );

Assigning the output value to a function:
FUNCTION SIMPLE FUN : REAL
variables declaration

function body

SIMPLE FUN := a * b - c ;
END_FUNCTION

Function and Function Block Statements

Semantics

» Functions are invoked as elements of expressions consisting of the function
name followed by a parenthesized list of arguments. Each argument can be a
literal, a variable, or an arbitrarily complex expression.

» Function blocks are invoked by a statement consisting of the name of the
function block instance followed by a parenthesized list of arguments. Both
invocation with formal argument list and with assignment of arguments are
supported.

» RETURN: function and function block control statements consist of the
mechanisms for invoking function blocks and for returning control to the
invoking entity before the physical end of a function or function block. The
RETURN statement provides early exit from a function or a function block (for
example, as the result of the evaluation of an IF statement).

Syntax
Function:
dst var := function name( argl, arg2 , ... , argN );
Function block with formal argument list:
instance name (var_ inl := argl ,
var_in2 := arg2 ,
var_inN := argN );
Function block with assignment of arguments:
instance name.var inl := argl;
instance name.var inN := argN;
instance name () ;
Function and function block control statement:
RETURN;
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Examples

FB invocation with formal argument list:

CMD TMR( IN := $IX5,PT:= 300 ) ;

FB invocation with assignment of arguments:
IN := $IX5 ;

PT:= 300 ;

CMD TMR() ;

FB output usage:

a := CMD_TMR.Q;

Early exit from function or function block:
RETURN ;

Selection Statements

Semantics

Syntax

Selection statements include the IF and CASE statements. A selection statement

selects one (or a group) of its component statements for execution based on a
specified condition.

» IF: the IF statement specifies that a group of statements is to be executed

only if the associated boolean expression evaluates to the value TRUE. If the
condition is false, then either no statement is to be executed, or the statement

group following the ELSE keyword (or the ELSIF keyword if its associated
boolean condition is true) is executed.

+ CASE: the CASE statement consists of an expression which evaluates to a

variable of type DINT (the “selector”), and a list of statement groups, each

group being labeled by one or more integer or ranges of integer values, as

applicable. It specifies that the first group of statements, one of whose ranges
contains the computed value of the selector, is to be executed. If the value of
the selector does not occur in a range of any case, the statement sequence
following the keyword ELSE (if it occurs in the CASE statement) is executed.

Otherwise, none of the statement sequences is executed.

EcoStruxure Machine Expert - HVAC does not set any constraint on the maximum

allowed number of selections in CASE statements.

Square brackets include optional code while braces include repeatable portions of

code.

IF:

IF expressionl THEN
stat list

[ { ELSIF expression2 THEN
stat list } ]

ELSE
stat list

END IF ;

CASE:
CASE expressionl OF
intv [ {, intv } ]
stat list
{ intv [ {, intv } ]
stat list }
[ ELSE
stat list ]
END CASE ;
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Examples

intv being either a constant or an interval: aor a..b

IF statement:
IF d < 0.0 THEN
nRoots := 0 ;
ELSIF d = 0.0 THEN
nRoots := 1 ;
xl := -b / (2.0 * a) ;
ELSE
nRoots
x1
x2
END IF ;

CASE statement:
CASE tw OF
1, 5:
display := oven_ temp ;

(-b + SQRT (d))
(=b - SORT(d))

~ O
N
(@}
[o}]
~

2
display := motor speed ;
3:
display := gross_tare;
4, 6..10:
display := status(tw - 4) ;
ELSE
display := 0;
tw_error := 1;
END CASE ;

Iteration Statements

Semantics

Iteration statements specify that the group of associated statements are executed
repeatedly. The FOR statement is used if the number of iterations can be
determined in advance; otherwise, the WHILE or REPEAT constructs are used.

+ FOR: the FOR statement indicates that a statement sequence is repeatedly
executed, up to the END_FOR keyword, while a progression of values is
assigned to the FOR loop control variable. The control variable, initial value,
and final value are expressions of the same integer type (for example, SINT,
INT, or DINT) and cannot be altered by any of the repeated statements. The
FOR statement increments the control variable up or down from an initial
value to a final value in increments determined by the value of an expression.
The default increment value is 1. The test for the termination condition is
made at the beginning of each iteration so that the statement sequence is not
executed if the initial value exceeds the final value.

+  WHILE: the WHILE statement causes the sequence of statements up to the
END_WHILE keyword to be executed repeatedly until the associated boolean
expression is false. If the expression is initially false, then the group of
statements is not executed at all.

» REPEAT: the REPEAT statement causes the sequence of statements up to
the UNTIL keyword to be executed repeatedly (and at least once) until the
associated boolean condition is true.

+ EXIT: the EXIT statement is used to terminate iterations before the
termination condition is satisfied. When the EXIT statement is located within
nested iterative constructs, exit is from the innermost loop in which the EXIT
is located, that is, control passes to the next statement after the first loop
terminator (END_FOR, END_WHILE, or END_REPEAT) following the EXIT
statement.
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NOTE: The WHILE and REPEAT statements cannot be used to achieve
interprocess synchronization, for example as a “wait loop” with an externally
determined termination condition. The SFC elements defined must be used for
this purpose.

Syntax
Square brackets include optional code while braces include repeatable portions of
code. If the terminating condition is not correct, it can cause an endless loop.
UNINTENDED EQUIPMENT OPERATION
» Ensure that the variable used in FOR instructions is of a sufficient capacity
(has a great upper limit) to account for the <END_VALUE> + 1.
* Ensure that the WHILE loop will be terminated within the instructions of the
loop by creating a FALSE condition of the boolean expression.
» Ensure that the REPEAT loop will be terminated within the instructions of the
loop by creating a TRUE condition of the boolean expression.
Failure to follow these instructions can result in equipment damage.
FOR:
FOR control var := init val TO end val [ BY increm val ] DO
stat list
END FOR ;
WHILE:
WHILE expression DO
stat list
END WHILE ;
REPEAT:
REPEAT
stat list
UNTIL expression
END REPEAT ;
Examples
FOR statement:
j o= 101 ;
FOR i := 1 TO 100 BY 2 DO
IF arrvals[i] = 57 THEN
J =13
EXIT ;
END_IF ;
END FOR ;
WHILE statement:
J =1 ;
WHILE j <=100 AND arrvals[i] <> 57 DO
=3+ 2 ;
END WHILE ;
REPEAT statement:
Jj o= -1 ;
REPEAT
Jo=3 + 2 ;
UNTIL j = 101 AND arrvals[i] = 57
END REPEAT ;
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IFDEF Statement to Exclude a Portion of Code

LogicLab allows you to exclude from the compilation only a specific portion of
code and checking if a certain symbol is defined, using the IFDEF feature.

First of all, the IFDEF feature needs to be enabled, since it's not an IEC standard
feature. You can do that by selecting Project > Project options > Code
generation and then checking the Enable preprocessor directives checkbox.

Refer to Code Generation Tab, page 103.

IMPORTANT: This feature is available only in ST, LD and FBD languages.

This feature will exclude from compilation the selected code only if a specified
symbol has not been defined; the symbol to be specified can be any symbol or
POU (program, function, function block, global variable...) but it must be
GLOBALLY VISIBLE.

Using IFDEF in ST Languages

Inside an ST program, you can disable a portion of code including it inside the
IFDEF syntax.
{ IFDEF : checkSymbol }
loopsValue :=0;
forl:=0to 15 do
bit := (y + 0.9) > (0.125*TO_REAL(i));
if bit then
loopsValue := loopsValue or RotateBit(i);
end_if;
end_for;

{ENDIF }

Using IFDEF in LD Languages

Inside an LD program, user can put under IFDEF condition every single network,
but not just a portion of a network.

Must be opened the network properties window, and inserted the specific symbol
to be checked.
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a0 DILO digital t DOL1 digital output
) digital inpus foDelay ) igital output
inpLogicData TON outDelayed
{1 N [ {)
I
parTimOnDelay parTimOnValue
0003 | ‘ 5 )
DILO digital input fbCtu DOL2 digital output
oooz 2
DILO digital input Network properties X | DoL1 digtal output
inpLogicData =ik ‘ ‘ outDelayed
||
11
Disabled: O

New

>
[parTimOnDelay

Dissble IFNOT DEF: | checkSymbol

oK Cancel
0003 ~
DILO digital input foCtu DOL2 digital output
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{IFDEF} DILO digital input foDelay DOL1 digital output
inpLogicData TON outDelayed
{1 N a { )
parTimOnDelay parTimOnValue
0003

Nl 0 dinital inout -ae

Using IFDEF in FBD Languages

N0l 2 dinital pistrt

Like LD language, also with FBD is possible to put under IFDEF condition every

single network, but not just a portion of a network.

Must be opened the network properties window, and inserted the specific symbol

to be checked.
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System response simulation using a low pass fiter
on the output

LowPassFilter
PO in out pidFeedback
[o05 ] K
i X
System response simulation using a low pas Network properties
on the output
Label:
MNew network  »
e - Deabes O
LowPassFilter
i - checksymbaol
pidOutput = e e Disable IF NOT DEF: !
[o05 ] K

OK Cancel

{IFDEF}

0002

System response simulation using a low pass fiter
on the output

LowPassFilter
pidCutput in out pidFeedback
[o05 ] k

IFDEF Supported Format

The condition of a valid IFDEF syntax can be more complex thag just a globally
visible symbol; here’s some example of valid IFDEF syntax:

{IFDEF: symbol_1}

{IFDEF: symbol_1 AND symbol_2}

{IFDEF: symbol_1 OR symbol_2}

{IFDEF: symbol_1 AND (symbol_2 OR symbol_3)}
{IFDEF: symbol_1 AND NOT symbol_2}

{IFDEF: symbol_1 OR NOT symbol_2}

Be aware that currently, due to an implementation limit, the negation of an
expression is not supported; that means that the following syntax is NOT
supported:

{IFDEF: symbol_1 AND NOT (symbol_2 AND symbol_3)}

The NOT statement must be used with a symbol, not with an expression.

Sequential Function Chart (SFC)

Overview

Description

This section defines Sequential Function Chart (SFC) elements to structure the
internal organization of a PLC program organization unit (POU), written in one of
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Steps

Definition

Initial Step

the languages defined in this standard, for performing sequential control functions.
The definitions in this section are derived from IEC 848, with the necessary
changes to convert the representations from a standard documentation to a set of
execution control elements for a PLC program organization unit.

Since SFC elements require storage of state information, the only program
organization units which can be structured using these elements are function
blocks and programs.

If any part of a program organization unit is partitioned into SFC elements, the
entire program organization unit is so partitioned. If no SFC partitioning is given for
a program organization unit, the entire program organization unit is considered to
be a single action which executes under the control of the invoking entity.

SFC elements

The SFC elements provide a means of partitioning a PLC program organization
unit into a set of steps and transitions interconnected by directed links. Associated
with each step is a set of actions, and with each transition is associated a
transition condition.

A step represents a situation where the behavior of a program organization unit
(POU) with respect to its inputs and outputs follows a set of rules defined by the
associated actions of the step. A step is either active or inactive. At any given
moment, the state of the program organization unit is defined by the set of active
steps and the values of its internal and output variables.

A step is represented graphically by a block containing a step name in the form of
an identifier. The directed links into the step can be represented graphically by a
vertical line attached to the top of the step. The directed links out of the step can
be represented by a vertical line attached to the bottom of the step.

Representation Description
t Step
Stephame (graphical representation with direct links)

EcoStruxure Machine Expert - HVAC does not set any constraint on the maximum
number of steps per SFC within the bounds of the available memory.

The initial state of the program organization unit is represented by the initial values
of its internal and output variables, and by its set of initial steps, that is, the steps
which are initially active. Each SFC network, or its textual equivalent, has exactly
one initial step. An initial step can be drawn graphically with double lines for the
borders, as presented below. For system initialization, the default initial state is
FALSE for ordinary steps and TRUE for initial steps.

EcoStruxure Machine Expert - HYAC cannot compile an SFC network not
containing exactly one initial step.
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Actions

Action Qualifiers

Jumps

Representation Description
Initial step
Init (graphical representation with direct links)

An action can be:
» Acollection of instructions in the IL language;
» A collection of networks in the FBD language;
» Acollection of rungs in the LD language;
» Acollection of statements in the ST language;
» A sequential function chart (SFC) organized as defined in this section.

Zero or more actions can be associated with each step. Actions are declared via
one of the textual structuring elements listed in the following table:

Structuring element Description

STEP StepName :
(* Step body *)
END_STEP

Step (textual form)

INITIAL STEP StepName :
(* Step body ¥*)
END STEP

Initial step (textual form)

Such a structuring element exists in the Isc file for every step having at least one
associated action.

The time when an action associated to a step is executed depends on its action
qualifier.

EcoStruxure Machine Expert - HYAC implements the following action qualifiers:

Qualifi- | Description Meaning

er

N Non-stored (null qualifier) The action is executed as long as the step remains active.

P Pulse The action is executed only once per step activation,
regardless of the number of cycles the step remains
active.

If a step has zero associated actions, then it is considered as having a WAIT
function, that is, waiting for a successor transition condition to become true.

Direct links flow only downwards. To return to an upper step from a lower one, you
cannot draw a logical wire from the latter to the former. A special type of block
exists, called Jump, which lets you implement such a transition.

A Jump block is logically equivalent to a step, as they have to always be
separated by a transition.
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Representation Description

Jump

(logical link to the destination step)

Transitions

Definition

A transition represents the condition whereby control passes from one or more
steps preceding the transition to one or more successor steps along the
corresponding directed link. The transition is represented by a small gray square
across the vertical directed link.

The direction of evolution following the directed links is from the bottom of the
predecessor steps to the top of the successor steps.

Transition Condition

Each transition has an associated transition condition which is the result of the
evaluation of a single boolean expression. A transition condition which is always
true is represented by the keyword TRUE, whereas a transition condition always
false is symbolized by the keyword FALSE.

A transition condition can be associated with a transition by one of the following

means:
Representation Description
By placing the appropriate boolean constant {TRUE, FALSE} adjacent
to the vertical directed link.
TRUE

By declaring a boolean variable, whose value determines whether the
transition is cleared.

WarName
By writing a piece of code, in any of the languages supported by
EcoStruxure Machine Expert - HVAC, except for SFC. The result of the

Proghlame evaluation of such a code determines the transition condition.

The scope of a transition name is local to the program organization unit (POU)
where the transition is located.

Rules of Evolution

Introduction

The initial situation of an SFC network is characterized by the initial step which is
in the active state upon initialization of the program or function block containing
the network.

Evolutions of the active states of steps take place along the directed links when
caused by the clearing of one or more transitions.
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A transition is enabled when all the preceding steps, connected to the
corresponding transition symbol by directed links, are active. The clearing of a
transition occurs when the transition is enabled and when the associated
transition condition is true.

The clearing of a transition causes the deactivation (or “resetting”) of all the
immediately preceding steps connected to the corresponding transition symbol by
directed links, followed by the activation of all the immediately following steps.

The alternation Step/Transition and Transition/Step are always maintained in SFC
element connections, that is:

+ Two steps are never directly linked; they are always separated by a transition;
+ Two transitions are never directly linked; they are always separated by a step.

When the clearing of a transition leads to the activation of several steps at the
same time, the sequences which these steps belong to are called simultaneous
sequences. After their simultaneous activation, the evolution of each of these
sequences becomes independent. In order to emphasize the special nature of
such constructs, the divergence and convergence of simultaneous sequences is
indicated by a double horizontal line.

The clearing time of a transition may theoretically be considered as short as one
may wish, but it can never be zero. In practice, the clearing time is imposed by the
PLC implementation: several transitions which can be cleared simultaneously are
cleared simultaneously, within the timing constraints of the particular PLC
implementation and the priority constraints defined in the sequence evolution
table. For the same reason, the duration of a step activity can never be considered
to be zero. Testing of the successor transition conditions of an active step shall not
be performed until the effects of the step activation have propagated throughout
the program organization unit where the step is declared.

Sequence Evolution Table

This table defines the syntax and semantics of the allowed combinations of steps
and transitions.
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54

Example Rule
L] Normal transition:
53

An evolution from step S3 to step S4 takes place if
and only if step S3is in the active state and the
transition condition c is TRUE.

Divergent transition:

An evolution takes place from S5 to S6 if and only if
S5 is active and the transition condition e is TRUE,
or from S5to S8 only if S5is active and fis TRUE
and e is FALSE.

S10

56 ]
! !
' ' Convergent transition:
57 58 An evolution takes place from S7 to S70 only if S7 is

active and the transition condition h is TRUE, or from
S9to S710 only if S9is active and jis TRUE.
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Example Rule
y Simultaneous divergent transition:
S An evolution takes place from S71 to S12, S14,...

only if S11 is active and the transition condition b
associated to the common transition is TRUE. After
the simultaneous activation of S72, S74, and so on,
the evolution of each sequence proceeds

independently.
[]¢
512 314
L * A L * A
p 1 " . I N Simultaneous convergent transition:
513 515 .
An evolution takes place from S713, S15,...to S16
only if all steps above and connected to the double
horizontal line are active and the transition condition
d associated to the common transition is TRUE.

316
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Examples
Invalid scheme Equivalent allowed scheme Note
Expected behavior: an
- 530 evolution takes place from
S30to S33if ais FALSE and
dis TRUE.

The scheme in the leftmost
['] d a [Ij d column is invalid because

conditions d and TRUE are
‘ s34 ‘

531 directly linked.

_D_

532

[|:| TRUE c [l:l TRUE

333

Expected behavior: an
evolution takes place from
S321to S31if cis FALSE and
dis TRUE.

530

The scheme in the leftmost
column is invalid because
direct links flow only
downwards. Upward
transitions can be performed
via jump blocks.

53

532

533 533

SFC Control Flags

Description

EcoStruxure Machine Expert - HYAC provides some control flags for SFC
program or function blocks.

To enable this feature, refer to paragraph Code generation, page 103.

Those flags are:
* <POU name>_HOLD _ SFC (type BOOL);
* <POU name>_RESET_SFC (type BOOL).
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Where <POU name> means the name of the SFC POU (program or function
block).

For example, if the SFC POU is named Main, the control flags are named Main_
HOLD_SFC and Main_RESET_SFC.

Another couple of actions is available for every SFC action, which also are
contained in an SFC POU.

For example, if the program Main contains an SFC action named Execute, the
control flags of this action are Main_Execute_ HOLD SFC and Main_Execute_

RESET_SFC.
Hold Flag
Following the main characteristics of the <POU name>_HOLD_SFC flag:

» the default value is FALSE;

*  When set to TRUE, the SFC block, which is referred to (the one with the
same name as <POU name>), it is kept in the current status (hold) and no
code is executed;

+  When the flag is set back to FALSE, the SFC block execution is recovered
from exactly the same point in which was set to hold, trough <POU name>_
HOLD_SFC := TRUE.

Reset Flag

Following the main characteristics of the <POU name>_ RESET_SFC flag:
* The default value is FALSE;

+  When set to TRUE, the SFC block, which is referred to (the one with the
same name as <POU name>), it is brought back to the initial state, that is the
execution state of the init action.

» This is an auto-reset flag, which means that if it is set to TRUE its own state
becomes FALSE after its reset action has been executed. It is not necessary
to bring the <POU name>_RESET_SFC value back to FALSE.

Flags Visibility

The <POU name>_HOLD_SFC and <POU name>_RESET_SFC flags are
automatically generated from the code compiler and they belong to the local
variables of the POU which are referred to.

EcoStruxure Machine Expert - HVAC does not show this flags in the variables list
of the POU; they are hidden but in any case they can be used everywhere within
the code.

Check an SFC POU from Other Programs

Description

To allow the managing of an SFC POU from other programs, EcoStruxure
Machine Expert - HVAC provides the following functionalities:

» The compiler automatically generates the <POU name> RESET_SFC and
<POU name>_HOLD_SFC flags.

+ Ifthe SFC POU is a function block, the user has the possibility to declare, as
VAR _INPUT and type BOOL, both flags having the name of the SFC POU
control flags.
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+ Ifthe SFC POU is a program, the user has the possibility to declare, as VAR _
GLOBAL and type BOOL, both flags having the name of the SFC POU
control flags.

* In both previous cases, EcoStruxure Machine Expert - HVAC compiler uses
the variables declared among the VAR _INPUT or VAR_GLOBAL ones and
not those automatically generated (therefore they are not generated).

Using these techniques, user then can manage the working state of the SFC POU
from other POU using the INPUT variables of the SFC POU.

Example
FUNCTION BLOCK test
VAR INPUT

test RESET SFC : BOOL; (* Control flag explicitly
declared *)
END VAR

END FUNCTION BLOCK
PROGRAM Main
VAR

block : test; (* SFC block instance *)
END VAR

(* Reset SFC block state *)
block.test RESET SFC := TRUE;

END PROGRAM

EcoStruxure Machine Expert - HVAC makes available a library called
SFCControl.pll to allow you to manage the SFC states trough commands instead
of variable settings.

This library is composed by macros usable only in ST language.

Usage Example of the Control Flags

Following are some example of control flags usage, assuming the SFC POU is
named Main:

* Hold (freeze):

Main HOLD SFC := TRUE;

* Restart from hold state:
Main HOLD SFC := FALSE;

* Restart form initial state of an SFC block in hold state:
Main RESET SFC := TRUE;
Main HOLD SFC := FALSE;

* Reset toinitial state and instant restart of SFC block:
Main RESET SFC := TRUE; (* automatic reset from compiler
*) .
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Extensions

Overview
Description
EcoStruxure Machine Expert - HVAC features a few extensions to the IEC 61131-
3 standard in order to further enrich the language and to adapt to different coding
styles.
Macros
Description
EcoStruxure Machine Expert - HYAC implements macros in the same way a C
programming language pre-processor does.
Macros can be defined using the following syntax:
MACRO <macro name>
PAR MACRO
<parameter list>
END PAR
<macro body>
END_MACRO
The parameter list may be empty, thus distinguishing between object-like macros,
which do not take parameters, and function-like macros, which take parameters.
A concrete example of macro definition is the following, which takes two bytes and
composes a 16-bit word:
MACRO MAKEWORD
PAR MACRO
lobyte;
hibyte;
END PAR
{ CODE:ST }
lobyte + SHL( TO _UINT( hibyte ), 8 )
END_MACRO
Whenever the macro name appears in the source code, it is replaced (along with
the current parameter list, in case of function-like macros) with the macro body.
For example, given the definition of the macro MAKEWORD and the following
Structured Text code fragment:
w := MAKEWORD( bl, b2 );
the macro pre-processor expands it to
w := bl + SHL( TO UINT( b2 ), 8 );
Pointers
Description

Pointers are special variables which act as a reference to another variable (the
pointed variable). The value of a pointer is, in fact, the address of the pointed
variable; in order to access the data stored at the address pointed to, pointers can
be dereferenced.

Pointer declaration requires the same syntax used in variable declaration, where
the type name is the type name of the pointed variable preceded by a @ sign:
VAR
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<pointer name> : @<pointed variable type name>;
END_ VAR

For example, the declaration of a pointer to a REAL variable shall be as follows:
VAR

px : @REAL;
END VAR

A pointer can be assigned with another pointer or with an address. A special
operator, ADR, is available to retrieve the address of a variable.

px := py; (* px and py are pointers to REAL (that is,
variables of type @REAL) ¥*)

px := ADR( x ) (* x is a variable of type REAL *)

px := ?x (* ? is an alternative notation for ADR ¥*)

The @ operator is used to dereference a pointer, hence to access the pointed
variable.

px := ADR( x );

@px := 3.141592; (* the approximate value of pi is assigned
to X *)

pn := ADR( n );

n := @pn + 1; (* n is incremented by 1 *)

Be aware that careless use of pointers is a potential source of serious
programming errors that, in a runtime environment, can have an undesirable
effect on the state of the controller and/or your machine or process.

ACAUTION

INVALID POINTER

» Verify the validity of the pointers when using pointers on addresses before
they are applied.

* Always initialize pointers with a valid memory address.

Failure to follow these instructions can result in injury or equipment
damage.

Beware that the pointer type and the pointed variable type must be of the same
type; else an error message is raised when compiling. To avoid type mismatching
you can use PVOID type as pointer type, this way the pointed type will be always
accepted.

Waiting Statement

Description

EcoStruxure Machine Expert - HVAC implements a WAITING statement that can
be used in ST code as following example:

WAITING <condition> DO
<code to be executed waiting for condition becomes true>
END WAITING;

Until the condition is not verified, the code is executed (not as in a loop cycle but
returning to caller in every execution).

The WAITING statement can be used only if the associated project option is
enabled. For more details, refer to Code Generation, page 103.
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Compile Time Error Messages

Error code | Short description

Explanation

A4097 Object not found The object indicated (variable or function block) has not been defined in the
application.

A4098 Unsupported data type The size (in bits) requested by the indicated data type is not supported by
the target system.

A4099 Auto vars space exhausted The total allocation space requested by all local variables exceeds the space
available on the target system.

A4100 Retentive vars space exhausted The total allocation space requested by all local retentive variables exceeds
the space available on the target system.

A4101 Bit vars space exhausted The total allocation space requested by all local bit (boolean) variables
exceeds the space available on the target system.

A4102 Invalid index in data block The variable indicated is associated with an index that is not available in the
relative data block.

A4103 Data block not found The variable indicated is associated with a data block that does not exist (is
not defined) in the target system.

A4104 Code space exhausted The total size of code used for POU (programs, functions and function
blocks) exceed the space available on the target system.

A4105 Invalid bit offset The variable indicated is associated with a bit index that is not available in
the relative data block.

A4106 Image variable requested Error code superseded.

A4107 Target function not found The function indicated is not available on the target system.

A4108 Base object not found The indicated instance refers to a function block definition non defined.

A4109 Invalid base object type The indicated variable is associated with a data type (including function
block definition) that is not defined.

A4110 Invalid data type The data type used in the variable definition does not exist.

Ad111 Invalid operand type The operand type is not allowed for the current operator.

A4112 Function block shares global data and is used | The indicated function block is called by more than one task but uses global

by more tasks

variables with process image. For this reason, the compiler is not able to
refer to the proper image variable for each instance of the function block.

A4113 Temporary variables allocation error Internal compiler error.
A4114 Embedded functions do not support arrays as | -
input variables
A4115 Too many parameters input to embedded -
function
A4116 Incremental build failed, perform a full build -
command
A4117 Less than 10% of free data -
A4118 Less than 10% of free retain data -
A4119 Less than 10% of free bit data -
A4120 Variable exceeds data block space -
A4121 Element not found -
A4122 Invalid bit mapped type Bit mapped variables must be of type BOOL
A4123 Invalid access to private member -
A4124 Invalid datablock type for bit mapping -
A4126 Invalid label specification -
A4127 Not a function Invalid function specification
A4128 Invalid bit mapping index -
A4129 Not a structured type -
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A4130 Not a function block instance -
A4131 Incompatible external declaration -
A4132 Label not found -
A4133 Not a variable -
A4134 Index exceeds array size Index value is out of the array range
A4135 Invalid index data type -
A4136 Missing index(es) -
A4137 Function block instance required -
A4138 Simple variable required -
A4139 Too many indexes -
A4140 Not a structure instance -
Ad4141 Not an array -
Ad4142 Invalid symbol specification -
A4143 Not a pointer -
A4144 Double pointer indirection not allowed -
A4145 To be implemented -
A4146 Bit datatype not allowed -
A4147 Unable to calculate variable offset -
A4148 _Complex variables cannot have process -
image
A4149 Cannot use directly represented variables -
with process image in function blocks (not
implemented)
A4150 Function block instance not allowed -
A4151 Structure not allowed -
A4152 16-bit variables must be aligned to a 16-bit -
boundary
A4153 32-bit variables must be aligned to a 32-bit -
boundary
A4154 Temporary string variable allocation error. -
Instruction shall be split.
A4155 Ext/aux auto vars space exhausted -
A4156 Ambiguous enum value, <enum># prefix -
required
A4157 Invalid init element -
A4158 Invalid target function table entry -
A4159 Invalid bit access syntax -
A4160 Invalid bit string type Bit access allowed only on bit string data types (BYTE, WORD, DWORD)
A4161 Invalid bit index -
A4162 Object is not a method -
A4163 Method not found -
A4164 Invalid usage of THIS/SUPER -
A4165 Parent function block not found -
A4166 Variable name already used into a parent -
A4167 Erroneus method override Return value or input variables mismatch
A4168 Erroneus local method override Override of a parent method belonging to a locally implemented interface
A4169 Not an interface instance -
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A4170 Not a reference -

A4171 Error dereferencing interfaces Interfaces can not be dereferenced from references/ pointers

A4172 Relocation table generation failure -

A4173 Bit mapped variables cannot be arrays -

A4174 64-bit variables must be aligned to a 64-bit On some architecture is required that 64-bit variables are mapped on

boundary memory address alinged to 64-bit

A4175 Enum base type must be DINT -

C0001 Parser not initialized Internal compiler error.

C0002 Invalid token Invalid word for the current language syntax

C0003 Invalid file specification Internal compiler error.

C0004 Cannot open file The indicated file cannot be opened due to a file system error or to a missing
source file.

C0005 Parser table error Internal compiler error.

C0006 Parser non specified Internal compiler error.

C0007 Unexpected end of file The indicated file is truncated or the syntax is incomplete.

C0009 Reserved keyword The indicated word cannot be used for declaration purposes because is a
keyword of the language.

C0010 Invalid element The indicated word is not a valid one for the language syntax.

Co0M Aborted by user -

C0032 Too many parameters in macro call -

C0033 Invalid number of parameters in macro call -

C0034 Too many macro calls nested -

C0035 IFDEF directives are not enabled -

C0036 Syntax error in IFDEF condition -

C0037 Recursive IFDEF condition -

C4097 Invalid variable type The data type indicated is not allowed.

C4098 Invalid location prefix The address string of the indicated variable is not correct, '%' missing.

C4099 Invalid location specification The address string of the indicated variable is not correct, the data access
type indication is not'l', 'Q" or 'M'.

C4100 Invalid location type The address string of the indicated variable is not correct, the data type
indication is not 'X', 'B','W', 'D', 'R" or 'L".

C4101 Invalid location index specification The address string of the indicated variable is not correct, the index is not
correct.

C4102 Duplicate variable name The name of the indicated variable has already been used for some other
project object.

C4103 Only 0 admitted here The compiler uses only arrays zero-index based

C4104 Invalid array dimension The dimension of the array is not indicated in the correct way (for example:
contains invalid characters, negative numbers and so on).

C4105 Constant not initialized Every constant need to have an initial value.

C4106 Invalid string size -

C4107 Initialization exceeding string size -

C4108 Invalid repetition in initialization -

C4109 Invalid data type for initialization -

C4110 Invalid binary file for initialization -

C4112 Duplicate type name -

C4353 Duplicate label The indicated label has already been defined in the current POU (program,

function or function block).
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C4354 Constant not admitted The operation indicated does not allow to use constants (typically store or
assign operations).
C4355 Address of explicit constant not defined -
C4356 Maximum number of subscripts exceeded -
C4358 Invalid array base -
C4359 Invalid operand -
C4609 Invalid binary constant A constant value with 2# prefix must contain only binary digits (0 or 1).
C4610 Invalid octal constant /%\)constant value with 8# prefix must contain only octal digits (between 0 and
C4611 Invalid hexadecimal constant A constant value with 16# prefix must contain only hexadecimal digits
(between 0 and 9 and between A and F).
C4612 Invalid decimal constant A decimal constant must contain only digits between 0 and 9, a leading sign
+ or -, a decimal separator '.' Or an exponent indicator 'e' or 'E".
C4613 Invalid time constant A constant value with t# prefix must contain a time indication in decimal
notation and a time unit between 'ms, 's' or 'm'.
C4614 Invalid constant string -
C4618 Invalid constant wstring -
C4619 Time constant exceedes maximum value -
C4620 LTime constant exceedes maximum value -
C4621 A non-most significant time unit exceede its -
range
C4622 A non-least significant time unit has a decimal | -
part
C4623 Invalid date constant -
C4624 Invalid Date and Time typed constant -
C4626 Invalid Time of Day typed constant -
C4864 Duplicate function name le;lle ir:dicated function name has already been used for another application
object.
C4865 Invalid function type The data type returned by the indicated function is not correct.
C5120 Duplicate program name TBe irtldicated program name has already been used for another application
object.
C5376 Duplicate function block name The indicated function block name has already been used for another
application object.
C5632 Invalid pragma -
C5633 Invalid pragma value -
C5889 Duplicate macro name -
C5890 Duplicate macro parameter name -
C6144 Invalid resource definition: two or more tasks -
have the same ID
C16385 Invalid init value -
C16386 Empty init value -
C16387 Invalid structure init value Invalid element name in structure init value
C16388 Unexpected token -
C16389 Syntax error -
C16390 Invalid function declaration Function declaration must begin at line one
C16391 Invalid variable init value Initial value must begin on the same line as the variable name
C16392 Invalid description Description exceeded 1024 characters
C16393 Invalid POU name declaration Declared POU name does not match actual POU name
C16394 Missing POU header Missing POU header (e.g.: PROGRAM main)
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F1025 Invalid network The indicated FBD or LD network contains a connection error (the errors are
normally indicated by red connections).
F1026 Unconnected pin The indicated block (operator, function, contact or coil) has an unconnected
pin.
F1027 Invalid connection (incomplete, more than a Internal compiler error.
source and so on)
F1028 More than one network per block The network indicated contains more networks of blocks and variables not
connected between them.
F1029 Ambiguous network evaluation The compiler is not able to find an univocal way to establish the order of
blocks execution.
F1030 Temporary variables allocation error Internal compiler error.
F1031 Inconsistent network The network indicated does not have input or output variables.
F1032 Invalid object connected to power rail -
F1033 Invalid use of pin negation (ADR operator -
does not allow negated input)
F1034 Invalid use of pin negation (SIZEOF operator | -
does not allow negated input)
F1035 Undefined function block -
F1036 Missing VAR_IN_OUT assignment -
F1037 Unknown function -
F1038 Unavailable default value for function -
parameter
F1039 Invalid pin -
F1040 Only variables with physical storage can be -
assigned to VAR_ IN_OUT
G0001 Invalid operand number The number of operands is not correct for the operand or the function
indicated.
G0002 Variable not defined The variable has not been defined in the local or global context.
G0003 Label not defined The label indicated for the JMP operand is not defined in the current POU
(program, function or function block).
G0004 Function block not defined The indicated instance refers to a function block not defined in the whole
project.
G0005 Reference to object not defined The indicated instance refers to an object not defined in the whole project.
G0006 Constant not admitted The operation indicated does not allow to use constants (typically store or
assign operations).
G0007 Code buffer overflow The total size of code used for POU (programs, functions and function
blocks) exceed the space available on the target system.
G0008 Invalid access to variable The access made to the indicated variable is not allowed. An attempt to write
a read-only variable or to read a write-only variable has been made.
G0009 Program not found The indicated program does not exist in the current project.
G0010 Program already assigned to a task The indicated program has been assigned to more than one task of the
target system.
G0011 Cannot allocate code buffer There is not enough memory on the PC to create the image of the code of
the target system.
G0012 Function not defined The indicated function does not exist in the current project.
G0013 Cyclic declaration of function blocks The indicated function block call itself directly or by using other functions.
G0014 Incompatible external declaration The external variable declaration of the current function block or function,
does not match with the global variable definition it refers to (the one with the
same name). Typically is the case of a type mismatch.
G0015 Accumulator extension -
G0016 External variable not found The external variable does not refer to any of the global variables of the
project (for example: there is not a global variable with the same name).
G0017 Program is not assigned to a task The indicated program has not been assigned to a task in the target system.
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G0018 Task not found in resources The indicated task is not defined in the target system.
G0019 No task defined for the application There aren't task definitions for the target system. The target definition file (*.
TAR) is missing or incomplete. Contact the target system vendor.
G0020 Far data allowed only for load/ store Huge memory access is not allowed for function blocks, only for programs
operations in PROGRAMs (error code valid only for some target system with NEAR/FAR data access).
G0021 Invalid processor type The processor indicated into the target definition file (*.TAR) is not correct or
is not supported by the compiler.
G0022 Function block with process image variables -
cannot be used in event tasks
G0023 Process image variables cannot be used in -
event tasks
G0024 Accumulator undefined -
G0025 Invalid index -
G0026 Only constant index allowed -
G0027 lllegal reference to the address of a register -
G0028 Less than 10% of free code -
G0029 Index exceeds array size -
G0030 Access to array as scalar - assuming index 0 -
G0031 Number of indexes not matching the var size -
G0032 Multidimensional variables not supported -
G0033 Invalid data type -
G0034 Invalid operand type -
G0035 Assembler error -
G0036 Aborted by user -
G0037 Element not defined -
G0038 Cyclic declaration of structures -
G0039 Cyclic declaration of typedefs -
G0040 Unresolved definition of typedef -
G0041 Exceeding dimensions in typedef -
G0042 Unable to allocate compiler internal data -
G0043 CODE GENERATOR INTERNAL ERROR -
G0044 Real data not supported -
G0045 Long real data not supported -
G0046 Long data not supported -
G0047 Operation not implemented -
G0048 Invalid operator -
G0049 Invalid operator value -
G0050 Unbalanced parentheses -
G0051 Data conversion -
G0052 To be implemented -
G0053 Invalid index data type -
G0054 Negation without condition -
G0055 Operation not allowed on boolean -
G0056 Negation of a non-boolean operand -
G0057 Boolean operand required -
G0058 Floating point parameter not allowed -
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G0059 Operand extension -

G0060 Division by zero -

G0061 Comparison between different types -

G0062 Function block must be instantiated -

G0063 String operand not allowed -

G0064 Operation not allowed on pointers -

G0065 Destination may be too small to store current | -
result

G0066 Cannot use a function block containing -
external variables with process image in more
than one task

G0067 Cannot load the address of an explicit -
constant

G0068 Writing a real value into an integer variable -

G0069 Cannot use complex variables in functions. -
Not implemented

G0070 Signed/unsigned mismatch -

G0071 Conversion data types mismatch, possible -
loss of data

G0072 Implicit type conversion of boolean to integer | -

G0073 Implicit type conversion of boolean to real -

G0074 Implicit type conversion of integer to boolean -

G0075 Implicit type conversion of integer to real -

G0076 Implicit type conversion of real to boolean -

G0077 Implicit type conversion of real to integer -

G0078 Arithmetic operations require numerical -
operands

G0079 Bitwise logical operations require bitstring/ -
integer operands

G0080 Comparison operations require elementary -
(that is, not user-defined) operands

G0081 Cannot take the address of a bit variable -

G0082 Writing a signed value into an unsigned -
variable

G0083 Writing an unsigned value into a signed -
variable

G0084 Implicit conversion from single to double -
precision

G0085 Implicit conversion from double to single -
precision

G0086 Function parameter extension -

G0087 Casting to the same type has no effects -

G0088 Function parameters wrong number -

G0089 Embedded target function not found -

G0090 Recursive type declaration -

G0091 Wrong initial value. Signed/unsigned -
mismatch

G0092 Wrong initial value. Conversion data types -
mismatch, possible loss of data

G0093 String will be truncated -

G0094 Init value type mismatch -
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G0095 Improper init value -

G0096 Init value object not found -

G0097 Invalid assignment to pointer -

G0098 Unsupported data type -

G0099 Variable bit access not supported -

G0100 Symbolic initialization of constants not -
supported

G0101 Type mismatch in assignment -

G0102 Array size mismatch in assignment -

G0103 Copy of array or structures not supported -

G0104 Data size mismatch in assignment -

G0105 Copy of data having a large size (see -
threshold in project options)

G0106 Object oriented features not supported -

G0107 Recursive usage of function -

G0108 Recursive usage of method -

G0109 Recursive usage of function block -

GO0110 Parent function block not found (with -
EXTENDS)

G011 Recursive inheritance (with EXTENDS) -

G0112 Object oriented programming not supported -
by target system

G0113 Undefined interface (with IMPLEMENTS) -

G0114 Incomplete interface implementation (with -
IMPLEMENTS)

G0115 Method prototype differs from interface -
definition

G0116 Redundant interface implementation -

G017 Function block does not implements interface | -

G0118 Copy between different interfaces -

G0119 Parent interface not found -

G0120 Recursive interface hierarchy (EXTENDS) -

G0121 Method redefinition in interface hierarchy -
(EXTENDS)

G0122 analid operands for query interface operator -

G0123 Invalid assignment to reference -

G0124 Can not load reference/address of an -
interface

G0125 Invalid operation on reference -

G0126 Improper assignment to a reference, different | -
type

G0127 Usage of deprecated pointer initialization, use | -
NULL instead

G0128 Comparison between pointer and non-pointer | -

G0129 Comparison between reference and non- -
reference

G0130 Operation between pointer and non-pointer -

G0131 Check for division by zero unsupported for -

LREAL type
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G0132 Mismatch in ENUM data types -
G0133 Operation between ENUM and generic -
constant
G0134 Operation requires explicit type cast -
G0135 Operation required an implicit type cast -
G0136 Type cast is not allowed -
G0137 Initialization of constants with addresses is -
not allowed
G0138 lllegal conversion to pointer -
G0139 Array dimension constant not found -
G0140 Invalid constant for array size -
G0141 Invalid pointer arithmetic operation -
G0142 VAR_IN_OUT cannot be a reference -
G0143 VAR_IN_OUT can be assigned to other VAR _ | -
IN_OUT only
G0144 Only variables can be assigned to VAR_IN_ -
ouT
G0145 Invalid MOVE operation -
G0146 Found invalid instruction in patch code, could | -
not set breakpoint/ trigger
G0147 Variable bit access with variable index not -
supported
G0148 Invalid array size indication -
G0149 Invalid operand on function call -
G0150 Argument types mismatch on function call -
G0151 Operand types mismatch on function -
invocation
G0152 Time parameter not allowed -
G0153 Converting a time into a number -
G0154 Converting a time into a string -
G0155 Converting a time into a bool -
G0156 Converting a number into a time -
G0157 Converting a string into a time -
G0158 Implicit conversion of Time to LTime -
G0159 Cannot convert an LTime into a Time implicitly | -
G0160 Invalid operation with a time typed operand -
G0161 Operation not allowed on Time operand -
G0162 Destination type not supported for Time type -
G0163 Destination type not supported for LTime type | -
G0164 Implicit conversion of DATE to LDATE -
G0165 Destination type not supported for DATE type | -
G0166 Destination type not supported for LDATE -
type
G0167 Cannot convert an LDATE into a DATE -
implicitly
G0168 Converting a date into a number -
G0169 Converting a date into a string -
G0170 Converting a date into a bool -
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G0171 Converting a number into a date type -

G0172 Operation not allowed on date operand -

G0173 Operation between a date type operand and -
a non date type operand is not allowed

G0174 Operation between different date type -
operands (Date and LDate) is not allowed

G0175 Operation not allowed on TIME or LTIME -

G0176 Operation not allowed on DATE or LDATE -

G0177 Cannot convert a DATE_AND_ TIME into a -
DATE implicitly

G0178 Cannot convert a DATE_AND_ TIME into an -
LDATE implicitly

G0179 Cannot convert an LDATE_AND_TIME intoa | -
DATE implicitly

G0180 Cannot convert an LDATE_AND_ TIME into -
an LDATE implicitly

G0181 Implicit conversion of DATE_AND_ TIME to -
LDATE_AND_TIME

G0182 Cannot convert an LDATE_AND_ TIME intoa | -
DATE_AND_TIME implicitly

G0183 Operation between a date and time type -
operand and a non date and time type is not
allowed

G0184 Operation between different date and time -
type operands (DT and LDT) is not allowed

G0185 Operation not allowed on date and time type -
operand

G0186 Operation not allowed on DATE_ AND_TIME | -
or LDATE_AND_TIME

G0187 Converting a date and time type into a string -

G0188 Converting a DATE into a DATE_ AND_TIME | -

G0189 Converting a LDATE into a DATE_ AND_ -
TIME

G0190 Converting a DATE into a LDATE_ AND_ -
TIME

G0191 Converting a LDATE into a LDATE_ AND_ -
TIME

G0192 Destination type not supported for DATE_ -
AND_TIME type

G0193 Destination type not supported for LDATE_ -
AND_TIME type

G0194 Date typed parameter not allowed -

G0195 Date and time typed parameter not allowed -

G0196 Converting a floating point into a time -

G0197 Converting a bool into a time type -

G0198 Converting a bool into a date and time type -

G0199 Converting a bool into a date and time type -

G0200 Converting a string into a date and time type -

G0201 Converting a number into a date and time -
type

G0202 Converting a date type into a time type -

G0203 Converting a date and time type into a time -
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G0204 Converting a floating point into a date type -

G0205 Converting a string into a date type -

G0206 Converting a bool into a date type -

G0207 Converting a time type into a date type -

G0208 Converting a time type into a date and time -
type

G0209 Converting a date type into a floating point -

G0210 Converting a date and time type into a floating | -
point

G0211 Converting a date and time type into a -
number

G0212 Converting a date and time type into a bool -

G0213 Converting a String into WString -

G0214 Converting a WString into String -

G0215 Converting a string into a bool -

G0216 Operation not allowed on TIME_ OF_DAY or -
LTIME_OF_DAY

G0217 Cannot convert an DATE_AND_ TIME into a -
TIME_OF_DAY implicitly

G0218 Cannot convert an DATE_AND_ TIME intoan | -
LTIME_OF_DAY implicitly

G0219 Cannot convert an LDATE_AND_ TIME into -
an TIME_OF_DAY implicitly

G0220 Cannot convert an LDATE_AND _ TIME into -
an LTIME_OF_DAY implicitly

G0221 Implicit conversion of TIME_OF_ DAY to -
LTIME_OF_DAY

G0222 Destination type not supported for TIME_OF_ | -
DAY type

G0223 Destination type not supported for LTIME_ -
OF_DAY type

G0224 Cannot convert an LTIME_OF_DAY into a -
TIME_OF_DAY implicitly

G0225 Operation between a time of day operand and | -
a non time of day operand is not allowed

G0226 Operation between different time of day type -
operands (TOD and LTOD) is not allowed

G0227 Operation not allowed on time of day type -
operand

G0228 Time of day typed parameter not allowed -

G0229 Converting a time of day type into a bool -

G0230 Converting a time of day type into a floating -
point

G0231 Converting a time of day type into a number -

G0232 Converting a time of day type into a string -

G0233 Converting a time of day type into a time type | -

G0234 Converting a time of day type into a date type | -

G0235 Converting a time of day type into a date and -
time type

G0236 Converting a bool into a time of day type -

G0237 Converting a number into a time of day type -
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G0238 Converting a floating point into a time of day -
type
G0239 Converting a string into a time of day type -
G0240 Converting a time type into a time of day type | -
G0241 Converting a date type into a time of day type | -
G0242 Zero length string not allowed -
G0243 Operation not allowed on references -
G0244 Different array/string size -
G0245 Complex parameter not supported -
G0246 Does not support bool accumulator -
G0247 Does not support float accumulator -
G0248 Time typed accumulator not supported -
G0249 Date typed accumulator not supported -
G0250 Date and time typed accumulator not -
supported
G0251 Time of day typed accumulator not supported | -
G0252 String typed accumulator not supported -
G0253 Converting a number into a String -
G0254 Converting a String into a number -
G0255 Operation between floating point and integer -
G0256 Operation between signed and unsigned -
variables
G0257 Converting %s to REAL -
G0258 Converting %s to LREAL -
G0259 Converting a number into a WString -
G0260 Converting a WString into a number -
G0261 Converting a WString into a bool -
G0262 Does not support a non boolean condition -
G0263 Operation between a string type and a non -
string type is not allowed
G0264 Operation between different time typed -
operands (TIME and LTIME) is not allowed
G0265 Branch higher of 1 MB -
G0266 Branch higher of 16 MB -
G0267 Branch higher of 32 MB -
G0268 Converting %s to the type of the second -
operand
G0269 Converting %s to the type of the first operand | -
G0270 Operation between boolean and integer -
G0271 Invalid operation on different pointed types -
G0272 Operation on different pointed types -
G0273 Implicit conversion of type '%s\’ to type '%s\" | -
is not admitted
G0274 Invalid conversion of type \'%s\ to type '%s\" | -
G0275 Loss of precision while converting a %s into -

%s
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G0276 Invalid operation on operands with different -
granularity
G0277 Invalid pointer operation -
G0278 Invalid string length indication -
G0279 String length constant not found -
G0280 Invalid constant for string length -
G0281 Operation between array and scalar variables | -
G0282 Extended Unicode characters are not -
enabled
G0283 Invalid number of inout parameters -
G0284 A variable cannot be assigned to a VAR_IN_ -
OUT with a different type
G0285 All inputs shall be of the same type -
G0286 VAR_IN_OUT on functions not implemented -
G8193 Type definition of unknown data type -
G8194 Type definition has exceeding array -
dimensions
G8195 Cyclic definition of data type -
G8196 Double pointers are not supported -
G8197 No enumerative elements -
G8199 Invalid or undefined initialization constant -
G8200 Global variable and ENUM field with the -
same name
G10241 Too many initializers for variable -
G10242 Too less initializers for variable -
G10243 Constant without init values -
L1153 Unconnected pin -
L1154 Jump to non existing label -
L1155 Invalid operand -
L1156 Undefined contact -
L1157 Undefined variable -
L1158 Undefined constant -
L1159 Undefined coll -
L1160 Undefined jump destination -
L1161 Undefined expression -
L1162 Assignment not admitted in expressions -
L1163 Comments not admitted in expressions -
L1164 Undefined function block -
L1165 VAR_IN_OUT must be assigned in function -
block invocation
L1166 Unknown function -
L1167 Unavailable default value for function -
parameter
L1168 VAR_IN_OUT parameters must be assigned -
L1169 Only variables can be assigned to VAR_IN_ -
OUT parameters
P2048 PostBuild error -
P2049 Symbol table file not created -
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P2051 Cannot create directory -
P2052 Cannot open source project -
P2053 Save project error -
P2054 Generic file error -
P2055 Cannot copy file -
P2056 Cannot save file -
P2057 Object already exist in project -
P2058 Cannot open library file -
P2059 Listing file not created -
P2060 Cannot create PLC application binary file -
P2061 Cannot open template project -
P2062 Support for processor is not available -
P2063 Less than 10% of free code -
P2064 Less than 10% of free data -
P2065 Less than 10% of free retain data -
P2066 Less than 10% of free bit data -
P2067 Task not found in resources -
P2068 No task defined for the application -
P2069 Project is in the old PPJ format. It will be -
saved in the actual PPJX format
P2070 Cannot open auxiliary source file -
P2071 Cannot read file -
P2072 Application name is longer than 10 -
characters: only the first 10 characters will be
downloaded into the target
P2073 Downloadable source code file is not -
password-protected
P2074 Downloadable PLC application binary file not | -
created
P2075 Less than 10% of free ext/aux data -
P2076 Project private copy of this library was -
missing and has been replaced with a new
copy of the library (from the original path)
P2077 Cannot load library! Project private copy of -
this library was missing and the original path
to the library is invalid: library has been
dropped
P2079 Debug symbols package (for following -
download to the target device) not created
P2080 Source code package (for following download | -
to the target device) not created
P2081 Invalid task definition -
P2083 Invalid or incoherent task period -
P2084 Broken library link -
P2085 Missing external aux source -
P2086 Object is already defined in the project and -
will be unloaded
S1281 Generic ST error -
S1282 Too many expressions nested -
S1283 No iteration to exit from -
S1284 Missing END_IF -

EI00000003412.05

315



Error code | Short description Explanation
S1285 Invalid ST statement -
S1286 Invalid assignment -
S1287 Missing “;” -
S1288 Invalid expression -
S1289 Invalid expression or missing DO -
S1290 Missing END_WHILE -
S1291 Missing END_FOR -
S1292 Missing END_REPEAT -
S1293 Invalid expression or missing THEN -
S1294 Invalid expression or missing TO -
S1295 Invalid expression or missing BY -
S1296 Invalid statement or missing UNTIL -
S1297 Invalid assignment, := expected -
S$1298 Invalid address expression -
S1299 Invalid size expression -
S1300 Function return value ignored -
S1301 Invalid parameter passing -
S1302 Function parameter not defined -
S1303 Useless expression -
S1304 Unbalanced parentheses -
S1305 Unknown function -
S1306 Invalid function parameter(s) specification -
S1307 Function parameter does not exist -
S1308 Multiple assignment not allowed (in -
accordance with IEC 61131-3)
S1309 ST preprocessor buffer overflow -
S1310 Function block invocation of a non-function -
block instance
S1311 Missing END_WAITING -
S1312 Syntax error -
S1313 Invalid range in CASE definition -
S1314 Value overlap in CASE definition -
S1315 Exceeding number of parameters -
S1316 Wrong number of function parameters -
S1317 Duplicated function parameter -
S1318 Improper use of THIS/SUPER -
S1319 Improper usage of query interface operator ? | -
S1320 Invalid reference to expression -
S1321 Missing IL block end marker ({IL}) -
S$1322 Function in/out variable doesn’t exist -
S1323 VAR_IN_OUT must be assigned in function -
block invocation
S1324 Complex type parameters cannot have -
default value
S1325 Invocation of an unexisting function block -
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S1326 Missing inout parameter -

S1537 Generic SFC error -

S1538 Initial step missing -

S1539 Output connection missing -

S1540 The output pin must be connected to a -

transition

S1541 Every output pin of a transition must be -

connected to a step/jump block

S1542 Transition expected -

S1543 Step or jump expected -

S1544 Could not find the associate program code -

S1545 Could not find the condition code -

S1546 Unknown-type transition -

S1547 Invalid jump destination -

S1548 Duplicates action. Same SFC action cannot -

be used in more than one step

S1549 Unconnected block in SFC schema -

T8193 Communication timeout The communication with the target system failed because there is no answer
from the system itself. More common causes of this problem are wrong
cable connection, invalid target address in communication settings, invalid
settings of communication parameters (such as baud rate), target system
failure.

T8194 Incompatible target version Error code not used.

T8195 Invalid code file The target system image file (with IMG extension) is invalid or corrupted. Try
to upload and create new version of the image file using the
"Communication Upload image file" menu option.

T8196 Invalid data block index The image file (with IMG extension) contains a data block that has an index
greater than the largest index supported by the target system. Try to upload
and create new version of the image file using the "Communication Upload
image file" menu option. If the problem persist, contact the target system
vendor.

T8197 Invalid target information address Internal compiler error.

T8198 Flash erase failure The target system was not able to complete the flash erasure procedure.
Contact the target system vendor for details.

T8199 Code write failure The target system was not able to complete the flash programming
procedure. Contact the target system vendor for details.

T8200 Communication device unavailable The compiler tried to communicate with the target system but the
communication channel is not available. If the problem persist and there are
other applications that communicate with the target system, deactivate the
communication on the other applications and try again.

T8201 Invalid function index Internal compiler error.

T8202 Invalid database information address The address of the parameter's database memory area of the target system
is not correct or valid. Try to upload and create new version of the image file
using the "Communication Upload image file" menu option.

T8203 Invalid target information -

T8204 Rebuild required -

T8205 Invalid task -

T8206 Application-level communication protocol -

error: PLC run-time was not able to
understand the received command

T8207 Not implemented -

T8209 No room for source file on the target -

T8210 Error while uploading source code from target | -

device
T8211 No room for debug symbols on the target -
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T8212 Memory read error -
T8213 Memory write error -
T8214 Not enough space available on the target -
device for the PLC application binary
T8215 Generic communication failure -
X4097 Recursive POU -
X4098 Recursive data type -
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Overview of the Display Window

Purpose

Display Layout

Display is used to create user interfaces for embedded systems based on HMI
runtime.

It allows you to implement graphical interfaces in a visual way. The created pages
are viewed in Display as they appear on the final target device.

Thanks to their multi-page structure, Display can support HMI (human machine
interface) applications with an arbitrary number of pages.

It is equipped with several tools to realize complex applications and it interfaces
directly to the PLC IEC1131 Programming compiler for managing the variables
which are defined in the target device PLC application.

The following illustration presents the default Display window:

1 2 3

o dPtruxure C:\My Project\My Project.plcprj
@ Machine Expert - HVAC D B &

&) File Edit View Project Page Window | Help

| aamaEdE \OB*e|Uee: |ME|= =7 1L|HI|WF
|BE av obE Q%D &i@% e 0@

| Current profile: Remote and local - % Configure profiles

HMI Project HMI Properties a4 x
@ &) My Project Events | Doc | All
ﬂrfl :"pe"'es CharDimx 6
ages N . . . . e (CharDimY 8
ocEE NN ..
[+ ] " Global variables Background color
pommee - N ot calor —
0 @ Resources [BaseLanguage] | (NSNS - - - - - - - - s s+ s e Title bar No
Page border No
"""""""""" Caption
.................... Appearance Flat
HMI Actions 4 x
>
B3l Alarms Local actions  Global act
Output & X HMI Vars and Parameters 4 x Key Action
Preprocessing Regul and Control completed. 2l (0% Enter Edit
Preprocessing Application completed. ¢ Up PrevField
Preprocessing gonml;:xcat;:? sor:pleted. @sysgamgm @sysnmer o NextField
g d‘.;’:glag tered gzii:;r:rnelsssselzcledPos\lvon [ui] sysver
0 warnings, 0 errors = [W]sysLangiD
W8] sysLocalLeds
[ui] sysmsK
Find in project = Debug  Resources HMI Output et vars LocalParameters bl " L4
Ready EDIT MODE o NOT CONNECTED
ltem Description
1 Toolbars This toolbar shows the tools in form of icons.
For more information, refer to Toolbars, page 324.
2 Editor window This window allows you to edit the content of the current selection in HMI Project window.
3 HMI Properties window Shows the properties and events of the selected object:
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Item Description

Properties: the properties of the selected page or control are displayed in the form of
a table and can be modified in the right column.

Events: the events of the currently selected object are displayed in the form of a table
and each event can be associated with local or variable procedures in the right
column.

Doc: the description of the currently selected object is displayed in the form of a table
and it can be modified (or created if it does not exist) in the right column.

4 HMI Project window

This window includes:

Project: shows the project tree and the objects that compose it.
Each page contains the list of:
o Local variables (visible and usable only in the page where they are declared),

o Local procedures (which can be started only from the page where they are
implemented).

Moreover there are the nodes of:

o Asynchronous messages,

o Global variables (visible and usable from whatever page),

o Global procedures which you can start from whatever page.

Resources: shows the project resources (fonts, bitmaps, string tables, enumerated
data types, image lists, and sets).

5 Output window

This tool window shows the messages relating to the development of the project.

6 HMI Vars and Parameters
window

This window is composed of two tabs.

One tab contains the list of the available variables, and the other tab contains the list of the
local parameters.

7 HMI Actions window

This window shows in tabular form the actions associated with the buttons of the target
device (either according to the page currently displayed or according to the pages). Actions
can be changed in the right columns.

Set of Controls

Each page may contain an arbitrary number of defined graphic controls.

There are two classes of graphic controls:

Static controls: drawing tools such as lines, rectangles, and figures.

Dynamic controls: multi-layered objects, which enable data, image display,
and user interaction (strings, boxes, buttons, progress, custom controls,
charts, and trends).

Display is an open system allowing the implementation of custom controls which
may be included in the target device system.
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Multi-pages Structure

Display supports the definition of an arbitrary number of pages. Each page may
contain links to other pages so that the whole project takes a tree structure:

B8 &1 My Project a

J Properties
o~

B Aarms
B ™ Analoginputs
B ™ AnalogOutputs
B ™ BiosCfg485
B ™ BiosCfgETH
B ™ Circuit1
B ™ Circuit2
B ™ ComprCirt
B ™ ComprCir2
B ™ Dayly_Consumptions
B ™ DefrostCir1
B ™ DefrostCir2
n [ Digitallinputs
B ™ DigitalOutputs
B ™ FansCirt
B T FansCir2 v

Resources Management

The properties of the controls in the page are not statically defined in the project
code, but they can be managed separately as resources.

Resources include for example:
+ Bitmaps, page 377
+ Enumeratives, page 379
* Fonts, page 377
+ Sets, page 379
» String table, page 378

HMI Project

B &1 My Project
& Properties
0 1 Pages
[FI Messages
[+ ] Global variables
[+ ] , Global procedures
¥4
Bitmaps
B =° Enumeratives
J Expressions
%4 Font styles
%1 Fonts
Image lists
Sets
String table

(RTINS

Display allows you to import bitmap files directly from the Windows-formatted file
(*.bmp, *.gif, *.emf, *.jpg, *.ico, and so on).

For more information about Resources, refer to Resources, page 377.

Variables and Procedures

Display enables the implementation of several procedures in the ST language.
Through these procedures, you can customize the behavior of the logical system
interface.
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Example of variables:

© 00 NO OB~ WN -

Name Type Array Init value Description
InsertedPassword WORD No
ReqlLevVis BOOL No
AccessLevelPasswor UINT [0..3]
i USINT No
dummy USINT No
ADDR_LEVO_PASSW UINT No 16966
PASSWORD_DISABL UINT No 0
WiredLev3Password UINT No 0
WIRED_ELIWELL_PA UINT No 1603

EH Local variables - [PasswordInsert] [ OnLoadScript - [PasswordInsert]

Example of procedures:

InsertedPassword := 0;

IF (PageAccessHandshake = PAGE_ACCESS_REQUESTED) THEN (* Calling page is requesting a permission access
%) IF (PermLevelCurr >= PermLevelReq) THEN
PageAccessHandshake := PAGE_ACCESS_GAINED; (* Permission gained *)

END_IF;

ELSE (* No permission request; user manually selected login page *)
PageAccessHandshake := PAGE_ACCESS_DENIED;

END_IF;

retUINT := Video_GetParam( 0, ADDR_PSW1l, 0, ?AccessLevelPasswords[l], tyUINT);

retUINT := Video_ GetParam( 0, ADDR_PSW2, 0, ?AccessLevelPasswords[l], tyUINT);
retUINT := Video GetParam( 0, ADDR_PSW3, 0, ?AccessLevelPasswords[l], tyUINT);

m »

[ Local variables - [Passwordlnsert] [# OnLoadScrif >asswordInser

For more information about variables and procedures, refer to Declaration of
Variables, page 371.

Run-time Functionalities

Menu Bar

Overview

Overview of the run-time functionalities:

Managing asynchronous messages: Display supports the issue of
asynchronous messages whatever their complexity. You can customize
management of issue messages by typing a ST procedure.

For more information about managing asynchronous messages, refer to
Asynchronous Messages, page 328.

Multilingual support: Display allows you to modify strings, resources, and
enumerations language without recompiling nor reloading the application.

For more information about Multilingual support, refer to Language Selection,
page 339.

Events management: Display applications are structured in events; you may
seize the available events and manage them through ST-coded procedures.

For more information about events management, Events, page 374.

The menu bar of Display tab is composed of these menus:

File, page 27
Edit, page 26
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+ View, page 32

* Project, page 29

+ Page, page 28

» Variables, page 31
*  Window, page 33
* Help, page 27

Toolbar

Introduction

The toolbar appears at the top of the EcoStruxure Machine Expert - HVAC window
to provide access to frequently used functions.

For generalities of toolbars, refer to Toolbars description, page 33.

HMI Page Toolbar

The HMI Page toolbar has the following buttons:

Icon Description

Grid
@ Show or Hide the grid

Zoom In

E:L Zoom in the current page

Zoom Out

E:L Zoom out the current page

Insert static

akc Insert a static object, page 344

Insert new edit

Insert a new edit box, page 349

Insert new text box

Reserved

Insert new combo box

E Reserved
Insert line
hY Insert a new line, page 344

Insert rectangle

O

Insert a new rectangle, page 345

Insert image

Insert a new image object, page 346

Insert animation

:* Insert a new animation object, page 348
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Icon

Description

Insert new button

Insert a new button object, page 354

Insert new check box

Insert a new check box, page 345

i

Insert new progress

Insert a new progress bar, page 358

%

New custom control

Reserved

Insert new chart

Reserved

&

Insert new trend

Reserved

Align left

Align the selected objects to the left

Align right

Align the selected objects to the right

Align top

Align the selected objects to the top

Align bottom

Align the selected objects to the bottom

Make same width

Make objects of the same width

Make same height

Make objects of the same height

Space across

Evenly space the selected objects horizontally

Space down

Evenly space the selected objects vertically

Send to back
Send to back

&2 |

Bring to front

Bring to front

HMI Project Toolbar

The HMI Project toolbar has the following buttons:
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New record

Insert a new record

Remove record

Remove the current record

Move up

Moves the current record one position up

Move down

Moves the current record one position down

Parameters management

Parameters management

Refresh parameters
¢
@

Refresh parameters

Template management

Template management

New page

=

Insert a new page object

New event
¥

Insert a new event object

New action

Insert a new action in list

Compile HMI project

Compile HMI project and generate IEC code

Simulation mode

Simulation mode

Download HMI code
“a

Download the compiled HMI project

Generate RSM

Generate redistributable source module

Generate Doc.

Generate auto documentation

Open compiled project to resolve compile errors

Open compiled project to resolve compile errors

HMI Profiles Toolbar

The HMI Profiles toolbar has the following buttons:
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Icon

Description

Current profile

Select the active project profile (must be activated in Configure profiles)

Configure profiles

Choose active project profiles (Remote and local or Local only)
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Managing Display Elements

What’s in This Chapter

Managing Pages .......ccuuiiiiiiiiie e 328
Organization of Created Pages. ..........ccoouuiiiiiiiiiiiii e 338
Insertion of CONEIOIS ........oiiei e 343
Editing Control Properties ..o 359
Declaration of Variables ...........cooiii e 371
Using Advanced FeatUres ..ot 374

Managing Pages
Pages Overview

Navigating between Pages

Display manages the creation of pages for a specific application.
It is composed of several pages where you can arbitrarily arrange the controls.

You have to specify the start page, page 334 which is displayed at the start of the
target device. Other pages have at least a parent page from which they are
invoked and may have a child page to invoke. The invoking/invoked relations
implicitly give to the whole project a tree structure.

A child page may be invoked in two ways:

+ Through an action associated to a key: associate an OpenPage action with a
physical key (if there is a keyboard) or with a virtual key (whose pressure is
an event raised by software).

» Through an action associated to a key: associate an OpenPage action with a
physical key (if there is a keyboard) or with a virtual key (whose pressure is
an event raised by software).

Pages

There are two main types of pages in Display:

» Child pages, page 329 (which are called Frame in EcoStruxure Machine
Expert - HVAC).

* Pop-up pages, page 331.

Asynchronous Messages

Asynchronous messages are similar to standard pages, except the following
features:

» They have an additional property, that is the identifier of the associated
message (Msg ID).

» They can not contain invocations to child pages.

» They have no defined parent page nor a tree structure, but they can be
invoked from any other standard page.

An asynchronous message can not be explicitly invoked. The system displays it
whatever the active page when it intercepts a message containing the
corresponding Msg ID. This message may be launched either by the firmware or
by a procedure through the Video SendMessage function by using the following
syntax: Video SendEvent (kWM MSG, Msg ID).
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Child Pages

Create a Child Page

When an asynchronous message is active, the controls of the Frameset (see
Frameset, page 340) are automatically disabled.

Step

Action

Right-click on the Pages item of the project tree and click Insert page:

HMIPoect &
a 21 My Project
J Properties
B ™ Pages
(=

£ Mes
Page properties...
0~ Giob 9e prop

4 Glob Frameset

= o T

Paste page

Import page...
Import page from template...
Import page from project...

Import var/procedures...

Export var/procedures...

The New page dialog box appears and you have to specify the name of the new page

and whether the page is a pop-up one or not.

New page X

Insert the name of the new

| Page2| |

|:| Pop-up

ook Cancel |

NOTE: If you do not select the Pop-up check box when creating the new page,
page is called “Child Page”. Its main feature is that it fits the whole area. So you

the

cannot define position and size of a child page because they are automatically set

depending on the area and on an eventual frame set.
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Step

Action

Choose to create a child page and if you want to call it “Page2” for example: type the
name Page2 in the apposite field and press OK to confirm your choice.

A new node appears in the page folder of the project tree:

B8 &1 My Project
J# Properties

B ™ Pages
) ™ Paget
=

[FJ Messages
n Global variables
’ Global procedures
B g Resources [BaselLanguage]

Double-click the Page2 item to open the document with this page preview, which is
blank:
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Pop-up Pages

Create a Pop-up Page

Step Action

1 Right-click on the Pages item of the project tree.

2 Click Insert page command from the contextual menu.

3 Write the name of this page (for example Page3) in the dialog box which appears and

select the pop-up property.

New page X

Insert the name of the new

’ Page3 ‘

Pop-up

\ OK Cancel ‘

4 A new item appears in the Pages folder of the project tree:

[wipoes |

a @ My Project

J Properties

-] Pages
T Page1
[ + ] Page2
G
[ Messages

[+ | Global variables
; Global procedures

ﬂ @ Resources [BaselLanguage]

Dimensioning and Setting the Pop-Up Page

Child and pop-up pages have different icons in HMI Project.
Pop-up pages are not subjected to any restriction from the frameset.

When a pop-up page is active, the controls of the Frameset (see Frameset, page
340) are automatically disabled.

You can choose their dimensions and positions in HMI Properties window:
+ Sets the dimensions in XDim and YDim properties.
» Sets the position in XPos and YPos properties.

Modal Property

When a pop-up page opens:

+ If Modal property is set to Yes, the controls are inactive. It means that the
parent page objects are disabled.

+ If Modal property is set to No, the controls are disabled. It means that the
parent page objects are enabled if they are completely visible.
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Basic Page Settings

Viewing the Title Bar and the System Button

Display allows you to create a title bar for each page by selecting Yes in the Title
bar property.

You can name this title bar by writing a name in Caption text box.

If you want to activate the title bar and the close button, and to display the Page2
string as title, set as follow:

Title bar Yes
Page border Yes
Caption Page 2
Appearance Flat

Then the page looks like the following picture:

Editing the Colors of the Page

You can edit the background color of the page and the text color through the HMI
Properties window: click the drop-down menu in the right-column of Background
color or Text color field.

The palette of colors appears, select the desired one:

HMI Properties

Properties | Events | Doc | All

CharDimX 6

CharDimY 8

Font EWP2_6x8
Background color I -
Text color v
Title bar

Page border .

Caption

Appearance Flat

NOTE: For monochrome screens, it is recommended to choose white as
background color and black as default text color.

Changing the Font

You can change the font of textual elements on the page through the HMI
Properties window: click the drop-down menu in the right-column of Font.
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The different fonts available appear. Choose the one which suits you the best:

Cwipoperies |

Properties’ Events ’ Doc ’ All ’

CharDimX 6
CharDimY 8

EWP2_6x8
EWP2_6x8

Background color

Text color AEWP2—8X16 ]
Title bar No

Page border No

Caption

Appearance Flat

NOTE: EWP2_6x8 and EWP2_8x16 are the same font but with a different
size (the second font is larger).

- EWP2 6x8

....... —_—

Window Title Bar Parameters

The text, the background color and the used font are the same for all the pages of
the project, so you do not find them in this specific page properties. In order to
customize the window title bar of the pages only, double-click on the Properties
item of the project tree.

The window Pages properties opens. In System options tab, assign the font (in
this case EWP2_6x8), the text color, and the background color (in this case
respectively black and white).

Pages properties X

General || System options || Language selection | |Global On Timer | | Resources

Window title bar

Font EWP2_8x16 v
Textcolor | NG -

Back color v

OK Annuler Aide
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For example, the page looks like the following figures:

Before the procedure described above After the procedure described above

A [~

Assigning a Style to the Page

Display supports three styles for the pages, which you can select through the
Appearance property:

» Flat (the default style when you create a page),
* Raised,
* Sunken.

Overview of the three styles:

Flat Raised Sunken

Choosing the Start Page

You have to indicate the start page of the whole HMI project. The start page opens

at the HMI application start. If the project consists in one single page, the system
takes this one as start page.

To indicate the start page, double-click the Properties item of the project tree. In
the General tab, select the window to define as the start page and click OK:

Pages properties X

General || System options || anguage selection | |Global On Timer | | Resources

Initial page selection Page model
® Hierachical
Page2
Page3 Flat

Screen size

Widht:

Height:

OK Annuler Aide

You can also indicate the start page by right-clicking a page in the project tree and
clicking Set as start page.
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The start page is marked in the project tree by a green triangle:
B ] Pages

[+ i Page
u ] Page2

NOTE: The pop-up pages can not be set as starting page.

Basic Page Operations

Overview

Basic operations such as export/import, copy/paste, and page-based template
management can be done with Display. Next paragraphs show these arguments
in detail.

Export of Pages to Files

Each page can be saved to be used later in other projects.

To export a page, right-click on the page in the HMI Project window and click
Export page... command.

Then, the application asks you to write the name of the file in which the page is
saved. This file has a *.pex extension. The exported file contains page information
and local procedures.

Import of Pages from Files

Each page can be saved to be used later in other projects.

To import a page, right-click Pages node and click Import page... command.
Then, you can select the file of the page to import. The imported page takes the
same name that it had when it was exported.

Export/Import Procedures and Variables

It is possible to export/import local or global variables and procedures using the
menu commands Export var/procedures... or Import var/procedures....

Copy/Paste of Pages in the Project

Rename Pages

It is possible to copy and to paste a page inside the project.
To copy a page, right-click on the desired page and click Copy page command.

Then, you can paste the copied page by right-clicking Pages node and clicking
Paste page command.

To rename a page, right-click on the page to rename and click Rename command.
This allows you to modify the name of the page.
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NOTE: This operation modify only the name of the page, project references to
the renamed page are not automatically updated.

Templates of Page Management

Templates allow you to save only the structure of the page and not the whole
page. Templates can be described as pages without references to external
variables. Templates can be grouped in library files (*.petx) and can be linked into
the project.

Export Pages into a Template File

To export a page into a library of templates, right-click on the page in the HMI
Project window and click Export page as template... command:

HMI Project
B [ My Project
S Properties
B 7 Pages
° e ; Set as start page
0B Pe
[ Mess Open
ﬂ Globg Rename
4 Globg
0 & Reso Copy page
Import var/procedures...
Export page...
Export page as template...
Export var/procedures...
Insert procedure...
Remove page
Page type

A library file with *.petx extension (new or already existing) is indicated. Template
is appended to the existing templates and a name for the library is requested. If
the template is already available in the library, a message asks you if you want to
rewrite the existing template or not.

Page is exported as template into the specified library with its element but without
any referenced variable.

Scripts and local variables are exported without modifications. References to
variables contained in the scripts are not modified.

Child pages, popup, and asynchronous messages can be treated as templates.

Usage of the Template Library in a Project

It is possible to include a template library in a project in order to use templates
when desired.
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Click Template Management... command from Project menu. The following
window appears:

Template list X

Add

Remove all

Close

Available operations are listed here:

+ Add: add a template library to the project. Including a library means that a
reference to the library of the *.petx file is added to the current project, and
that a local copy of the library is made.

+ Remove: Remove template library from current project.

+ Edit: To modify local copy of the template library removing no more used
templates.

* Re-Export: Export local copy of the template library into a new *.petx library
file.

* Remove all: Remove the template libraries from current project.

To add a template library to the project, click the Add button. Once chosen one of
the available libraries, Template list window appears as shown here:

Template list X

Remove

Re-Export

Edit

Remove all

Close

Template library has been included to the project. Then, click the Close button.

HMI Templates window shows a tab for each library imported in current project.
Each tab shows the list of templates of the corresponding library:

HMI Templates |

[T Page1

template

NOTE: If HMI Templates window is not displayed, click View > Tool windows
> HMI Templates.
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Using a Template

Once a template library has been added, you can use its elements by dragging the
chosen one from the HMI Templates window and by dropping it on the project
tree in the HMI Project window.

Once the item has been dropped, application asks you to write the name of the
new page created (based on the template).

Project Template Update

You can delete templates from the (local) template library using Edit button in the
Template list window:

Template list X Object browser X
Add | [Pages | r~ Filters ———————————
Name
Remove ‘ .
Re-Export
Edit - Commands ey
Import page into project ‘
Remove all Delete page
[ Close ‘

(oo ]

Organization of Created Pages

HMI Actions Window

Overview

The HMI Actions window allows you to assign an action to a key of the target
device:

* Local actions: assign to a key of the target device an action which depends
on the selected page,

* Global actions: assign to a key of the target device an action which is always
the same whatever the selected page.

The HMI Actions window is made up of three boxes:
» Key: key of the target device,
+ Action: action to be performed when the key is pressed,

» Link: name of the page to open (to be used when the selected action is Call
or OpenPage).

Parameters management X

ID ‘ Name ‘ DB address mode Device protocol ‘ Network address ‘ Add Device ‘
1 Frigo Modbus N v

‘ Remove Device ‘

Close
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Project Properties

Overview

Display manages the creation of pages for a specific application.
It is composed of several pages where you can arbitrarily arrange the controls.

You have to specify the start page which is displayed at the start of the target
device. Other pages have at least a parent page from which they are invoked and
may have a child page to invoke. The invoking/invoked relations implicitly give to
the whole project a tree structure.

Project Properties Window

General

System Options

Language Selection

To open the Pages properties window, double click Properties item in HMI
Project window. This window is composed of five tabs:

Pages properties X

General System options || Language selection | Global On Timer | Resources

Initial page selection Page model
Page1 @) Hierachical
Page2
Page3 Flat

Screen size

Widht:

Height:

OK Annuler Aide
+ General,

+ System options,

+ Language selection,
* Global On Timer,

* Resources.

It allows to select the start page among the implemented pages.

The Page model area allows you to select the type of page model in case of a
page calls another page. If the model is Hierarchical, then a child page can not
recall a parent page. If the model is Flat, all the pages can call the others without
limitations.

It allows you to customize the title bar features of the window: the font, the text
color and the background color.

Strings and enumerated data types are structured as to ease the multilingual
device. Moreover Display provides a function to export/import the above
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mentioned elements to/from a text file in order to simplify the translation from a
language to another.

English version French version
ID Caption o ID Caption o
IDS_Title_InsPW INSERT PASSWORD = IDS_Title_InsPW INSERER LE MOT DE PASSE | =
IDS_Title_Alarms ALARMS IDS_Title_Alarms ALARMES
IDS_ChilledTemp out IDS_ChilledTemp out
IDS_HotTemp INT IDS_HotTemp INT
IDS_OutdoorAlrTemp OAT IDS_OutdoorAlrTemp |OAT
IDS_CurrentWaterSet SET IDS_CurrentWaterSet |SET
IDS_Circuitl C1 IDS_Circuit1 C1
IDS_LP LP IDS_LP LP
IDS_HP HP IDS_HP HP
IDS_CondTemp CcnT IDS_CondTemp CnT
IDS_CondTempSet SET IDS_CondTempSet SET
IDS_CondOutTemp coT IDS_CondOutTemp CoT
INC_ _CuanTanan LT v INS _CunanTamn BT v
B String table (BaseLanguage) HH String table (BaseLanguage)

It allows you to add, remove, export, import, and select the resources languages
(for more information, refer to Strings Table, page 378 and Enumeratives, page
379). The label: sysLangID Value indicates the value which the sysLangID target
variables must take to display the pages in the selected language.

To add a language (for example Chinese), follow the procedure below:

Step

Action

1

Export the language supported by the translator, select BaseLanguage (or any other valid
translation).

Click Export... button.

It opens a window requiring the destination folder for the selected language file.

At the end of the exportation, the file is composed of the resources of the project which
have to be translated: stings and enumeratives.

Translate the exported file and replace the text under the LANGUAGE tag with the one of
the new language (for example, in this case change it into “Chinese”).

Then, in the Language selection area, click Import ... button and select the translated file.

The new language appears in the list.

Global Periodic Procedure

GlobalOnTimer allows you to specify the name of a global procedure to be
periodically and independently executed on the active page. Such a procedure
may be effectively used to constantly test one or more PLC variables and to emit
alarm messages, for example through asynchronous messages, page 328.

Frameset

Overview

Display allows you to define areas which are called frames and are placed on the
sides of the screen and are always active.
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My Project

You can set these dimensions of the frames and insert some controls which are
active whatever the currently loaded page. Consequently, frames are useful to
host the objects which have to appear in the whole project. In this way you do not
need to duplicate them in each page.

There are two exceptions:

* The pop-up pages, page 331 when the Modal property is set to Yes in HMI
Properties window.

* All the asynchronous messages, page 328.

When these pages are active, the controls of the frameset are automatically
disabled.

Activate and Deactivate the Frameset

To activate the frameset, right-click Pages in the HMI Project window and select
Frameset.

To deactivate the frameset, right-click Pages in the HMI Project window and
select Frameset. In the window that appears, click OK (the current frameset will
be lost).

For more information about frameset properties, refer to Frame Set, page 361.

Multiple Pages Management

Overview

These functions allow you to construct pages with data of different kind that must
be represented on distinct pages for space reasons.

Sets, page 379 can be used with edit boxes or progress bars. Sets are ensemble
of variables even of different type. Set definition can be done from the Resource
in HMI Project window, they are implemented using a table with a series of
variables that are dynamically associated to the control basing on the current
index assigned to the page.

Association of Elements of a Set

Elements of a set can be associated to a control using the following syntax:
character # first of all, then the name of the set followed by the index of the
position of the element in the page, between round brackets.
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Position index is used to indicate the order in which elements are shown in case of
more than one element in the same page.

A page contains one or more controls based on one (or more) set. At runtime, the
page is replied in order to show all the elements contained in the set. In the last
page, if any control can not be filled with element value, that control is hidden.

We created before a set of five elements named BIOSParameters, now we can
associate #BIOSParemeters (0) to the first edit box and #BI0SParemeters
(1) to the second. So there are three pages: first page with the first two elements
of the set, second page with elements 2 and 3 and third page showing the last
element of the set. In the last page, the second edit box is not visible.

Navigation of the Elements of a Set

Pages Numbering

Navigation of pages that represent a set of elements is automatically done using:
* NextEdit event of the last selectable control of the page,
* PrevEdit event of the first selectable control of the page.

It is also possible to send special events to force the change of the page in this
way: Video SendEvent (kEV_WM CHANGESETPAGE, numpage). Where
numpage is the number of the page of the set.

Display defines two variables related to pages numbering:
* S$PagIndex: current index of the page containing controls based on a set,

* SPagNumber: number of pages that complete the visualization of the whole
elements of the set.

These variables can be used in the page to show the numeration of the pages.
They can be used as variables associated to edit box controls in this way:

3 x
Events | Doc | All
Format %d -
Alignment Right
Access RW
Selection order 2
Data type UINT
Low limit
High limit *
Refresh TRUE =
Visible TRUE
Selectable TRUE
k5 Page1 | B3 Page2 Label M

Automatic Documentation

Overview

During project development, it is usually necessary to write comments for each
page in order to explain how the page works.

Display integrates into its development environment the automatic documentation
feature. It consists in the generation of a graphical report with all the previously
inserted comments followed by the pages they refer to.
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Comments related to controls and pages should be inserted in the Doc tab of the
HMI Properties window.

HMI Properties

Properties | Events | Doc | All
Description Write here how the page works
Description X

Write here how the page works

OK Cancel

Documentation is generated when the Generate Doc. button is pressed.

At the end of the process, a dialogue box is shown. Click Open documentation
link to view the generated report using the browser.

It is also possible to manually open the *.html file generated. This file is created in
the project folder and is named “project name.html”.

NOTE: Documentation generation process requires the file “Documentation.
xsl” to be in the project folder. You can personalize this file to redefine report
style.

Insertion of Controls

Controls

Overview

A control is a display element (textual or graphical) contained in a HMI page. It can
be used to present information. Control content can be fix or can modifiable with
variables or parameters through HMI application. Display supports the following
controls:

+ Static, page 344

» Edit Box, page 349

» Text Box, page 357

» Combo Box, page 346

» Graphic, page 344

* Image, page 346

* Animation, page 348

» Button, page 354

* Check Box, page 345

* Progress Bar, page 358
To insert a control on a page, you can do the following:

» In the HMI Page toolbar, click the icon of the control to be inserted. Then,
click at the place on the page where this control should be displayed.

* Inthe Page menu, click the icon of the control to inserted. Then, click at the
place on the page where this control should be displayed.
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Static

Graphic

Overview

Inserting a Line

*  From the HMI Vars and Parameters window, drag and drop a variable or a
parameter into a page. The Insert object window appears and lets you
choose which control to use to display this variable or parameter.

Static controls display a fixed string whose contents cannot be edited when
executing. You must specify the text of the string directly or by the association of
the ID of a string defined as resource to support multi-language management. For
project resources and multi-language support, refer to Resources, page 377.

To insert a static control, click Insert static icon in HMI Page toolbar. Then, click in
the editor window the point where you want to insert the control.

You can also drag a variable from the HMI Project window and drop it into the
editor window. In the Insert object window, select Static control and click OK
button.

For more information about properties and events of the static control, refer to
Static Properties, page 364.

Graphic controls are objects which are drawn when you open the page. They do
not change until the page is active.

They display a static line or rectangle. Their properties cannot be edited when
executing.

To insert a line, click Insert line icon in HMI Page toolbar.

Then, move the mouse to the active area of the page. A + cross shows the
insertion point of the object. Click-left to insert the object in the grid.

The inserted line has a default size and horizontal alignment:
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You can edit the color and the thickness of the line in the HMI Properties window.

HMI Properties I

Properties | Events | Doc | All

XPos 42
YPos 16
X2Pos 84
Y2Pos 56
Name Line_1

Thickness points 5

Border color I -

B3] page1*

Inserting a Rectangle

Check Box

To insert a line, click Insert rectangle icon in HMI Page toolbar.

Then, move the mouse to the active area of the page. A + cross shows the
insertion point of the object. Click-left to insert the object in the grid.

The inserted rectangle has a default size:

You can customize the inserted rectangle by modifying its parameters in the HMI

Properties window.

For example, you can modify the thickness of the borders, the color of the borders

or the background or make the background transparent.

HMI Properties

Properties | Events | Doc | All

XPos 48

YPos 16

XDim 32

YDim 32

Name Rect_1

;

Border color I -

Background color ~
&) page1* Transparent TRUE

Check box control displays a check box that allows you to select a true or false
condition identified by a variable.

To insert a check box control, click Insert new combo box icon in HMI Page

toobar. Then, either click in the editor window the point where you want to insert

the control or drag a variable from the project tree or from the library window.
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Combo Box

Image

Overview

You can also drag a variable from the HMI Project window and drop it into the
editor window. In the Insert object window, select Checkbox control and click
OK button.

Combo box control shows a list of strings connected to a variable with an
enumerator element.

To insert a combo box control, click Insert new combo box icon in HMI Page
toobar. Then, either click in the editor window the point where you want to insert
the control or drag a variable from the project tree or from the library window.

You can also drag a variable from the HMI Project window and drop it into the
editor window. In the Insert object window, select Combobox control and click
OK button.

Image control displays a bitmap image.

Static images are different from:

* Animations, page 348: which are images which may change dynamically,
even though they have fixed position and dimensions.

» Floating images: which are images which move in the page.

Importing a Bitmap in the Project

The following image formats are supported by EcoStruxure Machine Expert -
HVAC:

- BMP (*.BMP;*.DIB;*.RLE)
. JPEG (*.JPG;*.JPEG;*.JPE;*.JFIF)
. GIF (*.GIF)
- EMF (“~.EMF)
- WMF (*WMF)
. TIFF (“.TIF;*TIFF)
- PNG (*.PNG)
. ICO (*.ICO)
NOTE:

EcoStruxure Machine Expert - HVAC displays the images on the target device
without resizing them. So make sure that the size of the imported images is
not too large for the target device on which they are displayed.

In Resources [BaselLanguage], right-click Bitmaps item and click the Import
bitmap... command.
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In the Import bitmap into project window, click Browse button. You can navigate
in the computer resources and select the desired image. In this case, the image
file is BulbOn.jpg, which represents a lighted bulb:

Import bitmap into project X

Source bitmap Converted bitmap

v v

Browse H: 0 w: 0 Transparency color:
BmpName | BmpBubon R: nfa G na B: na @l

Reset Transp. Import

In the Bmp Name field, you can assign the bitmap name which appears in the
Resources [BaselLanguage] tree structure. The default name is the file name
without extension and preceded by the Bmp prefix.

The Transparency color field allows you to specify a transparency color. This
color is not drawn but lets the elements appear through the bitmap background.

You can customize the transparency color by taking the desired one with the
mouse from the Converted bitmap box.

RGB indicates the transparency color components. If the values are n/a, it means
that no transparency color has been selected. The Reset Transp. button allows
you to cancel the last selected transparency color.

At last, you can confirm the operation by clicking the Import button. The imported
bitmap appears as a new item in the Resources [BaseLanguage] tree structure:

B &3 Resources [BaselLanguage]

(-] Bitmaps
-~

=~ Enumeratives
f, Expressions
%1 Font styles

B *4 Fonts

Image lists

Sets

String table

(&) i & g3

Associating an Imported Bitmap with an Image Control

The control which is aimed to display the static images is called Image.
To insert an image, click Insert image icon in HMI Page toolbar.

Then, move the mouse to the active area of the page. A + cross shows the
insertion point of the object. Click-left to insert the object in the grid.

A new blank frame appears in the page. Drag the desired image from the Bitmaps
list and drop it to the blank frame. The image control does not modify its size to be
compatible with the assigned bitmap measures.

EI00000003412.05

347



Managing Display Elements

Animation

Overview

An animation control allows you to associate each variation in the value of a
variable with the display of a different image.

It displays a bitmap image which you select from a list of images depending on the
value of an associated selection variable.

Inserting an Animation

In order to create an animation, you must first create a list of images. This list of
images includes the images that the variable can display. Each image is
associated with a value or a range of values that the variable can take. To know
how to import an image, refer to Importing a Bitmap in the Project.

To create a list of images, right-click Image lists inResources [BaseLanguage]
item and click Add new command.

Then, right-click on the newly created list and click Rename command. Write the
name of your choice and press the Enter key.

a _g‘__; Resources [BaselLanguage]
[+ B Bitmaps
B =7 Enumeratives
Expressions
Font styles
Fonts

"‘bf"\":‘:‘

B

(4]
- | Image lists

Sets
| String table

To add images to the list, click the New Record icon in the HMI Project toolbar. A
line appears in the editor window and must be completed like this:

+ Init value: indicate the start of range value,

+ End Value: indicate the end of range value,

+ Bitmap: select the image to display for the specified value range from the list.
Repeat the operation until the list is complete:

Init value End Value Bitmap
1 1 BmpSettings32x32
2 2 BmpMonitor32x32
3 3 BmpOnOff32x32
4 4 Bmplo32x32
5 5 BmpPassword32x32
@ Image lists - [Folders]

Once the list of images is established, you have to create an animation. To do so,
select the desired page and click Insert new animation icon in HMI Page toolbar.

Then, move the mouse to the active area of the page. A + cross shows the
insertion point of the object. Click-left to insert the object in the grid.

You can also drag a variable from the HMI Project window and drop it into the
editor window. In the Insert object window, select Animation control and click
OK button.
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A new blank frame appears in the page. Select it and fill in the following
parameters in HMI Properties window as follows:

» Image list: indicate the list of images to use with the variable,
« Animation variable: indicate the animation variable,

» Data type: indicate the type of the variable (filled in automatically after
selecting the variable).

The creation of the animation is finished. If you want, you can also edit the other
parameters present in the HMI Properties window.

1 x
Events | Doc | All
XPos 48
YPos 16
XDim 32
YDim 32
Name Animation_1
Appearance Flat
Border points 1
Border color I -
Animation variable uiNbFansCirl
Data type UINT
Visible TRUE

Edit Box

Overview

An edit box control is a text frame which lets you display and edit an associated
variable or parameter.

It displays the contents of an associated variable.

Inserting an Edit Box in the Page

To insert an edit box, click Insert new edit icon in HMI Page toolbar.

Then, move the mouse to the active area of the page. A + cross shows the
insertion point of the object. Click-left to insert the object in the grid.

You can also drag a variable from the HMI Project window and drop it into the
editor window. In the Insert object window, select Edit control and click OK
button.

A new text frame appears. It consists by default in some characters and its font is
specified in the Font property of the page.
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In HMI Properties, you can modify several parameters including these:

HMI Properties a1 x
P es | Events | Doc | All

XPos 42

YPos 24

Name Edit_1

Appearance Flat

Font EWP2_6x8

Background color v

Text color I -

Sel. background I -

Sel. foreground M

Border points 1

Border color I -

Number of chars 3

Format %d

Alignment Center

Access RW

Selection order 1

Variable sysVER

Data type UINT

Low limit

High limit

Refresh TRUE

Visible TRUE

Selectable TRUE

Label

+ Appearance: appearance of the edit box (Flat by default).
» Font: font used by the text in the edit box (EWP2_6x8 by default).

» Sel. background and Sel. foreground: respectively text and background
colors when the edit box is selected.

* Number of chars: maximum number of characters which can be displayed.

» Access: to set the read-only mode, replace RW (read/write) by RO (read-
only).

» Refresh: to update constantly the contents of the edit box, select the TRUE
option.
Otherwise, the contents are refreshed just when drawing the page for the first
time.

» Label: if the target has a touchscreen display, shows keyboard and has this
feature enabled.

It is possible to add this text/string resource’ as header of keyboard.

+ Format: it represents the display format of the associated value of the
variable. The format value can be inserted only if a variable is available. It
opens a dialog window with these settings according to the type of variable
(integer, real, string).

For more control properties details, refer to Edit Box, page 365.
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Format Property Details

Integer format window:

Integer format X

Integers (1-31)

Decimals (1-7)

Hexadecimal Uppercase (...00H)
Hexadecimal Lowercase (...00h)
Fill with zeroes

View always sign

Password

Target metric

Target custom format

OK Cancel

* Integers (1-31): number of digits before decimal point.
+ Decimals (1-7): number of digits after decimal point.

* Hexadecimal Uppercase (...00H): the number is shown as ...00H
representation with uppercase H letter.

+ Hexadecimal Lowercase (...00h): the number is shown as ...00h
representation with lowercase h letter.

« Fill with zeroes: fill the entire edit box controls with 0 where there are not
numbers.

+ View always sign: show the + or - symbol in edit box.
+ Password: show only * symbols.
+ Target metric: reserved.

+ Target custom format: the target can define custom format to show the data
in a particular way. In that case, there is a variable on the target with the value
of the corresponding user mode.

+ Enumerative: this representation allows you to select a string value
corresponding to numeric value defined in Resources, under Enumeratives.
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Real format window:

Real format X

[ integers (1-31) ’ 1 ‘

| |Decimals (1-7) ’ 1 ‘

Automatic decimals format

Fill with zeroes

]

]

[ [Viewalways sign
| |Password

]

Target metric

[ [Target custom format
HH:MM

OK \ Cancel ]

* Integers (1-31): number of digits before decimal point.
» Decimals (1-7): number of digits after decimal point.

+ Automatic decimals format: hides unnecessary zeros in decimals. If
checked, Decimals (1-7) is disabled.

« Fill with zeros: fill the entire edit box controls with zero where there are not
numbers.

» View always sign: show the + or - symbol in edit box.
» Password: show only * symbols
» Target metric: reserved.

+ Target custom format: the target can define custom format to show the data
in a particular way. In that case, there is a variable on the target with the value
of the corresponding user mode.

String format window:

String format

[ ]Password

. 0K || Cancel

» Password: show only * symbols.

The Target custom format is a special feature which enables a particular custom
format implemented on the target.

The format is specified according with language printf syntax, refer to Format
Specification - Printf, page 367.

Edit Box and Display Variable Association

In order to display values, edit boxes have to be associated with variables.

To link an edit box to a variable, select the edit box by clicking it once and select
the Variable in HMI Properties window.
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Then, enter the name of the desired variable. If you do not know its name, click the
.. button to open the Property definition window.

Property definition X

Variable Selection

@LocalParameters.Addr_CAN_OB @LocalParameter
@LocalParameters.Addr_CAN_PI @LocalParameter|
@LocalParameters.Addr_RS232_PI @LocalParameter|
@LocalParameters.Addr_RS485_0OB @LocalParameter
@LocalParameters.Addr_RS485_0B1 @LocalParameter|
@LocalParameters.Addr_RS485_PI| @LocalParameter|
@LocalParameters.AlL1 @LocalParameter
@LocalParameters.AIL10 @LocalParameter|
@LocalParameters.AlL11 @LocalParameter
@LocalParameters.AlL12 @LocalParameter
@LocalParameters.AlL2 @LocalParameter|
@LocalParameters.AlL3 @LocalParameter|
@LocalParameters.AlL4 @LocalParameter
@LocalParameters.AIL5 @LocalParameter|
@LocalParameters.AlL6 @LocalParameter|
< >
Filter:

All N

Value selection

None

OK Cancel

The Property definition window allows you to find the desired variable.

You can use the Filter field to search for a variable according to its type:
* Page locals
* Global procedures

+ Target (variables which allow the interaction between user interface and
system)

* PLC application

» Parameters (for more information about how to name a parameter, refer to
Edit Box to a Parameter, page 353)

« PLC libraries
Once found, select the desired variable and click OK.

Now the edit box control shows the value of the selected variable constantly
refreshed.

Linking an Edit Box to a Parameter

The name of parameters is composed like this: @device.variable name. This is
different from the name of the variables which show just their name.

The parameter may be inserted in the apposite controls property in the following
forms:

+ Explicit form: @d.oi.os:type (example: @1.2010.0:UINT),
o d: numerical ID of the device,

This field of the device is a numerical or symbolic identifier (to be defined
at project creation). It refers to a specific device which may be local (the
device which executes the pages itself) or on the fieldbus.

o oi: object index,
o 0s: object subindex,
o type: PLC type.
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» Implicit form: @dev.name (example: Frigo.AIL1).
o dev: symbolic identifier of the device,

This field is a symbolic identifier of a device whose numerical ID can be
retrieved by Display.

o name: symbolic name of the parameter.

Linking an Edit Box to a Variable by Dragging and Dropping

You can add variables and parameters to the HMI Vars and Parameters window
by dragging and dropping them in the page. Display requests to define the type of
control to insert to associate it with the variable.

Button

Overview

Buttons are controls which allow you to interact with the system, particularly in
case of touchscreen systems without keyboard.

There are four kinds of button control:
» LED button: to view an associated state of a boolean variable.
+ Status button: to modify the state of a boolean variable.
» Opening button: to open an other page.
» Activation button: to start the execution of a customized procedure.

Inserting a Button

To insert a new button, click Insert new button icon in HMI Page toolbar.

Then, move the mouse to the active area of the page. A + cross shows the
insertion point of the object. Click-left to insert the object in the grid.

You can also drag a variable from the HMI Project window and drop it into the
editor window. In the Insert object window, select Button control and click OK
button.

A new button control appears. It has a default size. You can change the
dimensions of the button by dragging one side with the mouse.
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Creating a LED Button

Once the button is inserted, you must define the colors associated with the
different states of the boolean variable:

+ Border color: defines the border color when the button is inactive.

» Background color: defines the background color when the button is inactive.

+ Selection border: defines the border color when the button is selected.

+ Sel. background: defines the background color when the button is selected.
You can also customize the button appearance through the Appearance property.

HMI Properties

Properties | Events | Doc | All

Selection text/img o
Font
Appearance

Border points

Border color

EWP2_6x8

Flat

1

| E—
Background color
Selection border I -
Sel. background I
Selection order 1

Visible TRUE o

Then, you must associate the LED button with a boolean variable through the
Variable field. This property defines the state of the button and can be associated
with:

* A constant value:
o FALSE: the control is always inactive.
o TRUE: the control is always selected.
* A boolean variable whose value defines dynamically the selection state.

To declare a boolean variable and associate it with the button control, write its
name in Variable field or select it through the - button.

Creating a Status Button

Once the LED button is created, you must insert a new button (which corresponds
to the status button) and set it next to the LED button.

In HMI Properties window, write in Text field a name to display inside the new
inserted button.

HMI Properties I

Properties | Events | Doc | All

YDim 33 A

Name Button_1

Selection text/img

Font EWP2_6x8

2] Page2* Appearance Flat

Then, you must associate the status button with a boolean variable through the
Press variable field. In this case, the value of the boolean variable corresponds to
the pressure state of the status button.
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This allows you for example to display the LED button in green at runtime and to
display it in red as soon as you press the Press button (and therefore as soon as
you modify the value of the boolean variable).

Creating an Opening Button

Once the button is inserted, it can be used to open an other page when you press
it.

In HMI Properties window, select Action field and click OpenPage. Then, in
Action par field, write the name of the page to open when the opening button is
pressed.

In the following example, when you press the Open button of the Page2, it opens

the Page3 page.
HMI Properties

Properties | Events | Doc | All

Transparent FALSE o
Selection variable FALSE

Action par Page3

Alignment Center

EEl Page2* v

Creating an Activation Button

Display enables you to implement some procedures (refer to Procedures that
Can Be Associated to Events, page 375) through which it is possible to customize
the HMI behavior.

Take the example of the creation of a procedure to increment the local variable “n”
of the Page1 page.

As this procedure applies on a local variable, it is local in the Page1 page too.

To create a procedure on a page, expand its structure tree. Then, right-click on the
Local procedures item and click Insert procedure... command.

B8 &1 My Project
J Properties
B T Pages
B = Pagetl
(- ] Local variables

[ui] n
; Local procedures|

n 1 Page2 Set as start page

Page3 ‘
[E'I %essagges Insert procedure...
[ +] & Global variables Remove procedure

’ Global procedures
) & Resources [BaselLanguage]

In the New procedure window, write the name of the procedure and click OK
button.
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Text Box

Overview

New procedure X

Insert the name of the new procedure o)

prcincrem | Cancel

II Ix

Double-click the local variable which has been declared and appears under Local
procedures item. The ST language editor opens and lets you either implement or
edit the selected code of the procedure.

Write a procedure that applies a unit increment to the “n” variable. Then, close the
document.

n:=n+1; A
v

< >
[ prcincrem - [Page]* 4D v X

Insert a new button control (which corresponds to the activation button) beside the
edit box associated with the “n” variable and write the character “+” in the Text
property.

Take the example of the execution of the prclncrem procedure by clicking the +
button. In HMI Properties window, select Call action in the Action field. Then,
write the name of the procedure in the Action par field.

Every time you press the + button when executing the HMI, n increases by one
and the edit box shows the up-to-date value.

Text boxes are not part of static controls because they have some properties
which let them modify themselves in a page through time. Visibility, selection, and
refresh may be assigned to variables, which may modify their value at any time.

Text box displays the contents of an associated string variable. It supports the
formatting on several lines of the text which is contained in the string.

Inserting a Text String

To insert a new text string, click Insert static icon in the HMI Page toolbar.
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Progress Bar

Overview

Then, move the mouse to the active area of the page. A + cross shows the
insertion point of the object. Click-left to insert the object in the grid.

You can also drag a variable from the HMI Project window and drop it into the
editor window. In the Insert object window, select Textbox control and click OK
button.

A new text string control appears. It has a default text which can me modified
through the HMI Properties window by editing the Text field.

This is the basic use of a text string. You can also assign text strings by taking
them from the resources (refer to Stings Table, page 377).

A progress bar control allows you to display the variations in the value of a
variable in the form of a progress bar.

It represents the progress of an operation by showing a stained bar in a horizontal
or vertical rectangle. The length of the bar shows the percentage of the completed
operation.

Inserting a Progress Bar

To insert a progress bar, click Insert new progress icon in HMI Page toolbar.

Then, move the mouse to the active area of the page. A + cross shows the
insertion point of the object. Click-left to insert the object in the grid.

You can also drag a variable from the HMI Project window and drop it into the
editor window. In the Insert object window, select Progress control and click OK
button.

The inserted progress bar has a default size and horizontal orientation:

The orientation as well as the parameters of the progress bar can be modified
through the HMI Page window.

You must associate a variable with the progress bar. To do so, select the desired
variable in the Progress variable field of the HMI Properties window. The Data
type field is automatically updated.

Then, define the minimum value that the variable can reach in the Low limit field
and the maximum value that the variable can reach in the High limit field. When
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the value of the variable is at the minimum, the progress bar is empty. When the
value of the variable has reached its maximum, the progress bar is full.

Editing Control Properties

Visibility and Updating of Controls

Overview

Visibility Property

Each control has its own properties which you can customize through the HMI
Properties window. The content of this window depends on the selected control.

Two properties that are common to most controls: Refresh and Visible.

Most controls have the Visibility property, which determines whether the object is
visible or not.

This property can be associated either with:
* A constant value:
o TRUE: the field is always displayed,
o FALSE: the field is always hidden.
* Aboolean variable: whose value dynamically establishes the visibility state.

It is possible to condition the visibility of a variable. For example, in case you want
to display a variable when its value is even and hide it when its value is odd.

For the purposes of the demonstration, take the detailed case in Inserting a Button
to Launch a Procedure, page 354. Suppose that you want to display the text string
when the value of the variable n is even and hide it when this value is odd.

For this purpose, it is necessary to declare a new boolean local variable which
indicates whether currently n is even.

Name Type Array Init value Description
1 in o JUNT No 100 Counter variable
BOOL No TRUE Local variable n is even

2 Eeven

It is necessary to edit the prclncrem procedure so that, when it refreshes the n
value, it evaluates again whether it is even or odd. In order to access the
prcincrem source code, select the corresponding item in the project tree by right-
clicking it. Then, click Open command.

The ST language editor opens and the code of the procedure may be extended as
follows:

even := (n MOD 2) = 0;

< >

In order to associate the visibility of the string state with the even boolean

variable, select the text string and click - button in the Visibility property of HMI
Properties window.
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Refresh Property

In the Value selectionarea, click Variable and select Page locals in the Filter list.
Then, click the local boolean variable even.

Property definition X

Variable Selection

Filter:

Page locals v Add variable

Value selection

Expression
True
False

OK Cancel

Click OK button. The text string is only visible when the variable n is even.

When available, the Refresh property determines if the associated object has to
be drawn once (when opening the page or coming back from a child page) or if it
needs to be constantly refreshed.

For example, this property distinguishes the edit box and the text box.

With regard to the edit box, the refresh property has to be set when compiling and
it can not be edited at runtime. If you assign Refresh = TRUE, the associated
value of the variable value is constantly read and refreshed. Otherwise (Refresh =
FALSE), the value is read and refreshed only when you open the page or when
you come back from a child page.

There is another option about text boxes: you can associate a boolean variable
that is used as trigger for refresh. When the trigger variable becomes TRUE, the
contents of the controls are refreshed. Then, it is automatically reset by Display to
FALSE.

Using Expression to Set Visibility and Selectable Properties

Expressions can be used to dynamically change visibility and selectable
properties of a control.

From the Resources item in HMI Project window, double-click Expressions
item. The definition table of expressions appears.

To add a new expression definition row, click New record icon in HMI Project
toolbar. Then, you can fill the fields:
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Expressions ID Expression Result type

The univoque ID associated to *  YoucanusePLC Result type of all expressions
the expressions, you can not variables, target should be always BOOL.

use special characters. This is variables, global

the ID that would be indicated variables. You can use

in the page controls visibility/ simple variables,

selectable field. elements of array or

structure field.

»  Define your expression in
ST code, do not enter “="
at the beginning or “;” at
the end of the
expression.

Expression code should be
something like this:

« TRUE
e sysTimer > 10000
¢ sysAlarm=TRUE

e (conND[0] ORCONDI[1])
AND s.RUN

You can use expressions to set the visibility property of static, edit box, image,
animation, button, check box, and progress bar controls.

You can use expressions to set the Selectable property of a static, edit box, and
check box controls.

In HMI Properties window, click Visible or Selectable field of the control. Then,

open the Property definition window by clicking -+ button. In Value selection
area, select Expression box and the list of the defined expressions appears.

From the Expression Selection area, double-click the defined expression you
want to associate to the control. Property field assume the value: EXPR:
yourExpressionID.

You can also use expression for visibility and selectable properties of a set. From
a set definition grid, click the set item you want to modify. Then, in the Visible

field, click the = button and apply the method previously described.
The defined expressions are evaluated:
+ After the execution of the GlobalOnTimer page event (if specified),
» Before the execution of the OnTimer page event (if specified),
+ Before the refresh of the controls of the page.

Page and Object Properties

Frame Set
Properties
Properties Available values Description
TopDim 20 Top-height of the frame (#pixel).
BottomDim 20 Bottom-height of the frame (#pixel).
LeftDim 20 Left-width of the frame (#pixel).
RightDim 20 Right-width of the frame (#pixel).
CharDimX 20 Horizontal space among grid points (#pixel).
CharDimY 20 Vertical space among grid points (#pixel).
Font Name found in Resources Default font used when inserting new objects in page.

Background Color

Background color selectable from palette. In addition this color
is also set when inserting new objects in the frame.
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Properties Available values Description
Text Color Foreground color selectable from palette. This color is set
when inserting new objects in the frame.
Title bar Yes, No Title bar, settings can be found in System options dialog:
* Yes: page has title,
* No: page has not title.
Page Border Yes, No * Yes: page with outer border,

* No: page without outer border.

Caption

Text otherwise Resource ID

Text on title bar or Resource ID. This property is not sensible if
Title Bar field is set to No.

System menu

Yes, No

If Yes denotes that there is a button with ‘X’ image on it and
the behaviour is similar to Windows Dialog:

* Yes: page has close button,
* No: page has not close button.

Appearance Flat, Raised, Sunken *« Flat
* Raised
» Sunken
Child Page
Properties
Properties Available values Description
CharDimX 20 Horizontal space among grid points (#pixel).
CharDimY 20 Vertical space among grid points (#pixel).
Font Name found inResources Default font used when inserting new objects in page.

Background Color

Background color selectable from palette. In addition this color
is also set when inserting new objects in the frame.

Text Color Foreground color selectable from palette. This color is set
when inserting new objects in the frame.
Title bar Yes, No Title bar, settings can be found in System options dialog:
* Yes: page has title,
* No: page has not title.
Page Border Yes, No * Yes: page with outer border,

* No: page without outer border.

Caption

Text otherwise Resource ID

Text on title bar or Resource ID. This property is not sensible if
Title Bar field is set to No.

System menu

Yes, No

If Yes denotes that there is a button with ‘X’ image on it and
the behavior is similar to Windows Dialog:

* Yes: page has close button,
* No: page has not close button.

Appearance Flat, Raised, Sunken *  Flat
* Raised
+ Sunken
Events
Events Description
OnLoad On loading this page, i.e. when calling from parent page.
OnUnload On closing this page, when the page returns and the parent page is restored.

OnDeactivate

On calling a child page and the current page is no more active. This event does not exist in main page.
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Events Description

OnActivate When the previous opened child page is closed. This event does not appear in leaf page, that is, in the
pages which do not call child pages.

OnDraw When the page starts drawing all the objects. The page has just drawn border, background, and title.

OnTimer Asynchronous event. You can link a procedure which is executed cyclically.

Pop-Up Page

Properties
Properties Available values Description
XPos 20 Top-left ‘x coordinate’ edge of full page.
YPos 20 Top-left ‘y coordinate’ edge of full page.
XDim >0 Width of the page (#pixel).
YDim >0 Height of the page (#pixel).
CharDimX >0 Horizontal space among grid points (#pixel).
CharDimY >0 Vertical space among grid points (#pixel).
Modal Yes, No * Yes: the parent page objects are disabled,
« No: all the parent page objects are enabled if they are
completely visible.
Font Name found in Resources Default font used when inserting new objects in page.

Background Color

Background color selectable from palette. In addition this color
is also set when inserting new objects in the frame.

Text Color Foreground color selectable from palette. This color is set
when inserting new objects in the frame.
Title bar Yes, No Title bar, the settings can be found in System options dialog:

* Yes: page has title,
* No: page has not title.

Page Border

Yes, No * Yes: page with outer border,
* No: page without outer border.

Caption

Text otherwise Resource ID Text on title bar or Resource ID. This property is not sensible if

the Title Bar field is set to No.

System menu

Yes, No If Yes denotes that there is a button with X image on it and the
behaviour is similar to Windows Dialog:

* Yes: page has close button;
* No: page has not close button.

Appearance Yes, No *  Flat
» Raised
* Sunken
Events
Events Description
OnLoad On loading this page, i.e. when calling from parent page.
OnUnload On closing this page, when the page returns and the parent page is restored.

OnDeactivate

On calling a child page and the current page is no more active. This event does not exist in main page.

OnActivate When the previous opened child page is closed. This event does not appear in leaf page, that is, in the
pages which do not call child pages.

OnDraw When the page starts drawing all the objects. The page has just drawn border, background, and title.

OnTimer Asynchronous event. You can link a procedure which is executed cyclically.
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Static

Properties
Properties Available values Description
XPos 20 Top-left 'x coordinate' edge relative to page.
YPos 20 Top-left 'y coordinate' edge relative to page.
Name Not empty Name of object.
Text Text otherwise Resource ID Text or Resource ID shown in the object.
Font Name found in Resources Font used for drawing the text in object.

Background Color

Background color selectable from palette.

Text Color

Text color selectable from palette.

Sel. Background

Background color selectable from palette when the object is
chosen. This property is not available if the Select field is
constant FALSE.

Sel. Foreground

Text color selectable from palette when the object is chosen.
This property is not available if the Select field is constant
FALSE.

Appearance Flat, Raised, Sunken « Flat

* Raised

* Sunken

Border points 20 Border thickness (#pixel). This property is available only if
Appearance is set to Flat.

Border color Border color selectable from palette. This property is available
only if Appearance is set to Flat.

Number of Chars 20 Number of chars that this object can show. If the value is 0 the
object shows the complete text. Otherwise with another value
it can be truncated or extended.

Alignment Right, Center, Left Text alignment in the object.

Refresh TRUE, FALSE Continuous redraw of the object:

* FALSE: the Text value is read from memory and
updated only when opening the page or when a child
page is closed,

* TRUE: the Text value is read from memory and always
updated.

Select TRUE, FALSE, var_name Selected status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name: if var_
name is TRUE the object is selected and so it shows the
colors Select Back, Select Fore.

Visible TRUE, FALSE, var_name Visible status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name: if var_
name is TRUE the object is visible, otherwise it is hidden.

Events

Events Description

BeforeUpdate Before the object is redrawn.

AfterUpdate Immediately after the object is redrawn.
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Line
Properties
Properties Available values Description
XPos 20 Top-left 'x coordinate’ edge relative to page.
YPos >0 Top-left 'y coordinate’ edge relative to page.
X2Pos >0 Bottom-right 'x coordinate' edge relative to page.
Y2Pos >0 Bottom-right 'y coordinate' edge relative to page.
Name Not empty Name of object.
Thickness pts >0 Line thickness (#pixel).
Border col Line color selectable from palette.
Rectangle
Properties
Properties Available values Description
XPos 20 Top-left 'x coordinate' edge relative to page.
YPos >0 Top-left 'y coordinate’ edge relative to page.
XDim >0 Width (#pixel).
YDim >0 Height (#pixel).
Name Not empty Name of object.
Border points >0 Border thickness (#pixel).
Border color Border color selectable from palette.
Background Color Background color selectable from palette. This property is
available only if Transparent is set to TRUE.
Transparent TRUE, FALSE Transparency:
* TRUE: transparent background,
*  FALSE: solid background where color is Back Color.

Edit Box

Properties
Properties Available values Description
XPos 20 Top-left 'x coordinate’ edge relative to page.
YPos 20 Top-left''y coordinate’ edge relative to page.
Name Not empty Name of object.
Appearance Flat, Raised, Sunken » Flat: plain with use of Border pts and Border col,
* Raised
*  Sunken
Font Name found in Resources Font used for drawing the text in object.
Background Color Background color selectable from palette.
Text Color Text color selectable from palette.
Sel. Background Background color selectable from palette when the object is
chosen. This property is not available if the Selectable field is
constant FALSE.
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Properties

Available values

Description

Sel. Foreground

Text color selectable from palette when the object is chosen.
This property is not available if the Selectable field is constant
FALSE.

Border points

Border thickness (#pixel). This property is available only if
Appearance is set to Flat.

Border color

Border color selectable from palette. This property is available
only if Appearance is set to Flat.

Number of Chars

>0

Chars visible in the object. Width of entire object is calculated
among this value and the size of Font. If NumChar are less
than the value, the object shows this error string: #####.

Format

String as printf or enum_name

The format can be numeric, to define as printf of C language
(refer to Format Specification - Printf, page 367), numerative, if
in this field there is enum_name defined in Resources (refer
to Resources, page 377).

Alignment

Right, Center, Left

Text alignment in the object.

Access

RO, RW

Accesses variable Assoc var used in object:
* RO =read only,
* RW =read/write.

Selection Order

Selection order of the object. It can be selected by pressing a
key or by means of a procedure. In this case the selection
moves from the current object to the previous or next Sel.
Order object.

Variable

Not empty

Name of the variable that can be shown and edited with this
object. It can be any variable of the project, (local, global,
imported from PLC or target - refer to Edit Box and Display
Variable Association, page 352), a parameter (refer toEdit Box
and Display Variable Association, page 352) or an element of
a set (refer to Multiple Pages Management, page 341).

Data type

UNDEF, BOOL, SINT, USINT, BYTE,
INT, UINT, WORD, DINT, UDINT,
DWORD, REAL, STRING

Type of Assoc var. If it is a variable, the type is defined
automatically. This property is available if Assoc var is an
explicit parameter.

Low limit

CONSTANT, var_name

Name of variable or numeric constant. This is the least number
that the object can show. It can be any variable of the project,
(local, global, imported from PLC or target - refer to Edit Box
and Display Variable Association, page 352). This object

symbol means that there is no low limit.

High limit

CONSTANT, var_name

Name of the variable or numeric constant. This is the
maximum number that the object can show. It can be any
variable of the project, (local, global, imported from PLC or
target - refer to Edit Box and Display Variable Association,

does not hold. The * symbol means that there is no high limit.

Refresh

TRUE, FALSE

Enables continuous update of the value:FALSE: the Assoc
var value is read from memory and updated only when open
page or when a child page is closed, TRUE: the Assoc var
value is read from memory and always updated.

Visible

TRUE, FALSE, var_name

Visible status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name: if var_
name is TRUE the object is visible, otherwise hidden.

Selectable

TRUE, FALSE, var_name

Selected status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name: if var_
name is TRUE the object is selected and so it shows the
colors Select Back, Select Fore. If this field is FALSE the
Access property is not available.

Label

If the target has a touchscreen display, shows keyboard and
has this feature enabled.

Events

Events

Description

BeforeUpdate

Before the object is redrawn.

AfterUpdate

Immediately after the object is redrawn.
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Events Description
OnGotFocus Whenever object is selected.
OnLostFocus Whenever object loses the selection.
OnEnter Whenever the object is selected and receives the command for entering in edit-mode.
OnClick Touchsreen system: Whenever HMI receives a pressure on the object.
Other devices: Whenever an object enters the editing mode using the local keyboard.
OnChange Touchsreen system: Whenever you confirm the modifications and the value is different from start.

Other devices: Whenever an object exits the editing mode, even if its value remains unchanged.

Format Specification - Printf

Functions and Values

If the object has not any enumerative format, the format string is composed as
follows:

%[flags][width][.precision]type

The field has one or more characters, that describe the specification. The simplest
format contains only percentage symbol and one char as type (for example: %s).

Next table explains in details functions and values.

Field Available values Description
flags * + prints always the sign, even if This char is an option for chars order, print sign, number of
the number is positive. decimal digit. This field may have more than one flag.
* 0 prints zeros in head until width
(if specified) or NumChar.
width >0, <NumChar Maximum chars can be printed. Allows to view values that do
not fill NumChar fully.
precision 20 Decimal digits after the point. If the field is an integer and there
is a precision the object shows a decimal point. E.g. the value
is 102 integer, and precision is 2, with %.2d, the number is
shown as 1.02
type *  %d: Integer with sign. Mandatory field.
*  %f: Real.
*  %x: Hexadecimal with lowercase
chars.
*  %x: Hexadecimal with uppercase
chars.
*  %s: String.
*  %@sdf: Password.
*  [%d,u,f,x]: Custom measure unit
format.
Image
Properties
Properties Available values Description
XPos const 2 0, variable Top-left ‘x coordinate’ edge relative to page. It is possible to
assign a variable only if Style is set to Floating.
YPos const 20, variable Top-left ‘y coordinate’ edge relative to page. It is possible to
assign a variable only if Style is set to Floating.
XDim >0 Width (#pixel).
YDim >0 Height (#pixel).
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Properties Available values Description
Name Not empty Name of object.
Appearence Flat, Raised, Sunken * Flat: plain with use of Border pts and Border col,

* Raised,
* Sunken.

Border points

Border thickness (#pixel). This property is available only if
Appearance is set to Flat.

Border color

Border color selectable from palette. This property is available
only if Appearance is set to Flat.

Bitmap

Name found in Resources

Bitmap used for drawing the image in object.

Background image

Image object in the page

Name of another object that is redrawn when Style is set to
Floating. It is available only if it is overlapped with this image.

Visible TRUE, FALSE, var_name Visible status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name: if var_
name is TRUE the object is visible, otherwise it is hidden.

Style Docking, Floating » Docking: fixed position,

* Floating: variable position, according to XPos variable
and Ypos variable.
Animation
Properties

Properties Available values Description

XPos 20 Top-left 'x coordinate' edge relative to page.

YPos 20 Top-left 'y coordinate' edge relative to page.

XDim >0 Width (#pixel).

YDim >0 Height (#pixel).

Name Not empty Name of object.

Appearance Flat, Raised, Sunken * Flat: plain with use of Border pts and Border col,

* Raised,
* Sunken.

Border points

Border thickness (#pixel). This property is available only if
Appearance is set to Flat.

Border color

Border color selectable from palette. This property is available
only if Appearance is set to Flat.

Image list

Name found in Resources

It contains the images that the object can view and the value
range.

Animation variable

var_name

Name of the variable that is compared with value range in
Image list.

Data type SINT, USINT, BYTE, INT, UINT, WORD, | Type of Animation var. If it is a variable, the type is
DINT, UDINT, DWORD automatically defined.
Visible TRUE, FALSE, var_name Visible status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name: if var_
name is TRUE the object is visible, otherwise hidden.
Events
Events Description
BeforeUpdate Before the object is redrawn.
AfterUpdate Immediately after the object is redrawn.
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Button

Properties
Properties Available values Description
XPos 20 Top-left 'x coordinate’ edge relative to page.
YPos >0 Top-left 'y coordinate’ edge relative to page.
XDim >0 Width (#pixel).
YDim >0 Height (#pixel).
Name Not empty Name of object.
Text/Img Empty or explicit text or Resource ID or Text or image to view in the button:

Bitmap

« string,
* Resource ID,
*  bitmap.

Selection Text/Img

Empty or explicit text or Resource ID or
Bitmap

Text or image to view in the button when it is selected:

» string,
* Resource ID,
e bitmap.
Font Name found in Resources Font used for drawing the text in object. This field is not
available if it shows a bitmap.
Appearance Flat, Raised, Sunken »  Flat: plain with use of Border pts and Border col,
* Raised,
* Sunken.
Border points 20 Border thickness (#pixel). This property is available only if
Appearance is set to Flat.
Border color Border color selectable from palette. This property is available
only if Appearance is set to Flat or Text is not empty.
Background color Background color selectable from palette. This property is
available only if Transparent is set to TRUE.
Selection border Border color when the object is selected. This property is not
available if Selection var is FALSE fixed.
Sel. background Background color when the object is selected. This property is
not available if Selection var is FALSE fixed.
Selection order 20 Selection order on which the object can be selected with the

pressure of a key or with a procedure. In this case the
selection moves from the current object to the previous or next
Sel. Order object.

Visible TRUE, FALSE, var_name Visible status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name: if var_
name is TRUE the object is visible, otherwise it is hidden.

Transparent TRUE, FALSE, var_name Transparency. It can be constant (TRUE or FALSE) or linked

with a boolean variable var_name: if var_name is TRUE the
object is transparent.

Press variable

Empty or var_name

When the button is pressed var_name is set to TRUE. When
the button is not pressed, var_name is set to FALSE.

Selection variable

TRUE, FALSE, var_name

Selected status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name. If var_
name is TRUE the object is selected and so it shows the
colors Select Back, SelectBord. If this field is FALSE,
SelectBordand Select Back properties are not available.

Action Call, OpenPage, Close, NextField, Action executed on button pressure.
PrevField, Edit
Action par page_name proc_name Parameter associated with the action executed on button
pressure. It is available only if Action is OpenPage (Action
par = name of the page to open) or Call (Action par = name
of the procedure to execute).
Alignment Right, Center, Left Text alignment in the object.
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Events
Events Description
OnClick Whenever HMI receives a pressure on the object, valid only for touchscreen systems.
OnRelease Whenever HMI releases the pressure on the object, valid only for touchscreen systems.

Progress Bar

Properties
Properties Available values Description
XPos 20 Top-left 'x coordinate' edge relative to page.
YPos 20 Top-left 'y coordinate' edge relative to page.
XDim >0 Width (#pixel).
YDim >0 Height (#pixel).
Name Not empty Name of object.
Appearance Flat, Raised, Sunken » Flat: plain with use of Border pts and Border col,

* Raised,
* Sunken.

Border points

Border thickness (#pixel). This property is available only if
Appearance is set to Flat.

Border color

Border color selectable from palette. This property is available
only if Appearance is set to Flat or Text is not empty.

Bar color

Color of step bar, selectable from palette.

Background color

Background color selectable from palette.

Visible TRUE, FALSE, var_name Visible status of the object. It can be constant (TRUE or
FALSE) or linked with a boolean variable var_name: if var_
name is TRUE the object is visible, otherwise it is hidden.

Refresh trigger TRUE, FALSE, var_name Object redraw:

* FALSE: the Progress var value is read from memory
and updated only when opening page or when a child
page is closed.

* TRUE: the Progress var value is read from memory and
always updated.

« var_name: the Progress var value is read from memory
and updated only when the variable becomes TRUE.
After the update the runtime sets it to FALSE.

Progress variable

Not empty

Step variable. This is the filling percentage of bar in relation
with the range assigned by Lo limit and Hi limit. It can be any
string variable of the project (local, global, imported from PLC
or target) or a parameter (Edit Box and Display Variable
Association, page 352).

Data type UNDEF, BOOL, SINT, USINT, BYTE, Type of Progress var. If it is a variable, the type is
INT, UINT, WORD, DINT, UDINT, automatically defined. This property is available if Progress
DWORD, LWORD, REAL, LREAL, var is an explicit parameter.
STRING

Low limit Constant or var_name Name of the variable or numeric constant. This is the least
value for step bar. It can be any variable of the project, (local,
global, imported from PLC or target) with type specified by
Data type.

High limit Constant or var_name Name of the variable or numeric constant. This is the
maximum value for step bar. It can be any variable of the
project, (local, global, imported from PLC or target) with type
specified by Data type.

Orientation Horizontal, vertical Direction of step bar.
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Events
Events Description
BeforeUpdate Before the object is redrawn.
AfterUpdate Immediately after the object is redrawn.

Declaration of Variables

Types of Variables

Overview

Local Variables

Global Variables

System Variables

In a Display project, there are four different classes of variables.

Local variables are accessible via the page from which they were declared.

They are listed in the project tree, under the Local variables folder. Local
variables can be used to carry out operations on PLC (for example to apply a
different scale or to add an offset) or system variables, or to implement local
procedures.

Global variables are declared in Display and they are accessible from every page
of the project. Global variables are listed in the Global variables folder in the
project tree. The function of the global variables is similar to the one of the local
variable but the different visibility scope makes them unusable for the
implementation of global procedures or for the parameters passing between
distinct pages.

The interaction between Display and target is enabled by system variables which
the software publishes outside in a *.tgt file.

You may access system variables in read/write or in read-only mode. If you try to
access a read-only variable in write mode, an error occurs during compilation.

Data Management

Overview

It is possible to distinguish the data in local variables (visible in the page scope
only) and global variables (visible from every page). For some controls it is
possible to use parameters and sets.

Declaring a Local Variable

Declare a local variable, which you can use just in the specific page where the
declaration takes place.
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In the pages tree, under the Init page item, double-click the Local variables item.
The local variables editor window opens. It is blank at present.
Click New record icon in the HMI Project toolbar.

A dialog window opens requesting to specify the basic features of the new

variable. For example, you can declare “n” as a new 16 bit unsigned integer
variable.

Variable X

Type | UINT e
Array D

Attribute

I

Confirm the operation by clicking OK button. The new corresponding record is
added to the variables editor window.

You can change the features of this new variable by editing the fields of the record
which you have just created. For example, you may assign an initial value different
from null and a comment.

When you save the project by clicking the apposite button or when you close the
variables editor, Display adds a new item in the pages tree. It corresponds to the
local variable which you have just declared.

Declaring a Global Variable

Let us assume that you want to declare a floating point global variable “t™: right-
click on the Variables item under the Global variables node of the resources tree
and select the Open command in the contextual menu which appears.

Follow the steps as shown in Declaring a Local Variable, page 371, until the new
global variable appears as a new item in the pages tree.

Inserting Field Parameters

Target system usually has internal variables and is connected on a fieldbus, so it
needs to show some variables of the different devices which are connected on the
net.

For this reason, Display allows you to link a specific file which contains the
variables definition on the bus. Click the Parameters management icon in HMI
Profile toolbar.

The parameters management window appears.

Parameters management X

ID ‘ Name ‘ DB address mode ‘ Device protocol ‘ Network address ‘ Add Device ‘

Remove Device ‘

Close
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Through the Add Device button you can add a new object linked to the target on
the fieldbus.

The selection window appears. Then you have to take from your PC a *.parx file
(for more information, refer to Description of Parameter File, page 373).

A device called "Frigo” has been inserted. In order to see the relevant parameters,
click the Close button.

Parameters management X

ID Name DB address mode Device protocol Network address Add Device

1 Figo Modbus - I - B

Remove Device

Close

In HMI Vars and Parameters window, you can see the device and its parameters.

When you need to update the list of parameters, if the *.parx file has not been
moved to another directory, it is not necessary to repeat the above mentioned
procedure, but it is enough to press the button.

Description of Parameter File

Overview

As described in Inserting Field Parameters, page 372, it is possible to link in
Display some variables from external device.

In some objects you can define an explicit or implicit syntax in order to use the
parameter mode.

To use the implicit syntax, @Device.Parameter, Display requires a *.parx file in
XML format.

For example:

<parameters>
<par ipa=”10100” name="Par TAB” descr="Tab (map code)” defval="0" min=
70” max="65535" um="num” typetarg="unsignedShort” typepar=
"unsignedShort">
<protocol name="Modbus” commaddr="15716" commsubindex="0"/>
<protocol name="CanOpen” commaddr="15716" commsubindex="0"/>
</par>
<par ipa=”10001" name="Gain Ntc AI2” descr="NTC calibration gain AI2”
defval="32768" min="0" max="65535" um="num” typetarg="unsignedShort”
typepar="unsignedShort">
<protocol name="Modbus” commaddr="15617" commsubindex="0"/>
<protocol name="CanOpen” commaddr="15617" commsubindex="0"/>
</par>
<par ipa=”11308" readonly="false” name="Modem InitStrl” defval=""
descr="InitString (lst part)” typetarg="string” strsize="19">
<protocol name="Modbus” commaddr="15821" commsubindex="0"/>
<protocol name="CanOpen” commaddr="15821" commsubindex="0"/>
</par>
</parameters>

Where each parameter has these fields:

* ipa: parameter index used as input value of Video SetParam(), Video
GetParam (). If there are nodes with protocol type, they have more priority
than ipa, so Display uses them.

* Name: parameter name.
* descr: complete description of parameter.
* defval: default value of parameter.
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min: minimum value of parameter.
max: maximum value of parameter.
um: measure unit of parameter.

typetarg: type of parameter read as “In
with the translation in PLC are:

o char: SINT,

o unsignedChar: USINT,
o short: INT,

° unsignedShort: UINT,
o int: DINT,

unsignedInt: UDINT,
boolean: BOOL,
digitalInput: BOOL,
digitalOutput: BOOL,
float: REAL,

double: REAL,

string: STRING.

o

o

slaves should be the same as typetarg
translation in PLC are:

o char: SINT,

° unsignedChar: USINT,
o short: INT,

° unsignedShort: UINT,
o int: DINT,

unsignedInt: UDINT,
boolean: BOOL,
digitalInput: BOOL,
digitalOutput: BOOL,
float: REAL,

double: REAL,

string: STRING.

o
o

o

Using Advanced Features

Events

Overview

There are different classes of events.

Page or Control Events

staller type”. The available values

typepar: type of parameter read as “IEC type”. In case of generic modbus

. The available values with the

strsize: number of character if it is a string type.

Each characteristic behavior of a specific object can raise a specific event.

Each event can be associated to a procedure

Procedures that Can Be Associated

to Events, page 375 that is executed each time the event takes place. The list of

374
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all available events for each Display object (page or control) is reported in Page
and Object Properties, page 361.

Key Pressure Events

These events take place when a key is pressed, the raising of the event starts the
execution of the associated action (refer to Actions that Can Be Associated to Key
Pressure, page 376) ifitis. The pressure of a key can be also simulated by
software.

Events Raised by Software

Programmer can raise events by software using the function video SendEvent
inside the target software or in the body of the procedure, using following syntax:

Video SendEvent (event id, param),

Where event idis the identifier of the type of the event and param is an integer
16 bit parameter.

Display supports software events defined in this table:

Event Parameter Description
kWM NULL Do not care No event.
kWM _KEY Key code Simulates the pressure of the

key specified as parameter
then cause the associated
action if it is.

kWM MSG Window ID Causes a system message
that, once got by the system,
causes the instant opening of
the alarm page that has
Window ID as identifier.

kWM SELECT Edit box handle In touchscreen systems
simulates the pressure on the
edit box whose handle is
passed as parameter, causing
its selection or its transition to
edit mode.

kWM _PUSH Button handle In touchscreen systems
simulates the pressure on the
button whose handle is passed
as parameter, causing the
execution of the associated
action if it is.

kEV_WM CHANGESETPAGE Page number Shows the page specified by
the parameter (if the context is
a page in which sets are used).

Procedures that Can Be Associated to Events

A procedure is a program that is executed when the event that has been
associated to it, takes place.

There are two classes of procedures:

» Local procedures: This kind of procedures can be called only within the scope
of the page in which are declared. In particular, they can be associated to the
events of the page itself and of all their controls. The same can be said for
software events raised when the page they refer to is active. Procedure code
can contains references to all the types of variables, with local variables of the
page too.

» Global procedures: This kind of procedures can be called from every page
and can be also used as periodic asynchronous routine of alarm
management. They can not contain variables references.
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Here follow the description of the syntax to get the properties of a control from a
procedure; similarly to C language printf it is:

“fb%s%s.%s”, page name, ctrl name, prop name
Where:
* page_ name is the name of the page that has the control,
* ctrl name is the name of the control,
* prop_ name is the name of the property of the control.

So if you want to get the property Foreground color of the Static named
String 26 inMain page, we have to write:fbMainString 26.foreCol.

NOTE: The name of the property to use in the scripts of the procedures is the
name of the functional block exported by the software of the target, not the
name in the properties window, page 320.

Actions that Can Be Associated to Key Pressure

In common keyboard, not touchscreen systems, interaction between you and the
system is normally based on keys pressure.

The HMI Actions window allows you to associate a code of a key to one of the
actions listed in the table. In this way the pressure of that key causes the specified
action.

HMI Actions
O

Local actions Global actions

Key Action Link
Down _ical NextPageSet1
VK_F1 OpenPage MenuL1_Settings2
VK_F4 NextField
VK_F3 PrecField
Up Call PrevPageSet1

The table of the HMI Actions window is composed like this:

Event Link Description

Call Procedure name Causes the invocation of the
local or global procedure
whose name is indicated in the
Link field.

OpenPage Page name Causes the opening of the
page whose name is indicated
in the Link field.

Close Do not care Causes the closure of the
current page

NextField Do not care Move the selection to the next
edit box. If the system is not
touchscreen moves selection
to the buttons to allow their
pressure.

PrevField Do not care Move the selection to the
previous edit box.

Edit Do not care Access edit mode for the
selected edit box. If the system
is not touchscreen allows you
to simulate the pressure of the
button.

There are two types of associations key-action:

376
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Resources

Overview

Fonts

Bitmaps

» Local actions: local associations, valid only for the page currently open in the
editor of the pages.

* Global actions: global associations, valid in any point of the project.

If the system has the touchscreen feature, normal interaction with you is made by
the pressure of sensible area on the screen. However this table does not loss its
meaning because allows you to define virtual keys and to control their pressure by
software causing in this way the dynamic execution of specific actions.

NOTE: If the same action is defined both at local and at global level, system
does not give errors nor warnings because local declaration precedes global
one.

A resource is an interface element. You can get informations from resources or
can use them to do actions.

Display supports different categories of resources that are managed by
Resources item in HMI Project window, page 320.

Fonts are the different kinds of characters supported for the output of text strings
on the screen. Fonts had been managed by EcoStruxure Machine Expert - HVAC
old versions as text files with *.plf extension and structured with the same syntax
of the initialization definition of an array variable in IEC. Now, images are saved
and loaded in binary format to optimize loading time on images of big size.

At project opening time, if EcoStruxure Machine Expert - HVAC finds this
declaration, it searches in project folder for a file named “font_name.plk” and loads
it in memory.

Bitmaps are pictures to associate to image controls, page 346. The images are
saved and loaded in binary format to optimize loading time on images of big size.

At project opening time, if Display finds this declaration, it searches in project
folder for a file named “bitmap_name.plk” and loads it in memory.
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Strings Table

Display provides a tool to convert bitmaps from Windows format to Display
format. To start it, right-click Bitmaps item of Resources in HMI Project window
and click Import bitmap... command.

Import bitmap into project X

Source bitmap Converted bitmap

Browse H: 0w 0 Transparency color:
Bmp Name R: n/a G: nla B: nla Cancel
Reset Transp. Import

Click Browse button to navigate in computer resources and select the desired
source file.

In Bmp Name field, you can personalize bitmap name that is shown on resource
tree. Bitmap name is constituted by file name without extension and with “Bmp”
prefix by default.

Transparency color field allows you to specify transparency color. So a color that
is not really drawn on the screen but a transparent color zone that does not cover
elements previously drawn.

Transparency color can be personalized by choosing it by mouse from Converted
bitmap window.

RGB indicates transparency color Red, Green, Blue components. n/a value
indicates that no transparency color has been selected.

Reset Transp. button allows you to undo last selected transparency color.

Once finished these operations it is possible to confirm bitmap importation by
clicking Import button.

It is possible to explicitly write the text to show on a text string or on a title of the
page. Itis also possible to refer to one of the strings of the resources specifying its
ID. For more information, refer to Language Selection, page 339.

In first case, text is always the same. In second case, the text that correspond to
the active language is shown.

So, English language string table contains the following record.

If you refer to the identifier ID_GDB RXNAK from a page control or from a page:
+ If current active language is English, “Bad RX packets” is shown.

» If current active language is French, “Paquets RX défectueux” is shown
instead.

378
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Enumeratives

Image Lists

Sets

An enumerative is a data type defined by you, it is a set of constants that you
named. Each element of an enumerative is treated as a constant and can be
translated in the available languages of the project.

For example: create an enumerative called “SettingsTouch”.
Enumerative records are shown by double-clicking SettingsTouch node.

Then, introduce an edit box control, page 349 and insert the name of the
enumerative “SettingsTouch” in its Formatproperty in HMI Properties window.
Control shows the string associated to the value as it is in the table above, not the
numeric value of the variable associated to the control.

If the numeric value of the variable does not match with any record of the
enumerative table, an error string ###H#HHHHE is shown instead.

Even enumerative are supported by multi-language feature. It is possible to
personalize the name and the record values of the enumerative.

Value Description
0 Awaiting settings ...
Saving settings ...
2 Touch screen set up

An images list is very similar to an enumerative but with the following differences:
* Intervals of constants are supported (not only simple values),
+ Each value has an image associated,

+ Alist of images determines the content shown by an animation control, while
an enumerative can be associated to an edit box.

For example: if you have an images list “ListBulbs” that is shown under
Resources.

It is possible to see all the records of the list by double-clicking the node.

HMI Project B x Init value End Value Bitmap
B =7 Enumeratives Al f1 1 BmpBulbOn
S Expressions 2 2 BmpBulbOn2

‘J ion: styles 3 3 BmpBulbOn3
/4 ronts

+]

o @ Image lists

Sets =
String table

(5 ¥

v

Introduce an animation control, page 348 in the page, and select “ListBulbs” in
Image list property in HMI Properties window. The control shows the image
whose specified interval includes the value of a variable associated to the control.

If the numeric value of the associated variable does not match any record in the
list, a default image (with init and end value set to *) is shown if itis. If no default
image is specified, no image is drawn.

Sets are ensemble of global variable even of distinct type.

In particular there are two types of set:
+ \Variable/parameter sets even of not equal type (VARIANT),
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Strings sets (STRINGS).

The sets of the first type are defined indicating VARIANT as type. This kind of set
has the following attributes:

Dynamic: indicates that every n execution cycles target automatically reloads
the elements of the set and hides those elements that have no visibility
(boolean constant FALSE or associated visibility variable set to false at that
moment).

Array: indicates that the unique element of this set is a variable of type array.
NOTE: This kind of set can be assigned only to an edit-box control.

Once defined a set, each element of the set can be added via drag and drop from
HMI Vars and Parameters window or can be manually inserted by you.

The VARIANT type is used to define the following attributes:

Variable/Parameter: variable/parameter name.

Format: indicates how to show associated variable value specifying a syntax
analogous to C language printf (for more information, refer to Child Page,
page 362).

Text Align: the alignment of the text to show.
Min/Max: minimum and maximum value for the element of the set.

Visible: boolean variable or constant that defines the visibility of the element.
If dynamic feature of the set is active, the variable is periodically checked to
hide or show the element.

Selectable: indicates that the element can be selected. In this case, a
boolean variable or constant can be assigned too.

For a set of type STRING, you have to define only two attributes, the string or the
ID of a string resource, page 378 and the variable/constant of visibility. An element
not visible is not shown on the screen.

NOTE: This kind of set can be used with static control only.
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File for Target Description

Overview

The files contain some definitions of target environment. Display uses this
information for generating custom code.

The *.def file consists of two sections. It is allowed comment, that starts with a
semicolon (;).

This file is included in *.pajx file.

Target Properties

Description

This section consist of five records, which support one or more parameters. Each
record is on new line and the elements must be separated with spaces or tabs.

Record Structure

Header Param. 1 Param. Description
2
SCREEN dimX dimY Screen dimension of target measured in pixel:
«  DimX: width,

* DimY: height.

SAVESCREEN 0/1 — Target board can save and restore video
memory:

*« 0:nosave,
* 1:save and restore.

TOUCHSCREE- | 0/1 — Target board has touchscreen can use the
N pressure events:

¢ 0:notouchscreen;
* 1:exists touchscreen.

REFRESH msec — Refresh time of all objects in page, measured in
milliseconds.

FONT_ “HH"/*VH” — Font encoding.

FORMAT

ColorSET “RGB” —

BMP_FORMAT | “SIMULAB” — Image encoding.

UNICODE 01 — Target board has support for Unicode fonts.

JOYPAD 0 — Target board has a joypad that can be used for

moving among elements of page and can be
connected to actions.

INIT 01 — If set to 1 says that HMI run-time has video
InitHMI (), invoked on target start-up.
Typically it is used for custom commands on
start-up.

BMPFULL 01 — If set to 1 generates PLC code extended for
bitmap instead binary bitmap.
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Object Version

The graphical objects (edit box, text box, static, bitmap, and so on) can have a
version, or can not exist. The syntax is:

CTRL “Name” “Version”

Where:
* Name: name of graphical object. Example: Editbox;
* Version: version of HMI run-time objects.
If this value is set to -1, Display does not make available this object.

System Enumeratives

Enumeratives of *.def file are maps for binding among numeric values and strings,
or other numeric values.

Each enumerative has an identifier, that specifies a function in the map with this
syntax:

ENUM iden keyen val

Where:
» id: enumerative identifier,
* en key: value-key of record (must be a number),
* en_val: value of value-key (can be a number or string).

Descriptions

This paragraph describes the values for system enumeratives.
*  Enumerative 100

With this key you can define new buttons (the names are shown in the Key
field of actions table in HMI Actions window (refer toActions that Can Be
Associated to Key Pressure, page 376).

The number of lines is not limited. But you must define at least the elements of
102 enumerative.

+ 1d: 100,

* en_ key: key encoding (one byte),
e en_val: string with key name.

* Enumerative 101

With this key you can define new actions (the names are shown in Action
field of actions table in HMI Actions window (refer toActions that Can Be
Associated to Key Pressure, page 376.

+ 1d: 101,
* en_key: action identifier,
* en_val: string with action name.

This enumerative has a well defined number of lines. The following table presents
the corresponding actions:

en_key Action

0 Calls local or global procedures.

1 Opens child page.
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en_key Action
2 Closes current page.
3 Selects next object Edit Box, Button, and so on.
4 Selects previous object Edit Box, Button, and so on.
9 Enters editing-mode (Edit Box, Button).
10 Leaving (not implemented).

The string en_val is arbitrary.
* Enumerative 102
Selection and edit functions:
+ 1d: 102,
* en_key: identifier of edit function,
* en_val: string with the name of associated string.

The name of this field en_val must be the same of en _val of 100 enumerative,
so that Display associates an edit function with a key.

This enumerative has a well defined number of lines. See the actions in the table
below:

en_key Action
0 Confirms modifications and leaves editing-mode.
1 Loses modification and leaves editing-mode.
2 Deletes selected character.
3 Moves cursor left.
4 Moves cursor right.
5 Selects the previous element of an enumerative associated with an Editbox.
6 Selects the next element of an enumerative associated with an Editbox.
7 Deletes the first character on the left.
8 Inserts tab character.
9 Switching to uppercase alphanumeric characters for a single character.
10 Transition to permanent uppercase alphanumeric characters.

*  Enumerative 103
Define a color palette, the encoding is RGB:
e id: 103,
» en key:index of the color inside palette,
* en_val: RGB color encoding.

RGB encoding represents 24 bit of colors: 0x00bbggrr where bb (1 byte)
intensity of blue, gg (1 byte) the green and rr (1 byte) the red. The intensity is at
least 0 and at most Oxf£.

The number of lines is not limited. You can define which colors he wants.
*  Enumerative 104
Names of object styles (shown on Appearance in HMI Properties window):
* 1d: 104,
* en key:style,
* en val: string with the name of style.
This enumerative contains at most 3 records, supported by Display.
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Example

en_key Style

0 Flat, plane.
1 Raised.
2 Sunken.

’

; Target properties

SCREEN 128 64
SAVESCREEN 1
REFRESH 50

FONT FORMAT "VH"
JOYPAD 1

INIT1

BMPFULL 1

UNICODE 1

;Versions of controls
CTRL "Static"1

CTRL "EditBox"1
CTRL "TextBox" -1
CTRL "Button"?2

CTRL "Progress"O0
CTRL "Animation"O0
CTRL "Image" O

CTRL "CustomCtrl"-1
CTRL "Chart"-1

CTRL "Trend" -1

; Enumeratives

; ENUM 100: key codes
ENUM 10013"Enter"
ENUM 1008"Left"

ENUM 10012"Right"
ENUM 10011 "Up"

ENUM 10010"Down"
ENUM 10019"LongEnter"
ENUM 10015"LongLeft"
ENUM 10016"LongRight"
ENUM 10017"LongUp"
ENUM 10018"LongDown"
ENUM 10030"VK F1"
ENUM 10031"VK F2"
ENUM 10032"VK F3"
ENUM 10033"VK F4"
ENUM 10034"VK_F5"
ENUM 10035"VK F6"
ENUM 10036"VK F7"
ENUM 10037"VK_F8"
ENUM 10038"VK F9"
ENUM 10039"VK F10"

’

; ENUM 101: key-related actions

ENUM 1010"Call™
ENUM 1011"OpenPage"
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ENUM 1012"Close"
ENUM 1013 "NextField"
ENUM 1014 "PrevField"
ENUM 1019"Edit"

r

; ENUM 102: editing-mode keys

ENUM 1020"Enter"

ENUM 1021"LongLeft"

ENUM 1023"Left"

ENUM 1024 "Right"

ENUM 1025"Up"

ENUM 1026"Down"

; ENUM 103: color codes

; BBGGRR

ENUM 1030"0x00000000™ ; Bianco
ENUM 1031"0xOOFFFFFEF" ; Nero

’

; ENUM 104: controls appearance

ENUM 1040"Flat"
ENUM 1041"Raised"
ENUM 1042"Sunken"
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Functions and Function Blocks for HMI

What’s in This Chapter

FUNCHONS fOr HMI ... e 386
Function BIOCKS fOr HIMI .......oneie e 396

Overview

Here is the lists of the functions that HMI run-time exports to Display. You can use
them into script and procedures.

These functions are divided into several categories which are shown in details in
the following paragraphs.

Functions for HMI

System Functions: Hardware and Operating System

Video_InitHMI (dmy)

Initialization for HMI runtime

110 Name Type Description
Input dmy unsigned char Reserved. Set 0.
Output Video InitHMI unsigned char TRUE if successful, FALSE otherwise.

Video_Switch (on)

Turn on/off the display

110 Name Type Description

Input on unsigned char TRUE: turns on the display.
FALSE: turns off the display.

Output Video Switch unsigned char Not sensible (always TRUE).

Video_LCDContrast (more)

Display contrast

/10 Name Type Description

Input on unsigned char TRUE: turns on the display.

FALSE: turns off the display.

Output Video Switch unsigned char Not sensible (always TRUE).

Video_SaveRect (x1, yl, x2, y2)

Save display area to memory

110 Name Type Description
Input x1 unsigned short Top-left 'x coordinate’ edge relative to full page.
vyl unsigned short Top-left 'y coordinate’ edge relative to full page.
x2 unsigned short Bottom-down 'x coordinate' edge relative to full page.
y2 unsigned short Bottom-down 'y coordinate' edge relative to full page.
Output Video SaveRect unsigned char Not sensible (always TRUE).
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Video_WriteFromBuff (x1, yl, x2, y2)

Restore display area from memory (previously saved with Video_SaveRect).

110 Name Type Description

Input x1 unsigned short Not sensible (saved area has the original coordinates).
vyl unsigned short Not sensible (saved area has the original coordinates).
x2 unsigned short Not sensible (saved area has the original coordinates).
y2 unsigned short Not sensible (saved area has the original coordinates).

Output Video unsigned char Not sensible (always TRUE).
WriteFromBuff

Video_Lock (res)

Lock the display resources for exclusive access

110 Name Type Description
Input res unsigned char Reserved. Set 0.
Output Video Lock unsigned char Not sensible (return input parameter res).

Video_Unlock (res)

Unlock the display resource after exclusive access

110 Name Type Description
Input res unsigned char Reserved. Set 0.
Output Video Unlock unsigned char Not sensible (return input parameter res).

Video_Sleep (msec)

Suspend the task where the function is used

110 Name Type Description
Input msec unsigned short Suspends time measured in milliseconds.
Output Video Unlock unsigned short Not sensible (always TRUE).

Function for Managing Project Resources and Common
Properties

Video_SetWndSysProps (pFont, colFore, colBack)

Unlock the display resource after exclusive access

110 Name Type Description
Input pFont unsigned long Address of font for printing text in title bar (the font must be added with
Video AddFont function).
colFore unsigned long Text color of Title Bar.
colBack unsigned long Background color of Title Bar.
Output Video unsigned char Not sensible (always TRUE).
SetWndSysProps
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Video_SetEditKey (id, code)

Set key-code for editing functions

110 Name Type Description
Input id unsigned char Identifier of editing function (see. Enumerative table, page 382).
code unsigned char Key code associated with editing function.
Output Video unsigned char Not sensible (always TRUE).
SetEditKey
Video_AddFont (pFont, charLen, charHei, offs)
Publish a new font in HMI run-time
110 Name Type Description
Input pFont unsigned long Address of first byte of font.
charLen unsigned long Character width of font (#pixel).
charHei unsigned long Character height of font (#pixel).
offs unsigned long Byte offset of a font that starts with ASCII 0x00 (subset of characters).
Output Video AddFont unsigned char TRUE if successful, FALSE otherwise.

Video_AddFontUnicode (pFont, charLen, charHei)

Publish a new unicode font in HMI run-time

110 Name Type Description

Input pFont unsigned long Address of first byte of font.
charLen unsigned long Character width of font (#pixel).
charHei unsigned long Character height of font (#pixel).

Output Video unsigned char TRUE if successful, FALSE otherwise.
AddFontUnicode

Video_LoadLanguage (pResStrings, pEnums)

Load strings and enumeratives of any language

110 Name Type Description

Input pResStrings unsigned long Address of first resources string for current language.
pEnums unsigned long Address of first resources string for current language.

Output Video unsigned char TRUE if successful, FALSE otherwise.
LoadLanguage

Video_ DrawFrames (left, top, right, bottom, colBack, fBar, pTitle, fResStr, £SysBtn, style)

Function for draw frame-set

/10 Name Type Description
Input left unsigned short Width of left frame (#pixel).
top unsigned short Height of top frame (#pixel).
right unsigned short Width of right frame (#pixel).
bottom unsigned short Height of bottom frame (#pixel).
colBack unsigned long Background color.
fBar unsigned char TRUE: shows title bar.
FALSE: hides title-bar.
pTitle unsigned long Text of title bar: NULL: No string in title.
fResStr unsigned char TRUE: pTitle is a resource string.
FALSE: pTitle is an address of constant string.
388 EIO0000003412.05



Functions and Function Blocks for HMI

Video_DrawFrames (left, top, right, bottom, colBack, fBar, pTitle, fResStr, £SysBtn, style)

Function for draw frame-set

110 Name Type Description
f£SysBtn unsigned char TRUE: shows system.
FALSE: hides system button.
style unsigned char 0: Flat
1: Raised
2: Sunken
Output Video_ unsigned char Not sensible (always TRUE).
DrawFrames

Functions for Operating with Pages

Video_InitPage (x1, yl, x2, y2, pTitle, wData)

Show a page on display

110

Name

Type

Description

Input

x1

unsigned short

Top-left ‘x coordinate’ edge relative to full page.

vl

unsigned short

Top-left ‘y coordinate’ edge relative to full page.

X2

unsigned short

Bottom-down ‘x coordinate’ edge relative to full page.

y2

unsigned short

Bottom-down ‘y coordinate’ edge relative to full page.

pTitle

unsigned long

Address of Text of title bar. NULL: no text in title bar.

wData

unsigned short

Feature declaration

bit 0...7:
*  O:flat
* 1:raised
* 2:sunken

* 0:notitle bar
* 1:shows title bar

» 0: pTitle is an address of constant string
» 1:pTitle is a resource string

*  0:no system button
* 1:shows system button

*  0: window not modal
* 1: modal window (sensible only for pop-ups windows)

Output

Video InitPage

unsigned char

Not sensible (always TRUE).

Video_SetPageColors (colFore, colBack)

Assign all colors for current page

110 Name Type Description

Input colFore unsigned long Color of the text of page.
colBack unsigned long Background color of page.

Output Video unsigned char TRUE if successful, FALSE otherwise.
SetPageColors
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Video_ClrScreen ()

Delete entire display area and fill with background color defined with Video_SetPage-Colors

110 Name Type

Description

Output Video ClrScreen | unsigned char

TRUE if successful, FALSE otherwise.

Video_ClrRect (x1, yl, x2, y2)

Delete only a portion of display and fill with background color defined with Video_Set-PageColors

110 Name Type Description
Input x1 unsigned short Top-left 'x coordinate' edge relative to full page.
vyl unsigned short Top-left 'y coordinate’ edge relative to full page.
x2 unsigned short Bottom-down 'x coordinate' edge relative to full page.
y2 unsigned short Bottom-down 'y coordinate' edge relative to full page.
Output Video ClrRect unsigned char TRUE if successful, FALSE otherwise.

Video_SetFont (fontPtr)

Load a font as current font for drawing objects. To correctly execute this function, the font must be declared with video_

AddFont

110 Name Type Description

Input fontPtr unsigned long Address of first byte of font.

Output Video SetFont unsigned char TRUE if successful, FALSE otherwise.

Video_SetColors (colForeTxt, colBackTxt, colForeSel, colBackSel)

Assign the current colors for drawing objects

110 Name Type Description
Input colForeTxt unsigned long Text color.

colBackTxt unsigned long Background color.

colForeSel unsigned long Text color for selection.

colBackSel unsigned long Background color for selection.
Output Video_SetColors | unsigned char TRUE if successful, FALSE otherwise.

Video_ResetMaps (res)

Delete the maps saved for every object. The maps are created adding an object at once, with access mode kACS_INIT

/10 Name Type

Description

Input res unsigned long

Reserved. Set 0.

Output Video ResetMaps | unsigned char

Not sensible (return input parameter res).

Function for Objects

Video_NextEdit (£RWOnly)

Enable selection for next objects identified by Sel. order attribute

/10 Name Type

Description

Input fRWONnly unsigned char

Limit for selecting the next edit-box: FALSE: next edit-box must be
selectable.

TRUE: the next edit-box must be selectable and writable.

Output Video NextEdit unsigned char

Handle of selected objects; if -1 the function has an error.
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Video_PrevEdit (fRWOnly)

Enable selection for previous objects identified by Sel. Order attribute

110 Name Type Description

Input fRWOnly unsigned char Limit for selecting the next edit-box:
* FALSE: the next edit-box must be selectable.
*  TRUE: the next edit-box must be selectable and writable.

Output Video PrevEdit unsigned char Handle of selected objects; if -1 the function has an error.

Video_EnterEdit (wHnd)

Enter edit-mode of an Edit Box otherwise execute the action for a button. The object holds the task until exits from edit-mode.

110 Name Type Description

Input wHnd unsigned short Handle of object that must be edited or execute his action.

Output Video EnterEdit | unsigned char Return pressed key code for exiting edit-mode. If return -1 is an error
only if the object is an edit-box.

Video_EnterEditSel (wHnd, onlySelect)

Select object or enter edit-mode of an Edit box otherwise execute the action for a button. The object holds the task until exit from
edit-mode.

110 Name Type Description
Input wHnd unsigned short Handle of object that must be edited or execute his action.
OnlySelect unsigned char * FALSE: asVideoEnterEdit ().

+ TRUE: enables only the selection without entering edit-mode.

Output Video unsigned char Return pressed key code for exiting edit-mode. If return -1 is an error
EnterEditSel only if the object is an edit-box.

Video_PushButton (wHnd)

Enter press-mode for buttons. The object holds the task until exit from press-mode. This function is sensible only for
touchscreen systems.

110 Name Type Description
Input wHnd unsigned short Handle of button.
Output Video unsigned char * TRUE: last pressure event was in button area.
PushButton * FALSE: last pressure event was outside button area. -1: error.

Video_FirstLastEdit (rwReq, last)

Return the handle of first or last selectable controls.

110 Name Type Description

Input rwReq unsigned char Boolean parameter. It indicates if the function checks for the objects that
have read-write access mode.

last unsigned char * TRUE: last selectable object.
» FALSE: first selectable object.

Output Video short Handle of the object; -1 if errors or do not exist selectable objects.
FirstLastEdit

Drawing Functions

Video_Line (x1, yl1, x2, y2, pts, color)

Draw a line
110 Name Type Description
Input x1 unsigned short Top-left 'x coordinate' edge relative to full page.
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Video_Line (x1, y1, x2, y2, pts, color)

Draw a line

110 Name Type Description
vyl unsigned short Top-left 'y coordinate' edge relative to full page.
%2 unsigned short Bottom-down 'x coordinate' edge relative to full page.
y2 unsigned short Bottom-down 'y coordinate' edge relative to full page.
pts unsigned char Thickness.
color unsigned color Line color.

Output Video ClrRect unsigned char TRUE if successful, FALSE otherwise.

Video Rectangle (x1, yl, x2, y2, pts, transp, bordCol, £illCol)

Draw a rectangle

1/0 Name Type Description
Input x1 unsigned short Top-left 'x coordinate' edge relative to full page.
vyl unsigned short Top-left 'y coordinate’ edge relative to full page.
x2 unsigned short Bottom-down 'x coordinate' edge relative to full page.
y2 unsigned short Bottom-down 'y coordinate' edge relative to full page.
pts unsigned char Border thickness.
transp unsigned char » TRUE: transparent square.
* FALSE: solid square.
bordCol unsigned long Border color.
fillCol unsigned long Fill color. The value is not sensible if transp is TRUE.
Output Video Rectangle unsigned char TRUE if successful, FALSE otherwise.

Video DrawBorder (style, x1, yl, x2, y2, pts, color)

Draw a border outside the rectangle area

1/0 Name Type Description

Input style unsigned char 0: flat. 1: raised. 2: sunken.
x1 unsigned short Top-left 'x coordinate' edge relative to full page.
vyl unsigned short Top-left 'y coordinate’ edge relative to full page.
x2 unsigned short Bottom-down 'x coordinate' edge relative to full page.
y2 unsigned short Bottom-down 'y coordinate' edge relative to full page.
pts unsigned char Border thickness. It is sensible only if style = 0.
color unsigned char Border color. It is sensible only if style = 0.

Output Video unsigned char TRUE if successful, FALSE otherwise.
DrawBorder

Video DelBorder (style, x1, yl, x2, y2, pts)

Delete a border outside the rectangle area. The color of fill is the page color assigned with Video SetPageColors

1/0 Name Type Description
Input style unsigned char * 0:Flat
* 1:Raised
e 2:Sunken
Input x1 unsigned short Top-left 'x coordinate' edge relative to full page.
Input vyl unsigned short Top-left 'y coordinate’ edge relative to full page.
Input x2 unsigned short Bottom-down 'x coordinate' edge relative to full page.
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Input y2 unsigned short Bottom-down 'y coordinate' edge relative to full page.
Input pts unsigned char Border thickness It's sensible only if style = 0
Output Video DelBorder | unsigned char TRUE if successful, FALSE otherwise.

Video PrintBitmap (ptrBmp, x, y)

Print a bitmap coded with run-time HMI format

1/0 Name Type Description
Input ptrBmp unsigned long Address of first byte of bitmap.
x unsigned short Top-left 'x coordinate' edge relative to full page.
y unsigned short Top-left 'y coordinate' edge relative to full page.
Output Video unsigned char Not sensible (always TRUE).
PrintBitmap

Video DelBitmap (ptrBmp, %, y)

Delete a bitmap where it is not transparent, coded with run-time HMI format

1/0 Name Type Description

Input ptrBmp unsigned long Address of first byte of bitmap.

Input x unsigned short Top-left 'x coordinate’ edge relative to full page.
Input y unsigned short Top-left 'y coordinate' edge relative to full page.
Output Video DelBitmap unsigned char Not sensible (always TRUE).

Video InitBmpTreeRefresh (x1, yl, x2, y2)

Delete a bitmap where it is not transparent, coded with run-time HMI format

1/0 Name Type Description

Input x1 unsigned short Top-left 'x coordinate' edge relative to full page.

Input vyl unsigned short Top-left 'y coordinate' edge relative to full page.

Input x2 unsigned short Bottom-down 'x coordinate' edge relative to full page.
Input y2 unsigned short Bottom-down 'y coordinate' edge relative to full page.
Output Video DelBitmap | unsigned long Address of invisible device context.

Video EndBmpTreeRefresh (pDC, x1, yl, x2, y2)

Restore original device context and copy the area from invisible context to display context

1/0 Name Type Description
Input pDC unsigned short Address of invisible device context.
Input x1 unsigned short Top-left 'x coordinate’ edge relative to full page.
Input vyl unsigned short Top-left 'y coordinate' edge relative to full page.
Input x2 unsigned short Bottom-down 'x coordinate' edge relative to full page.
Input y2 unsigned short Bottom-down 'y coordinate' edge relative to full page.
Output Video unsigned long Not sensible (always TRUE).
EndBmpTreeRe-
fresh

Functions for Text

Video PrintStr (str, x, y)

Print a string using the current font set with setFont and current colors set with Set-Colors ()
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1/0 Name Type Description
Input str char* Text to print.
x unsigned short Top-left 'x coordinate' edge relative to full page.
y unsigned short Top-left 'y coordinate’ edge relative to full page.
Output Video PrintStr unsigned char Number of chars printed.

Video PrintResStr (idRes, x, y)

Print a resources string using the current font set with Set Font and current colors set with SetColors ()

1/0 Name Type Description
Input idRes unsigned short Identifiers of resource.
x unsigned short Top-left 'x coordinate' edge relative to full page.
y unsigned short Top-left 'y coordinate’ edge relative to full page.
Output Vic}eo_ unsigned char Number of chars printed.
PrintResStr

Video PrintNChar (str, accMode, x, y, nChar, format)

Print at most nChar characters of a string, using the current font set with SetFont and current colors set with SetColors (). It uses also
a format for drawing the text. If nChar is less than string length, it truncates the string; otherwise apply the alignment.

110 Name Type Description
Input str char* Text to print.
accMode unsigned char kACS PRINT: print with colForeTxt and colBackTxt colors.

kACS SELECT: print with colForeSel and colBackSel colors.

x unsigned short Top-left 'x coordinate' edge relative to full page.

y unsigned short Top-left 'y coordinate’ edge relative to full page.

nChar unsigned char Maximum number of chars to print.

format unsigned long Alignment of text. It is sensible only if nChar > length of str:

*  0x08 = right alignment;
*  0x10 = center alignment;
*  0x20 = left alignment.

Output Video unsigned char Number of chars of truncated string.
PrintResStr

Functions for Parameter Access

Video GetParam(idxDevice, idxParam, subIdxParam, pVal, type)

Read a variable at address idxParam from Modbus idxDevice and put the result to variable addressed by pointer pval

I/0 Name Type Description
Wr
Input idxDevice unsigned char Index of device connected.
idxParam unsigned short Index of parameter.
subIdxParam unsigned char Sub-index of parameter.
pval unsigned long Address of variable that contains the read value.
type unsigned char Parameter type. Available values: tyBool, tySInt, tyUSInt,
tyByte, tyInt, tyUInt, tyWord, tyDInt, tyUDInt, tyDWord
tyReal,tyString.
Output Video GetParam unsigned short Number of chars printed.
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Video SetParam(idxDevice, idxParam, subIdxParam, pVal, type)

Write the value of a variable addressed by pointer pval to the variable of address idxParam of Modbus idxDevice

1/0 Name Type Description
Input idxDevice unsigned char Index of device connected.
idxParam unsigned short Index of parameter.
subIdxParam unsigned char Sub-index of parameter.
pval unsigned long Address of variable that contains the value to write.
type unsigned char Parameter type. Available values: tyBool, tySInt, tyUSInt,
tyByte, tyInt, tyUInt, tyWord, tyDInt, tyUDInt, tyDWord,
tyReal, tyString.
Output Video SetParam unsigned short Integer values:

* 0= successful;

* 1 =index of parameter not found;

*  2,8,9=system errors;

* 3 =type not valid;

* 4 =read-only parameter;

* 5= cannot write now;

* 6 =the value is less than the min value;

* 7 =the value is more than the max value.

Functions for Events

Video_ SendEvent (msgID, wParam)

Send an event from code

1/0 Name Type Description
Input msgID unsigned char Available values:
* kWM NULL = no event;
* kWM KEY = key pressure;
* kWM MSG = open message;
* kWM SELECT = select an edit-box, a button;
* kWM _PUSH = pressure on button.
wParam unsigned short Event parameter. It has a different meaning according to msgID:
if kWM NULL = not sensible;
if kWwM_KEY = pressed key.
For the key a constant value exists. The syntax is: kKKEY <key> Ex.
LongLeft ->kKEY LongLeft
if kwM_MSG =ID of message page to open;
if kwM SELECT= handle of selected edit-box, button;
if kwM_PUSH = handle of pressed button.
Output Video SendEvent | unsigned short TRUE if successful, FALSE otherwise.
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Video GetEvent (dmy)

Pop an event from queue

1/0 Name Type Description
Input dmy unsigned char Reserved. Set 0.
Output Video GetEvent unsigned short Double word with inside the encoding.

16 low bit = type of event:
* kWM_NULL = no event;
* kWM KEY = key pressure;
*  kWM_MSG = open message;
* kWM SELECT = select an edit-box, a button;
* kWM_PUSH = pressure on button.
16 high bit = event parameter:
+ if kWM NULL = not sensible;
+ if kWM KEY = pressed key;
« ifkwM MSG = ID of message page to open;
» ifkwM SELECT = handle of selected edit-box, button;
+ if kwM PUSH = handle of pressed button.

Function Blocks for HMI

Function Blocks

Video_GetPageColors

Get the page colors of the page where called

110 Name Type Description

Local variables —_ — _

Input variables —_ —_ —_

Output variables | color word32 Text color in the page.

back word32 Background of the page.
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StaticO1

Text strings with variable visibility

/10 Name Type Description
Local variables memVis byte Visibility status of the previous execution.
Input variables wHnd word16 Handle of the object. Must be unique among static objects.
x word16 Top-left 'x coordinate’ edge relative to full page.
y word16 Top-left 'y coordinate’ edge relative to full page.
accMode byte * kACS_IDLE = no effect;
* kACS_INIT =first draw on display;
* kACS_PRINT = update draw on display.
fResStr byte Boolean value:
* FALSE =psStringis the address of string to draw;
« TRUE = pString is the identifier of resource string.
pString word32 Text to draw. It is different according to fResStr.
pFont word32 Address of font for drawing text. The font must be initialized with
Video AddFont.
foreCol word32 Text color.
bckCol word32 Background color.
pVisVar word32 Visibility. Available values:
* FALSE = text not visible;
* TRUE = text always visible;
* var_addr = address of boolean variable.
format word16 Format for numeric values, encoded in 32 bit:
«  bit 3: 1 = right alignment
« bit4: 1 = center alignment
*  bit5: 1 = left alignment
style byte « 0=flat
* 1=raised
+ 2=sunken
bordPts byte Border thickness. It is sensible only if style = 0
bordCol word32 Border color. It is sensible when style = 0 bordPts > 0 and not
pSelvar = 1 fixed.
selBackCol word32 Background color when object is selected. It is not sensible if pSelvar
=0 fixed.
selForeCol word32 Text color when selected. It is not sensible if pSel1var = 0 fixed.
pRefrvVar word32 Variable for update:
* FALSE = the object is redrawn only when the page is opening or
when returning from child page;
*  TRUE = the object is always redrawn.
pSelVar word32 Selection flag for the object. Suggest if the object must uses
{ ‘selBackCol’ } and { ‘selForeCol’ }. Available values:
* FALSE = object is never selected;
* TRUE = object is always selected;
« var_addr = address of boolean variable.
numChars word16 Number of max characters. 0 indicates that the string is drawn with the

entire value of pString.

Output variables
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Image

Image object

110 Name Type Description
Local variables memVis byte Visibility status of the previous execution.
memSel byte Selection status of the previous execution.
Input variables wHnd word16 Handle of the object. Must be unique among image objects.
x1 word16 Top-left 'x coordinate’ edge relative to full page.
al word16 Top-left 'y coordinate’ edge relative to full page.
px1 word32 Address of variable for moving image on X-Axis. It is sensible only if
floating = TRUE
pyl word32 Address of variable for moving image on Y-Axis. It is sensible only if
floating = TRUE
type x byte Type for px1. Available values: tySInt; tyUSInt; tyByte; tyInt;
tyUInt; tyWord; tyDInt; tyUDInt; tyDWord. Itis sensible only if
floating = TRUE and px1 <> NULL
type y byte Type for py1. Available values: tySInt; tyUSInt; tyByte; tyInt;
tyUInt; tyWord; tyDInt; tyUDInt; tyDWord. Itis sensible only if
floating = TRUE and pyl <> NULL
dx word16 Width (#pixel).
dy word16 Height (#pixel).
style byte + 0O=flat
*+ 1=raised
+ 2=sunken
floating byte Position of object:
* FALSE = docking
+ TRUE = floating
bordPts byte Border thickness. It is sensible only if style = 0
bordCol word32 Border color. It is sensible when style = 0 bordPts > 0 and not
pSelvar = 1 fixed.
bordSelCol word32 Border color for selected object. It is sensible when style = 0 and
bordPts > 0and notpSelvar =0 fixed
accMode byte * kACS_IDLE = no effect
* kACS_ INIT = firstdraw on display
* kACS_ PRINT = update draw on display
* kACS_QUERY = request for updating output variables
* kACS_ BCKQUERY = request for updating output variables when
the object is in background pages
* kACS DELETE = delete object
pBmp word32 Address of first byte of bitmap to view. It is not sensible if pSe1Bmp =1
fixed.
pSelBmp word32 Address of first byte of bitmap to view when selected. It is not sensible
if pSe1Bmp = 0 fixed.
pSelvVar word32 Selection flag for the object. Suggest if the object must uses
{‘bordCol’, ‘pBmp’ } or { ‘bordSelCol’, ‘pSelBmp’}.
Available values:
* FALSE = object is never selected
+ TRUE = object is always selected
« var_addr = address of boolean variable
pVisVar word32 Flag of visibility. Available values:
* FALSE = image not visible
* TRUE =image always visible
» var_addr = address of boolean variable
Output variables reqRefr byte Request refresh, updated when the object is called with accMode =

kACS_QUERY Or accMode = kACS_BCKQUERY.
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Image

Image object

110 Name Type Description
abs x1 word16 Top-left 'x coordinate' edge relative to full page obtained with the sum
among ‘x1’ and px1’. The value is updated when the object is called
with accMode = kACS_INIT or accMode = kACS QUERY.
abs yl word16 Top-left 'y coordinate’ edge relative to full page obtained with the sum
among ‘y1’ and ‘py1’. The value is updated when the object is called
with accMode = kACS_INIT or accMode = kACS QUERY.
mem_ x1 word16 Value read from abs_x1 when the object is called with accMode =
kACS INIT Or accMode = kACS PRINT.
mem_yl word16 Value read from abs_y1 when the object is called with accMode =
kACS_INIT or accMode = kACS PRINT.
Animation
Animation object
110 Name Type Description
Local variables memBmp word32 Address of bitmap of the previous execution
Input variables wHnd word16 Handle of the object. Must be unique among animation objects.
x1 word16 Top-left 'x coordinate' edge relative to full page.
it word16 Top-left 'y coordinate' edge relative to full page.
x2 word16 Bottom-right 'x coordinate' edge relative to full page.
y2 word16 Bottom-right 'y coordinate' edge relative to full page.
style byte + O=flat
* 1=raised
+ 2=sunken
bordPts byte Border thickness. It is sensible only if style = 0
bordCol word32 Border color. It is sensible when style = 0 bordPts > 0 and not
pSelvar =1 fixed
accMode byte * kACS_ IDLE = no effect
* KkACS_INIT =first draw on display
* kACS_PRINT = update draw on display
pPBmpArr word32 Address of first image to view.
pCaseArr word32 Address of first element of selection.
nArrEl byte Number of elements in image list.
pBmpDe £ word32 Address of bitmap to view pSelvar notin pCaseArr.
pSelVar word32 Address of variable for selection.
type byte Type of pSelvar. Available values: tyBool; tySInt; tyUSInt;
tyByte; tyInt; tyUInt; tyWord; tyDInt; tyUDInt; tyDWord.
pVisVar word32 Flag of visibility. Available values:
* FALSE =image not visible
* TRUE = image always visible
* var_addr = address of boolean variable
Output variables — — —
Button02
Button object
110 Name Type Description
Local variables memVis byte Visibility status of the previous execution.
memTransp byte Transparency status of the previous execution.

EI00000003412.05

399



Functions and Function Blocks for HMI

Button02
Button object
/10 Name Type Description
memSel byte Selection status of the previous execution.
Input variables wHnd word16 Handle of the object. Must be unique among buttons objects.
x1 word16 Top-left 'x coordinate’ edge relative to full page.
vyl word16 Top-left 'y coordinate' edge relative to full page.
x2 word16 Bottom-right 'x coordinate' edge relative to full page.
y2 word16 Bottom-right 'y coordinate' edge relative to full page.
fResStr byte Boolean value:
*  FALSE =psString is the address of string to draw
*+ TRUE =pStringis the identifier of resource string
pText word32 Text to draw on the button. It has different meaning according to
fResstr. If this field is NULL, no text is drawn.
pFont word32 Address of font for drawing text. The font must be initialized with
Video AddFont.
style byte + O=flat
*+ 1=raised
* 2=sunken
bordPts byte Border thickness. It is sensible only if style = 0
bordCol word32 Border color and text color. It is sensible only if style =0 and bordPts
>0, or pString different as NULL, and not pSelvar = 1 fixed.
fillCol word32 Color of button area. It is sensible only if pTransp different as 1 fixed,
and not pselvar = 1 fixed.
bordSelCol word32 Border color and text color when selected. It is sensible only if style = 0
and bordPts >0, or pString different as NULL, and not pSelvar =
0 fixed.
fillSelCol word32 Color of button area when selected. It is sensible only if pTransp
different as 1 fixed, and not pse1var = 0 fixed.
accMode byte * kACS_ IDLE = no effect
* kACS_INIT = first draw on display
* kACS_PRINT = update draw on display
pVisVar word32 Flag of visibility. Available values:
* FALSE =image not visible
* TRUE = image always visible
» var_addr = address of boolean variable
pTransp word32 Flag of transparency. Available values:
* FALSE = button always solid
*  TRUE = button always transparent
* var_addr = address of boolean variable
pPressVar word32 Address of a boolean variable.
* Pressed button= *pPressvar = TRUE
* Released button= *pPressvar = FALSE
If the field is NULL there is no variable.
pSelvar word32 Selection flag for the object. Suggest if the object must uses
{‘bordCol’, *fillCol’ } or { ‘bordSelCol’, ‘fillSelCol’}.
Available values:
* FALSE = object is never selected
* TRUE = object is always selected
» var_addr = address of boolean variable
format word16 Format of numeric values encoded with 16 bit:

* bit4: 1 =right alignment

* bit5: 1 = center alignment
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Button02

Button object

/10 Name Type Description

* bit6: 1 = left alignment

order word16 Number for establishing a sequential selection.
Output variables — — —
EditBox01
Edit object
110 Name Type Description
Local variables memVis byte Visibility status of the previous execution.
wHnd word16 Handle of the object. Must be unique among edit-box objects.
x1 word16 Top-left 'x coordinate' edge relative to full page.
Input variables vyl word16 Top-left 'y coordinate' edge relative to full page.
x2 word16 Bottom-right 'x coordinate' edge relative to full page.
y2 word16 Bottom-right 'y coordinate' edge relative to full page.
pFont word32 Address of font for drawing text. The font must be initialized with

Video_ AddFont.

style byte + O=flat
* 1=raised
* 2=sunken

foreCol word32 Text color.

bckCol word32 Background color.

foreSelCol word32 Text color when selected. It is sensible only if pCanSel is not 0 fixed.

bckSelCol word32 Background color when selected. It is sensible only if pCanSel is not 0
constant.

bordPts byte Border thickness. It is sensible only if style = 0

bordCol word32 Border color. It is sensible when style = 0 bordPts> 0

rw byte * FALSE = read-only mode

¢ TRUE = read-write mode

refr byte Request refresh:

* FALSE = the object is redrawn only when the page is opening or
return from child page

* TRUE = the object is always redrawn

pvar word32 Address of variable or parameter according to format. It cannot be
NULL. If it is a parameter is encoded in this way:

* bit0...7 = Subindex parameter
* bit8...23 = IPA parameter
*  bit 24...32 = Device address

type byte Type of data. Available values: tyBool; tySInt; tyUSInt; tyByte;
tyInt; tyUInt; tyWord; tyDInt; tyUDInt; tyDWord; tyReal

pVarMin word32 Min value for edit-box variable. If bit 16...17 (LSB) of field format
contains 0 the limit is not set, if contains 1 is a constant limit, if contains
2 itis a variable limit.

pVarMax word32 Max value for edit-box variable. If bit 14...15 (LSB) of field format
contains 0 the limit is not set, if contains 1 is a constant limit, if contains
2 it’s a variable limit.

enumId int16 Identifier of enumerative. If 0 no enumerative associated with this field
exists.
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EditBox01

Edit object

110

Name

Type

Description

format

word32

View format encoded in 32 bit:

bit 0

o0 =draw sign only if number is negative

o 1 =draw sign also for positive numbers

bit 1

> 0=does not print most significant null digits
o 1 =draw zeroes on most significant null digits
bit 2

o 0='pVar is a variable

o 1="pVar is a parameter

bit 3: 1 = right alignment

bit 4: 1 = center alignment

bit 5: 1 = left alignment

bit 10: Hexadecimal format, with a...f lowercase
bit 11: Hexadecimal format, with A...F uppercase
bit 14...15

o 0=no max limit

o 1= constant max limit

o 2 =variable max limit

bit 16...17

o 0=nomin limit

o 1 =constant min limit

o 2 =variable min limit

bit 24...26: Precision (real numbers)

bit 27...31: Width

pVisVar

word32

Flag of visibility. Available values:

FALSE = object not visible
TRUE = object always visible
var_addr = address of boolean variable

pCanSel

word32

Available values:

FALSE = object not selected
TRUE = object always selected
var_addr = address of boolean variable

order

byte

Number for establish a sequential selection.

accMode

byte

kACS IDLE = no effect

kACS INIT =first draw on display

kACS_ PRINT = update draw on display

kACS_SELECT = update draw on display when selected
kACS MODIFY = enter in editing mode

Output variables

outKey

char

Key code for exiting editing-mode.
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TextBox

Text box object

/10 Name Type Description
Local variables memVis byte Visibility status of the previous execution.
base word16 Number of first line seen in object.
Input variables wHnd word16 Handle of the object. Must be unique among textbox objects.
x1 word16 Top-left 'x coordinate' edge relative to full page.
vyl word16 Top-left 'y coordinate’ edge relative to full page.
x2 word16 Bottom-right 'x coordinate' edge relative to full page.
y2 word16 Bottom-right 'y coordinate' edge relative to full page.
pFont word32 Address of font for drawing text. The font must be initialized with
Video AddFont.
style byte + O=flat
* 1 =raised
+ 2=sunken
foreCol byte Text color.
bckCol byte Background color.
bordPts byte Border thickness It is sensible only if style =0
bordCol byte Border color. It is sensible when style = 0 bordPts >0
LineNr byte * FALSE = hide line number
*  TRUE = show line number
rw byte * FALSE-= read-only mode
*  TRUE= read-write mode
pvVar word32 Address of string variable. It cannot be NULL.
szpvar word32 Size of pvar.
pVisVar word32 Flag of visibility. Available values:
* FALSE= object not visible
*  TRUE-= object always visible
» var_addr= address of boolean variable
order byte Number for establishing a sequential selection.
accMode byte Access mode. Available values:
* kACS_IDLE = no effect when selected
* kACS_INIT = first draw on display
* kACS_ PRINT = update draw on display
* kACS_SELECT = update draw on display
* kACS_MODIFY = enter editing mode
* kACS_SCROLLUP = scroll up one line
* kACS_SCROLLDW = scroll down one line
rqgCursPos word16 Char Index where move the cursor.
rgqCursRow word16 Row to select.
dispCurs byte » TRUE=the cursor is always visible even if it is not enabled
editing mode
» FALSE= the cursor is visible only if it is enabled editing mode
dispRow byte » TRUE= the row selection is always visible even if it is not enabled
editing mode
* FALSE-= the row selection is visible only if it is enabled editing
mode
bckSelCol word32 Future developments.
wParam word32 Future developments.
IParam word32 Future developments.
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TextBox

Text box object

/10 Name Type Description
Output variables outKey char Key code for exiting editing-mode.
outCursPos word16 Char index where there is the cursor.
outCursRow word16 Index of selected row.
Progress
Progress bar object
110 Name Type Description
Local variables memvis byte Visibility status of the previous execution
memVal word32 Progress status of the previous execution
Input variables wHnd word16 Handle of the object. Must be unique among progress objects.
x1 word16 Top-left 'x coordinate’ edge relative to full page.
vyl word16 Top-left 'y coordinate' edge relative to full page.
x2 word16 Bottom-right 'x coordinate' edge relative to full page.
y2 word16 Bottom-right 'y coordinate' edge relative to full page.
style byte + O=flat
* 1=raised
* 2=sunken
barCol word32 Color of step bar.
bckCol word32 Background color.
bordPts byte Border thickness. It is sensible only if style = 0
bordCol word32 Border color. It is sensible when style = 0 bordPts >0
pvVar word32 Step variable. This is the filling percentage of bar in relation with the
range assigned by pMin and pMax.
type byte Type of pvar. Assigned values: tyBool; tySInt; tyUSInt; tyByte;
tyInt; tyUInt; tyWord; tyDInt; tyUDInt; tyDWord
pMin word32 Min value for edit-box variable. If bit 0 (LSB) of field format contain 0 is
a constant limit, if contain 1 it is a variable limit.
pMax word32 Min value for edit-box variable. If bit 1 (LSB) of field format contain 0 is
a constant limit, if contain 1 it is a variable limit.
format word32 View format encoded in bit:
+  bit0:
o 0 =pMin contains a constant value of Type ‘type’
° 1 =pMin contains the address of variable of Type ‘type’
+  bit1:
o 0 =pMax contains a constant value of Type type
o 1 =pMax contains the address of variable of Type type
+  bit2:
o 0= horizontal orientation
o 1 =vertical orientation
pVisVar word32 Flag of visibility. Available values:
* FALSE = object not visible
+ TRUE = object always visible
» var_addr = address of boolean variable
accMode byte Access mode. Available values:

* kACS_IDLE = no effect
*  KACS_INIT = first draw on display
* kACS_PRINT = update draw on display

Output variables
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CustomCtrl

Progress bar object

/10 Name Type Description
Local variables memVis byte Visibility status of the previous execution.
ptrFunct word32 Address of function that implements Type wCtr11ID.
datal word32 Local variable.
datal word32 Local variable.
data2 word32 Local variable.
data3 word32 Local variable.
Input variables wHnd word16 Handle of the object. Must be unique among custom control objects.
x1 word16 Top-left 'x coordinate' edge relative to full page.
vyl word16 Top-left 'y coordinate’ edge relative to full page.
x2 word16 Bottom-right 'x coordinate' edge relative to full page.
v2 word16 Bottom-right 'y coordinate' edge relative to full page.
wCtrlID word16 Identifier of custom control.
pVisVar word32 Flag of visibility. Available values:
* FALSE = object not visible
* TRUE = object always visible
* var_addr = address of boolean variable
refr byte Request refresh:
* FALSE = the object is redrawn only when the page is opening or
return from child page
* TRUE = the object is always redrawn
accMode byte Access mode. Available values:
* KkACS_IDLE = no effect
* kACS_INIT =first draw on display
* kACS_PRINT = update draw on display
The value greater than 200 can be used for custom purpose.
wParam word16 16 bit data without sign, used for custom purpose
lParam int32 32 bit data with sign, used for custom purpose
rParam float 32 bit real data with sign, used for custom purpose

Output variable
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The Commissioning Tab

What’s in This Chapter

Overview of the Commissioning Window

Menu Bar
Toolbar

Overview of the Commissioning Window

General Description

Commissioning is the entry point to deploy projects on real devices.

The following illustration presents the default Commissioning window:

3
|

4 5

oH -
B ) BIOS parameters
@ = Al parameters
Acknowledgement
Calibration Al
Calibration AO
© @ Analogue 110
RS485-1 On Board
RS485-2 On Board
CAN On Board
RS485 Plugin Passive
CAN Plugin Passive
RS232 Plugin Passive
Ethernet
Modem
Display
BACnet
FileSystem Volumes
Miscellaneous
[-] 1/0 Values
Lower Board
Upper Board
Led & Backlight Values
System Clock Values
Protection Password
USB-Host and microSD
Battery Handling
Ethernet
Web Password
@@ Application
& crgfiles
Recipes

Ready

Information

W Resources

Output

N\

Status:
Firmware version:
PLC application:

Model

Preprocessing Application completed.

Preprocessing

Communication completed.

Pumping
display leted

0 warnings, 0

errors

Find in project | Debug | Resources| HMI Output

C:\My Project\My Project.plcprj

Display Commiss

NOT CONNECTED

No Application

Undefined 10s

- X
-0 x
Commissioning Watch 8 x
“imme|r
Device Name Value
“ M >
Commissioning Oscilloscope 8 x
1888 B|a&a8(«Lxm

4bvx

EDIT MODE

4 x

Min val

NOT CONNECTED

Watch window

format when the application is running and connected to the target device.

For more information about how to use the Commissioning Watch window, refer to Commissioning

Watch Window, page 417

Item Description
1 Toolbar This toolbar shows the tools in form of icons.
For more information, refer to Toolbars, page 408.
2 Cpmmissioning This window shows the configurable BIOS parameters of the target device.
window For more information, refer to Content of the Commissioning Window, page 410.
3 Editor window This window allows you to edit the content of the current selection in Commissioning window.
4 Commissioning This window enables you to manage variables debugging by displaying their status in numerical
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Item Description
5 Commissioning This window enables you to plot the evolution of the values of a set of variables. Being an
Qscilloscope asynchronous tool, the Oscilloscope cannot establish synchronization of samples.
window For more information about how to use the Commissioning Oscilloscope window, refer to
Commissioning Oscilloscope Window, page 418
6 Output window This window shows the messages relating to the development of the project (file opening, reading/
writing detected faults, status of connection to device, and so on).
NOTE: The connection to the device is also visible in the status bar, page 34.
Menu Bar
Overview
The menu bar of Commissioning tab is composed of these menus:
* File, page 27
+ View, page 32
+ Parameters, page 29
* Recipes, page 30
+ Target, page 31
* Options, page 28
* Help, page 27
Toolbar
Introduction

The toolbar appears at the top of the EcoStruxure Machine Expert - HVAC window
to provide access to frequently used functions.

For generalities of toolbars, refer to Toolbars description, page 33.

Commissioning Toolbar

The Commissioning toolbar has the following buttons:

Description Shortcut

Connects to the target -

|3
=}

Starts the communication with the device.

Toggle Auto refresh mode -

!

Starts or stops (toggle) the Auto refresh mode.

Refresh page -

Reloads the values for the current page.

Select all parameters Ctrl+A

Select all the parameters from the currently displayed parameter table.

Read parameter Ctrl+R

A H G

Read the value of the selected parameters.

408
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Icon | Description Shortcut
w Write parameter Ctrl+W
Write the value of the selected parameters.
i Read all Ctrl+Shift+R
- Read all BIOS parameters from the target.
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Managing Commissioning Elements

Overview

What’s in This Chapter

L@ YT 11 410
Target DEVICE ... 413

Commissioning Window

Overview

Once the target device is connected, the Commissioning window allows you to:

* Read and write one or more BIOS parameters,
* Modify and restore the BIOS parameters to default,
* Read the current value of application variables (but not modify them).

NOTE: These variables can be displayed by dragging them to the Watch
and Oscilloscope windows.

Content of the Commissioning Window

The Commissioning window consists of the following items:

Item

Icon

Description

Target device

Shows the picture of the target device and allows you to configure some settings.
NOTE: For more information, refer to Target Device, page 413.

BIOS parameters

Shows the list of BIOS settings that you can modify.

Application = Shows the menu list.
NOTE: For more information, refer to Target Menus, page 62.
Cfg files _iq. Shows the CONNEC.PAR configuration file.
— NOTE: To download this file to the target device, right-click on Cfg files and click
Download files.
Recipes Shows the list of recipes.

NOTE: You can add a parameter directly to a recipe by dragging and dropping.

NOTE: The Commissioning window content depends on the selected

device.

Match Software and Hardware Configuration

The 1/O that may be embedded in your controller is independent of the I/O that you
may have added in the form of I/O expansion. It is important that the logical /O
configuration within your program matches the physical I/O configuration of your
installation. If you add or remove any physical I/O to or from the I/O expansion
bus, then you must update your application configuration. This is also true for any

field bus devices you may have in your installation. Otherwise, there is the
potential that the expansion bus or field bus no longer function while the
embedded I/O that may be present in your controller continues to operate.

410
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Expansion Bus

AWARNING

UNINTENDED EQUIPMENT OPERATION

Update the configuration of your program each time you add or delete any type
of 1/0 expansions on your I/O bus, or you add or delete any devices on your
field bus.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

You must monitor within your application the state of the bus and the error state of
the module(s) on the bus, and to take the appropriate action necessary given your

particular application.

AWARNING

UNINTENDED EQUIPMENT OPERATION

* Include in your risk assessment the possibility of unsuccessful
communication between the logic controller and any I/O expansion modules.

* Monitor the state of the 1/0 expansion bus using the dedicated %SW system
words and take appropriate actions as determined by your risk assessment.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Read and Write BIOS Parameters

Overview

Read Parameters

The term “parameter” refers to any resource present on the target device:
parameters, 1/O, and variables of the application.

By default, the project contains a list of the BIOS parameters and I/O values with
their respective default settings.

From the target device, you can read the parameters.

To read a parameter, select it and click the R icon.
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Write Parameters

To read the parameters, click Parameters > Read all. The operation takes a few
seconds.

C:\My Project\My Project.plcprj - 0 X
D E
9 File View Parameters Recipes Target Options  Help -0 x
iHoco=|lRrw*s
Commissioning 2 x =
(-] - M172 2842 1/0s
& 4 BIOS parameters Address Name Value Um Default -
© i All parameters 9492 False False
© = O Values 9435 00 %
Led & Backlight Values 0462 Falee e
System Clock Values 5
9466 False False
Protection Password
USB-Host and microSD 9509 xCmdOpHoursResetComp1Cir2 False False
Battery Handling 9519 0 s 0
Ethernet 9527 a = o
8 [ Application 9535 Reading parameters.
@ [ My Project = 16464 E2_udiOpHoursComp1Cir2 _ 0
General 16480 E2_udiNbStarsComp1Cir2 0
Pumps 0493 336/ 1410 Cancel False
Circuitt 9436 00
CompressorsCirt
FanaCirt 9463 False False
EEVCirt 9467 False False
Circuit2 9510 xCmdOpHoursResetComp2Cir2 False False
FansCir2 9528 0 s 0 <
EEVCir2 « ] >
Alarms | B Resources* 4bvx
Ready READ ONLY DIFF. CODE

The default value of the analog inputs and outputs is 0.0. The digital inputs and
outputs are set to FALSE.

You can download the parameters to the target device, either with their default
values or with modified values inserted by you.

To write a parameter, select it and click the W icon.

To download the parameters (local BIOS), click Parameters > Select all or click
Select all parameters icon. The parameters are highlighted in yellow. Then, click

Parameters > Write selected or click the W Write parameter icon. The
parameters are downloaded to the target device.

Downloading the parameters by clicking Parameters > Write all replaces the
values present on the target device with the values listed in the Value column.

If you select Parameters > Write all default values, the default values including I/
O is downloaded to the target device.

Color Rules of Values

The inputs are read-only and are shown in gray. See the following table of
parameter values:

Color Column Description Cases
Black Value Value aligned with default Target already read
Blue Default Default column value different from value in value Target already read
column
Red Value Value NOT aligned with default Device just opened value
changed by you
Gray Name Read-only parameters I/0 values analog inputs Al
digital inputs DI
Green Name Parameters not visible on target display (only for See visibility table
M1710)
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Target Device

Overview
Description
In the Commissioning window, double-click the title of the project to display the
editor window.
The editor window presents the graphic of the target device and lets you access
some settings.
These settings may differ depending on the target device chosen for the project.
General
Overview
The General box displays the name of the project target device and the version
number of its excepted firmware.
General Name: | M17228-42 I/Os
File
) 596.11
version:
Communication
Overview

The Communication box displays information about the communication between
the PC and the target device (protocol, address, port, and baud rate).

Communication

Protocol: Modbus Settings
Address: 1

Port: COoM:4

Baud rate: 38400

Communication Settings

To modify the communication settings, click the Settings button or click Target >
Communication settings.
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To modify the communication protocol, select the desired protocol in the
Protocols list and click the Activate button.

DeviceLinkManager Config 11.1.0.0 X

Selected protocol : Modbus

Protocols Active

¥ Can
¥ GbB

Active
%~ ModbusTCP
W TM171ADMI

Properties Activate
Description

Modbus Protocol

OK Cancel

The communication modalities can be modified by clicking the Properties button.

Modbus Config 11.1.0.0 X

Communication
Port

COM4 v

Baudrate 38400

v

Frame settings N.8.1

v
Protocol

@Modbus Address | q

(O Modbus ASCII Timeout 1000

OJbus

| ] Enable remote communication

Server name

[ "] Enable modem communication

Dial number

OK Cancel

For more information on how to establish communication between EcoStruxure

Machine Expert - HVAC and the target device, refer to Setting Up the
Communication, page 177.

Information
Overview
The Information box displays the information of the device connected to the PC
(firmware version, current device application, and model).
Information Status:
Firmware version: [ 596.11 }
PLC application: [ TVDA_HeatPump }
Model: [ Display 42 10s }
NOTE: Make sure the firmware version installed on the target device matches
the firmware version used by the project. For more informations, refer to Other
Operations, page 415.
414

EI00000003412.05



Managing Commissioning Elements

Download Settings

Overview

The Download settings box displays where data is downloaded.

Download settings Use manual settings [v|
NOR SD
PLC ® O
HMI ® O
HMI Remote @ O
Cfg files ® O
Web site ® O

[] Reset binding configuration
[] Align Target RTC

To modify the data download location, select from the drop-down list Use manual
settings and choose:

* NOR: to download to internal memory,
+ SD: to download to SD card.
Two additional options are available:
* Reset binding configuration: remove the bindings defined in the installer,
« Align Target RTC: align controller clock with PC clock.

Other Operations

Overview

The Other operations box allows you to perform the following actions:

Action Goal

BIOS download Update the BIOS of the target device using a *.bin file.

Open file browser Explore the storage space of the device through a Windows
Explorer.

Web site download Downloads webpages created in the project by user.

Web site preview Preview created webpages.

Generate XIF file Create a *.xif file which needs to be manually transferred to

the target device.

NOTE: The XIF is a text-based file that defines the
network image of the device to a network management
tool (for example, Niagara, LonMaker, and so on). The
XIF along with files termed device resource files (DRFs)
are used by the management tools to work with the LON

device.
Generate parameters files Create parameters files Param.dat, Param.raw and Param.
CSV.
Generate USB files on target Force target controller to generate Param.dat and Param.bin

directly in an USB memory key connected to the port.

NOTE: The controller must be powered to allow for this
feature.
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Action Goal
Import parameters files Allows to import a pre-generated parameters file in the target
controller.

NOTE: After import procedure the software asks to
generate a recipe in the project.

Create USB programming files Create a backup of the project for later restore.

Bios Download Feature

If an incorrect firmware is downloaded into a device, the device could be
damaged.

ACAUTION
UNINTENDED EQUIPMENT OPERATION

Verify that the firmware to be downloaded into your device corresponds to the
connected device.

Failure to follow these instructions can result in injury or equipment
damage.
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Debugging

Overview

Description

What’s in This Chapter

OVEIVIEW ...ttt ettt e e ettt e e e et e e e e eetn e eeeees 417
Commissioning Watch WINdOW ... 417
Commissioning Oscilloscope WINAOW ...........viiiiiiiiiiiiiiei e 418

EcoStruxure Machine Expert - HVAC provides several debugging tools, which
help you to verify whether the application behaves as intended.

These debugging tools basically allow you to watch the value of selected variables
while the PLC application is running.

Commissioning debugging tools are asynchronous debuggers. They read the
values of the variables you selected with successive queries issued to the target
device. Both the manager of the debugging tool (that runs on the PC) and,
potentially, the task which is responsible to answer those queries (on the target
device) run independently from the PLC application. The values of two distinct
variables being sampled in the same moment are not necessarily in concordance
with each other with respect to the PLC application execution (one or more cycles
may have occurred). For the same reason, the evolution of the value of a single
variable is not consistent with its actual value in the controller memory, especially
when it is updated rapidly within the application.

This chapter presents how to debug your application using debugging tools.

Commissioning Watch Window

Description

The Watch window allows you to monitor the values of a set of variables. Being an
asynchronous tool, the Watch window does not establish synchronization of
values. Values of the variables in the Watch window may refer to different
execution cycles of the corresponding task.

The Watch window contains an item for each variable that you added to it. The
information displayed in the Watch window includes the name of the variable, its
value, its type, and its location in the PLC application.

mmissioni tch 0 x
|IB@e|r s

Device Name Value Subldx | Um Description

For more information about the Commissioning Watch window, refer to Watch
Window, page 195.

NOTE: The functions available in the Programming Watch window are only
available for variables with Modbus address (EEPROM Parameters, Status
variables, and BIOS Parameters).
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Debugging

Commissioning Oscilloscope Window

Description
The Oscilloscope allows you to plot the evolution of the values of a set of
variables. Being an asynchronous tool, the Oscilloscope cannot establish
synchronization of samples.
Oscilloscope window is an interface for accessing the debugging functions that
the Oscilloscope makes available:
4 x

IHEE O Fa0 L0 00 » |[E =W

Track Um Min value Max value Cur value Value/Div  Description
The Oscilloscope consists of three elements:

» The toolbar allows you to control the Oscilloscope.

» The Chart area includes several items:

o Plot: area containing the curve of the variables.

> Vertical cursors: cursors identifying two distinct vertical lines. The values
of each variable at the intersection with these lines are reported in the
corresponding columns.

o Scroll bar: if the scale of the x-axis is too large to display all the samples in
the Plot area, the scroll bar allows you to slide back and forth along the
horizontal axis.

» The lower section of the Oscilloscope is a table consisting of a row for each

variable.

For more information about Commissioning Oscilloscope window, refer to

Oscilloscope, page 201.
NOTE: The functions available in the Programming Watch window are only
available for variables with Modbus address (EEPROM Parameters, Status
variables, and BIOS Parameters).
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Appendices

M1730 Specific Libraries

Filesystem Folder

Listed below are the functions specific for M1730 targets, available in the Library
Tree > Function blocks section of EcoStruxure Machine Expert — HVAC

software .

NOTE: These functions are available starting from EcoStruxure Machine
Expert — HVAC version 1.8.0.

Filesystem Functions

FS_CloseFile Close the specified file.
The function returns a BOOL with the following meaning:
TRUE = File closed.
FALSE = An error occurred or invalid calling task.
FS_CopyFile Copy a file

FS_CopyFileSync

Copy a file with SYNC mode on (every segment write ends with sync)

FS_CreateDir

Create specified directory if not exists.
The function returns a BOOL with the following meanings:
TRUE = Specified directory created.

FALSE = Cannot create directory or directory already exists or invalid
calling task.

FS_DeleteFile

Delete afile.
The function returns a BOOL with the following meaning:
TRUE = File deleted.

FALSE = Cannot delete file or invalid calling task.

FS_DirExists

Check if the specified directory exists or not
The function returns a BOOL with the following meanings
TRUE = Specified directory exists.

FALSE = Specified directory does not exists or invalid calling task.

FS_FileEOF

Test if end of file is reached.

The function returns a BOOL with the following meaning:
TRUE = End of file reached.

FALSE = End of file not reached yet.

FS_FileExists

Check if the specified file exists or not
The function returns a BOOL with the following meanings
TRUE = Specified file exists.

FALSE = Specified file does not exists or invalid calling task.

FS_FileTell

Returns the actual position of the file:

-1in case of error.

FS_Find_GetFileName

Returns the name of a matching file of a search

FS_Find_GetFileSize

Returns the size of a matching file of a search

FS_Find_GetFileTime

Returns the date and time of a matching file of a search

FS_Find_lIsDirectory

Returns if matching file is a directory

FS_Find_IsWritable

Returns if matching file is writable
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FS_FindClose

Close a search handle

FS_FindFirstFile

Searches for files on the disk, starting on path and using the specified
filter with wildcard.

Returns an handle that can be passed to FS_Find* functions, or O if
no files found; returns -1 for invalid calling task

FS_FindNextFile

Searches the next matching file. Returns FALSE if no more files are
found or invalid calling task

FS_Flush

Force writing on specified handle.
The function returns a BOOL with the following meaning:
TRUE = flush ok

FALSE = An error occurred or invalid calling task

FS_GetFreeSpace

Returns the free space in Kbytes of the volume path specified:

-1in case of error.

FS_MoveFile

Move or rename a file

FS_OpenFile

Open a file in the specified mode.
The function returns an UDINT with the following meaning:
0 = No file found or Invalid calling task

Otherwise = handle of the file.

FS_OpenFileSync

Open a file with SYNC mode on (every write ends with sync)
The function returns an UDINT with the following meaning:
0 = No file found.

-1 = Invalid calling task

Otherwise = handle of the file.

FS_ReadFile

Read binary data from the specified file.
The function returns the number of bytes read, or
0 = Error reading

-1 = Invalid calling task

FS_ReadString

Read a STRING from the specified file. Returns FALSE if error or
invalid calling task

FS_SeekFile

Seek a position into the file.
TRUE = Cursor position set.

FALSE = An error occurred or invalid calling task

FS_Sync

Sync all modifies on external drivers (only POSIX compatible targets)

FS_Unmount

Unmount the mount point specified

NOTE: Function for safe disconnection. If the USB Memory Key or
MicroSD Memory Card extracted from the M1730 is not correctly
disconnected, it may be that connecting it to a PC gives an error, in
this case a window will appear with the request to correct the error,
answer oK.

FS_WriteFile

Write binary data to the specified file.
The function returns the number of bytes written, or
0 = Error writing

-1 = Invalid calling task

FS_WriteString

Write a STRING to the specified file. Returns FALSE if error or invalid
calling task

422
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Glossary

A
%:

According to the IEC standard, % is a prefix that identifies internal memory
addresses in the logic controller to store the value of program variables,
constants, 1/0, and so on.

analog input:

Converts received voltage or current levels into numerical values. You can store
and process these values within the logic controller.

analog output:

Converts numerical values within the logic controller and sends out proportional
voltage or current levels.

application:
A program including configuration data, symbols, and documentation.
ARRAY:

The systematic arrangement of data objects of a single type in the form of a table
defined in logic controller memory. The syntax is as follows: ARRAY
[<dimension>] OF <Type>

Example 1: ARRAY [1..2] OF BOOL is a 1-dimensional table with 2 elements of
type BOOL.

Example 2: ARRAY [1..10, 1..20] OF INT is a 2-dimensional table with 10 x
20 elements of type INT.

ASCII:

(American standard code for Information Interchange) A protocol for representing
alphanumeric characters (letters, numbers, certain graphics, and control
characters).

assigned variable:
A variable is assigned if its location in the logic controller memory is known.

For example, the Water pressure variable is said to be assigned through its
association with memory location $MW102.

B
BOOL:

(boolean) A basic data type in computing. A BOOL variable can have one of these
values: 0 (FALSE), 1 (TRUE). A bit that is extracted from a word is of type BOOL;
for example, $MW10. 4 is a fifth bit of memory word number 10.

Boot application:

(boot application) The binary file that contains the application. Usually, it is stored
in the controller and allows the controller to boot on the application that the user
has generated.

byte:
A type that is encoded in an 8-bit format, ranging from 00 hex to FF hex.
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C

conditional element:
Allows to implement conditions in the program in offline mode.
configuration:

The arrangement and interconnection of hardware components within a system
and the hardware and software parameters that determine the operating
characteristics of the system.

controller:

Automates industrial processes (also known as programmable logic controller or
programmable controller).

D
digital 1/O:

(digital input/output) An individual circuit connection at the electronic module that
corresponds directly to a data table bit. The data table bit holds the value of the
signal at the I/O circuit. It gives the control logic digital access to I/O values.

DINT:

(double integer type) Encoded in 32-bit format.
DWORD:

(double word) Encoded in 32-bit format.

E
EDS:

(electronic data sheet) A file for fieldbus device description that contains, for
example, the properties of a device such as parameters and settings.

EEPROM:

(electrically erasable programmable read-only memory) A type of non-volatile
memory to store required data even when power is removed.
NOTE:

Ethernet:
A physical and data link layer technology for LANs, also known as IEEE 802.3.

expansion I/O module:

(expansion input/output module) Either a digital or analog module that adds
additional I/0 to the base controller.

F
FBD:

(function block diagram) One of 5 languages for logic or control supported by the
standard IEC 61131-3 for control systems. Function block diagram is a graphically
oriented programming language. It works with a list of networks, where each
network contains a graphical structure of boxes and connection lines, which
represents either a logical or arithmetic expression, the call of a function block, a
jump, or a return instruction.

424
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FB:

(function block) A convenient programming mechanism that consolidates a group
of programming instructions to perform a specific and normalized action, such as
speed control, interval control, or counting. A function block may comprise
configuration data, a set of internal or external operating parameters and usually
1 or more data inputs and outputs.

function block diagram:

One of the 5 languages for logic or control supported by the standard IEC 61131-
3 for control systems. Function block diagram is a graphically oriented
programming language. It works with a list of networks where each network
contains a graphical structure of boxes and connection lines representing either a
logical or arithmetic expression, the call of a function block, a jump, or a return
instruction.

function block:

A programming unit that has 1 or more inputs and returns 1 or more outputs. FBs
are called through an instance (function block copy with dedicated name and
variables) and each instance has a persistent state (outputs and internal
variables) from 1 call to the other.

Examples: timers, counters

function:

A programming unit that has 1 input and returns 1 immediate result. However,
unlike FBs, it is directly called with its name (as opposed to through an instance),
has no persistent state from one call to the next and can be used as an operand
in other programming expressions.

Examples: boolean (AND) operators, calculations, conversions (BYTE_TO _INT)

H

hex:

(hexadecimal)

I
1/0:

(input/output)
%l:

According to the IEC standard, %I represents an input bit (for example, a
language object of type digital IN).

IEC 61131-3:

Part 3 of a 3-part IEC standard for industrial automation equipment. IEC 61131-3
is concerned with controller programming languages and defines 2 graphical and
2 textual programming language standards. The graphical programming
languages are ladder diagram and function block diagram. The textual
programming languages include structured text and instruction list.

IL:

(instruction list) A program written in the language that is composed of a series of
text-based instructions executed sequentially by the controller. Each instruction
includes a line number, an instruction code, and an operand (refer to IEC 61131-
3).

instruction list language:

A program written in the instruction list language that is composed of a series of
text-based instructions executed sequentially by the controller. Each instruction
includes a line number, an instruction code, and an operand (see IEC 61131-3).
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IP:

(Internet protocol Part of the TCP/IP protocol family that tracks the Internet
addresses of devices, routes outgoing messages, and recognizes incoming
messages.

%IW:

According to the IEC standard, %IW represents an input word register (for
example, a language object of type analog IN).

L

ladder diagram language:

A graphical representation of the instructions of a controller program with symbols
for contacts, coils, and blocks in a series of rungs executed sequentially by a
controller (see IEC 61131-3).

LED:

(light emitting diode) An indicator that illuminates under a low-level electrical
charge.

M

machine:

Consists of several functions and/or equipment.

master/slave:

The single direction of control in a network that implements the master/slave
mode.

Modbus:

The protocol that allows communications between many devices connected to the
same network.

%MW:

According to the IEC standard, %MW represents a memory word register (for
example, a language object of type memory word).

N

node:

An addressable device on a communication network.

P
PDO:

(process data object) An unconfirmed broadcast message or sent from a
producer device to a consumer device in a CAN-based network. The transmit
PDO from the producer device has a specific identifier that corresponds to the
receive PDO of the consumer devices.

PLC:

(programmable logic controller) An industrial computer used to automate
manufacturing, industrial, and other electromechanical processes. PLCs are
different from common computers in that they are designed to have multiple input
and output arrays and adhere to more robust specifications for shock, vibration,
temperature, and electrical interference among other things.

426
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POU:

(program organization unit) A variable declaration in source code and a
corresponding instruction set. POUs facilitate the modular re-use of software
programs, functions, and function blocks. Once declared, POUs are available to
one another.

program:

The component of an application that consists of compiled source code capable
of being installed in the memory of a logic controller.

protocol:

A convention or standard definition that controls or enables the connection,
communication, and data transfer between 2 computing system and devices.

Q
%Q:

According to the IEC standard, %Q represents an output bit (for example, a
language object of type digital OUT).

R
RJ45:

A standard type of 8-pin connector for network cables defined for Ethernet.

RPDO:

(receive process data object) An unconfirmed broadcast message or sent from a
producer device to a consumer device in a CAN-based network. The transmit
PDO from the producer device has a specific identifier that corresponds to the
receive PDO of the consumer devices.

RS-232:

A standard type of serial communication bus, based on 3 wires (also known as
EIA RS-232C or V.24).

RS-485:

A standard type of serial communication bus, based on 2 wires (also known as
EIA RS-485).

RTU:

(remote terminal unit ) A device that interfaces with objects in the physical world
to a distributed control system or SCADA system by transmitting telemetry data to
the system and/or altering the state of connected objects based on control
messages received from the system.

S
SFC:

(sequential function chart) A language that is composed of steps with associated
actions, transitions with associated logic condition, and directed links between
steps and transitions. (The SFC standard is defined in IEC 848. Itis IEC 61131-3
compliant.)

SINT:
(signed integer) A 15-bit value plus sign.

string:

A variable that is a series of ASCII characters.
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ST:

(structured text) A language that includes complex statements and nested
instructions (such as iteration loops, conditional executions, or functions). ST is
compliant with IEC 61131-3.

symbol:

A string of a maximum of 32 alphanumeric characters, of which the first character
is alphabetic. It allows you to personalize a controller object to facilitate the
maintainability of the application.

T
TCP:

(transmission control protocol) A connection-based transport layer protocol that
provides a simultaneous bi-directional transmission of data. TCP is part of the
TCP/IP protocol suite.

terminal block:

(terminal block) The component that mounts in an electronic module and provides
electrical connections between the controller and the field devices.

TPDO:

(transmit process data object) An unconfirmed broadcast message or sent from a
producer device to a consumer device in a CAN-based network. The transmit
PDO from the producer device has a specific identifier that corresponds to the
receive PDO of the consumer devices.

U
UDINT:

(unsigned double integer) Encoded in 32 bits.
UINT:

(unsigned integer) Encoded in 16 bits.
user defined function:

It allows you to create your own functions with one or more input parameters,
local variables, and a return value. The user-defined function can then be called
in operation blocks. A user-defined function is stored as part of the project and
downloaded to the logic controller as part of the application.

W
WORD:

A type encoded in a 16-bit format.
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